
Street Atlas USA User Guide 



WARNING: Messaging, tracking and SOS functions require an active Iridium satellite subscription. 
Always test your device before you go.

This manual is provided as a convenience.
GARMIN IS NOT RESPONSIBLE FOR THE ACCURACY OF THIS MANUAL AND DISCLAIMS ANY 
LIABILITY ARISING FROM THE RELIANCE THEREON.



 

iii 

Table of Contents 
Getting Started .......................................................................................................... 1 

Welcome to Street Atlas USA .................................................................................... 1 
Frequently Asked Questions ...................................................................................... 1 
Helpful Tips ............................................................................................................ 8 
Activating Advanced/Simplified File Management ....................................................... 11 
Basic Functions ..................................................................................................... 11 
Zooming In and Out .............................................................................................. 11 
Panning/Centering the Map ..................................................................................... 13 
Copying Your Map to the Clipboard .......................................................................... 13 
Saving a Map as a Bitmap or JPEG Image ................................................................. 14 
Measuring Distance and Area .................................................................................. 15 
Chart of Supported Coordinate Formats.................................................................... 16 
Searching Tips ...................................................................................................... 17 
About the Interface................................................................................................ 18 
Tab Area .............................................................................................................. 18 
Control Panel ........................................................................................................ 18 
Overview Map ....................................................................................................... 19 
Toolbar ................................................................................................................ 20 

Tutorials ................................................................................................................. 21 
Tutorial: Use the E-Z Nav Route Wizard ................................................................... 21 
Tutorial: Find Points of Interest on a Route ............................................................... 24 
Tutorial: Plan a Long Distance Trip .......................................................................... 26 
Tutorial: Share Maps .............................................................................................. 29 
Tutorial: Route with XData Points ............................................................................ 33 

Map Legend ............................................................................................................. 35 
Map Legend .......................................................................................................... 35 

Using the Toolbar ..................................................................................................... 39 
Showing/Hiding Toolbar Options .............................................................................. 39 
Reordering the Toolbar Options ............................................................................... 39 
To Create a New Map File ....................................................................................... 39 
To Open a Map File ................................................................................................ 39 
To Save a Map File ................................................................................................ 40 
To Share Maps ...................................................................................................... 40 
To Create a Route ................................................................................................. 40 
To Start/Stop Your GPS Connection ......................................................................... 41 
To Use GPS NavMode ............................................................................................. 41 
To Open the Map Library ........................................................................................ 42 
To View Imagery ................................................................................................... 42 
To Get Information About a Location ........................................................................ 43 
To Choose Options ................................................................................................. 44 



Street Atlas USA User Guide 

iv 

To Add Images to a GPS Location ............................................................................ 44 
To Grab and Pan the Map ....................................................................................... 44 
To Measure Distance .............................................................................................. 45 
To Print ................................................................................................................ 45 
To Print the Map Screen ......................................................................................... 45 

Customizing the Map and Tab Display ......................................................................... 47 
Customizing the Interface ....................................................................................... 47 
Displaying Basic Map Features ................................................................................ 47 
Customizing the Map Feature Preferences ................................................................. 49 
Changing the Map Colors ........................................................................................ 50 
Changing the Map Magnification Level ...................................................................... 51 
Changing How POIs Display on the Map ................................................................... 51 
Setting Units of Measure Preferences ....................................................................... 52 
Resizing the Map and Tab Areas .............................................................................. 54 
Showing or Hiding Tabs .......................................................................................... 55 
Importing/Exporting Tab Manager Preferences .......................................................... 56 
Reordering the Tabs .............................................................................................. 57 

Using Keyboard Shortcuts ......................................................................................... 59 
Selecting a Keyboard Shortcut Scheme .................................................................... 59 
Creating a New Custom Scheme .............................................................................. 59 
Assigning Keyboard Shortcuts in a Custom Scheme ................................................... 59 
Customizing a DeLorme Scheme ............................................................................. 61 
Renaming a Custom Scheme .................................................................................. 61 
Deleting a Custom Scheme ..................................................................................... 62 
Importing a Custom Scheme ................................................................................... 62 
Exporting a Custom Scheme ................................................................................... 62 
Searching For Commands ....................................................................................... 63 
Viewing All of the Shortcut Keys for a Scheme .......................................................... 63 

Viewing Map Data .................................................................................................... 65 
Saving Data to Your Hard Drive ............................................................................... 65 
Connecting Data .................................................................................................... 65 
Viewing Imagery ................................................................................................... 66 
Showing Roads in Raster Data ................................................................................ 66 

Using Map Files ........................................................................................................ 67 
Map Files Overview ................................................................................................ 67 
Creating and Deleting Map Files .............................................................................. 67 
Opening an Existing Map File .................................................................................. 68 
Setting which Map File Opens with Street Atlas USA .................................................. 69 
Saving a Map File .................................................................................................. 70 
Editing a Map File .................................................................................................. 70 
Creating Transfer Files ........................................................................................... 71 
Creating Transfer Files with Hyperlinked Files ............................................................ 72 



Table of Contents 

v 

Importing Transfer Files ......................................................................................... 73 
E-mailing a Transfer File ......................................................................................... 75 

Printing ................................................................................................................... 77 
Printing a Map ....................................................................................................... 77 
Printing a Route and Directions ............................................................................... 78 
Adding Text or Graphics to Your Map ....................................................................... 79 
Aligning Text and Graphic Items on Your Map ........................................................... 81 
Snapping Text and Graphic Items on Your Map ......................................................... 82 
Layering Multiple Text and Graphic Items on a Printed Map ........................................ 83 
Changing the Background Color of a Printed Map ....................................................... 83 
Manually Assembling a Multi-page Map .................................................................... 84 

Finding a Location on the Map.................................................................................... 89 
Find Overview ....................................................................................................... 89 
Find Options ......................................................................................................... 89 
Performing a Basic Search ...................................................................................... 90 
Performing an Advanced Search .............................................................................. 91 
Performing a POI Search ........................................................................................ 94 
Finding Points Near Your Current Location ................................................................ 95 
Finding a Symbol by its Name ................................................................................. 96 
Tips on Viewing Search Results ............................................................................... 97 
Keywords for Category Searches ............................................................................. 98 
MapTags: Converting, Moving, Hiding, and Deleting ................................................. 100 

Using Address Book Contacts ................................................................................... 103 
Searching for Address Book Contacts ..................................................................... 103 
Importing Existing Address Book Information .......................................................... 103 
Manually Entering Address Book Information .......................................................... 104 
Centering the Map on an Address Book Contact ....................................................... 104 
Editing a Contact In Your Address Book .................................................................. 105 
Manually Moving a Contact on the Map ................................................................... 105 
Relocating Address Book Contacts ......................................................................... 106 
Deleting a Contact In Your Address Book ................................................................ 106 
Showing/Hiding Address Book Contacts on the Map ................................................. 107 
Deleting Your Entire Address Book ......................................................................... 107 
Exporting Your Address Book ................................................................................ 108 

Searching for Phone Book Listings ............................................................................ 109 
Using Phone Data ................................................................................................ 109 
Searching for a Phone Book Listing ........................................................................ 109 
Finding Phone Book Listings for a Specific Road ....................................................... 112 

Using XData .......................................................................................................... 115 
XData Overview .................................................................................................. 115 
Importing Data ................................................................................................... 115 
Managing Datasets .............................................................................................. 117 



Street Atlas USA User Guide 

vi 

Viewing Dataset Records ...................................................................................... 118 
Creating a Route with XData Records ..................................................................... 119 
Geocoding or Moving a Record's Location ............................................................... 119 
Exporting Data .................................................................................................... 120 
Printing XData Dataset Records ............................................................................. 121 

Using the Draw Tools .............................................................................................. 123 
Draw Overview ................................................................................................... 123 
Viewing Hidden Draw Tools ................................................................................... 126 
Draw File Management ......................................................................................... 126 
Creating a New Draw File ..................................................................................... 126 
Saving a Draw File ............................................................................................... 127 
Deleting a Draw File ............................................................................................. 128 
Hiding Draw Files ................................................................................................ 128 
Editing/Locking Draw Files .................................................................................... 129 
Exporting Draw Files to Text Files .......................................................................... 130 
Exporting Track or Waypoint Files to GPX Files ........................................................ 131 
Importing Files to Draw Files................................................................................. 131 
Formatting a Text File to Import as a Draw File ....................................................... 133 
Copying a Map Line to a Draw File ......................................................................... 135 
Saving a Track as a GPS Log ................................................................................. 135 
Viewing the Contents of a Draw File ....................................................................... 136 
Copying a Draw File ............................................................................................. 138 
Changing Draw Object Types ................................................................................ 138 
Renaming a Draw File .......................................................................................... 139 
Copying a Draw Object From One Draw File to Another ............................................ 140 
Moving a Draw Object to a Different Draw File ........................................................ 141 
Using Draw Objects ............................................................................................. 141 
Copying and Placing Draw Objects ......................................................................... 141 
Moving Draw Objects ........................................................................................... 142 
Renaming a Draw Object ...................................................................................... 143 
Deleting Draw Objects ......................................................................................... 144 
Snapping Draw Objects ........................................................................................ 145 
Adding Points to Draw Objects .............................................................................. 146 
Deleting Points and Line Segments from Draw Objects ............................................. 146 
Labeling a Draw Object ........................................................................................ 147 
Routable Roads, Tracks, Lines, Arcs, and Splines ..................................................... 148 
Drawing Routable Roads on the Map ...................................................................... 148 
Drawing a Line, Arc, or Spline on the Map .............................................................. 148 
Drawing a Track on the Map ................................................................................. 149 
Editing a Routable Road, Line, Arc, or Spline ........................................................... 150 
Editing a Track .................................................................................................... 151 
Placing a Routable Road, Line, Arc, or Spline at a Specific Location ............................ 152 



Table of Contents 

vii 

Joining and Breaking Linear Objects ....................................................................... 152 
Circles, Rectangles, and Polygons .......................................................................... 153 
Drawing a Circle, Rectangle, or Polygon on the Map ................................................. 153 
Editing a Circle, Rectangle, or Polygon ................................................................... 154 
Placing a Circle, Rectangle, or Polygon on the Map .................................................. 155 
Waypoints, Symbols, MapNotes, Text Labels, and Images ........................................ 156 
Adding a Waypoint, Symbol, MapNote, Text Label, or Image to the Map ..................... 156 
Editing a Waypoint, Symbol, MapNote, Text Label, or Image ..................................... 158 
Placing a Waypoint, Symbol, Text Label, or Image at a Specific Location .................... 159 
Moving and Deleting Draw MapNotes ..................................................................... 159 
Custom Symbols ................................................................................................. 160 
Custom Symbols Overview ................................................................................... 160 
Creating a New Symbol ........................................................................................ 161 
GPS Device Custom Symbols ................................................................................ 162 
Editing a Symbol ................................................................................................. 163 
Finding a Custom Symbol ..................................................................................... 164 
Importing a Bitmap ............................................................................................. 164 
Copying and Pasting ............................................................................................ 165 
Pasting a Bitmap into XSym .................................................................................. 166 
Dragging a Bitmap into XSym ............................................................................... 167 
Removing a Symbol ............................................................................................. 167 
Draw Tool Box .................................................................................................... 168 
Using the Transparency Option ............................................................................. 168 
Anchor Position ................................................................................................... 169 
Cursor Position .................................................................................................... 170 
Creating a New Symbol Set .................................................................................. 170 
Opening a Symbol Set ......................................................................................... 171 

Routing ................................................................................................................. 173 
Creating a Route ................................................................................................. 173 
Adding and Inserting Stops and Vias ...................................................................... 174 
Changing the Routing Method ............................................................................... 177 
Changing the Properties of a Stop Along Your Route ................................................ 177 
Viewing Route Directions ...................................................................................... 177 
Avoiding a Specified Area When Routing ................................................................. 178 
Saving Route Directions as Text ............................................................................ 179 
Setting Your Routing Preferences .......................................................................... 179 
Editing a Route ................................................................................................... 180 
Editing Roads ...................................................................................................... 181 
Labeling a Route Point with a MapNote ................................................................... 182 
Moving Route MapNotes ....................................................................................... 182 
Displaying and Centering Routes on the Map........................................................... 183 
Saving a Route .................................................................................................... 183 



Street Atlas USA User Guide 

viii 

Deleting a Route ................................................................................................. 184 
Importing Routes ................................................................................................ 185 
Setting Your End of Day and Fuel Break Preferences ................................................ 185 
Estimating the Fuel Cost of Your Route................................................................... 186 
Converting a Route to a GPS Log ........................................................................... 186 

Using GPS ............................................................................................................. 189 
GPS Overview ..................................................................................................... 189 
GPS Options/Initializing GPS ................................................................................. 189 
Using NavMode or GPS Tab View ........................................................................... 192 
Tracking a Route with GPS.................................................................................... 193 
Getting Back on Track When Off Course ................................................................. 195 
Using the E-Z Nav Route Wizard ............................................................................ 195 
Panning the Map Automatically While GPS Tracking ................................................. 196 
Playing Back a Log File ......................................................................................... 197 
Previewing a GPS Log File ..................................................................................... 198 
Viewing File Details for a GPS Log .......................................................................... 199 
Monitoring Your GPS Status .................................................................................. 199 
Monitoring GPS Satellite Information...................................................................... 200 
Viewing Sun and Moon Information........................................................................ 201 
GPS Devices ....................................................................................................... 202 
About GPS .......................................................................................................... 202 

Using Small-screen Devices ..................................................................................... 205 
Using Small-screen Devices .................................................................................. 205 

Using Voice Navigation and Speech Recognition ......................................................... 207 
Voice Overview ................................................................................................... 207 
Voice Options ...................................................................................................... 207 
Activating and Monitoring Speech Recognition ......................................................... 208 
Training the Speech Recognition Engine ................................................................. 208 
Voice Commands ................................................................................................. 210 
Speech Recognition Tips ....................................................................................... 212 
Changing Voice Output ......................................................................................... 214 
Voice Preferences ................................................................................................ 214 
Voice Prompts ..................................................................................................... 215 

Exchanging Information with A Third-party GPS Device ............................................... 217 
Sending Route Information ................................................................................... 217 
Sending Tracks ................................................................................................... 218 
Sending Waypoints .............................................................................................. 218 
Receiving a Route ................................................................................................ 219 
Receiving a Track ................................................................................................ 220 
Receiving Waypoints ............................................................................................ 220 

Using NetLink ........................................................................................................ 223 
NetLink .............................................................................................................. 223 



Table of Contents 

ix 

Using GeoTagger .................................................................................................... 225 
Getting Started with GeoTagger ............................................................................ 225 
Tagging an Image ............................................................................................... 225 
Calculate the Timestamp Offset ............................................................................. 226 

Legal Information ................................................................................................... 227 
Street Atlas USA® 2015 Plus Single-User License Agreement ................................... 227 
Important Notices................................................................................................ 231 

Index .................................................................................................................... 237 





 

1 

Getting Started 

Welcome to Street Atlas USA 

Tips 
• Double-click a book in the Table of Contents to view all of its associated topics. 

Click a topic to read its contents. 
• Additional information is available online: 

o support.delorme.com 
o forum.delorme.com 

  

Street Atlas USA Features 
• GPS NavMode—a hands free full-screen view that you can view in 2-D or 3-D. GPS 

Radar results display on the screen. Optimized for use on netbooks. 
• Find a street address, city/town, ZIP/Postal Code, coordinate, point of interest, and 

more. Use the advanced search function to locate the intersection of two streets, a 
specific category of map items, such as landmarks along the current route, or an 
area code and exchange. 

• Connect your GPS device to the program and track your progress on a portable 
computer as you travel. View your next turn as well as the turn after that—very 
helpful when you need to make a turn directly after another turn. You can even use 
the automatic back-on-track feature to recalculate your route when detours v9er you 
off course. 

• Use MapShare to share your current map view and even route directions with 
anyone. 

• Use the NetLink tab to get free downloads of data and imagery from the Map Library 
for your area of interest. 

• Use Canadian data to create door-to-door routes in Canada. 
• Import your personal address book information and visualize your contacts on the 

map. You can even use them as a start, stop, or finish route point or search for them 
using the Find tab. 

• Create custom keyboard shortcuts to navigate the program more easily than ever. 
• Combine digital photos with GPS locations using GeoTagger. 
• Use the toolbar to create routes, share maps, open/create/save map files, and edit 

your preferences. 
• Print high quality, detailed, single-page maps or mural maps as large as 3 x 3 pages. 
• Print your route and/or route directions. 
• Customize your map with routable roads, text, MapNotes, and more! 

  
With the Phone tab in Street Atlas USA Plus, you can also: 

• Search over 121 million residential and business phone listings, including Canada. 
• Find phone numbers for a specific road. 

Frequently Asked Questions 

http://support.delorme.com/
http://forum.delorme.com/
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These questions are asked most frequently by our customers. 

• Where do I find the map and other options settings? 

All options are located in the Options dialog box. To open it, click the Options button 

 on the toolbar. You can use it to modify GPS, voice, map feature, display, 
and keyboard shortcut preferences. For more information, see the Toolbar topic.  
Notes   

• Some tabs also have an Options button , which opens the same dialog 
box. 

• You can also click the arrow next to the Options toolbar button to open the 
Options menu. Then, click Options to open the dialog box. 

• How can I make the program open with my most recent map file instead of in Salt 
Lake City? 

Use the Welcome Screen to determine if you want to create a new map file project 
each time you open Street Atlas USA or if you want to open a recent map file. When 
you use the new map file option, the default location is Salt Lake City. 

• Upgraders only: What happens to my map files when I upgrade? 

Your map files, draw files, route files, and log files are stored in the DeLorme Docs 
folder, usually found on the root of your computer's C: drive. They are not affected 
by an install or removal of DeLorme software. 

• Upgraders only: Why doesn't this version of Street Atlas USA overwrite the older 
version? 

This allows you to view both versions on the same computer. 

• Upgraders only: Should I uninstall my previous version before installing this 
version of Street Atlas USA? 

Uninstalling is not necessary; however, you can uninstall the previous edition of the 
software either before or after installing this version of Street Atlas USA. 

• Can I see my imagery and data from Topo USA, Topo North America, and XMap on 
the map? 

Yes, as long as the DeLorme Docs\Downloads is located in the same location for 
Street Atlas USA as it was in Topo USA, Topo North America, or XMap. 

Note  You cannot view 7.5-minute USGS Quad maps, NOAA charts, or DigitalGlobe® 
maps in Street Atlas USA. 

• How do I create a route? 

You can create a route using the Route tab, right-click menu options, or the toolbar. 
If you are using a GPS, you can use E-Z Nav to quickly create a route to a location. 
See the following topics for more information about creating routes. 
Creating a Route 
Tutorial: Plan a Long Distance Trip 
Tutorial: Use the E-Z Nav Route Wizard 
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• How do I import files from an earlier version of Street Atlas USA into this version? 

You can import map files, routes, and draw files from many other DeLorme mapping 
programs by using a drag-and-drop operation or by using the import function in 
Street Atlas USA. 
Note  Information for Street Atlas USA 9.0 and earlier users. 
The structure of map files has changed throughout the life of Street Atlas USA. Map 
files in older products, such as Street Atlas USA 9.0 and earlier, are a single file that 
contain route information, draw objects, and the current display settings. These map 
files cannot be opened in this version of Street Atlas USA; however, you can view the 
route and/or draw information that the map file contains using the import and drag-
and-drop functions within Street Atlas USA. 
  
Map files do not contain the draw and route information but connect to separate 
route and draw files. You can open these map files in Street Atlas USA to view their 
contents. Or, you can import/drag-and-drop the draw/route information individually. 

To Open A Map File 

•  
1. Click the Map Files tab. 
2. Click File and then click Open. 
3. Select the map file you want to view and then click Open.  

Notes   
Street Atlas USA can open only map files with an .saf extension. 
Regular Street Atlas USA only: If you have simplified file management 
activated and the map file you are opening contains more then one draw file 
or route file, you will be prompted to select the file you want to open. 

4. Click OK. The files are imported into one .saf file. 
Note  Once you save the map file in Street Atlas USA, you can no longer 
open it in previous versions of Street Atlas USA. If you want to continue to 
use the map file in a previous version, select Save As and rename the file. 

To Import a Route 

5. Using Windows® Explorer®, browse to the source folder of the route file. The 
default directory is C:\DeLorme Docs\Navigation or C:\Program Files\Street 
Atlas USA. 

6. Locate the file you want to import. 
7. While holding the left mouse button, drag the file to the Windows task bar 

button for Street Atlas USA (Street Atlas USA opens) and then drag the file to 
the map. Release the mouse button when finished. 

8. Drag the file on top of the map and release the left mouse button. The file 
imports and displays the route. 

To Import a Draw File 

9. Click the Draw tab, click File, and then click Import. 
10. Browse to the path where your draw files are stored. The default directory is 

C:\DeLorme Docs\Draw. 
11. Under Files of Type, select the file type from the list. If the type is not listed, 

select All Files; for example, All Files (*.*). 
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12. Click the file to select it and then click Open. The imported draw layer 
displays in Street Atlas USA. A copy of the draw layer is imported into the 
current map file and the original file is not modified. 

• What is the difference between NavMode and the GPS tab view when using GPS? 

The default GPS view is NavMode—a hands free full-screen view that you can display 
in 2-D or 3-D. By default, the Control Panel is hidden and the tabs are minimized; 
however, you can customize your interface. By default, NavMode uses the E-Z Nav 
route wizard so you can quickly plan a trip. 
The GPS tab view option allows you to use the GPS tab to control navigating and 
tracking. By default, the tabs and Control Panel are visible, but you can opt to hide 
them. It is available only in 2-D mode. For more information, see Using NavMode or 
GPS Tab View. 

To turn NavMode on or off, click the NavMode button  on the toolbar. When the 

button appears indented,  NavMode is on.  
Note  The button is grayed out  unless you have a GPS device plugged in or are 
playing back a GPS log file 
You can also change your GPS view in the Options dialog box: 

1. Click the Options button  on the toolbar and click the GPS tab. You 
can also click the Options button  on the GPS tab. 

2. Clear the Use NavMode check box to turn it off, or select the check box to 
turn it on. 

3. Click OK. 

• How do I find a specific location? 

Street Atlas USA offers powerful search tools that enable you to locate any place in 
the United States or Canada. 
In addition, you can search for places along your route, within a certain radius of the 
current map center, or within a particular region. 
To access the search features in Street Atlas USA, click the Find tab. For more 
information on searching for specific locations, see Performing a Basic Search, 
Performing a POI Search, Performing an Advanced Search, and Finding POIs Near 
Your Current Location. 

• How can I find all of the nearby points of interest? 

Right-click your location on the map, click Find Travel POIs, and then click the 
distance you want to search within (1 mile, 5 miles, or 10 miles). The points of 
interest display in Find tab results area. 
OR 
If you are tracking with a GPS device, do a radar search to locate points of interest 
within a designated distance of your current GPS position. 

• How do I perform an Along the Way search in the Find tab and print my results? 

You can search for names or categories along your current route by doing an 
advanced search in the Find tab. You can then print your search results using the 
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Along the Way print option. Use the following steps to search for a name/category 
along your current route and print the results: 

1. Click the Find tab and then click Advanced. The Advanced dialog area 
displays. 

2. Select Category from the From drop-down list. 
3. Select Current Route from the Within drop-down list. 
4. Type the appropriate keyword in the Keywords text box. 
5. Type the distance within which you want to search in the Distance text box. 
6. Click Search. The search results display in the dialog area. 
7. Click the Print tab and then click Route. The Route dialog area displays. 
8. Select the Along the Way check box. 
9. Click Print. The search results print. 

• How do I turn on voice navigation? 

Voice is used in the following ways: 
•  
• Listen to your route directions while tracking along a route using GPS. 
• Use the speech recognition feature to issue commands or ask questions about 

map panning and zooming, navigation, or GPS functions. 

• Why can't I hear the voice during voice navigation? 

The voice navigation system depends on your computer's sound system for volume 
levels. 
To Set the Volume Level 
If your system is not playing the sound loud enough, use the following steps to verify 
the Wave volume control is set to its highest levels. 

•  
1. From the Start menu, point to Programs, point to Accessories, point to 

Multimedia (or Entertainment depending on your operating system) and 
then click Volume Control. 
OR 
If available, click the audio control shortcut on your taskbar. 

2. In the Wave column, move the Volume slider to the top. 
3. Close the Volume Control dialog box. 

If the voice commands are still not loud enough to hear, contact your sound card 
manufacturer to download and install the latest driver for your specific model sound 
card. The new driver may be able to provide louder output. 
There are a variety of external speaker output options for your laptop. Some of them 
are simply larger external speakers; others allow you to send the voice to your car 
stereo speakers. 

• Why doesn't Street Atlas USA recognize my voice? 

To troubleshoot why Street Atlas USA may not recognize your voice, verify the 
following: 

•  
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• Ensure Street Atlas USA is the active application. 
• Ensure you are wearing your microphone correctly. See your microphone's 

user guide for more information. 
• Train your speech engine in the environment in which you are using the Voice 

tab of Street Atlas USA. It is important to speak as naturally as you did during 
the training. 

Note  You can also designate a phrase with which to prefix all of your commands 
(similar to Simon Says) within the program or the Speech settings in your Windows 
Control Panel to change your voice settings. 

• How do I get data updates or fix the roads on my map? 

The data in Street Atlas USA can be updated only by buying a more recent version of 
the product when it is available. 
However, if you find there is a local road that is missing, you can add it to the 
current draw layer using the Routable Roads Draw tool. For more information, see 
the topic Drawing Routable Roads on the Map. 
Note  You can also report data corrections to DeLorme using the NetLink tab. 

• What is a map file? 

Street Atlas USA lets you save all of the work you have done in the mapping 
application as a single workspace so you can open it later. These saved workspaces 
are called map files. 
A map file consists of the following items: coordinates of the map center, current 
zoom level, current magnification, map display preferences, any added items: such 
as draw layers, routes, and so forth. As you create new routes or draw layers, 
change preferences or the map center, and so forth, they are added to the current 
map file. Changes can be saved or discarded. 
To learn how to create a map file in Street Atlas USA, see Creating and Deleting Map 
Files. 

• What do the different colors and symbols on the map mean? 

The different colors on the map represent different areas of land use and land cover 
(parks, population centers, water, forests, and so on). The Map Legend provides 
examples and descriptions of the map features. 

Click the Help button  on the Street Atlas USA toolbar and click Map Legend to 
display the Map Legend Help topic. 

• What's the difference between a stop and a via? 

When routing in Street Atlas USA, you have the option of adding/inserting stops or 
vias in the route. A stop is a location in the middle of a route where you want to stop 
and then proceed from. A via is a road on the map that you want to specifically use 
when routing.   

• What's the difference between adding and inserting a stop or via? 

The Insert Stop/Via function arranges stops/vias geographically in the route. The Add 
Stop/Via function adds stops/vias in the order you add them to the route. 

• Why does my route fail to calculate? 
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Your route will fail to calculate if you create a route: 
• With a route start, stop, via, or finish point in an area that you have 

designated as a Route Avoid. 
• That includes route points outside the United States, Mexico, or Canada. 
• On an island without roads. In this case, Street Atlas USA will look for the 

nearest road to that island to place the route point. If the nearest road is not 
routable (for example, it is the only road on the island and/or the island does 
not have ferry access), you will get an error message saying "Route failed to 
calculate." 

• Why do X marks display on the map when I calculate a route? 

• When you place a route point in a location that isn't on a street, Street Atlas 
USA finds the closest street to that location, marks the space between the 
point you clicked and the street with X marks, and starts the route at the 
street. 

• If you search for an address that is on a walkway and place a route point on 
it, Street Atlas USA finds the closest street to that location, marks the space 
between the point you clicked and the street with X marks, and starts the 
route at the street. 

• Why are the tab area and control panel so narrow? 

Street Atlas USA was designed to accommodate resolutions of 800 x 600 or higher. 
If you are using a very high resolution (such as 1920 x 1200), the tab area and 
control panel in Street Atlas USA may appear to be very narrow. 

Note  Use the Windows Control Panel to adjust your display settings. 

• Can I send maps to my GPS device? 

You cannot export maps to a GPS device with Street Atlas USA. You can send routes, 
draw files, waypoints, and tracks. 

• Why can’t I see all the information about my route on the Route tab? 

If your have your screen resolution set to 800 x 600, some information, such as the 
route summary, may not display for a longer route. Increase your screen resolution 
to view all details. 

• Regular Street Atlas USA only: What's the difference between advanced and 
simplified file management? 

Simplified file management allows you to save one route or draw layer in a single 
map file. 
Advanced file management allows you to save multiple routes and draw layers in 
a single map file. 
During the product installation, you chose to use simplified or advanced file 
management. Once the program is installed, you can verify the type of file 
management you are using and change it. Click the arrow next to the Options 

button  on the toolbar to open the menu, and then click Change File 
Management. Your current option displays in the dialog box. To change the option, 
click the button for the file management option you want to use. For more 
information, see Activating Advanced/Simplified File Management. 
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Helpful Tips 
These tips may help you use the features in your DeLorme mapping program. The Did You 
Know? pop-up tutorials provide hints while you are working in the application. 
Tips   

• To disable a specific pop-up tutorial, select the Don't Show Again check box before 
you close it. 

• To disable all pop-up tutorials, click the Help button  on the toolbar and click 
Shut Off All Pop-up Tutorials. 

• To enable all pop-tutorials after you have shut off one or more, click the Help button 
on the toolbar and click Reset All Pop-up Tutorials. 

Control Panel 

If you want to... Use this tip... 

Zoom the map out/in 
quickly 

Drag the map cursor in an up-left direction to zoom the 
map out or drag it in a down-right direction to zoom the 
map in. 

Pan the map quickly Position your cursor on the edge of the map; it becomes a 
white hand that you can use to drag the map to the new 
location. 

Update the coordinate 
format that displays in the 
Control Panel 

Update your measurement preferences at any time using 
the Display tab in the Options dialog box. 

View the last map center Press the middle button in the Compass Rose in the 
Control Panel to center the map on the previous map view. 
This button performs an undo function for the last pan or 
zoom (up to 256 times). 

Draw 

If you want to... Use this tip... 

Create a route using a 
road you have added to 
the map with the Draw tab 

When drawing a routable road, click each existing road it 
crosses to ensure that you can route on the new road. 
When you open a track you've imported from your GPS 
device, join the imported line with existing lines by right-
clicking each intersection and selecting Manage 
Draw/Join. 

Find 

If you want to... Use this tip... 

Modify a Find search result Right-click a result item in the Find tab to add it as a 
MapNote, insert it as a stop in your route, copy the 
information to your clipboard, and so on. 

Find a custom point of 
interest (such as a Chinese 

You can use the Custom option to find other categories 
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restaurant) when 
performing a GPS radar 
search in Find 

besides those listed, or to find multiple categories at once. 

GPS 

If you want to... Use this tip... 

View a GPS log on the map Use the Draw tab to import a GPS log file and view it as a 
line object on the map. 

Info 

If you want to... Use this tip... 

Quickly view information 
for a location on the map. 

Hover your cursor over objects on the map to see 
information (such as road names, city/town, details about 
draw objects, etc.) in the status line that appears at the 
bottom of the map, just above the tab area. 

Map Files 

If you want to... Use this tip... 

Determine which map file 
opens when you open 
Street Atlas USA. 

Use the Welcome Screen to set which map file opens with 
Street Atlas USA. 

Learn how to add route 
and/or draw layers to your 
map file 

Add existing route and/or draw files to your map file by 
clicking the Add button and selecting the Draw File or 
Route File option. 
Note  In Street Atlas USA, you must use Advanced File 
Management to use this option. This does not apply to 
Street Atlas USA Plus. 

Measurement Tool 

If you want to... Use this tip... 

Measure the 
area/perimeter of a 
location on the map 

Use the measure tool to draw a polygon on the map and 
determine its area and perimeter. Just click point-by-point 
to draw the polygon on the map and then double-click to 
close the polygon. The area and perimeter display in the 
center of the polygon. 

Phone 

If you want to... Use this tip... 

Get all of the phone 
listings for a particular 
road. 

You can right-click the map on a road to view phone 
listings for that road. 

Note  The Phone tab is available only in Street Atlas USA Plus. 



Street Atlas USA User Guide 

10 

Print 

If you want to... Use this tip... 

Stop a page in a multi-
page map from printing 

If you do not want to print all the pages in a multi-page 
map, on the Layout graphic, click each page you do not 
want to print. 

Route 

If you want to... Use this tip... 

Reorder inserted stops Reorder your inserted route stops using the Advanced 
features in the Route tab. 

Create a route quickly For quick route creation, right-click the map and select one 
of the Create Route options or use the Route buttons on 
the toolbar. 

Reorder the columns in the 
Route Directions list 

Click the Directions list column headers to change the 
column order. 

Determine the difference 
between adding and 
inserting stops and vias 

Added stops/vias are placed in the order you add them to 
the route. Inserted stops/vias are placed in the order you 
would approach them between the Start and Finish points 
of the route. 

View information about 
your second turn 

Click the Show Turns button when GPS tracking to view 
information about the following turn. 

Tab Area 

If you want to... Use this tip... 

Adjust the size of the tab 
area 

Adjust the size of the tab area by dragging the top or right 
side of the tab area. 

Show, hide, or reorder 
tabs 

Use the Tab Manager option in the Help menu to show, 
hide, or reorder tabs. 

Import or export  a tab 
configuration file 

Use the Tab Manager option in the Help menu to import or 
export a tab configuration file 

Voice 

If you want to... Use this tip... 

Create new speech 
recognition profiles 

You can create a new speech recognition profile for each of 
your working environments (noisy, quiet) and users (your 
spouse or child) by clicking the Speech settings in the 
Windows Control Panel. 

Learn how to make the 
microphone more sensitive 
to your commands in noisy 
environments 

If there is background noise while you are speaking, it may 
be helpful to precede all of your voice commands with a 
special phrase (like Simon Says). See the Voice Settings 
tab of the Options dialog box. 
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XData 

If you want to... Use this tip... 

Geoplace XData records 
that do not have complete 
address information or 
were not correctly located 
during the import process 

You can drag a record from the Query list and place it at 
the correct geo-location on the map. 

Add a blank record to your 
XData database 

To add a blank record to an XData database, you must 
select All Records as the Table Display type. 

Note  The XData tab is available only in Street Atlas Plus. 
  

Activating Advanced/Simplified File Management 

 

Note for regular Street Atlas USA only 
Advanced file management allows you to save multiple routes and draw layers in a 
single map file. With simplified file management, you can save only one route 
and/or draw layer in a single map file. If you did not select to enable advanced file 
management during the product installation, you can still change the settings 
using the Change File Management option in the Options menu. 
This note does not apply to Street Atlas USA Plus users. 

When you installed Street Atlas USA, you were given the option to use simplified or 
advanced file management. Simplified file management allows you to have one route or 
draw layer saved in a map file. If you want to save multiple route and/or draw layers in a 
map file, you must activate advanced file management. 

To Activate Advanced/Simplified File Management 

Use the following steps to change your file management preferences. 

1. Click the arrow next to the Options button  on the toolbar. 
2. Click Change File Management. 

The Change File Management dialog box opens, indicating if the program is set to 
use advanced or simplified file management. 

3. To use advanced file management, click Advanced. 
OR 
To use simplified file management, click Simplified. 

4. At the confirmation message, click OK. 
5. You must restart Street Atlas USA to view the change in file management. 

Note  Some of the Help topics related to the Map Files tab, Route tab, and Draw tab include 
instructions for both simplified and advanced file management. Be sure to follow the 
instructions for the file management system you have selected. A note appears at the end 
of each related Help topic. 
  

Basic Functions 

Zooming In and Out 
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You can use the drag and zoom feature, zoom tools, or the data zoom level(Data zoom level 
is the relationship between what you see in a map view and how it exists in reality. It is the 
amount of geographic data displayed on a computer monitor. The data zoom level is similar 
to the traditional fractional relationship expressed on paper maps. For example, 1:24,000, 
1:100,000, 1:500,000, and so on.) to quickly change the zoom level of the map view. 
Notes 

• Increase the data zoom level number to show a smaller geographic area at greater 
detail. 

• Decrease the data zoom level number to show a larger geographic area at lesser 
detail. 

• If you view both the right (primary) and left (secondary) maps at different data 
zoom levels, a box (or lines, depending on the current data zoom level) displays on 
the map that is zoomed out the furthest. The box/lines indicate the area that is in 
view on the other map. 

• If you view the right and left maps at the same data zoom level but they are not 
equally represented on the screen (50/50), a box (or lines) displays on the map that 
is covering the most screen area. The box/lines indicate the area that is in view on 
the other map. 

To Drag and Zoom In 

Use the following steps to zoom in either the right or left map. 
1. Click and hold down the left mouse button as you drag the mouse in a down-right 

direction on the map to encompass the area you want to display. A view box displays 
on the screen and changes dimension as you move the mouse. A label displays the 
data zoom level at the current map center. 

2. Once you reach the map area or data zoom level you want to display, release the 
mouse button. The area you selected fills the map window, the map re-centers, and 
the map view adjusts to show the appropriate level of detail. 
Tip  To move the view box to another location, press the SHIFT key at any time. 

To Drag and Zoom Out 

Use the following steps to zoom in either the right or left map. 
1. Click and hold down the left mouse button as you drag the mouse in an up-left 

direction on the map. A staircase with a small circle displays on the screen. 
2. Continue dragging the mouse in an up-left direction. The small circle moves up the 

steps, one step per data zoom level. A label displays the data zoom level to the 
bottom-right of the staircase. 

3. Once you reach the data zoom level you want to display, release the mouse button. 
The map view adjusts to display the appropriate level of detail. The map center is 
retained on your screen. 

To Zoom In/Out Using the Zoom Tools 

There are two sets of zoom tools. The zoom tools for the right map are located in the 
Control Panel. The zoom tools for the left map are located at the top of the left map view. 

Right 
Map 
Controls 

 

Click the up arrow to zoom out one minor data zoom level at a 
time. Click the down arrow to zoom in one minor data zoom 
level at a time. 
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Click the Zoom In 1 tool to increase the detail number to the 
next full level. 

 

Click the Zoom Out 1 tool to decrease the detail number to the 
next full level. 

 

Click the Zoom Out 3 tool to decrease the detail number by 
three full levels. 

Left 
Map 
Controls 

 

Click the plus button to increase the detail number to the next 
full level. 
Click the minus button to decrease the detail number to the next 
full level. 
The data zoom level of the left map displays in the text area to 
the left of the buttons. 

Tips 
• Press ALT+PAGE UP on your keyboard to zoom out to the next full data zoom level. 

Press ALT+PAGE DOWN on your keyboard to zoom in to the next full data zoom 
level. 

• Use the mouse wheel to zoom the map in and out. Rotate the mouse wheel to zoom 
in by individual data zoom level steps or hold the SHIFT key while rotating the 
mouse wheel to zoom to the next full data zoom level. 

  

Panning/Centering the Map 
Use any of the following methods to pan (move) or center the map. 

• Click anywhere on the map. The point you click becomes the new map center. 
• When you point near the map edge, a white hand displays. Drag the hand to move 

the map in that direction. 

• Click the Map Panning button  on the toolbar to drag/pan the map in any 
direction. 

• Click anywhere on the overview map. The point you click becomes the new map 
center. This allows you to traverse greater distances with each mouse click than you 
can within the main map. 

• Point anywhere on the black view box in the overview map window. When the 
pointer becomes a , drag the view box to the new location. 

 
• Use the search features on the Find tab to center the map on a particular location. 
• Assign shortcut keys to pan the map up, down, left, or right in small increments. 

  

Copying Your Map to the Clipboard 
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Click the Copy to Clipboard button  on the Print tab to copy your map to the clipboard. 
You can then paste it into another program. 
You can also right-click anywhere on the map and click Copy Map to Clipboard. 
  

Saving a Map as a Bitmap or JPEG Image 
You can save the current map view as a bitmap (.bmp) or JPEG (.jpg) image in all page 
layout formats: Single, 2 x 2, and 3 x 3. If you select a multi-page format, all the active 
pages are saved as individual bitmaps or JPEGs. The file name is the specified file name 
with an incremental page number at the end. 
See Printing a Map for information about printing a map without saving it as a file.   

To Save a Map as a Bitmap or JPEG 

Use the following steps to save a map as an image. 
1. Locate the area on the map that you want to save as an image. 
2. Click the Print tab and then click the Map subtab (if it is not already selected). 
3. Under Print Layout, select Page(the map print area is based on the paper size 

specified in the Setup options) or Screen(the map print area is based on the screen 
size). 
The print area for a Page map displays as a red box and the print area for a Screen 
map displays as a blue box on the overview map. 

4. If you selected Page in step 3, the following options are available. 
• Under Print Layout, select a layout option (Single, 2 x 2, or 3 x 3). The 

print area displays on both the Map and the Overview Map. In the example 
below, 2 x 2 is selected. This means the print area encompasses four 
standard pages at whatever paper size you specified in the Setup options. You 
can assemble a multipage map into a large map. 

 
• If you selected 2 x 2 or 3 x 3 and do not want to save all the pages in the 

multipage map on the map layout graphic, click each page you do not want to 
save. The page appears dimmed or gray. In the example below, page 4 will 
not print. 

 
• Verify this is the location and photo zoom you want to save. If not, pan the 

map to the location and zoom to the level you want.   
Note  Changing the photo zoom enlarges/reduces the map features and 
changes the map area that you save as an image. If you increase the photo 
zoom level, map text, lines, symbols, etc. are larger and your map area is 
reduced. If you decrease the photo zoom level, map text, lines, symbols, etc. 
are smaller and your map area is enlarged. The reduction/enlargement 
percentages for your photo zoom level display under the Photo Zoom drop-
down list. 
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• If you want to use other tabs and functions but not lose your current print 
area, print photo zoom, or other settings, select the Lock Print Center check 
box. This locks the print area and changes the tab label to red. 

• Add text or graphics to your map. 
• Select the Print Preview check box to zoom the map and view the entire 

area that will be saved as a bitmap image. Clear the check box to return to 
your previous data zoom level. 

6. Click the Save button . 
The Save 2D Map Image dialog box opens. 

7. Type the file name in the File Name text box, select to save the file as a .bmp or 
.jpg from the Save as Type drop-down list, select the DPI (dots per inch) value 
(optional), and click Save. 

  

Measuring Distance and Area 

Use the Measure tool  on the toolbar to measure linear distance and area on the map 
based on the units chosen in the Display tab of the Options dialog box. 
The snap function snaps (attaches) the point of a measurement line to a point on a road or 
another measurement object. This ensures a more accurate measurement of distance or 
area. To measure area, you must completely enclose the area by snapping your finish point 
to your starting point. 
Notes 
• The Measure tool is hidden by default. To show it, right-click the toolbar to open the 

menu and click Measure Distance. 
• The Measure tool is the best way to measure short distances on the map. If you want to 

measure the distance of a road, try creating a route. If you want to measure a large 
area on the map, use the area object tools in the Draw tab. 

• To disable the auto-snap function, hold down the ALT key on your keyboard while using 
the Measure tool. 

• Measure objects (lines and areas) are saved with the current map file. When you create 
a new map file, the measure objects do not display. If you want the same measure 
objects on your new map file, you must recreate them. 

• To view information about a measurement line, right-click it and click Info. The 
measurement information is automatically displayed in the Info tab. 

To Measure Distance or Area 

Use the following steps to measure linear distance or area on the map. 
1. Verify you have the correct units of measure selected in the Display tab of the 

Options dialog box. For more information, see Setting Units of Measure Preferences. 

2. On the toolbar, click the Measure tool . The pointer changes to . 
3. Click point-by-point to draw a measurement line on the map. A text box displays 

next to your pointer indicating the total distance of the measurement taken. 
Note  When you pass over a point in a road, measurement line, or measurement 
area to which you can snap, a yellow circle  defines the snap point. Click to snap 
the point of the measure line to the road or measurement object's point coordinate. 

4. To end a measurement line, double-click the last point of the measurement line. 
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OR 
Click the last point of your measure line or area and then click the Measure tool on 
the toolbar. 
The measure line is a two-pixel wide yellow line and the total length of the line is 
displayed in a label at each endpoint of the line. 

5. To end a measure area, hover over the starting point until the yellow snap circle 
displays, and then double-click the last point to the starting point. The closure area 

is transparently shaded, and the area and perimeter measurements display. 
  

Chart of Supported Coordinate Formats 
These are the supported search formats. Sample coordinates are for Yarmouth, Maine. 
Tip  Examples of search formats are listed in the Advanced search drop-down text boxes 
along with a history of your most current search criteria. 
  

Coordinate 
Format 

QuickSearch Advanced Search 

Latitude/Longitude N 43 48 30, W70 9 52 N 43 48 30 W70 9 52 

N 43 48.4910, W 070 
09.8440 

N 43 48.4910 W 070 09.8440 

N434829.4600, 
W0700950.6400 

N434829.4600 W0700950.6400 

N43-48-30, W70-9-52 N43-48-30 W70-9-52 

N 43:48:29.46, W 
70:9:50.64 

N 43:48:29.46 W 70:9:50.64 

4348, -7009 4348 -7009 

4348N, 7009W 4348N 7009W 

N4348, W7009 N4348 W7009 

4348n, 7009w 4348n 7009w 

n4348, w7009 n4348 w7009 

4348 N, 7009 W 4348 N 7009 W 

N 4348, W 7009 N 4348 W 7009 

4348 n, 7009 w 4348 n 7009 w 

n 4348 w 7009 n 4348 w 7009 

434829, -700950 434829 -700950 

4348.491, -7009.844 4348.491 -7009.844 

4348.491, -7009.844 4348.491 -7009.844 

434829.46, -700950.64 434829.46 -700950.64 
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43.80818333, -
70.16406667 

43.80818333 -70.16406667 

43 48.4910 N, 70 09 50.64 
W 

43 48.4910 N 70 09 50.64 W 

43 48.4910 n, 70 09 50.64 
w 

43 48.4910 n 70 09 50.64 w 

N 43 48.4910, W 70 09 
50.64 

N 43 48.4910 70 09 50.64 W 

434829.46 N, 700950.64 W 434829.46 N 700950.64 W 

43, -70 43 -70 

USNG 
Street Atlas USA 
Plus only 

19TDJ 06354 51187 
19TDJ0635451187 
(NAD27)* 
19TDJ06355109 
19TDJ064511 
19TDJ0651 

Same as QuickSearch 

UTM/UPS 19T 0406311E 4850964N Zone 19T 
Easting 0406311E 
Northing 4850964N 

19T 0406311 4850964 Zone 19T 
Easting 0406311 
Northing 4850964 

19T / 0406311 / 4850964 Zone 19T 
Easting 0406311 
Northing 4850964 

SPCS 
  

ME-W 0500490 0355150 Zone ME-W 
Easting 0500490 
Northing 0355150 

* Use this example for USNG with non-standard datum. 
  

Searching Tips 
When you use the Quick Search subtab on the Find tab or the Route tab to search for a 
location, you must enter the information in a specific format. 
Tips 

• Use punctuation as in the examples in the table below. 
• Do not use periods. 

  
This table shows formats for search types. 

For this type of search... Use this format... Example 
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Address Street address, City, State 100 Baxter Blvd, Portland, 
ME 

Street address, ZIP Code 100 Congress St, 04101 

Street address, City, State, 
ZIP Code 

100 Congress St, Portland, 
ME 04101 

City City, State Atlanta, Georgia 

ZIP/Postal Code Within the U.S.: ##### (5-
digit ZIP Codes only) 
Within Canada: ### 6-digit 
Postal Codes only) 

04096 
J8E756 

Minor Point of Interest POI name, City, State Subway, Columbus, OH 

Major Point of Interest or 
Landmark 

POI/landmark name Mount Rushmore 

POI/landmark name, State Space Needle, WA 

Latitude/Longitude See Chart of Supported of Supported Coordinate Formats 

For more information about the Find tab, see the Help topics under Finding a Location on 
the Map. 
  

About the Interface 

Tab Area 
You can access most of the application's functions from the tab area at the bottom of the 
screen. To access Help for a specific tab, click the Help button  on the tab. You can also 
reorder the tabs, show or hide individual tabs or show or hide the tab panel. 

• Map Files 
• Find 
• Phone Street Atlas Plus only 
• XData Street Atlas Plus only 
• Print 
• Draw 
• GPS 
• Route 
• Info 
• NetLink 
• Voice 

  

Control Panel 
The Control Panel, located to the right of the map view, displays information pertinent to 
the current map view and map cursor position. It also includes zoom and map pan buttons. 
You can customize your interface to show or hide the Control Panel. 
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Data Zoom Level—The current data zoom level of the map view; ranges 
between 2-0 (maximum zoom out) and 16-0 (regular Street Atlas 
maximum zoom in) or 17-0 (Street Atlas Plus maximum zoom in). 
Zoom Tools—Buttons that quickly zoom out three levels, out one level, or 
in one level. For more information, see Zooming In and Out. 
Compass Rose—A group of nine buttons on a globe. The outer buttons 
have yellow arrows; click one of the arrow buttons to pan the map in that 
direction. Click the middle button to center the map on the previous map 
view. This button performs an undo function for the last pan or zoom (up 
to 256 times). 
Map Rotation Tool—The arrow in the graphic indicates True North in 
relation to the rotated map. Use the Map Rotation Tool to rotate the map 
in any direction. You can rotate the map by clicking or dragging the square 
map graphic in the direction you want or by selecting/typing the degree of 
map rotation from the drop-down list. 
Map Coordinates—Coordinates for the current map cursor position 
display based on the units of measurement preferences chosen in the 
Display tab of the Options dialog box. 
Scale Bar—Indicates the distance one scale bar unit equals in the 
measurement chosen under in the Display tab of the Options dialog box. 

    

  

Overview Map 
The overview map is a small map in the lower-right corner of the screen that offers a wide-
angle view of your current map view area. It is approximately three data zoom-levels out 
from the current map view. 
Tips 

• Click anywhere on the overview map and that point becomes the new map center. 
This allows you to travel greater distances with each mouse click than you can within 
the larger, current map view. 

• Use the black view box in the overview map window to pan the map. Point anywhere 
on the view box. When the pointer becomes a , drag the view box to the new 
location. 
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Toolbar 
• You can show or hide toolbar options. 
• You can change the order of the toolbar options. 

Default Toolbar 

You can also view toolbar topics in the Using the Toolbar section of the Help. When you use 
Netbook Mode, the toolbar is optimized for small screen use. 

 

Additional Toolbar Options 

These button groups are hidden in the default toolbar. To show a button group, right-click 
the toolbar and click the check box next to the name of the group. 
Map Tools 

 
  
Measure Tool 

 
  
Exchange 

 
  
GeoTagger 

 
  
Print 

 
  
Print Screen 
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Tutorials 

Tutorial: Use the E-Z Nav Route Wizard 
When using a GPS device with your DeLorme mapping application, the E-Z Nav route wizard 
works with NavMode to make trip planning to a single destination quick and easy.To use the 

E-Z Nav route wizard at any time while using Nav Mode, click the E-Z Nav button  in 
the top right corner of the map. 

Navigate the pages in the E-Z Nav route wizard 

• Click  to go back to the previous screen. 
• Click  to see another page of results. 
• Click  to see the previous page of results. 

  

Optimize Street Atlas USA for E-Z Nav 

Set your GPS preferences 
Use the GPS tab on the Options dialog box to change your GPS preferences. 

• Select the Start GPS with the program check box so that E-Z Nav opens when 
you start Street Atlas USA 

• Clear the Start GPS log check box to disable track logging. If you want to create 
logs of E-Z Nav routes, leave the check box selected—you will be prompted to 
save the log when you close the program. 

• If you are not using a DeLorme Earthmate GPS device, you need to initialize your 
device. 

Set Street Atlas USA to always open with your E-Z Nav route map file 
project 
First, create an E-Z Nav route and save it; when prompted to save changes to E-Z Nav 

Route, click Yes. Then, click the Help button  on the toolbar and click Welcome 
Screen. Select Open a recent project and Use selected project option at start.... 
Then, click OK. For more information, see Setting which Map File Opens with Street Atlas 
USA. 

Set GPS Radar preferences 
To use GPS Radar with an E-Z Nav route, create your route and then use the Find tab to 
set up your GPS Radar search. Use GPS Radar to search for points of interest (POIs) such 
as gas stations, restaurants, accommodations, rest areas, and so on along your route. 
See the Find Points of Interest on a Route tutorial for more information. 
  

  

Use the E-Z Nav route wizard to find a location 
In this tutorial, you are visiting DeLorme and want to find a good place to eat lunch. 
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Step 1—Get ready 
You have already optimized Street Atlas USA for use with E-Z Nav (see orange box above). 
Plug your GPS device into your portable computer and open Street Atlas USA. The E-Z Nav 
route wizard opens. 

 

Step 2—Pick the search category 
Since you don't want to go too far, leave the location setting as Near Current Location 
and click Food & Restaurants. Click  to view all the categories—you can't make 
up your mind, so you click the All Fast Food & Restaurants category. 
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Step 3—Pick a search result 
The results show each restaurant with its distance from your location. Once you page 
through the list of results, you decide on Bruce's Burritos and note that it's 1.5 miles from 
DeLorme. Click Bruce's Burritos in the list. 

 

 

Step 4—View the result on the map 
On the details page, click View Map to view the location on the map before you route to it. 
The map displays the search result for 15 seconds and then reverts to the details page. You 

can close the map view at any time by clicking the E-Z Nav button  in the top right 
corner of the map. Note  The map displays in 2-D even if you are in 3-D mode. 
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Step 5—Create the route and start your trip 
Once you are back on the details page, click Create Route and start navigating! 

 

Tutorial: Find Points of Interest on a Route 
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Use GPS Radar to find the closest point of interest to your current location as you travel 
along a route. 
  
In this tutorial, you are creating a route on the toolbar and using NavMode to navigate with 
the route. You want GPS Radar to find gas stations along your route as you travel. 

Step 1—Get ready 
Use the program to create a route using your current GPS location as the route start point 
and an address book entry as your finish. 

 

Step 2—Set your preferences 
Set your GPS Radar preferences on the Find tab in the Options dialog box. 

 
• Select Road to calculate the distance you will have to travel by road to reach the 

result. 
• Select the Repeat search every... check box (required for NavMode) and select 

how often you want to repeat the search. 
• Select the Only in Direction of Travel check box so you don't have to back track to 

make your next stop—if you're driving in a very rural area, you may not want to use 
this feature because the closest point of interest may be behind you. 

• Select the Enable voice reporting check box and then select what you want 
reported from the Report drop-down list. 

Step 3—Start the GPS 
1. Connect your GPS device to your portable computer. Ensure the speakers are turned 

on and loud enough for you to hear while driving. 
2. Launch Street Atlas USA. 

3. Make sure the NavMode button  on the toolbar is on (appears indented). 
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4. Click the GPS button  on the toolbar to start your GPS. 

Step 4—Pick what you want to search for 
1. Click the Find tab (it is minimized at the bottom of the screen) and click GPS Radar. 
2. From the Find list, select Gas Stations. 
3. Click Search. 
4. Minimize the tab area. 

 

Step 5—Start driving 
The computer speaks the route directions as you drive. If you are using speech recognition 
software, you can ask the computer questions like, "What is the next turn?" or "Where am 
I?" NavMode displays your search results in the orange bar below the map. 

 

Tutorial: Plan a Long Distance Trip 
When you are using Street Atlas USA to plan a long trip, use the many features on the 
Route tab to customize your route. 
  

Before you leave on your trip 
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Step 1—Create your route 
Create a route—there are several ways to do this. When you create a route, you can add or 
insert stops or vias if you want to travel through specific locations. In this scenario, we 
created a route from Yarmouth, Maine, to Tucson, Arizona, and inserted several vias 
because we want to go through specific locations. 
Click the Advanced button on the Route tab to see the route details. 
Tip  Another thing you can do on the Advanced subtab is set your route preferences to fine 
tune the way the route is created. 

 

Step 2—Set your end of day and fuel break preferences 
Click Plan Trip on the Route tab and set your preferences. Then, click Apply. Your End of 
Day Breaks and Fuel Breaks are displayed on the map. 
To view the estimated fuel cost, click Fuel Cost. 

 

Step 3—Print your route map and directions 
You can print your route map and directions. 

1. Click the Print tab and then click Route. 
2. Select your options and click View to see a preview. 

 

Step 4—Save your map file! 
Save your map file so you can make sure have everything ready when you begin your trip. 
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Using GPS 
If you are using a GPS device with your program on a portable computer to navigate the 
route you created, use the following steps. 

• NavMode is the default view when GPS tracking. If you want to use the tab view 

when travelling, click the NavMode  button on the toolbar. For more information 
about NavMode and the GPS tab, see Using NavMode or GPS Tab View. 

• The E-Z Nav route wizard is on by default. When planning a long trip, disable E-Z 
Nav on the GPS tab in the Options dialog box. 

Step 1—Get ready to travel 
1. Connect your GPS device to your portable computer. Ensure the speakers are turned 

on and loud enough for you to hear while driving. 
2. Check your GPS preferences on the GPS tab in the Options dialog box. 

3. Click the GPS button on the toolbar to start your GPS. 
• If you are using a GPS device that is not a DeLorme Earthmate GPS device, 

you need to initialize it. 
• If your GPS location is not the same as the start location of your trip, you will 

be prompted to navigate with it or hide it. Click Navigate. 
4. If your map file is not open, open it. 

Step 2—Optional. Find points of interest along your route 
You can use the GPS Radar option on the Find tab to find points of interest along your route 
as you travel. 

1. Set your GPS Radar preferences on the Find Tab in the Options dialog box. If you are 
using NavMode, make sure the Repeat the search every... check box is selected. 

2. Click the Find tab and click the GPS Radar subtab to search for your category of 
interest. 
If you selected the Search only in direction of travel check box in the Options 
dialog box, you won't have to back track to make your next stop; however, if you're 
driving in a very rural area, the closest point of interest may be behind you. For 
more information, see the Find Points of Interest on a Route tutorial and Finding 
Points Near Your Current Location. 

 

Step 3—Start driving 
If you have set up speech recognition software, you can ask the computer questions like, 
"What is the next turn?" or "Where am I?" For more information, see Voice Overview. This 
view shows the beginning of our trip using NavMode. 
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Tutorial: Share Maps 
MapShare lets you create static maps with or without route directions to send to your 
friends, family, and associates. 
  
Step 1—Open the MapShare Wizard 

Click the MapShare button  on the toolbar to open the MapShare Wizard. 

Step 2—Select the type of information you want to share 
Select Share the Current Map View (a static map) or Share a Route Map and 
Directions and then click Next. 
For this tutorial, we will share a route map and directions. 
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Step 3—Select the route to share 
Select the route file you want to share from the Available Routes drop-down list and then 
click Next. 

 
Step 4—Add a title or notes to the route map 
To add a title or notes to your route map, type the appropriate information in the text boxes 
and click Next. 
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Step 5—Add notes to the directions 
Then, if you would like to add notes to display with your directions, type them in the Notes 
text box and click Next. 

 
Step 6—View upload confirmation 
A message informs you that your map has been uploaded successfully to the MapShare site. 
Click Next. 
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Step 7—Preview or e-mail the route 
Click E-mail the MapShare Link for Your Route Map and Directions to e-mail a link of 
your route map and directions. This option is available only if an e-mail program is 
detected. If an e-mail program is not detected, copy and paste the link provided into your 
online e-mail program. 
AND/OR 
Click Preview Your Route Map and Directions to preview your route map and directions 
as they appear on the MapShare site.  
Note  Print your route map and directions from the MapShare site by clicking Print in the 
upper-right corner of the page. 

 
Step 8—Exit the MapShare Wizard 
Click Close to exit the MapShare Wizard. 
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Tutorial: Route with XData Points 

 

This Help topic describes functionality that is available only in 
Street Atlas USA Plus. 

Once you import an XData dataset, you can use the data to create a route. 
  

Step 1—Import the dataset 
Import the dataset into the XData tab. For more information, see Importing Data. 

Step 2—Create a route 
Assign the Start and Finish points of the route. You can assign the Start and Finish using the 
Route options on the toolbar, right-click functionality, or the Route tab. For more 
information, see Creating a Route. 

Step 3—Select records to include as stops 
Click the Query tab and select the records that you want to include as stops in the route. 
Note  To select multiple records at once, press and hold the CTRL key on your keyboard 
while you select the individual records. 

 
Step 4—Add Stops to route 
Right-click the selected record(s), point to Route, and then click Add Stop (to add the stops 
in the order they were selected in the table) or Insert Stop (to add the stops in 
geographical order). 
Note  Use the Advanced subtab in the Route tab to reorder multiple stops. 

 
Step 5—Calculate the route 
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If you do not have the Auto calculate check box selected in the Route/New Edit tab, click 
the Go To button on the right side of the tab or click the Calculate button in the Route tab. 
The route displays on the map. 

 
Step 6—Print the route directions 
Print the directions as a Travel Package using the Route option on the Print tab. 
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Map Legend 

Map Legend 
The features that display on the map may display differently depending on which map colors 
you chose on the Display tab of the Options dialog box. The tables below show the 
symbolization of each feature, by map color. 
Notes 
• Not all features are available at all zoom levels. 
• Not all features are available in all datasets. 
• High-contrast Color features display the same as the default features (except for land, 

which displays as black). 
  

Routable Road Features 

 Ferry Passenger 

 Ferry Vehicle 

 Interstate Highway (can also include this symbol: ) 

 Limited Access Road 

 Local Road 

 Major Connector, Forest Road 

 Minor Connector 

 Non Limited Access Interstate 

 Primary State Route 

 State Route (can also include this symbol: ) 

 Toll Road 

 U.S./National Route (can also include this symbol: ) 

 Unclassified Road 

 Unimproved Road 

Land Cover 

 Bare Rock or Sand 

 Bureau of Land Management Land 

 Bureau of Mine Reclamation Land 

 Forest, evergreen 

 Forest, mixed 

 Ice or Snowfield 

 
Indian Reservation (at data zoom level 11) 
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 Indian Reservation (at data zoom level 2 thru 10-7) 

 Intermittent Water 

 Land 

 
Military Area (at data zoom level 11) 

 Military Area (at data zoom level 2 thru 10-7) 

 Mine or Quarry 

 Parks 

 River/Stream 

 Transitional Area, Lava, Salt Flats, or Mixed Barren 

 Water 

 Wetlands 

Point Features 

 Amusements 

 Airport (private) 

 
Airport (commercial public) 

 Airport (general aviation public) 
 Business (Amusement, Recreation, Specialty or Department Store) 

 Camping (at data zoom level 14) 

 Camping (at data zoom level 11 thru 13) 
 Cemetery 

 Educational Facility 
 Exit, with services (at data zoom levels 10 thru 11-7) 
 Exit, without services (at data zoom levels 10 thru 11-7) 

 Exit, food (at data zoom levels 12 thru 17) 

 Exit, gas (at data zoom levels 12 thru 17) 

 Exit, lodging (at data zoom levels 12 thru 17) 

 Exit, other (at data zoom levels 12 thru 17) 

 Fast Food 

 

Gas 

 Hospital 

 Lodging 

 Metropolitan City 
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 National Capital (data zoom level 7 thru 10) 

 National Capital (data zoom levels 2 thru 6) 
 

Point of Interest (smaller black square) 

 Population Center 

 Public Service 

 Religious (buildings) 

 Rest Area with Facilities (at data zoom levels 10 thru 11) 

 Rest Area with Facilities (at data zoom level 12) 

 

Rest Area without Facilities (at data zoom levels 10 thru 11) 

 Rest Area without Facilities (at data zoom level 12) 

 Restaurants (general) 

 

Restaurants (specialty) 

 Small City 

 State Capital 

Line Features 

 County Boundary 

 Dam 

 Game Management District 

 International Boundary 

 Park Boundary 

 Pipeline 

 Power Line 

 Railroad (Abandoned) 

 Railroad 

 Runway 

 State Boundary 

Road Edit Features 

 

One Way, South or West 

 

One Way, North or East 

 

No Left Turn, South or West 

 

No Left Turn, North or East 
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No Right Turn, South or West 

 

No Right Turn, North or East 

 

No Turn, South or West 

 

No Turn, North or East 

 

No Way 
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Using the Toolbar 

Showing/Hiding Toolbar Options 
You can customize the toolbar to show the options you use most. You can also activate 
toolbar options that are not turned on by default. Some toolbar options are grouped—you 
can show or hide groups of buttons. 
To modify the toolbar. 

1. Right-click the toolbar. 
Toolbar options with a selected check box next to them are displayed on the 
toolbar. 

2. Click an item to activate or inactivate it in the toolbar. 

 
  

Reordering the Toolbar Options 
To reposition the toolbar segments horizontally or vertically, just drag the dotted vertical 
bar  that separates each segment to the new location (left, right, up, or down). 
  

To Create a New Map File 

To create a new map file, click the New button  on the toolbar. If you made changes to 
the map file that is currently open, the Save Changes dialog box opens. 
For more information, see Creating and Deleting Map Files. 
  

To Open a Map File 
To open an existing map file: 

1. Click the Open button  on the toolbar. 
If you made changes to a map file that is already open, the Save Changes dialog box 
opens to ask you if you want to save your changes. Note  Map files have .saf 
extensions and are saved by default in C:\DeLorme Docs\Map Files. 
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The Open File dialog box opens.  
Note  You can also click the arrow next to the Open toolbar button to open a menu. 
Then, click Open Map File. 

2. Select the map file you want to view and click Open. 
For more options for opening files, see Opening an Existing Map File. 
  

To Save a Map File 
To save the map file that is currently open: 

1. Click the Save button  on the toolbar. 
The Save File dialog box opens. 

2. Browse to the location where you want to save the map file. 
If you want to rename the map file, type a new name in the File Name text box. 

3. Click Save. 
  

To Share Maps 
To share your current map view or a route map and directions, click the MapShare button 

 on the toolbar to open the MapShare Wizard. 
For information on e-mailing maps and routes with the MapShare Wizard, click the Help 
button in the MapShare Wizard. 
  

To Create a Route 
To set route points using the toolbar: 

1. Type the location where you want to start your route in the Start text box (next to 
the green Start button). 
OR 

Click the green Start button  and then click the location on the map where you 
want to start your route. 
OR 
Select an address book entry, a previous location, or your current GPS position from 
the Start drop-down list. 

2. Type the location where you want to end your route in the Finish text box (next to 
the red Finish button). 
OR 

Click the red Finish button  and then click the location on the map where you 
want to end your route. 
OR 
Select an address book entry or your current GPS position from the Finish drop-
down list. 

3. Optional.  If you want to add a stop or via to your route, click the Stop button  or 

the Via button  and then click the location on the map where you want to add or 
insert the stop or via. Repeat this step for each stop or via you want to add to your 
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route. 
Note  If the Add option is selected in the Route tab, stops and vias are added in the 
order they are added to the route. If the Insert option is selected in the Route tab, 
stops and vias are added in the order they are approached in the route. For more 
information, see Adding and Inserting Stops and Vias. 

4. Click the Calculate button . 
Note  To use the current GPS location in a route, you must connect your device to your 

computer and click the GPS button  on the toolbar or on the GPS tab. 
  
Tip  Once a route is calculated, you can use the subtabs in the Route tab to view route 
directions, edit a route, and more. Click the Directions subtab to view the route directions, 
the Advanced subtab to display the advanced routing options, or click Back on Track to 
add your current GPS position as a stop to the current route. 

To Start/Stop Your GPS Connection 
The GPS button on the toolbar lets you start your GPS connection if the device is not active 
or stop the connection if it is active. 

To start or stop your GPS connection, click the GPS button  on the toolbar. 
• If you are using NavMode, the GPS tab is minimized and the Control Panel is hidden, 

but you can show them. For more information, see Customizing the Interface. 
• If you start a connection and you are not using NavMode, the GPS tab area opens so 

you can monitor your GPS status. 
Note  NavMode is enabled by default. If you want to use the GPS tab for your default mode, 
you can disable NavMode on the GPS tab in the Options dialog. 
  

To Use GPS NavMode 
NavMode—a hands free full-screen view that you can view in 2-D or 3-D—is the default view 
when you navigate or track with GPS. You can turn off NavMode to use the GPS tab. 

To Turn NavMode On/Off 

Click the NavMode button to turn it on or off. The button is grayed out  unless you have 
a GPS device plugged in or are playing back a GPS log file. When the button appears 

indented , NavMode is on.  
  
You can also change your GPS view in the Options dialog box: 

1. Click the Options button  on the toolbar and click the GPS tab. 
OR 
Click the Options button  on the GPS tab. 

2. Clear the Use NavMode check box if you do not want to use NavMode when you 
start your GPS. Select the check box if you do want to start GPS in NavMode. 

3. Click OK. 
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To Open the Map Library 

To open the Map Library subtab on the NetLink tab, click the Map Library  button. 
  

To View Imagery 
You can view imagery, such as aerial and satellite imagery, within the program. This data is 
available separately from DeLorme and can be purchased through the NetLink tab in your 
program. 

Use the Imagery button  and menu on the toolbar to turn imagery on and off, select 
which type of imagery you want to view, and also show roads on top of the imagery (raster 
data). If no raster data types are detected, the Show Roads feature is grayed out and no 
data types are listed. 
  

To Turn Raster Imagery On/Off 

Click the Imagery button  to toggle raster imagery on/off. When the Imagery button 
appears indented, all connected imagery displays on the map. When the Imagery button 

does not appear indented , no raster imagery displays on the map. 
You can also turn raster imagery on/off by clicking the arrow next to the Imagery button 
and selecting the Show Imagery option from the menu. A selected check box next to the 
option indicates that imagery is currently displaying on the map; if the check box is cleared, 
it indicates that raster imagery is currently hidden. 

To Show/Hide Roads in the Raster Imagery 

1. Click the arrow next to the Imagery button  on the toolbar to open the 
Imagery menu. 

2. If a selected check box displays next to the Show Roads option, road names/labels 
display in the imagery. 
OR 
If the check box next to the Show Roads option is cleared, road names/labels do not 
display in the imagery. 

3. To change the Show Roads status, click Show Roads to toggle the option. 

To Change the Raster Data Type 

1. Click the arrow next to the Imagery button  on the toolbar to open the 
Imagery menu. 
All of the connected, compatible raster data types are listed under the Show Roads 
and Show Imagery options. 
The active raster data type has a black dot next to it. In the graphic below, Aerial 
Imagery is the active raster data type. 

2. To change the raster data type, click a different data type in the list. 
Note  Only one raster data type is displayed at a time. 
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To Get Information About a Location 

Use the Information button  on the toolbar to click a point, symbol, feature, 
measurement line, track, or area on the map to identify it and view detailed information 
about it. 
The Information button is hidden by default; to show it, right-click the toolbar to open the 
menu and click Information. 
  
Use the following steps to get information about a particular map feature. 

1. Click the Information button. 
2. Click the map feature you want information for, such as a road, town, measurement 

line, waypoint, track, draw symbol, or point of interest. 
The Info tab opens and displays a list of information categories.  
Note  Descriptive information may include a name or feature type, length/area, 
ZIP/Postal Code, town name, county name, state/province, coordinates, and 
Standard Industrial Classification categories. 

3. Click the plus sign next to each of the information categories to expand the category 
to view more detailed information. 
OR 
Right-click in the information box and click Expand All to expand all of the 
information categories. Right-click in the information box again and click Collapse 
All to minimize all of the information categories. 

4. Optional. Repeat steps 1–3 to get information about another location. 
5. Optional. Right-click in the information box and click Print to print your map feature 

information. 
Notes 
• You can also get information about a location using the right-click option. Just right-

click the location and click Info. 
• The status bar (located above the tab area) displays draw object type, draw file 

information, point of interest name (if applicable), street name/address, highway, city, 
state/province, and ZIP/Postal Code information for the map location that your cursor is 
positioned on. 

• Some map features (such as campgrounds, national scenic/historic trail information 
centers, and state parks) display with a blue outline at higher data zoom levels. The 
blue outline indicates that the feature has a hyperlink to its website. To open the 
hyperlink, right-click the feature and then click Open Hyperlink OR click the URL in the 
Info tab. 

  



Street Atlas USA User Guide 

44 

To Choose Options 

To open the Options dialog box, click the Options button  on the toolbar. Use the 
Options dialog box to set preferences for program options. 
The Options dialog has the following tabs: 

• GPS 
• Voice 
• Map Features (Basic and Custom) 
• Display 
• Keyboard Shortcuts 
• Find (GPS Radar) 

An Options button that opens the Options dialog box is also available on the Find > GPS 
Radar, and GPS tabs. 

To open the Options menu, click the arrow next to the Options button  on the 
toolbar. The following menu options are available: 

• Options—Opens the Options dialog box. 
• Tab Manager—Opens the Tab Manager dialog box where you can show or hide 

individual tabs and reorder tabs. 
• Change File Management— Opens the Change File Management dialog box, where 

you can view or change your file management option. Note  This option is available 
only for regular Street Atlas USA users. 

• Netbook Mode—Allows you to turn the Netbook Mode on or off. If the mode is 
turned on, the check box next to it is selected. Click Netbook Mode to turn it on or 
off. For more information, see Using Small-screen Devices. 

You can also customize your interface: 
• Show Tab Area Panel—Allows you to show or hide all the tabs. If Show All Tabs is 

turned on, the check box next to it is selected. Click Show Tab Area Panel to show 
or hide the tab area. 

• Show Control Panel—Allows you to show or hide the Control Panel. If Show Control 
Panel is turned on, the check box next to it is selected. Click Show Control Panel to 
show or hide it. 

To Add Images to a GPS Location 
To open the GeoTagger Wizard, where you can combine images with GPS information on the 

map, click the GeoTagger button  on the toolbar. 
The Geotagger button is hidden by default; to show it, right-click the toolbar to open the 
menu and click Geotagger. 
For more information, see Getting Started with GeoTagger. 
  

To Grab and Pan the Map 

To drag and pan the map in any direction, click the Map Panning button  on the 
toolbar. 
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The Map Panning button is hidden by default; to show it, right-click the toolbar to open the 
menu and click Map Panning. 
  

To Measure Distance 
Use the following steps to measure linear distances and perimeter/area on the map. For 
more information, see Measuring Distance and Area. 
The Measure tool is hidden by default:to show it, right-click the toolbar to open the menu 
and click Measure Tool. 

1. Click the Measure tool  on the toolbar. 
2. Click point-by-point to draw a measurement line on the map. A text box displays 

next to your pointer indicating the total distance of the measurement taken. 
Note  When you pass over a point in a road, measurement line, or measurement 
area to which you can snap, a yellow circle  defines the snap point. Click to snap 
the point of the measure line to the road or measurement object's point coordinate. 
Press and hold the ALT key on your keyboard to disable snapping. 

3. To end a measurement line, double-click the last point of the measurement line. The 
measure line displays as a two-pixel wide yellow line and the total length of the line 
displays in a label at each endpoint of the line. 

4. To end a measure area, hover over the starting point until the yellow snap circle 
displays and then double-click the last point to the starting point. The perimeter 

measurements display. 
  

To Print 

To print a map using the current settings in the Print tab, click the Print button  on the 
toolbar. 
The Print button is hidden by default; to show it, right-click the toolbar to open the menu 
and click Print. 
For more information, see Printing a Map. 
  

To Print the Map Screen 

To print the current view as it displays on the screen, click the Print Screen button  on 
the toolbar. 
The Print Screen button is hidden by default; to show it, right-click the toolbar to open the 
menu and click Print Screen. 
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Customizing the Map and Tab Display 

Customizing the Interface 
You can customize the interface for your application by hiding the tab panel area and the 
Control Panel. If you optimized your installation for use with a netbook, you can turn 
Netbook Mode on or off. 

To Customize the Interface 

1. Click the arrow next to the Options button  on the toolbar. 
2. To turn on an option when it is not selected, click it to select the check box. 

OR 
To turn off an option when it is selected, click it to clear the check box. 

 
• Use Tab Manager to show or hide individual tabs or reorder tabs. 
• Use Show Tab Area Panel to show or hide the entire tab area. 
• Use Show Control Panel to show or hide the Control Panel. 
• Use Netbook Mode to turn the optimized small-screen device view on or off. For 

more information, see Using Small-screen Devices. 
Notes   

• You can also use keyboard shortcuts to customize the interface. 
• Your settings are saved until you change them. 
• Clicking Options in the menu opens the Options dialog box. 

  

Displaying Basic Map Features 
You can show or hide basic map features on your map. 
You can also customize map features and customize the interface. 
Notes 
• If you cannot make changes to the basic preference check boxes, verify the Use 

Custom Map Features check box is not selected. 
• Click Use Defaults to change the map feature settings to the default preferences. 
• The map features available are based on the Map Colors option you are using. 

To Select Basic Map Feature Preferences 
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Use the following steps to change the basic map feature preferences. Changes made to the 
map view display almost immediately after selection. 

1. Click the Options button  on the toolbar. 
OR 
Click the arrow next to the Options toolbar button to open the menu. Then, click 
Options to open the dialog box. 

2. Click the Map Features tab.   
3. Select the check box next to the map features you want to display on the map. 

OR 
Clear the check box next to the map features you want to hide on the map. 

• Grids 
The Grids option can be used to identify coordinate points on the map. Grid 
lines automatically adjust for the data zoom level of your map. 

• Map Center Crosshair 
The map center crosshair indicates the map center at any data zoom level. 

• Exits 
View exits on primary limited access roads, interstates, and toll roads. 
Available at data zoom level 10-0 or greater. 

• One Ways 
One ways display as bright green triangles on roads, pointing toward the 
direction of travel (most noticeable in large cities). They are available at data 
zoom level 13-0 or greater. 

• Places (Minor) 
View smaller towns, suburbs, locales, and natural features. Zoom levels vary. 

• Roads (Minor) 
View secondary roads, local and rural routes, trails, and railroads. Zoom 
levels vary. 

• Points of Interest 
• Major—View many different points of interest, including recreational 

areas, public safety, rest areas, and more. 
• Minor—View general points of interest including educational, 

technology, government, and religious buildings/locations. 
• Business (Major)—View many different travel-related points of 

interest including hospitals, camping, restaurants, and more. 
• Business (Minor)—View general points of interest including small 

shops and food stores, laundromats, and golfing. 
• ZIP-Postal Codes 

ZIP/Postal Code boundaries display at data zoom level 8-0 and greater, with 
ZIP/Postal Code labels displaying at data zoom level 10-0 and greater. 

• Town Borders 
• View town borders at data zoom level 10-0 and greater for the 

following states: 

Arkansas 
Connecticut 
Illinois 

Louisiana 
Maine 
Maryland 

Mississippi 
Missouri 
Nebraska 

North 
Carolina 
North 

Vermont 
Virginia 
Washington 
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Indiana 
Iowa 
Kansas 

Massachusetts 
Michigan 
Minnesota 

New 
Hampshire 
New 
Jersey 
New York 

Dakota 
Ohio 
Pennsylvania 
Rhode 
Island 
South 
Dakota 

DC 
West 
Virginia 
Wisconsin 

•   
• County Borders 

View shaded outlines of U.S. counties at data zoom levels 7-0 or greater. 
• International Labels 

View country labels at data zoom levels 2-0 through 4-0. 
• Urban Area Color 

Displays a shaded map area in populated regions at data zoom levels 9-0 and 
10-0. 

4. Click OK to commit the change and exit the Options dialog box. 
OR 
Click Apply to commit the change and keep working in the Options dialog box. 

  

Customizing the Map Feature Preferences 
You can change the display of a wide variety of map features so you can customize your 
map to meet your specific needs. You can even customize which POIs display. 

To Set Custom Map Features 

This is an advanced feature that lets you create a specific, custom set of map features for 
your map display from hundreds of options. Note that changes are not visible until you click 
the Done button. 

1. Click the Options button  on the toolbar. 
OR 
Click the arrow next to the Options toolbar button to open the menu. Then, click 
Options to open the dialog box. 

2. Click the Map Features tab. 
3. Select the Use Custom Map Features check box and then click Customize 

Features to display the custom options.  
Note  Custom map feature selections override selections in the basic features list. 

4. To quickly search for a particular type of feature, type the name of the item in the 
Search text box. 
A list of matching keywords displays and corresponding feature types are listed in 
the Search Results window. Results for the number of keywords and types found 
also display. 

A selected check box indicates the feature displays on the map. 
• Select/clear the individual feature check box to show or hide that feature. 
• Click the small None button to the right of the Search Results window to 

show none of the features listed. 
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• Click the small All button to the right of the Search Results window to 
display all of the features listed. 

• Click Only to display only those features listed in the Search Results 
window. 

• Click Exclude to display all features except those listed in the Search 
Results window. 

5. To use the map feature tree to select which POIs display on the map, click the plus 
signs to expand the individual branches. A selected check box indicates the feature 
type displays on the map.  
Note  Some branches expand further than others. Selecting/clearing a check box at 
a certain branch of the tree shows/hides all the items below that level. 

• Select/clear the individual map feature check box to show or hide that 
feature. 

• Click All to select all map features in the program. 
• Click None to select none of the types in the program. 

Note  A small number of features cannot be turned off. They are part of the 
base map display and cannot be changed. This is why certain levels on the 
tree remain unavailable (appear dimmed or gray). 

6. Click OK to accept the change and exit the Options dialog box. 
OR 
Click Apply to accept the change and keep working in the Options dialog box. 

Notes 
• When you save the current map file, the following feature preferences are saved in 

reference to map features: 
o Major map features preferences 
o Individual custom feature preferences 

o When you create a new map file, the current map settings are used. Click Use Defaults 
to return to the default settings. 

  

Changing the Map Colors 
When you use a laptop computer while traveling, it can be difficult to see the map display 
on your screen. This can be especially true at night or on a bright sunny day. Changing your 
default map colors to high-contrast map colors can make your map display easier to see. 

To Change the Map Colors 

Use the following steps to change the map display. 

1. Click the Options button  on the toolbar. 
OR 
Click the arrow next to the Options toolbar button to open the menu. Then, click 
Options to open the dialog box. 

2. Click the Display tab. 
3. From the Map Colors drop-down list, select High-Contrast Colors to make the 

map display darker for improved in-vehicle visibility. Select Default Colors to use 
the standard display. 
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4. Click OK to accept the change and exit the Options dialog box. 
OR 
Click Apply to accept the change and keep working in the Options dialog box. 

  

Changing the Map Magnification Level 
If you want to change the size of the map image, but not change the degree of geographic 
detail on the map, use the magnification settings in the Options dialog box. 

To Change the Map Magnification 

Use the following steps to change the map magnification. 

1. Click the Options button  on the toolbar. 
OR 
Click the arrow next to the Options toolbar button to open the menu. Then, click 
Options to open the dialog box. 

2. Click the Display tab. 
3. Select a magnification percentage (50%, 75%, 100%, 125%, 150%, 175%, or 

200%) from the Magnification drop-down list.  
Note  Although the size of the image changes, the degree of geographic detail does 
not. 

4. Click OK to accept the change and exit the Options dialog box. 
OR 
Click Apply to accept the change and keep working in the Options dialog box. 

  

Changing How POIs Display on the Map 
You can change the data zoom level at which large POI symbols display on the map. 

To Change the Data Zoom Level for Large POI Symbols 

Use the following steps to change the data zoom level at which large POI symbols are 
displayed on the map. 

1. Click the Options button  on the toolbar. 
OR 
Click the arrow next to the Options toolbar button to open the menu. Then, click 
Options to open the dialog box. 

2. Click the Display tab. 
3. Select the data zoom level from the Large Symbols At drop-down list. 
4. Click OK to accept the change and exit the Options dialog box. 

OR 
Click Apply to accept the change and keep working in the Options dialog box. 

Notes 
• The appearance of a POI many change at different data zoom levels. 
• The number of points of interest that displays is dependent on the basic map 

features you selected on the Map Features tab in the Options dialog box. For more 
information, see Displaying Basic Map Features. 
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This table shows the actions that may happen if you display major and minor POIs. 

If you 
view large 
symbols 
at data 
zoom 
level... 

You will see 
the following 
information 
at data 
zoom level 
13-0 

You will see 
the following 
information 
at data 
zoom level 
14-0 

You will see 
the following 
information 
at data 
zoom level 
15-0 

You will see 
the following 
information 
at data 
zoom level 
16-0 
Regular Street 
Atlas 

You will see 
the following 
information 
at data 
zoom level 
17-0 
Street Atlas 
Plus 

14 names and 
small square 
symbols 

name of the 
POI and the 
large symbol 

name of the 
POI and the 
large symbol 

name of the 
POI and the 
large symbol 

name of the 
POI and the 
large symbol 

15 small 
squares only 

name of the 
POI and a 
small square 
symbol 

name of the 
POI and the 
large symbol 

name of the 
POI and the 
large symbol 

name of the 
POI and the 
large symbol 

16 N/A small square 
symbols 
only 

name of the 
POI and a 
small square 
symbol 

name of the 
POI and the 
large symbol 

name of the 
POI and the 
large symbol 

16 
(Regular 
Street 
Atlas USA) 
17 (Street 
Atlas USA 
Plus) 

N/A small square 
symbols and 
some names 
of POIs 

name of the 
POI and a 
small square 
symbol 

name of the 
POI and a 
small square 
symbol 

name of the 
POI and the 
large symbol 

  

Setting Units of Measure Preferences 
You can change the units of measure used to represent how coordinate formats, distance, 
datum, and bearing listings display. Changing these preferences affects how units of 
measure display in several areas of the program: such as on the map and in the Control 
Panel. 
As you change your unit of measure preferences, a description of each choice displays in the 
information box (in the center of the Options dialog box) immediately after you select it. 

To Change the Coordinate Preferences 

Changing the coordinate preferences affects the: 
• Coordinates display on the Control Panel. 
• Coordinate MapNotes. 
• Grid label display, if Grids are selected in Map Features. 
• Any other place where coordinates display or print. 

  
Use the following steps to change how coordinate measurement units display. 
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1. Click the Options button  on the toolbar. 
OR 
Click the arrow next to the Options toolbar button to open the menu. Then, click 
Options to open the dialog box. 

2. Click the Display tab. 
3. Select the coordinate display format from the Coordinates drop-down list. 

• Degrees 
• Degrees, Minutes 
• Deg, Min, Sec 
• USNG (United States National Grid) Street Atlas USA® Plus only 

5. Click OK to commit the change and exit the Options dialog box. 
OR 
Click Apply to commit the change and keep working in the Options dialog box. 
Note  The Datum displayed is automatically adjusted when your change your 
coordinate preference. 

To Change the Distance Preferences 

Distance preferences affect how distance and areas display throughout the program. 
Use the following steps to change the measurement units for distance and area. 

1. Click the Options button  on the toolbar and then click Options. 
2. Click the Display tab. 
3. Select the measurement from the Measurements drop-down list. 

• Statute Miles (statute feet are used for small distances) 
• Kilometers (meters are used for small distances) 
• Nautical Miles/Feet (statute feet are used for small distances) 
• Nautical Miles/Meters (meters are used for small distances) 

4. Click OK to commit the change and exit the Options dialog box. 
OR 
Click Apply to commit the change and keep working in the Options dialog box. 

To Change the Bearing Preferences 

Bearing listings are created as the result of creating route directions in the Route tab or 
from an Advanced (Distance From) search in the Find tab. Bearing refers to the compass 
direction of a given object measured clockwise in degrees (for example, 30°) or nearest 
compass point (for example, NNE) and indicated from True North or Magnetic North. 
Notes: 

• Magnetic declination is the difference in degrees between True North and Magnetic 
North at a specific location. 

• The bearing setting does not affect map appearance. 
Use the following steps to change the bearing. 

1. Click the Options button  on the toolbar and then click Options. 
2. Click the Display tab. 
3. Select the bearing from the Bearing drop-down list. 

• True North—The direction to the north pole. This is the default setting. 
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• Magnetic North—The direction that a compass needle points. 
4. Click OK to commit the change and exit the Options dialog box. 

OR 
Click Apply to commit the change and keep working in the Options dialog box. 

Resizing the Map and Tab Areas 
You can horizontally and vertically resize the primary (right) map, secondary (left) map, tab 
area, and overview map with the map and tab area resize tools. 
Notes 

• The tab and overview map window size does not change when you choose another 
tab. 

• Some tab areas that provide search results automatically resize depending on the 
number of results. 

• Street Atlas USA displays both maps only when you are using GPS in GPS tab view. 
To use this feature, select the Auto-display GPS Overview check box on the GPS 
Settings tab in the Options dialog box. 

• You can also hide the tab area panel. 

To Resize the Map and Tab Area Using the Drag Method 

Use the drag method to horizontally or vertically resize these areas. 
1. Point to the frame area between the tab and overview map windows. The pointer 

becomes a . 
OR 
Point to the horizontal edge of the tab/main map window. The pointer becomes a 

. 
2. Drag to resize. 
3. To cancel the resize while dragging, press the ESC key on your keyboard. The size 

just prior to this resize is restored. 

To Resize the Map Area Using the Resize Tools 

 
The map resize tool runs perpendicular to the tab area. If the secondary and primary maps 
are both displaying, the resize tool is the bar that separates them. When the bar is moved 
all the way to the left of the map, only the primary map displays. When the bar is moved all 
the way to the right of the map, only the secondary map displays. 
There are several methods you can use to resize the map area: 

• Drag the bar left to expose the area of the primary map you want to see. 
• Drag the bar right to expose the area of the secondary map you want to see. 
• Click the right arrow on the resize tool once to move the secondary map 1/4 of the 

screen width. You can repeat this step until the primary map is no longer visible. 
• Click the left arrow on the resize tool once to move the primary map 1/4 of the 

screen width. You can repeat this step until the secondary map is no longer visible. 
• Double-click the bar above the right arrow to show only the secondary map. 
• Double-click the bar below the left arrow to show only the primary map. 
• Double-click the bar between the right and left arrows to display an equal percentage 

of both the secondary and primary maps. 
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To Resize the Tab and Map Area Using the Resize Tools 

 
There are two tab area resize tools. The horizontal resize tool is located above the tab area 
and lets you adjust the height of the tab area. The vertical resize tool is located between the 
tab area and the overview map lets you resize the width of the tab area. 

Using the Horizontal Resize Tool 

• Drag the horizontal bar up/down to expose the tab area you want to see. 
• Click the up arrow on the horizontal resize tool once to incrementally increase the 

tab height. You can repeat this step until the top of the tab area is flush with the 
bottom of the compass rose in the control panel. 

• Click the down arrow on the horizontal resize tool once to incrementally decrease the 
tab height. You can repeat this step until only the tab names display. 

• Double-click the bar to the right of the up arrow to expand the tab height to its 
maximum percentage (if the tab height is at the default mode or higher).  
Note  If the tab area is below the default mode, double-click the bar to return the 
tab height to its default percentage. 

• Double-click the bar to the left of the down arrow to decrease the tab height to its 
minimum percentage (if the tab height is at the default mode). 
Note  If the tab area is above the default mode, double-click the bar to return the 
tab height to its default percentage. 

• Double-click the bar between the up and down arrows to return the tab height to its 
default view. 

Using the Vertical Resize Tool 

• Drag the vertical bar left to expose the area of the overview map you want to see. 
• Drag the vertical bar right to expose the tab area you want to see. 
• Click the right arrow on the vertical resize tool once to incrementally increase the tab 

width. You can repeat this stop until the overview map is no longer exposed. 
• Click the left arrow on the vertical resize tool once to incrementally increase the 

width of the overview map. You can repeat this step until the tab area is no longer 
exposed. 

• Double-click the bar above the right arrow to show only the tab area. 
• Double-click the bar below the left arrow to show only the overview map. 
• Double-click the bar between the right and left arrows to return the tab and overview 

maps to their default views. 
  

Showing or Hiding Tabs 
The Tab Manager feature allows you to customize your program by showing or hiding 
individual tabs. You can access Tab Manager: 

• During installation 
• After installation using the Tab Manager option in the Options menu 
• From the Start menu 

Notes 
• If you use Tab Manager while the program is open, you must exit and restart the 

program to view the tab changes. 



Street Atlas USA User Guide 

56 

• To show or hide the entire tab area panel, click the arrow next to the Options 

button   on the toolbar. If the tab area is showing and you want to hide it, 
click Show Tab Area Panel to clear the check box next to it. If the tab area is 
hidden and you want to show it, click Show Tab Area Panel to select the check 
box.   

To Show Individual Tabs 

Use the following steps to show tabs using Tab Manager. 

1. Open Street Atlas USA, click the arrow next to the Options button   on the 
toolbar, and select Tab Manager from the menu. 
OR 
From the Start menu, point to Programs > DeLorme> Street Atlas...>Tools, 
and then click Tab Manager. 

2. Select the check box next to each tab you want to display in the program. 
Note  Click Default to show all the tabs in the program in the default order. 

3. Click OK. 
4. Exit Street Atlas USA. 
5. Open Street Atlas USA. 

To Hide Individual Tabs 

Hiding tabs may significantly increase the startup speed of Street Atlas USA. 
Use the following steps to hide tabs using Tab Manager. 

1. Open Street Atlas USA, click the arrow next to the Options button on the 
toolbar, and select Tab Manager from the menu. 
OR 
From the Start menu, point to Programs> DeLorme> Street Atlas...> Tools, 
and then click Tab Manager. 

2. Clear the check box next to each tab you want to hide in the program. 
OR 
Click Minimum. Only the required tabs will display in the program. 
Note  Find, Map Files, Info, and NetLink are required tabs and cannot be hidden. 

3. Click OK. 
4. Exit Street Atlas USA. 
5. Open Street Atlas USA. 

  

Importing/Exporting Tab Manager Preferences 
Tab Manager includes a feature that allows you to share your custom tab manager 
preferences with other Street Atlas USA users. 

To Import Tab Manager Preferences 

Use the following steps to import another user's Tab Manager preferences. 

1. If your application is open, click the arrow next to the Options button  on 
the toolbar and click Tab Manager. 
OR 
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From the Start menu, point to Programs > DeLorme > Street Atlas... > Tools 
and then click Tab Manager. 

2. Click File and then click Import. 
The Import Tab Configuration dialog box opens. 

3. Browse to the location of the configuration (preferences) file, select it, and then click 
Open. 
Tab Manager displays with the preferences saved in the imported configuration file. 

4. Click OK to close Tab Manager. 
5. Exit your application. 
6. Open your application. 

To Export Tab Manager Preferences 

Use the following steps to export your Tab Manager preferences as a configuration file. 

1. If your application is open, click the arrow next to the Options button  on 
the toolbar and click Tab Manager. 
OR 
From the Start menu, point to Programs > DeLorme > Street Atlas... > Tools, 
and then click Tab Manager. 

2. Click File and then click Export. 
The Export Tab Configuration dialog box opens. 

3. Type a name for the configuration (preferences) file in the File Name text box and 
then click Save. Configuration files are saved by default in C:\DeLorme 
Docs\Configuration. 

4. Click OK to close Tab Manager. 
  

Reordering the Tabs 
Use the Tab Manager feature to customize your program by reordering tabs. You can access 
Tab Manager: 

• During installation 
• After installation using the Tab Manager option in the Options menu 
• From your computer's Start menu 

Note  If you use Tab Manager to make changes while the program is open, you must exit 
and restart the program to view the tab changes. 

To Reorder the Tabs 

Use the following steps to reorder the tabs with Tab Manager. 

1. Open Street Atlas USA, click the arrow next to the Options button on the 
toolbar and click Tab Manager. 
OR 
From the Start menu, point to Programs> DeLorme> Street Atlas...>Tools, and 
then click Tab Manager. 

2. Click the tab you want to reorder to highlight it. 

3. Click the up arrow  or the down arrow  to move the tab to the new position. 
4. Repeat steps 2 and 3 for each tab you want to reorder. 
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5. Optional. Click Default to cancel the reordering process and use the default tab 
order (showing all available tabs). 

6. Click OK. 
7. Exit Street Atlas USA. 
8. Open Street Atlas USA. 
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Using Keyboard Shortcuts 

Selecting a Keyboard Shortcut Scheme 
Your application comes with the following DeLorme keyboard shortcut schemes: 

• Desktop Mapping 
• In-vehicle Navigation 

You cannot edit DeLorme schemes, but you can create custom schemes that you can edit. 
You can create as many additional custom schemes as you need. 

To Select a Keyboard Shortcut Scheme 

Use the following steps to select a keyboard shortcut scheme. 

1. Click the Options button  on the toolbar. 
OR 
Click the arrow next to the Options toolbar button to open the menu. Then, click 
Options to open the dialog box. 

2. Click the Keyboard Shortcuts tab. 
3. Select a scheme from the Scheme drop-down list. 
4. Click Apply to activate the selected scheme. 

  

Creating a New Custom Scheme 
You can create a custom keyboard shortcut scheme for different program uses. 

To Create a Custom Scheme 

Use the following steps to create a custom scheme. 

1. Click the Options button  on the toolbar. 
OR 
Click the arrow next to the Options toolbar button to open the menu. Then, click 
Options to open the dialog box. 

2. Click the Keyboard Shortcuts tab. 
3. Click File and then click New. 

The Scheme drop-down list is completed with Custom Scheme# (where # indicates 
the incremental number for the number of custom scheme files you have created). 
Note If you want to rename the new scheme file, click File, click Rename, and then 
type a new name in the Scheme text box. Press the ENTER key on your keyboard 
when finished. The new name displays. 

4. Assign keyboard shortcuts for the commands that are listed. 
  

Assigning Keyboard Shortcuts in a Custom Scheme 
There are three DeLorme keyboard shortcut schemes that you cannot edit; however, you 
can create a custom scheme that you can edit with Keyboard Shortcuts tab in the Options 
dialog box. 

To Assign Keyboard Shortcuts in a Custom Scheme 
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Use the following steps to edit a custom scheme. 

1. Click the Options button  on the toolbar. 
OR 
Click the arrow next to the Options toolbar button to open the menu. Then, click 
Options to open the dialog box. 

2. Click the Keyboard Shortcuts tab. 
3. Select a custom scheme from the Scheme drop-down list. 

Note You cannot edit DeLorme schemes. 
4. Select the List option. 
5. From the Commands drop-down list, select the command grouping to which you 

want to assign shortcuts. If you want assign shortcuts to several groupings, select 
All Commands. 

6. Click to select the command to which you want to assign a shortcut. 
7. Click inside the Customize Shortcut text box. 
8. Press the shortcut key combination on your keyboard that you want to assign for 

that command. 
9. Click Assign. The shortcut for that command changes to the combination you 

assigned and displays as "pending." 
10. Repeat the steps for each command you want to assign. 
11. Click Apply to save the changes. 

OR 
Click OK to save the changes and close the Options dialog box. 
OR 
Click Cancel to cancel your pending changes and close the Options dialog box. 

Notes 
• To sort the command list view, click a heading (Group, Command, or Shortcut). 
• You cannot change the following keyboard shortcut combinations: 

o ALT+F4 (Close Window) 
o F1 (Help) 
o ALT+F1 (Help Menu) 
o SHIFT+F10 (Context Menu) 
o CTRL+C (Copy) 
o CTRL+V (Paste) 
o CTRL+X (Cut) 
o CTRL+Y (Redo) 
o CTRL+Z (Undo) 
o ALT+M (Set Focus on Map) 

o You cannot use the following keys when assigning shortcuts: 
o Windows Key 
o Application Key 
o Print Screen 
o Scroll Lock 
o Sleep 
o Pause/Break 
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o Enter 
o Caps Lock 
o Num Lock 
o Spacebar 
o Insert 
o Backspace 
o Multi-media Keys 

o You cannot assign a letter or number on its own. For example, you cannot assign a 
keyboard shortcut with the number 3; you must use a modifier (such as CTRL or ALT) 
with letters and numbers. 

  

Customizing a DeLorme Scheme 
You cannot edit DeLorme schemes; however, you can create a copy of a DeLorme scheme 
that you can modify to fit your needs. 

To Customize a DeLorme Scheme 

Use the following steps to customize a DeLorme scheme. 

1. Click the Options button  on the toolbar. 
OR 
Click the arrow next to the Options toolbar button to open the menu. Then, click 
Options to open the dialog box. 

2. Click the Keyboard Shortcuts tab. 
3. Select the DeLorme scheme you want to copy from the Scheme drop-down list. 
4. Click File and then click Copy. 

The active scheme changes to Copy of Desktop Mapping#, Copy of In-vehicle 
Navigation#, Copy of 3-D Navigation#, etc. (depending on the DeLorme scheme you 
chose to copy). 

5. Assign keyboard shortcuts for the copied scheme. 
6. Optional. Rename the scheme. 

  

Renaming a Custom Scheme 
Custom schemes can be renamed to whatever name you choose. You cannot rename 
DeLorme schemes. 

To Rename a Custom Scheme 

Use the following steps to rename a custom scheme. 

1. Click the Options button  on the toolbar. 
OR 
Click the arrow next to the Options toolbar button to open the menu. Then, click 
Options to open the dialog box. 

2. Click the Keyboard Shortcuts tab. 
3. Select the custom scheme you want to rename from the Scheme drop-down list. 
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4. Click File and then click Rename. 
The Scheme text box becomes active. 

5. Type the name in the Scheme text box. 
6. Click Apply. The new name displays. 

OR 
Press the ENTER key on your keyboard. The new name displays. 
OR 
Press the ESC key on your keyboard to keep the old name. 

  

Deleting a Custom Scheme 
Once you have created a custom scheme, you can delete it at any time. You cannot delete 
DeLorme schemes. 

To Delete a Custom Scheme 

Use the following steps to delete a custom keyboard shortcut scheme. 

1. Click the Options button  on the toolbar. 
OR 
Click the arrow next to the Options toolbar button to open the menu. Then, click 
Options to open the dialog box. 

2. Click the Keyboard Shortcuts tab. 
3. Select the custom scheme you want to delete from the Scheme drop-down list. 
4. Click File and then click Delete. 
5. Click Yes when asked if you are sure you want to delete the scheme. 

  

Importing a Custom Scheme 
You can share their keyboard shortcut schemes with other DeLorme users. 

To Import a Custom Scheme 

Use the following steps to import a custom scheme. 

1. Click the Options button  on the toolbar. 
OR 
Click the arrow next to the Options toolbar button to open the menu. Then, click 
Options to open the dialog box. 

2. Click the Keyboard Shortcuts tab. 
3. Click File and then click Import. 

The Import Scheme File dialog box opens. 
4. Browse to the location where you saved the .keyscheme file, select it, and then click 

Open. 
The imported file is now your active scheme. 

  

Exporting a Custom Scheme 
You can share their keyboard shortcut schemes with other DeLorme users. 
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To Export a Custom Scheme 

Use the following steps to export a custom scheme. 

1. Click the Options button  on the toolbar. 
OR 
Click the arrow next to the Options toolbar button to open the menu. Then, click 
Options to open the dialog box. 

2. Click the Keyboard Shortcuts tab. 
3. Select the scheme you want to export from the Scheme drop-down list. 
4. Click File and then click Export. 

The Export Scheme File dialog box opens. 
5. Type a name in the File Name text box, browse to the location where you want to 

save the .keyscheme file, and then click Save. 
  

Searching For Commands 
The Keyboard Shortcuts tab in the Options dialog box has a Search feature that lets you 
search for a specific command or command group. 
Note  You can sort the command list view at any time by clicking the heading you want to 
sort by (Group, Command, or Shortcut). 

To Search For a Command or Command Group 

Use the following steps to search for a command or command group. 

1. Click the Options button  on the toolbar. 
OR 
Click the arrow next to the Options toolbar button to open the menu. Then, click 
Options to open the dialog box. 

2. Click the Keyboard Shortcuts tab. 
3. Select the Search option. 
4. In the Commands text box, begin typing the name of the command or command 

group you are searching for. As you type, the list box under the Commands text box 
displays word matches. 

  

Viewing All of the Shortcut Keys for a Scheme 
The Reference Card option in the Keyboard Shortcuts tab lets you view a complete list of all 
of the scheme's shortcut keys. 

To View a List of Shortcut Keys 

Use the following steps to view a list of shortcut keys for a scheme. 

1. Click the Options button  on the toolbar. 
OR 
Click the arrow next to the Options toolbar button to open the menu. Then, click 
Options to open the dialog box. 

2. Click the Keyboard Shortcuts tab. 
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3. Select the scheme that contains the shortcut keys you want to view from the 
Scheme drop-down list. 

4. Optional. To sort the list view, click the heading you want to sort by (Group, 
Command, or Shortcut). 

5. Click Reference Card. 
The list displays in your default Web browser and is sorted by the same column you 
selected in step 3. 

6. Optional. Print the list from your Web browser. 
  

Print a reference card from your web browser 
• Use the Print Preview functionality in your web browser to see if the list will 

display as you want it to. If you do not like the way the list looks in the preview 
(for example, the list prints without grid lines in the table or does not print in 
color), change the advanced print settings in your Web browser. 

• If you want to remove the header and footer text from the printout, from the File 
menu, select Page Setup. Remove the text and the header and footer text boxes 
and then click OK. 

• Changes made to the browser's advanced print settings and page setup affect the 
printing of all web pages. 
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Viewing Map Data 

Saving Data to Your Hard Drive 
If you did not install the Street Atlas USA map data to your computer's hard drive during 
installation, you can do so anytime. Saving data to your hard drive makes it readily 
available and improves performance. 

To Save Street Atlas USA Data to Your Hard Drive 

Use the following steps to save Street Atlas USA data to your hard drive. 
1. Close all programs on your computer. 
2. Use your computer’s Control Panel to locate the program and click Change. The 

Program Maintenance screen opens. 
OR 
Insert the Street Atlas USA DVD into your DVD-ROM drive. Browse to the DVD drive 
on your computer and view the contents. Double-click setup.exe. 
The Program Maintenance screen opens. 

3. Ensure Modify is selected and click Next. 
4. Follow the on-screen instructions to complete installation. 
5. When prompted, click Finish. 

If you did not install the Street Atlas USA map data to your computer's hard drive during 
installation, you can do so anytime. Saving data to your hard drive makes it readily 
available and improves performance. 
  

Connecting Data 
Only connected, compatible data displays in Street Atlas USA. You can improve performance 
by saving the data to your hard drive. 

To Connect Data 

Use the following steps to connect a dataset. 
1. Click the Map Files tab. 
2. Street Atlas Plus only: Click Add and then click Data Locations. 

The Data Locations dialog box opens and displays a list of the of the data sources on 
your system. 
Regular Street Atlas USA only: If you are using simplified file management, click 
File and then click Data Locations. 
The Data Locations dialog box opens and displays a list of each of the data sources 
on your system. 
OR 
If you are using advanced file management, click Add and then click Data 
Locations. 
Note  See Activating Advanced/Simplified File Management for more information. 

3. If the dataset you want to view displays in the list, ensure its check box is selected. 
AND/OR 
If the dataset you want to view does not display in the list, click Add, select the data 
folder where the dataset is located from the Browse for Folder dialog box, and click 
OK. 
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4. Click Done when finished. 
Note To remove a data source from the Data Locations list, select the data source and click 
Remove. 
  

Viewing Imagery 
Your purchase of Street Atlas USA entitles you to free imagery and data from NetLink. 
To learn how to view imagery and data, see To View Imagery. 
  

Showing Roads in Raster Data 
Raster data, such as aerial and satellite data, is image-based and does not provide typical 
map information, such as street names, route numbers, and so on. Street Atlas USA has a 
Show Roads feature that lets you overlay this type of map information onto raster data. 
For more information, see To View Imagery. 

To Show Roads and Text Labels in Raster Data 

Use the following steps to show road names, numbers, etc. on raster data. 

1. Click the arrow next to the Imagery button  on the toolbar. 
When Show Roads displays in the shortcut menu with a check mark next to it, 
roads display in the raster data. When Show Roads displays in the menu without a 
check mark next to it, roads do not display in the raster data. 

2. Click Show Roads to toggle the option on/off. 
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Using Map Files 

Map Files Overview 
You can save all of the work that you have done as a single map File so you can open it 
again later. You can create various map views and save each in a different map file, if 
desired. In this way, you can save separate views of often-viewed areas at your preferred 
zoom level and other settings. Then, open them as you need them using the Map Files tab. 

What is a Map File? 

A Map File consists of the map center coordinates, the current data zoom level, the current 
magnification, rotation, preferences, and links to routes or draw layers you have added to it. 

As you create routes and draw layers, they are added to the currently selected map file. 
Map files are saved by default in C:\DeLorme Docs\Map Files. 

Each associated file is saved in its respective folder in the C:\DeLorme Docs directory. For 
example, a draw layer is saved in C:\DeLorme Docs\Draw. 

Set the Map File Street Atlas USA Opens When you Start the Program 
Use the Welcome screen to set how Street Atlas USA opens map files. You can create a new 
map file each time the program opens OR open the file you last used. 

Use Draw Layers and Routes in Another Map File 

After creating routes or adding your own roads, you may not want to do all of the work 
again in another map file. You can share routes and draw layers between map files using 
the Add button in the Map Files tab. 

Send Routes or Draw Layers to Another Street Atlas USA User 

You can package map files, including their routes and draw layers, into one transfer file. The 
transfer file facilitates e-mailing, copying map file information to other computers and 
copying map files between DeLorme programs. 

  

 

Note for regular Street Atlas USA users 
This Help topic describes functionality provided in advanced file management. 
Advanced file management allows you to save multiple routes and draw layers in a 
single map file. With simplified file management, you can save only one route 
and/or draw layer in a single map file. If you did not select to enable advanced file 
management during the product installation, you can still change the settings 
using the Change File Management option in the Options menu. For more 
information, see Activating Advanced/Simplified File Management. 
This note does not apply to Street Atlas USA Plus users. 

  

Creating and Deleting Map Files 
You can create various map views and save each in a different map file. 

To Create a New Map File 
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Use the following steps to create a new map file. 
1. Click the Map Files tab. 
2. Click File and then click New. 

OR 

Click the New File button . 

3. Click the Save button  on the tab. Map Files have .saf extensions and are saved 
by default in the C:\DeLorme Docs\Map Files directory. 
OR 
Click File and then click Save As to rename the map file. 

Note  You can also use the toolbar to create and save map files. 

To Delete a Map File 

Use the following steps to delete a map file. 
1. Open a map file. 
2. From the Map Files tab, click File, point to Current View, and click File Info. 
3. Browse to the file location on your computer specified under Directory in the Map 

Files tab area. 
4. Select the file. 
5. From your computer's File menu, select Delete. 
6. Click Yes at the Delete File confirmation message. 

  

 

Note for regular Street Atlas USA users 
This Help topic describes functionality provided in advanced file management. 
Advanced file management allows you to save multiple routes and draw layers in a 
single map file. With simplified file management, you can save only one route 
and/or draw layer in a single map file. If you did not select to enable advanced file 
management during the product installation, you can still change the settings 
using the Change File Management option in the Options menu. For more 
information, see Activating Advanced/Simplified File Management. 
This note does not apply to Street Atlas USA Plus users. 

  

Opening an Existing Map File 
You can create various map views and save each in a different map file. You can view your 
map files by opening them one at a time. 

To Open a Map File 

Use the following steps to open a map file. 
1. Click the Map Files tab. 
2. Click File and then click Open. 

OR 

Click the Open button  on the tab. 
3. Double-click the map file. The last saved map view for that map file displays. 

OR 



Using Map Files 

69 

Click the map file to select it and then click Open. The last saved map view for that 
map file displays. 

  
You can also: 
• Open a map file from the Welcome Screen. 

• Open a map file by clicking the Open button  on the toolbar. 
• Open a map file by dragging and dropping it into Street Atlas USA from Windows 

Explorer. 
• View the most recently saved map files by clicking File, Recent Files, and then clicking 

the map file you want to open on the Map Files tab. 
• Click the arrow next to the toolbar button to open a menu. Then, click Open Map File 

to open the Open File dialog box OR click a recently saved map file in the list. 
  

 

Note for regular Street Atlas USA users 
This Help topic describes functionality provided in advanced file management. 
Advanced file management allows you to save multiple routes and draw layers in a 
single map file. With simplified file management, you can save only one route 
and/or draw layer in a single map file. If you did not select to enable advanced file 
management during the product installation, you can still change the settings 
using the Change File Management option in the Options menu. For more 
information, see Activating Advanced/Simplified File Management. 
This note does not apply to Street Atlas USA Plus users. 

  

Setting which Map File Opens with Street Atlas USA 
By default, when Street Atlas USA opens, the Welcome Screen appears. From the Welcome 
Screen, you can create a new map file project or you can open a recent map file project—if 
the file you want to use is not listed, you can browse to it. 
You can also set the program to hide the Welcome Screen on startup and always use the 
selected map file project option. If you select the "recent" option, the most recently opened 
file is opened the next time you start the program. You can easily open an existing map file 
or create a new map file at any time. 

The Welcome Screen is always available—click the Help button  on the toolbar and 
click Welcome Screen. 
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Saving a Map File 
Use the Map Files tab to save each of your map files quickly and easily using one of the 
following methods: 

• Click File and then click Save or click the Save button . 
o If you have not saved the map file before, the Save File dialog box opens. 

Type a file name in the File Name text box and click Save. 
o If you have saved the map file before, the Save dialog box opens. All of the 

changes made to the current project display as a check list. Select the check 
box next to each change you want to save and clear the check box next to 
each change you do not want to save. Click Yes to save the selected changes, 
click No to save the file without the changes, or click Cancel to cancel the 
saving process. 

• Click File and then click Save As. 
The Save File dialog box opens. Type a file name in the File Name text box and click 
Save. 

You can also click the Save button  on the toolbar. 

Editing a Map File 
As you create new routes and draw objects, they are added to the current map file. You can 
also pan and zoom the map as needed, and then save all these changes. 

To Add/Delete Files Contained in a Map File 

Use the following steps to add or delete specific files contained in a particular map file from 
the Map Files tab. 

1. Open a map file. 
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2. Click File, click Current View, and then click Contents to view the contents of the 
map file. 

• To add a file, click Add and then click Draw Files or Route Files. Then 
select the file you want to add to the current map file. 
Note  If a file is added to a map file and then changed later, the file is 
updated in every map file it has been added to. 

• To remove a route or draw file from a map file, select that file and then click 
Remove. 
Note  This process does not delete the file; it just removes it from the current 
map file. 

3. Click File and then click Save. 
OR 

Click the Save button . Map files have .saf extensions and are saved by default in 
the C:\DeLorme Docs\Map Files directory. 

Note  Under the tree menu, you can use the check box next to each draw or route file to 
display or hide it in the current map view. 
  

 

Note for regular Street Atlas USA users 
This Help topic describes functionality provided in advanced file management. 
Advanced file management allows you to save multiple routes and draw layers in a 
single map file. With simplified file management, you can save only one route 
and/or draw layer in a single map file. If you did not select to enable advanced file 
management during the product installation, you can still change the settings 
using the Change File Management option in the Options menu. For more 
information, see Activating Advanced/Simplified File Management. 
This note does not apply to Street Atlas USA Plus users. 

  

Creating Transfer Files 
A map file is made up of several different files; for example route, draw, and waypoint files. 
A map file and its contents can be packaged into a single file, called a transfer file, to 
facilitate e-mail or copying. Transfer files do not include map data. 

To Create a Transfer File 

Use the following steps to create a transfer file. 
1. Click the Map Files tab. 
2. Open the map file you want to create as a transfer file. 
3. Click File, click Transfer, and then click Create. 

The Create Transfer File dialog box opens. 
Street Atlas USA Plus only If your file contains links to other files, you can select 
to maintain part of the directory structure for files with at least a common drive 
location or choose not to include the directory. For more information, see Creating 
Transfer Files with Hyperlinked Files. 

4. In the File Name text box, type the file name.  
Note  Transfer files have .dmt extensions and are saved by default in the 
C:\DeLorme Docs\Transfer Files directory by default. Browse to another location if 
you want to save the file somewhere else. 
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5. Click Create. Your file is created and saved in the specified location. 
  

 

Note for regular Street Atlas USA users 
This Help topic describes functionality provided in advanced file management. 
Advanced file management allows you to save multiple routes and draw layers in a 
single map file. With simplified file management, you can save only one route 
and/or draw layer in a single map file. If you did not select to enable advanced file 
management during the product installation, you can still change the settings 
using the Change File Management option in the Options menu. For more 
information, see Activating Advanced/Simplified File Management. 
This note does not apply to Street Atlas USA Plus users. 

  

Creating Transfer Files with Hyperlinked Files 

 

This Help topic describes a feature that is available only in Street Atlas 
USA Plus. 

When you create a transfer file containing hyperlinked files, you can select to maintain part 
of the directory structure for files with at least a common drive location or choose not to 
include the directory. 

To Maintain the Directory Structure When Creating a Transfer File with 
Hyperlinked Files 

Use the following steps to create a transfer file with hyperlinked files. 
1. Click the Map Files tab. 
2. Open the map file you want to create as a transfer file. 
3. Click File, click Transfer, and then click Create. 

The Select Hyperlinked Files dialog box opens. 
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4. Verify the Include Hyperlink Files for Transfer check box is selected. 

If you do not want to include hyperlink files in your transfer file, clear this check box 
and go to step 8. 

5. Under File Options, select Maintain Directory Info to save the directory structure 
of the hyperlinked files. 
If you do not want to include the directory information for the hyperlinked files in the 
transfer file, select Do Not Include Directory Info and go to step 7. 

6. Type the common base directory location of the hyperlinked files (up to the folder 
location that you want to maintain) in the text box. 
OR 
Click the Browse button  and browse to the common base directory location. 

7. Under Select Files to Be Included, clear the check box next to each file you do not 
want to include in your transfer file. 

8. Click OK. 
The Create Transfer File dialog box opens. 

9. In the File Name text box, type the file name. 
Transfer files have .dmt extensions and are saved by default in the C:\Transfer Files 
directory. Browse to another location if you want to save the file somewhere else. 

10. Click Create. 
Your file is created and saved in the specified location. 

  

Importing Transfer Files 
You can package a map file and its contents into a single file, called a transfer file, to 
facilitate e-mailing or copying. You can also import transfer files, allowing you to share your 
map files with other DeLorme users. 
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You can import a transfer file with or without attached hyperlink files. When you create a 
transfer file with hyperlinked files, you can choose to maintain the directory information of 
common files. By doing this, the recipient of the transfer file can keep a similar directory 
structure as the creator. This is helpful when a transfer file is shared and updated between 
users. 
Note  Transfer files do not include map data. 

To Import a Transfer File 

Use the following steps to import a transfer file, including transfer files that have been e-
mailed to you by other DeLorme users. 

1. Click the Map Files tab. 
2. Click File, click Transfer, and then click Import. 

The Import Transfer File dialog box opens. The C:\DeLorme Docs\Transfer Files 
directory is the default location. Browse to another location if you want to save the 
file somewhere else. Transfer files have .dmt extensions. 

3. Click a file to select it. 
The name displays in the File Name text box. 

4. Click Import to finish the import process. 
The imported map file opens and displays in the map view. 

To Import a Transfer File with Hyperlinked Files 

Use the following steps to import a transfer file that includes hyperlinked file attachments. 
1. Click the Map Files tab. 
2. Click File, click Transfer, and then click Import. 

The Import Transfer File dialog box opens. The C:\DeLorme Docs\Transfer Files 
directory is the default location. Browse to another location if you want to save the 
file somewhere else. Transfer files have .dmt extensions. 

3. Click a file to select it. 
The name displays in the File Name text box. 

4. Click Import. 
The Browse for Folder dialog box opens. 

5. Select the folder where you want to save the hyperlinked files.  
C:\DeLorme Docs\Transfer Files is the default location. Browse to another location if 
you want to save the file somewhere else. 

6. Click OK. 
The imported map file opens and displays in the map view. 

  

 

Note for regular Street Atlas USA users 
This Help topic describes functionality provided in advanced file management. 
Advanced file management allows you to save multiple routes and draw layers in a 
single map file. With simplified file management, you can save only one route 
and/or draw layer in a single map file. If you did not select to enable advanced file 
management during the product installation, you can still change the settings 
using the Change File Management option in the Options menu. For more 
information, see Activating Advanced/Simplified File Management. 
This note does not apply to Street Atlas USA Plus users. 
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E-mailing a Transfer File 
You can package a map file and its contents into a single file, called a transfer file, to 
facilitate e-mailing or copying. Note Transfer files do not include map data. 

To E-mail a Transfer File 

This procedure creates an attachment file, but does not permanently save a file to 
C:\DeLorme Docs\Transfer Files. 
Use the following steps to e-mail a transfer file. 

1. Click the Map Files tab. 
2. Open the map file you want to e-mail as a transfer file. 
3. Click File, click Transfer, and then click E-mail. 

A transfer file is created and your computer's default operating system e-mail 
program opens with the transfer file included as an attachment. 

4. Complete the e-mail in accordance with your e-mail system. 
  

 

Note for regular Street Atlas USA users 
This Help topic describes functionality provided in advanced file management. 
Advanced file management allows you to save multiple routes and draw layers in a 
single map file. With simplified file management, you can save only one route 
and/or draw layer in a single map file. If you did not select to enable advanced file 
management during the product installation, you can still change the settings 
using the Change File Management option in the Options menu. For more 
information, see Activating Advanced/Simplified File Management. 
This note does not apply to Street Atlas USA Plus users. 
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Printing 

Printing a Map 
You can print a map based on your paper size or screen size. If you choose to print a map 
based on your paper size, you can also print a multi-page map that you can assemble using 
the Manually Assembling a Multi-page Map instructions. 

To Print a Map 

Use the following steps to print a map. 
1. Locate the area you want to print. 
2. Click the Print tab. 
3. Click the Map subtab. 
4. Under Print Layout, select Page (the map print area is based on the paper size you 

have specified in the Setup options) or Screen (the map print area is based on the 
screen size). 
The print area for a Page map displays as a red box on the map, which may not 
always be visible. The overview map and the print area for a Screen map display as 
a blue box on the overview map. 

5. If you selected Screen in step 4, go to step 6. If you selected Page in step 4, select 
your options and then go to step 6. 

• Under Print Layout, select a layout option (Single, 2 x 2, or 3 x 3). The print 
area displays on both the map and the overview map. 

• If you selected 2 x 2 or 3 x 3 on the map layout graphic, and you do not want 
to print all the pages in the multi page map, click each page you do not want 
to print. The page appears dimmed or gray. (You can click a dimmed/gray 
page again to print it.) 
Note  In the example below, page 4 will not print for the 2 x 2 map. 

 
• Verify this is the location and photo zoom you want to print. 

• If not, pan the map to a new location and zoom to the correct level. 
OR 

• Street Atlas USA® Plus only: To change the photo zoom, select an 
option from the Photo Zoom drop-down list or type the photo zoom in 
the text box.  
Note  Changing the photo zoom enlarges or reduces the map features 
and changes the map print area. If you increase the photo zoom level, 
map text, lines, symbols, etc. display larger and your map print area is 
reduced. If you decrease the photo zoom level, map text, lines, 
symbols, etc. display smaller and your map print area is enlarged. The 
reduction/enlargement percentages for your photo zoom level display 
under the Photo Zoom drop-down list. 

• If you want to use other tabs and functions but not lose your current print 
area or other settings, select the Lock Print Center check box. Selecting this 
check box locks the print area and changes the tab label to red. 

• Select the Print Preview check box to zoom the map and view the entire 
print area. Clear the check box to return to your previous data zoom level. 
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• Street Atlas USA Plus only: Add text or graphics to your map 
• Street Atlas USA only: To add a title to a single-page map, select the Map 

Title check box and click Map Title to assign the title's text, font, and 
alignment. 

6. To change printers or make choices for transparent/yellow background, paper 
orientation, paper size, and paper source, click Setup. The Print Setup dialog opens. 
Note  From the Setup dialog box, click Properties to view additional options. If the 
options are available, set the graphics mode to use raster graphics and set TrueType 
fonts to print as graphics. Consult your printer manual for additional information. 

7. Click the Print button to print your map. 
Tips 

• To save a map to a file, see Saving a Map as a Bitmap or JPEG Image. 
• To adjust the print area of a Page map, select the Lock Print Center check box, 

select the Select tool , and then drag the frame to the new position. 
  

Printing a Route and Directions 
You can print maps of your route and route directions for any route you create. 
Additionally, you can save your directions or along the way results in a text file. For more 
information, see Saving Route Directions as Text. 
For specific recommendations on best printing results, see your printer manual. 

To Print a Route 

Use the following steps to print an existing route. 
1. Click the Print tab and then click the Route subtab. 

Note  If you do not have a route on this map file, the route options are unavailable. 
2. Optional. Click Setup to open the Print Setup dialog box and select a printer, change 

printer properties, select a transparent/yellow background, select paper size, and 
select paper orientation. Click OK when finished. 
If the options are available under Printer Properties, set the graphics mode to use 
raster graphics and set TrueType fonts to print as graphics. 

3. Select the route you want to print from the Name drop-down list. Only routes 
contained in the current map file display in this list. 
Street Atlas USA only - this does not apply to Street Atlas USA Plus: If you 
are using simplified file management, your only route print option displays in the 
Name text box. 

4. Under Options, select from one of the following choices: 
• Overview–Provides an optimized map of your route and the route 

summary—trip distance, trip time, start, total stops, and finish. 
• Travel Package–Provides maps of the route with corresponding directions. 
• Turn Details–Prints 2" x 2" maps of each of the turns in your route 

directions. 
• Directions–Provides action-based directions (turn, merge, bear, depart, 

arrive, and continue) including the time frame for each action.  
Note  You can save route directions as a text file. 

• Along the Way–Prints the search results of a previous Advanced Find search 
within a current route. The search results are listed as they are listed in the 
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Find results. The Along the Way option is only available if you have recently 
performed a find/category within current route search in the Advanced Find 
subtab. For more information, see Performing an Advanced Search. 

• Strip Maps–Provides detailed maps in the direction of travel of the route 
along with directions that appear in the map margin. Strip maps are not 
printed North Up like other printed maps. They are printed so that the 
direction of travel is always at the top of the printed map. 

5. If you selected Travel Package or Strip Maps in step 4, select the miles per page that 
you want your route to cover from the Miles Per Page drop-down list. 
Note  When setting the number of miles per page, keep in mind that the number of 
miles is not the distance of the route. Instead, it equals the width of the strip map 
and determines the scale of the map. 

6. Select Increasing from the Trip Time/Distance drop-down list to end the route 
directions with the total time and distance. 
OR 
Select Decreasing from the Trip Time/Distance drop-down list to start the 
directions with the total time and distance — similar to a countdown. 

7. Optional. To view a preview of your selection, click View. 
8. Click Print. 

  

Adding Text or Graphics to Your Map 

 

This Help topic describes functionality that is available only in Street Atlas USA 
Plus. 

  
You can add text (framed or unframed) and graphics (north arrows, scale bars, and images) 
to your map. 

• To modify the properties of a text/graphic item, click the Select tool  and click the 
item on the map. 

• To make graphic items added to your map the same size, press and hold the SHIFT key 
on your keyboard or drag to select two items, right-click, select Make Same Size, and 
select Width, Height, or Both from the menu. 

• After you add text/graphic items to your map, you can align, snap, or layer them on the 
map. 

To Add Text to Your Map 

Use the following steps to add text to your map. 
1. Click the Print tab and then click the Map subtab. 
2. Select your Map and Print Layout options. For more information, see Printing a 

Map. 
3. Under Layout Tools, click and hold the text and graphics button to reveal the 

hidden text and graphic tools. 

4. Click the Framed Text tool . 
OR 
Click the Unframed Text tool . 
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5. Click the location on the map where you want to add your text. A text box displays. 
When not in editing mode, you can reposition your text by dragging the text box to 
the new position. 

6. Type the text in the text box. To type more than one line of text, press 
SHIFT+ENTER on your keyboard to advance to another line. Press the ENTER key on 
your keyboard when finished typing your text. 

7. Under Layout Tools, select the font, style, and size for your text from the drop-
down lists. 

8. To underline your text, click the Underline tool . 

9. To change the color of your text, click the Font Color tool . From the Color dialog 
box, you can: 

• Click to select an alternative color. Click OK when finished. 
• Click Define Custom Colors and create a custom color by assigning 

red/green/blue or hue/sat/lum values. Click Add to Custom Colors and then 
click OK. 

10. Click the Align Left button  to align the text in your text box to the left. 
OR 
Click the Center button  to align the text in the center of the text box. 
OR 
Click the Align Right button  to align the text in your text box to the right. 

11. Click the Text Box Size button  if you want the size of your text box to grow with 
the amount of text typed. 
The Text Box Size button is a toggle button. If the button is not activated, any text 
placed on the map is placed in a default-sized text box. You can resize the default 
size text box by selecting the text box on the map and dragging any of the white 
boxes on the corners/sides of text box. 

To Add a North Arrow to Your Map 

Use the following steps to add a North arrow to your map. 
1. Click the Print tab and then click the Map subtab. 
2. Select your Map and Print Layout options. For more information, see Printing a 

Map. 
3. Under Layout Tools, click and hold the text and graphics button to reveal the 

hidden text and graphic tools. 

4. Click the North Arrow tool . All of the North Arrow styles display to the right. 
5. Select the North Arrow style and then click the location on the map where you want 

to add the graphic. 
Once you place the North Arrow on the map, you can resize it by dragging any of the 
white boxes on the corners/sides of the graphic. Reposition the North Arrow at any 
time by dragging the graphic to the new position. 

To Add a Scale Bar to Your Map 

Use the following steps to add a scale bar to your map. 
1. Click the Print tab and then click the Map subtab. 
2. Select your Map and Print Layout options. For more information, see Printing a 

Map. 
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3. Under Layout Tools, click and hold the text and graphics button to reveal the 
hidden text and graphic tools. 

4. Click the Scale Bar tool . All of the Scale Bar styles display to the right. 
5. Select the check box to the left of the Scale Bar style options and then select the 

Scale Bar style. 
AND/OR 
Select the Scale check box to display the current scale on the map. 
AND/OR 
Select the Scale Reference Length check box to display the scale reference length 
on the map. 
AND/OR 
Select the Zoom check box to display the current data zoom level on the map. 

6. Click the location on the map where you want to add the graphic. 
Once you place the Scale Bar on the map, you can resize it by dragging any of the 
white boxes on the corners/sides of the graphic. 

To Add an Image to Your Map 

Use the following steps to add an image to your map. 
1. Click the Print tab and then click the Map subtab. 
2. Select your Map and Print Layout options. For more information, see Printing a 

Map. 
3. Under Layout Tools, click and hold the text and graphics button to reveal the 

hidden text and graphic tools. 

4. Click the Image tool . 
5. Click the location on the map where you want to add your image. The Select Image 

File dialog box opens. 
You can reposition the image at any time by dragging it to the new position. 

6. Select an image file (.jpg, .bmp, or .gif) to place on your map and then click Open. 
The image displays on the map and the file name displays in the text box next to the 
Image tool under Layout Tools. 
You can update the image at any time by clicking the Browse button  and 
browsing to an alternative image. 

7. Select the Maintain Aspect Ratio check box to maintain the image's width-to-
height ratio while resizing. 

8. Select the Preview Image check box to preview the image on the map. 
  

Aligning Text and Graphic Items on Your Map 

 

This Help topic describes functionality that is available only in Street Atlas USA 
Plus. 

  
After you add a text or graphic tool to your map, you can use the right-click options to align 
each object with a certain location on the map. 

Aligning Multiple Text and Graphic Items on Your Map 

Use the following steps to align multiple text and graphic items on the map. 
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1. Click the Print tab and then click the Map subtab. 
2. Place more than one text or graphic item on your map. For more information, see 

Adding Text or Graphics to Your Map. 
3. While pressing the SHIFT key on your keyboard, click each text/graphic item on the 

map. 
OR 
Drag your mouse over the text/graphic items on the map to select multiple items at 
once. 

4. Right-click one of the items, point to Align, and then click: 
• Left to align the left sides of all of the items; placement is based on the left 

side of the left-most item. 
• Right to align the right sides of all of the items; placement is based on the 

right side of the right-most item. 
• Top to align the top side of all of the items; placement is based on the top 

side of the top-most item. 
• Bottom to align the bottom side of all of the items; placement is based on 

the bottom side of the bottom-most item. 
• Vertical Center to center the items based on the average of the vertical 

placement of the items. 
• Horizontal Center to center the items based on the average of the 

horizontal placement of the items. 
• Center to center the items based on the center of the average area that the 

items cover on the map. 
• Stack Vertically to stack the items vertically on top of each other. 
• Stack Horizontally to position the items side-by-side. 

Tips 
• To make multiple graphic items the same size, press the SHIFT key on your keyboard 

and select each item. Then, right-click, point to Make Same Size, and click Width, 
Height, or Both. When you attempt to make multiple items the same size, the largest 
item is always the basis for the size change. Important: For an item to be made the 
same size as another item, the item must not be locked — for example, the Maintain 
Aspect Ratio check box should be cleared for any images, only text items with default 
size text boxes can be resized, and so on. 

• To delete multiple text or graphic items, click the Edit tool, drag the mouse on the map 
to encompass the items you want to delete, and then press the DELETE key on your 
keyboard. 

  

Snapping Text and Graphic Items on Your Map 

 

This Help topic describes functionality that is available only in Street Atlas USA 
Plus. 

  
After you add a text or graphic tool to your map, you can snap each item to the location you 
want it by dragging the item along the edges of the map or by dragging the item to snap it 
to the horizontal center of the page. 
To disable the auto-snap function, hold down the ALT key on your keyboard while dragging 
the text/graphic items on the map. 
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To Snap Text and Graphic Items on Your Map 

Use the following steps to snap text and graphic items on a printed map. 
1. Add text or graphics to your map. 
2. Drag each text/graphic item you placed on the map to the location you want them on 

the map. If you drag an item to the edge of the map print area, the text/graphic 
snaps to the edge. If you drag the item to the horizontal center of the edge of the 
map print area, the text/graphic snaps to the center of the edge. You can also drag 
the item to the center of the map print area to snap it to the center of the printed 
map. 

Tips 
• To make multiple text and graphic items the same size, press the SHIFT key on your 

keyboard and select each item. Then, right-click, select Make Same Size, and click 
Width, Height, or Both. When you attempt to make multiple items the same size, the 
largest item is always the basis for the size change. 

• To delete multiple text/graphic items, select the Edit tool, drag the mouse in a down-
right direction on the map to encompass the items you want to delete, and then press 
the DELETE key on your keyboard. 

  

Layering Multiple Text and Graphic Items on a Printed Map 

 

This Help topic describes functionality that is available only in Street Atlas USA 
Plus. 

  
You may want to layer text or graphic items on your printed map. In this case, use the 
right-click Bring to Front/Send to Back options so that each can still be displayed. 

To Layer Multiple Text or Graphic Items on a Printed Map 

Use the following steps to layer multiple text or graphic items on the map. 
1. Click the Print tab and then click the Map subtab. 
2. Place more than one text or graphic item on your map (see Adding Text or Graphics 

to Your Map), placing the text/graphic items on top of each other. 
3. If one of the text/graphic items you want to display is partially underneath another 

text/graphic item, select the item you want to display, right-click, and click Bring to 
Front. 
To reverse this step, right-click the item and select Send to Back. 

Tips 
• To make multiple text and graphic items the same size, press the SHIFT key on your 

keyboard and select each item. Then, right-click, point to Make Same Size, and click 
Width, Height, or Both. When you attempt to make multiple items the same size, the 
largest item is always the basis for the size change. 

• To delete multiple text/graphic items, select the Edit tool, drag the mouse in a down-
right direction on the map to encompass the items you want to delete, and then press 
the DELETE key on your keyboard. 

  

Changing the Background Color of a Printed Map 
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When you print a map, a yellow (or black if you are using High Contrast Colors) background 
automatically displays on the printout. If you want a transparent background — for 
example, if you are printing transparencies — you can change the Print settings to print with 
a transparent background. 

To Print Maps With a Transparent Background 

Use the following steps to turn off the yellow background when printing a map. 
1. Center the map on the area you want to print. 
2. Click the Print tab and then click the Map subtab. 
3. Select the Print Layout options. For more information, see Printing a Map. 
4. Click Setup. 

The Print Setup dialog box opens. 
5. At the bottom of the dialog box, select the Print Maps with a Transparent 

Background check box. 
6. Click OK. 

All map printouts print with a transparent background. 

To Print Maps With a Yellow/Black Background 

Use the following steps to turn on the yellow/black background when printing a map. 
1. Center the map on the area you want to print. 
2. Click the Print tab and then click the Map subtab. 
3. Select the Print Layout options. For more information, see Printing a Map. 
4. Click Setup. 

The Print Setup dialog box opens. 
5. At the bottom of the dialog box, clear the Print Maps with a Transparent 

Background check box. 
6. Click OK. 

All map printouts print with a yellow background (or black if you are using High 
Contrast Colors). 

  

Manually Assembling a Multi-page Map 
After you have printed the sheets for your multi-page map, you are ready to assemble the 
map. 
Before you begin, be sure you have a clear work surface large enough to accommodate the 
final map size. 
You will need the following tools to assemble your map: 

• Pencil 
• Razor knife 
• Straight-edge ruler (longer than the edge of the longest sheet) 
• Permanent tape (invisible or "magic" type) 
• Removable tape 

To Manually Assemble a Multi-page Map 

Use the following steps to manually assemble a multi-page map. 
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1. For each sheet that needs to be trimmed, mark the edges of the sheet to indicate the 
areas to trim. 

2. Use the straight edge ruler and razor knife to trim each sheet to the thin black line 
bordering the map. 
Note  For adjacent sheets, trim only one page. This makes piecing the sheets 
together easier. 
The following diagrams of a 2 x 2 and 3 x 3 multi-page map provide additional 
information on where to trim the sheets. The arrows indicate the edges to be 
trimmed. 

2 x 2 multi-page Map 

 
3 x 3 multi-page Map 

 
3. Align two adjacent sheets, placing the trimmed edge on top of the non-trimmed 

edge. 
Notes 

• Piece together the multi-page map one seam at a time. This is especially 
important for a 3 x 3 multi-page map. 

• Build the multi-page map from the inside out to minimize any misalignment. 
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4. Using two small pieces of removable tape, tack together the aligned sheets. 

 
Note  This is a temporary measure. Steps 6 through 10 describe how to completely 
secure the sheets. 

5. Repeat steps 3 and 4 until all the sheets are pieced together. 
6. With the multi-page temporarily pieced together, use small pieces of removable tape 

to secure the corners and edges of the multi-page map. 

 
Note  Place the removable tape on the corners and edges, not along the seams. 

7. For each seam, fix the tape to the work surface, not on the sheet, so the tape is in 
alignment with the seam. 

8. Spool off enough permanent tape to cover the entire seam. Be careful not to let the 
tape touch the map until you are ready to apply it (in step 9). 

9. Keeping the length of the tape taut, carefully apply the tape to the seam until both 
sides are fixed to the work surface. 
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10. Press the tape along the seam to remove any air gaps. 
11. Repeat steps 6 through 10 until all seams are completely pieced together. 

 
12. Using the straight-edge ruler, carefully trim the edges of the map at the seams 

(where the tape is affixed to the workspace). 
13. Peel off the removable tape at the corners and the edges. You are now ready to 

display your multi-page map. 
  





 

89 

Finding a Location on the Map 

Find Overview 
There are four Find options you can use to search for and locate places and other map 
items. 

• QuickSearch–Search for places, addresses, cities/towns, ZIP/Postal Codes, and 
coordinate positions. If the item you are looking for is not recognized, the Advanced 
tab displays automatically. 

• POIs–Search for specific points of interest, such as hotels, restaurants, hospitals, 
department stores, etc. Search a specified distance from the current map center or 
along an active route. 

• GPS Radar–Search for points of interest and waypoints within a designated distance 
from your current location while tracking a route with a GPS receiver. Before you use 
GPS Radar, check the Find settings in the Options dialog box. 

• Advanced–Control what you are looking for with the Find field, and where you are 
looking for it with the Within field while you conduct a more detailed search. 

Find Options 
Use the Find tab in the Options dialog box to set your preferences when you use GPS Radar 
to find POIs when tracking with GPS. 

To Set GPS Radar Find Options 

1. Click the Options button  on the toolbar (or click the menu arrow and click 
Options) and then click the Find tab. 
OR 
Click the Find tab and click the Options button . 

2. Select your preferences: 
• Calculate the distance to objects by–The method to search for objects. 

• Select Road to calculate the distance by road. 
• Select Distance to calculate the distance as the crow flies. 

• Search area equals miles–The search distance (for a 
road search) or radius (for a direct search). Select the distance from the 
drop-down list. 
The results returned are based on the calculation method. For example, if you 
are looking for gas stations and you have set your calculation method as Road 
and the search area for 10 miles, the results will not show you gas stations 
that are 10 miles or less in distance as the crow flies if the distance to get to 
them by road is more than 10 miles. 

• Search only in direction of travel–Select the check box if you want to 
search only in the direction you are traveling (when you are moving). 

• Repeat the search every  
• minute(s)–The interval at which to repeat the search. Select the check box 

and then select the number of minutes from the drop-down list. Note  This 
option must be selected to use GPS Radar with NavMode. 
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• Only repeat search when GPS is tracking–Select the check box if 
you want to suspend searching when the GPS is disabled. 

• Only highlight the selected object–Select the check box to highlight only 
the selected result on the map, rather than all results. 

• Enable voice reporting–Select the check box to allow voice reporting of 
results. 

• Report: –From the drop-down box, select the 
option for reporting. 

• Interrupt report for new search results–Select this check box if 
you want a new result to interrupt voice reporting. 

  
To restore the default settings, click Use Defaults. 

Performing a Basic Search 
Use the QuickSearch tab to locate places, addresses, ZIP/Postal Codes, coordinate positions, 
and more. To search for other items, such as an area codes, street intersections, or a 
category (such as Park, Interstate, and so on), use the Advanced subtab. 

To Perform a Basic Search 

Follow the steps below to use the QuickSearch subtab. 
1. Click the Find tab and then click the QuickSearch button. 

OR 
Press CTRL+F on your keyboard. 

2. Type a name, address, ZIP/Postal Code, town name, coordinate, draw object label, 
address book contact name, street intersection, etc. in the Search For text box. See 
Searching Tips for a description of input formats. 
OR 
Select From Address Book from the Search For drop-down list to find an address 
book entry in your DeLorme Address Book and then click OK. 
Notes 

• The Book check box (under the Address Book buttons) must be selected to 
search for address book contacts. For more information, see Searching for 
Address Book Contacts. 

• Do not enter more than five digits for a ZIP Code search or six characters for 
a Postal Code search (you do not need to include spaces in a Postal Code). 

• Address searches should be in the following formats: street address, city, 
state OR street address, ZIP/Postal Code OR street address, city, state, 
Zip/Postal Code. 

3. Click Search. If your search is: 
 Very Successful 

The results list displays and, if there is one excellent match, the map centers 
on that place. A MapTag displays if the MapTags check box is selected. The 
only time a MapTag is not placed is when you find and then go to a labeled 
area that has no single map point associated with it (for example, a large 
park). 

 Successful 
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The results list displays. Scroll or browse through the list of search results 
until you find the one you want to locate. To center an item on the map, 
double-click it or select it and then click Go To. A MapTag displays if the 
MapTags check box is selected. 
Tip  Single click an item in the results list to highlight it on the map without 
adding a MapTag or centering it in the map view. For more information on 
viewing results, see Tips on Viewing Search Results. 

 Not Successful 
The Advanced dialog area displays. The program makes its best guess about 
the type of search you were trying and your search word(s) display in the 
upper-right text box. Click Search to proceed. For more information, see 
Performing an Advanced Search. 

Tips 
• Use a comma to separate city and state/country (Atlanta, Georgia; Montreal, 

Canada), major point of interest and state (Mt Washington, NH), parts of an address 
(444 E Pk Drive, Milford, CT or 444 E Pk Dr, 06460), or coordinate points (N 43.8, W 
70.2). 

• You can find major landmarks or points of interest, such as Yellowstone National 
Park and Mount Rushmore, without using the state as part of the search criteria. 

• Separate street intersections with an ampersand (Congress St & High St, Portland, 
ME or Congress St & High St, 04101). 

• Avoid entering a period in your text. 
• Click the Search For down arrow to view a drop-down list of previously used search 

words and examples. 
• The Search For drop-down list keeps a history of your successful search words 

during a session and between sessions. To delete your search history, select Clear 
History from the drop-down list. Click No to delete the search history in the 
QuickSearch drop-down list. Click Yes to delete the search history in both the 
QuickSearch and Advanced subtabs. 

• Use the right-click feature to copy search result information to the clipboard; center 
a search result on the map (go to); select all search results; add a result as a 
MapTag, MapNote, Detailed MapNote, Waypoint, or Address Book Entry; or assign it 
a start, stop, or finish in a route. Just right-click a search result and click the option. 

  

Performing an Advanced Search 
The Advanced search option allows you to perform more detailed searches by controlling 
what you are looking for using the Find field and where you are looking for it using the 
Within field. 

• The fields available for selection under Within vary based on your Find selection. 
• Type text in the fields and use the drop-down list to see examples and your recent 

searches. 
• The fill-in fields located in the center of the tab vary based on both your Find and 

Within selections. 
You can also search for more types of items than you can in the QuickSearch tab, such as 
by category, street intersection, and more. 

To Perform an Advanced Search 
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Follow the steps below to use the advanced search function. 
1. Click the Find tab and then click the Advanced subtab. 

Note  This screen automatically displays if you performed an unsuccessful 
QuickSearch. 

2. From the Find drop-down list, select the Find type. 
When more than one match is available, the closest match displays first in the 
Results list. 
Click a Find type in the list below for more information. 

• Name 
Use Name to locate a city, town, landmark, object label, and so on. 

• Street Address 
Use Street Address to locate by street number and name, highway number, 
and so on. 
You can use standard abbreviations like Rd (Road), St (Street or Saint), Mt 
(Mount), Dr (Drive), and Ct (Court). 

• Street Intersection 
Use this search to locate the intersection of two specified roads. 

• ZIP/Postal Codes 
Use at least a partial ZIP/Postal Code to locate the covered regions. The 
results are displayed in a browse list. This means you are taken into the 
ZIP/Postal Code database at the closest matching, valid ZIP/Postal Code. You 
can browse through results in either direction. 
Use at least a partial ZIP Code to locate the covered regions. The results are 
displayed in a browse list. 

• Name and/or Category 
Searches for a specific name in a specific category. For example, if you want 
to find a particular restaurant in your town, you would type restaurant in the 
Keywords text box, type the name of the restaurant in the Name text box, 
and then type your location information in the available text boxes. 
For more information on category searches, see Keywords for Category 
Searches. 
Note  Category keywords must be at least three characters in length. 

• Category 
Searches for a category of items within the specified area. For more 
information on category searches, see Keywords for Category Searches. 
Notes 

• In all category searches, the Keywords field is optional. If the 
Keywords field is left blank, all objects in the selected Within area 
display in the Results list. 

• Category keywords must be at least three characters in length. 
• Area Code and Exchange 

There are no Within options for Area Code and Exchange search. Use at least 
a partial Area Code and Exchange to locate the covered regions. This is not an 
individual phone search. The results display in a browse list. 

• Latitude/Longitude 
A single result is returned using a latitude/longitude coordinate search. There 
are no Within options. Coordinates must be in one of the many formats 
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recognized by the program and are based on your Display settings in the 
Options dialog box. 

3. From the Within drop-down list, select an option. Available choices are based on 
what you selected as your Find type. 
Click a Within type in the following list for more information. 

• North America 
Searches for a name in North America. 

• US/Canada 
Searches for ZIP/Postal Code within the United States and Canada. Available 
only when ZIP/Postal Code(s) is selected as the Find parameter. 

• City or County 
Searches for the specified name within the ZIP/Postal Codes associated with 
the city/county and state/province specified in the text boxes. 

• ZIP/Postal Code 
Searches for the specified name within a ZIP/Postal Code. Displays a 
ZIP/Postal Code text field. A U.S. search for a ZIP+4 Code is treated the 
same as a 5-digit ZIP Code. A Canadian search for a 3-character Postal Code 
is treated the same as a 6-character Postal Code. 
Searches for the specified name within a ZIP Code. Displays a ZIP Code text 
field. A search for a ZIP+4 Code is treated the same as a five-digit ZIP Code. 

• U.S. State 
Searches for a name within a specific U.S. state. This option is available only 
when Category or Name and/or Category is selected as the Find parameter. 
Note  If you are searching within a larger state, this type of search may take 
longer than others because a lot of data is being searched to obtain a result. 

• Current Map City 
Searches for the specified name within the boundaries of all ZIP/Postal Codes 
associated with the city at the current map center. 

• Current Map Rectangle 
Searches for the specified location within the currently visible map area. 

• Distance from Map Center 
Performs a search in all directions from the center of the map using the 
specified distance. Also called a radius search. The minimum distance you can 
use is 50 feet; the maximum distance is 100 miles. 

• Current Route 
Searches for objects within the specified distance from your currently active, 
calculated route. The minimum distance you can use is 500 feet; the 
maximum distance is 10 miles. Results are listed in the sequence they occur 
along the route, from start point to finish point. 
Note  This search may take longer than other types of searches. 

4. Type information in the text boxes to the right of the Find and Within fields. The 
text boxes available are based on the selected Find and Within fields. 
Tip  A few text boxes are optional and you may get more results by leaving them 
blank. To see if a text box is optional, hold your cursor over the text box label or 
down arrow and read the ToolTip for that text box. 
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5. Click Search or press the ENTER key on your keyboard. 
The Results list displays your search results with closest matching items at the top of 
the list. 

6. Scroll or browse through the list of search results until you find the one you want to 
locate. To center an item on the map, select it and then click Go To or double-click 
it. 
A yellow MapTag displays at the location if the MapTags check box is selected.  

Tips 
• Single click an item in the results list if you want to highlight it on the map without 

adding a MapTag or centering it in the map view. For more information on viewing 
results, see Tips on Viewing Search Results. 

• Use the right-click feature to copy search result information to the clipboard; center 
a search result on the map (go to); select all search results; add a result as a 
MapTag, MapNote, Detailed MapNote, Waypoint, or Address Book entry; or assign it 
a start, stop, or finish in a route. Just right-click a search result and click the option. 

• The program keeps a history of your search words during a session. If you want to 
delete your Advanced search history, click the QuickSearch subtab and select Clear 
History from the Search For drop-down list. Then, click Yes to delete the search 
history in both the QuickSearch and Advanced subtabs. 

  

Performing a POI Search 
The POIs subtab gives you an easy way to find the places of interest you are looking for. 
You can search over four million places of interest including Wal-Mart stores, post offices, 
hospitals, and much more. 
• Some POIs contain extended information, such as website links, hours of operation, and 

so on. To view this extended information, right-click the POI search result, point to 
Add, and then click Detailed MapNote to view the information on the map. Or, right-
click the POI search result and click Info to view the extended information in the Info 
tab.   

• POI searches will find more objects than may be currently visible on the map. To see all 

POIs on the map, click the Options button  on the toolbar (or click the menu 
arrow and click Options), click the Map Features tab, select the Points of Interest 
(Minor) and the Business Points of Interest (Minor) check boxes, and click OK. 

To Find a Point of Interest 

Use the following steps to find a point of interest with the POIs subtab. 
1. Click the Find tab. 
2. Click the POIs subtab. 
3. Type the name of the point of interest you are searching for (for example, Wal-Mart 

or Sheraton) in the Name text box. 
4. Type the category that best fits your POI name (for example, type Hotel if you are 

searching for a Sheraton, type Department Store if you are searching for Wal-
Mart) in the Keywords text box. See Keywords for Category Searches for more 
information. 
OR 
Select an appropriate keyword from the Keywords drop-down list examples and 
history. 
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5. Type the distance you want to search in the Distance text box. Type the number of 
miles followed by "mi" — for example, 5 mi. 

6. Select From Map Center or Along Current Route. 
7. Click Search. If your search is: 

 Very Successful–The results list displays and, if there is one excellent 
match, the map centers on that place and a yellow box displays at the 
location of the POI match. 

 Successful–The results list displays. Scroll or browse through the list of 
search results until you find the one you want to locate. To center an item on 
the map, double-click it or select it and then click Go To. 

Tips 
• Single click an item in the results list to highlight it on the map without adding a 

MapTag or centering it in the map view. For more information on viewing results, see 
Tips on Viewing Search Results. 

• Use the right-click feature to copy search result information to the clipboard; center a 
search result on the map (go to); select all search results; add a result as a MapTag, 
MapNote, Detailed MapNote, Waypoint, or Address Book entry; or assign it a start, stop, 
or finish in a route. Just right-click a search result and click the option you want. 

  

Finding Points Near Your Current Location 
Use the GPS Radar option on the Find tab to search for points of interest (POIs) such as gas 
stations, restaurants, accommodations, rest areas, and so on near your current location (if 
tracking with a GPS) or near the current map center when viewing another location. 
You can also search for waypoints. If you enable voice reporting on the Find tab in the 
Options dialog box, you can hear the nearest search result. Once you find the waypoint or 
POI you want, you can use the GPS Radar subtab to center the map on the route on that 
point or POI and get directions to it. 

What you need to know 
• Before you start, set your Find preferences in the Options dialog. 
• A GPS Radar search finds items that are the shortest driving distance from your current 

location—within just a few miles. Unless you select the Only in Direction of Travel 
check box, some of the search results may be behind you. GPS radar calculates a route 
to each point and the fastest destination for you to drive to is listed first. If you are on a 
one-way road or freeway, GPS Radar takes into account the fact that you need to drive 
further to get off at an exit. You can click each item in the result list to see each option, 
to highlight the route to each destination, and to see a description of each one as well 
as driving directions. This should help you choose the best one for your needs. 

• The time required for a GPS Radar search varies by the distance, density of objects in 
the area, the categories chosen, and whether you are searching only in the direction of 
travel. 
• In GPS tab view, click the Interrupt button to interrupt a long search and see a 

listing of the nearby points. Driving directions will not be provided. 
• In GPS NavMode, GPS Radar results display in an orange status bar at the bottom of 

the map area and long searches are automatically interrupted; click the More Info 
button on the orange status bar to open the GPS Radar subtab and adjust your 
settings for a shorter search. 
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• Important  To enable GPS Radar in NavMode, you must select the Repeat Search 
Every check box and enter the number of minutes for repeating the search on the 
Find tab in the Options dialog box. If you are using the E-Z Nav route wizard, you 
must create your route and then set up your GPS Radar search. 

To Find Points Near Your Location 

Use the following steps to find points near your location. 
1. Set your GPS Radar preferences on the Find tab in the Options dialog box. 
2. In the program's tab area, click the Find tab. 
3. Click the GPS Radar subtab button. 
4. From the Find drop-down list, select the category to search (for example, Gas 

Stations, Restaurants, etc.). 
OR 
From the Find drop-down list, select Custom and then click the Custom button. In 
the Radar dialog, type a keyword or phrase to search for a specific point or to search 
for multiple POI types, such as "Chinese restaurant or Mexican restaurant." 
To use the Custom search to search for waypoints, use search general or specific 
terms such as "draw symbol," "map pin," or "waypoint." 

5. To turn the search repeat on or off (set with the Repeat Search Every check box 
on the Find tab in the Options dialog box), click the Repeat button . This is 
required if you are using GPS NavMode.  
Note  Searches are not repeated when the GPS position is stationary. 

6. Click Search. 
The search results display in the list box. 

7. Click a search result to select it. 
A green, highlighted line displays on the map between your current/specified location 
and the point of interest's location. 
Note  Click Recenter to center the map on the selected point in the route. Click 
Insert Stop to insert the selected search result into your current route. 

8. Select the Info option to view the information about the point, including the distance 
from the current location. 
OR 
Select the Directions option to view directions to the point from your 
current/specified location. 

  

Finding a Symbol by its Name 
Within the Draw tab, you can attach a name to any symbol you add to your map. For more 
information on adding symbols to the map, see Adding a Waypoint, Symbol, MapNote, or 
Text Label to the Map. 
You can use a name to help locate a symbol you have already placed on a map using the 
QuickSearch feature on the Find tab. For example, if you named a symbol "My House" when 
you placed it on the map, use the following steps for conducting a search on the unique 
symbol name. 

To Find a Symbol by its Name 

Use the following steps to find a symbol by its name. 
1. Click the Find tab. 
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2. Using QuickSearch, type the symbol name followed by the town and state 
abbreviation (for example, My Office, Yarmouth, ME) in the Search For text box. 

3. Click Search. The closet matches display in the list view to the right of the Search 
For text box. The symbol name displays in the Name column. 

4. Double-click the item or select the item and click Go To to locate your selection on 
the map. The map view centers on the item. A MapTag displays the symbol name at 
the symbol location. 
Note  To display MapTags, select the MapTags check box on the Find tab. 

  

Tips on Viewing Search Results 
These tips can help you view Find tab search results. 

• To make it easier to view a long list of search results, increase the height of the tab 
by dragging the top of the tab area up or by clicking the increase (up) tab height 
arrow  at the top of the tab. 

• To sort results by another column, click the column header. An arrow identifies the 
sort column. Click a second time to reverse the sort order. 
Note  This feature is not available when in browse mode; see last item in this list. 

• To copy the information for the selected item or items, press CTRL+C on your 
keyboard. You can then paste the text into another program, such as a word 
processing program. 

• Right-click an item in the results list to display the following options: 
 Copy to Clipboard–Copies the detailed information for the selected item or 

items and is available for pasting into another program. 
 Go To–Centers the map on the selected item. 
 Select All–Selects all items in the list and highlights up to 350 on the map. If 

you right-click again with all items selected, you can select Copy to 
Clipboard; point to Add and then click MapTag, MapNote, Detailed 
MapNote, Address Book Entry, or Waypoint; or point to Route and click 
Insert Stop. You must have the MapTags checkbox on the Find tab selected 
to add a MapTag. 

 Add–Adds a MapTag, MapNote, Detailed MapNote, Address Book Entry, or 
Waypoint for the selected item or items. You must have the MapTags 
checkbox on the Find tab selected to add a MapTag. 

 Route–Places a start, stop, or finish point at that location on the map based 
on your selection. The location is listed in the Start text box, Stop text box, or 
Finish text box in the Route tab. 

• To locate an item on the map without moving the map, single click an item in the 
results list. It is highlighted on the map as long as it is in the current map view. This 
is especially helpful when you are at the data zoom level you want but point labels 
are not displaying. 
Notes  To select multiple items, press and hold the CTRL key while clicking up to 
350 items in the results list. If the items are listed continuously, click the first item in 
the list and then press and hold the SHIFT key while clicking the last item you want. 

• You can adjust column widths. The new size is retained until changed again. You 
cannot rearrange the column order. Different search types result in different column 
orders. 

• There are two types of results lists: 
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 Most searches provide a fixed number of results. If all of 
the results do not fit in the screen area, a scroll bar 
automatically displays. 

 Some searches provide results you can browse. This means 
the entire database displays with the best match 
highlighted. It is possible to continue browsing to the first 
or last item in the database. 

Scroll 
Bar 

 

Browse 
Buttons 

 

  

Keywords for Category Searches 
Your DeLorme application recognizes hundreds of English words to generate both general 
and specific searches using category keywords. Try entering words that seem appropriate. 

Keyword Samples 

The list below shows a few of the categories that expand to reveal sample keywords. 
Sample keywords may be listed in more than one category. 
Boundaries, Map, and Surveying 
Border 
Boundary 
Contour 
Crosshair 
Grid 
Line 
Point 
ZIP/Postal Code 
Buildings and Structures 
Airport 
Bridge 
Business 
Landmark 
Library 
Businesses 
Hotel 
Gasoline 
Restaurant 
Pizza 
Education and Cultural 
College 
Local Park 
Park 
School 
State Park 
University 
Miscellaneous 
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Cemetery 
Hiking 
Mine 
Note 
Park 
Object Types 
All of the stock draw symbols (such as blue map pin, red flag, canoe, etc.) 
Draw symbols 
XData objects (Street Atlas Plus only) 
Phone objects 
Objects in non-DeLorme data 
Roads and Trails 
Bridge 
Exit 
Ferry 
Foot Trail 
Highway 
Hiking 
Interstate 
One Way 
Railroad 
Road 
Street 
Trail 
Tunnel 
Travel Amenities 
Airport 
Exit 
Landmark 
Rest Area 

Notes on Category Searches 

The following list provides notes you may find helpful for performing category searches. 
• Category keyword searches must be at least three characters in length. 
• Keywords are not case-sensitive. Using all capital letters or no capital letters does 

not affect the search. 
• Some generic keywords (water, for example) match many categories and display a 

dialog box with specific categories. Select or clear these categories, depending on 
what you want to locate. 

• In the Keyword Category samples below, some keywords are used together to 
narrow the search. The following two examples provide information on how results 
may differ using words together and separately: 

• Example 1–Using Local Road provides many category results, such as Ferry 
Crossing Local Road, Local or Rural Road, and Railroad Local Line. 
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• Example 2–Using Road provides over 100 results from more categories. 
• Partial words are recognized when performing a search. 
• You can use keywords in any order. You get the same results using Local Road as for 

Road Local. 
• A keyword may find categories related to the word rather than including the word. 
• Use the word "or" in the Keywords text box to search for multiple categories. For 

example, "pizza" or "fast food." 
  

MapTags: Converting, Moving, Hiding, and Deleting 

When you search for and go to a Find search result, a yellow 
MapTag displays at that location if the MapTags check box on the 
Find tab is selected. If MapTags are cluttering your view of the 
map, you can move the text area of the MapTag, hide them from 
view, or delete one, several, or all MapTags. 

 

To Convert MapTags to MapNotes 

To change all of the MapTags on the map to MapNotes, which can be retained when you 
save the map file, right-click the map, click Manage Draw, and then click Convert All 
MapTags to MapNotes. A new draw layer called MapNotes is created in your map file. 

To Move a MapTag 

You cannot detach a MapTag from its anchor point; you can move only the text area. 
Use the following steps to move the MapTag text area. 

1. Use the Find tab, search for a place, street address, coordinate, category item, or 
street intersection. MapTags are placed on the map at each point you locate. 

2. Click the Select tool . 
3. Click the text area for the MapTag you want to move and drag it to the position on 

the map where you want it. The anchor point does not move. 
4. Click the Select tool again to resume normal map operations. 

To Hide MapTags 

The MapTags check box controls if existing MapTags display on the map. 
• MapTags are visible when the MapTags check box is selected. 
• MapTags are hidden from view when the MapTags check box is cleared. Select the 

MapTags check box at any time to display existing MapTags. 

To Delete MapTags 

You can delete one, several, or all MapTags. 

To delete MapTags from the Find tab: 

• To delete one MapTag, click the Select tool , click the MapTag, click the Delete 
Tag tool , and click the Select tool again. 
OR 
Right-click the MapTag you want to delete and select Delete MapTag. 
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• To delete several MapTags, click the Select tool , hold down the SHIFT key on 
your keyboard while clicking the MapTags, click the Delete Tag  tool, and click 
the Select tool again. 

• To delete all MapTags, click the Delete Tag tool . A message box displays "Delete 
all MapTags?" Click OK to confirm deletion. Click Cancel to retain all MapTags. 

To delete MapTags from other tabs: 

• Right-click the MapTag and click Delete MapTag. 
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Using Address Book Contacts 

Searching for Address Book Contacts 
You have several ways to search for address book contacts: 

• Use the QuickSearch function on the Find tab to search for the name of a contact; 
browse for the contact or type the name of the contact 

• Use the Route tab to search for an address book entry as a route start, stop, or 
finish; browse for the contact or type the name of the contact 

• Use the toolbar to search for an address book entry as a route start or finish; browse 
for the contact or type the name of the contact 

With these functions, you can select the <From Address Book> option from the applicable 
drop-down list or you can type the name of the contact directly in the text box to find the 
entry. If you type the name of the contact, you must select the Book check box in the Find 
tab (underneath the Address Book buttons). To disable the address book search 
functionality, clear the Book check box. 
  
Notes 

• The address book has a 200-record limit. 
• You can resize and move the Address Book dialog box. 
• You can resize the columns inside the Address Book dialog box. 

  

Importing Existing Address Book Information 
You can import an existing address book or build a new address book by manually entering 
each record. Imported address book items are merged with your existing address book. 
Items with identical names are not replaced during the import process. 

To Import an Existing Address Book 

Use the following steps to import an existing address book and view its contents on the 
map. 

1. Click the Find tab. 

2. Click the Address Book button . 
The DeLorme Address Book dialog box opens. 

3. Click Import. 
4. Click Browse to find the .dab, .txt, .csv, or .tab address book file. Click the file and 

then click Open.   
5. If the first line of the title contains column names, select the First Row is Header 

check box. 
6. If you want to adjust the column headers for your address book information, select a 

default column label from the available drop-down lists. 
There is a list for Name, Street Address, City, State Abbreviation, ZIP/Postal Code, 
Telephone, Latitude, Longitude. The information in your address book displays to the 
right of these lists. 

7. Click OK. 
The address book contacts are imported into the program. All street address or 
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latitude/longitude matches display on the map with the following symbol and the 
name of the contact. 
Note  If your contacts do not display on the map, check the Located? column in the 
Address Book dialog box to verify a successful match was made. If Not Located 
displays next to any of your records, either address/coordinate information was not 
provided with the contact or the address/coordinate information could not be found 
in the program. 

Notes 
• The address book has a 200-record limit. 
• You can resize and move the Address Book dialog box. 
• You can resize the columns inside the Address Book dialog box. 

  

Manually Entering Address Book Information 
You can import an existing address book or build a new address book by manually entering 
each record. 
You can also add an address book entry by right-clicking the map, selecting Create 
Address Book Entry, and following steps 4–6 below. If you right-click the map at the 
location for the address book entry, some of the information, such as coordinates, street 
name, city, state, etc., automatically complete the Edit a DeLorme Address Book Entry 
dialog box. 

To Manually Enter Address Book Information 

Use the following steps to manually enter address book information. 
1. Click the Find tab. 

2. Click the Address Book button . 
The DeLorme Address Book dialog box opens. 

3. Click New. 
The Edit a DeLorme Address Book Entry dialog box opens. 

4. Enter the information for the entry. 
5. From the Update Location drop-down list, select the method for updating the 

location on the map; From Street Address, From Lat/Lon, or No (if you do not 
want to update the location. 

6. Click OK. 
7. Repeat steps 2-6 for each contact you want to add. 

Notes 
• The address book has a 200-record limit. 
• You can resize and move the Address Book dialog box. 
• You can resize the columns inside the Address Book dialog box. 

  

Centering the Map on an Address Book Contact 
You can center the map on any address book contact you have with the Go To function in 
the Address Book dialog box. 

To Center the Map on an Address Book Contact 
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Use the following steps to center the map on an address book contact. 
1. Click the Find tab. 

2. Click the Address Book button . 
The DeLorme Address Book dialog box opens. 

3. Click the contact. 
4. Click Go To. 

The map centers on the selected contact. 
Notes 

• The address book has a 200-record limit. 
• You can resize and move the Address Book dialog box. 
• You can resize the columns inside the Address Book dialog box. 

  

Editing a Contact In Your Address Book 
Once you have imported your address book contacts, you may need to edit the information 
if your contacts have moved, changed phone numbers, etc. Instead of importing the 
information again, you can simply edit the information. 

To Edit a Contact In Your Address Book 

Use the following steps to edit a contact in your address book. 
1. Click the Find tab. 

2. Click the Address Book button . 
The DeLorme Address Book dialog box opens. 

3. Double-click the record you want to edit. 
OR 
Click the record you want to edit and then click Edit. 

4. Edit the applicable information. 
5. If you want to move the contact, select the method to place it on the map from the 

Update Location drop-down list. 
6. Click OK. 

Notes 
• The address book has a 200-record limit. 
• You can resize and move the Address Book dialog box. 
• You can resize the columns inside the Address Book dialog box. 

  

Manually Moving a Contact on the Map 
Once you have created a contact in an address book, you can manually move it on the map 
using the move address book entry function. 

To Manually Move a Contact's Location on the Map 

Use the following steps to manually move a contact's location on the map. 
1. Click the Find tab. 
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2. Click the Move Address Book Entry button . 
Your cursor changes to  when you hover over the location of an address book 
contact. 

3. Click and drag the contact to a different location on the map. 
The Located status for that record (in the Address Book dialog box) changes to 
Manual. 

4. Click the move address book entry icon again to resume normal map operations. 
Notes 

• The address book has a 200-record limit. 
• You can resize and move the Address Book dialog box. 
• You can resize the columns inside the Address Book dialog box. 

  

Relocating Address Book Contacts 
Once you import an address book from a previous version of your application, you can 
relocate your address book entries (except for manual entries) so they match the most 
recent data. You are prompted to do this the first time you open the address book after 
installing a new version of your application; however, if you do not relocate the entries at 
that time, you can do it later. 
Important  If you do not relocate your address book, the entries may not be accurately 
placed according to the latest DeLorme road data. 

To Relocate Contacts In Your Address Book 

Use the following steps to relocate address book entries (except manual entries) on the 
map. 

1. Click the Find tab. 

2. Click the Address Book button . 
The DeLorme Address Book dialog box opens. 

3. Click Relocate All. 
A confirmation message displays. 

4. Click OK to relocate the entries. 
Notes 

• The address book has a 200-record limit. 
• You can resize and move the Address Book dialog box. 
• You can resize the columns inside the Address Book dialog box. 

  

Deleting a Contact In Your Address Book 
Once you successfully create an address book, you can delete the contact information at 
any time. 

To Delete a Contact In Your Address Book 

Use the following steps to delete a contact in your address book. 
1. Click the Find tab. 
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2. Click the Address Book button . 
The DeLorme Address Book dialog box opens. 

3. Click the record you want to delete. 
4. Click Delete. 
5. Click OK to confirm the deletion. 
6. Click Done. 

Notes 
• The address book has a 200-record limit. 
• You can resize and move the Address Book dialog box. 
• You can resize the columns inside the Address Book dialog box. 

  

Showing/Hiding Address Book Contacts on the Map 
Once you add contacts to your address book, you can show or hide the contact information 
on the map. 

To Show/Hide Address Book Contacts on the Map 

Use the following steps to show/hide address book contacts on the map. 
1. Click the Find tab. 
2. Select the Book check box to show address book contacts on the map and enable 

address book searching with the Find tab, Route tab, and toolbar. 
OR 
Clear the Book check box to hide address book contacts on the map and disable 
address book searching with the Find tab, Route tab, and toolbar. 

Notes 
• The address book has a 200-record limit. 
• You can resize and move the Address Book dialog box. 
• You can resize the columns inside the Address Book dialog box. 

  

Deleting Your Entire Address Book 
Once you have created an address book, you can delete the records it contains one at a 
time or all at once. 

To Delete an Entire Address Book 

Use the following steps to delete an entire address book. 
1. Click the Find tab. 

2. Click the Address Book button . 
The DeLorme Address Book dialog box opens. 

3. Click Clear All. 
A confirmation message displays. 

4. Click OK to delete the address book. 
5. Click Done. 

Notes 
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• The address book has a 200-record limit. 
• You can resize and move the Address Book dialog box. 
• You can resize the columns inside the Address Book dialog box. 

  

Exporting Your Address Book 
You can export your address book to another program using the Export function in the 
Address Book dialog box. Exported address books are in DeLorme Address Book binary 
format (*.dab) or comma-separated file (*.csv) format. Latitude and longitude values are 
not exported. 

To Export Your Address Book 

Use the following steps to export your address book. 
1. Click the Find tab. 

2. Click the Address Book button . 
The DeLorme Address Book dialog box opens. 

3. Click Export. 
The Save As dialog box opens. 

4. Browse to the location where you want to save the exported address book file. 
5. Type the file name for your exported file in the File Name text box. 
6. Select DeLorme Address Book (*.dab) or Comma-separated File (*.csv) from 

the Save as Type drop-down list. DeLorme Address Book files retain all of their 
information and can be imported into compatible DeLorme programs. Comma-
separated files do not contain coordinate information. You can view text files in third-
party applications such as Microsoft® Excel. 

7. Click Save. 
8. Click OK to acknowledge the export location. 
9. Click Done. 

Notes 
• The address book has a 200-record limit. 
• You can resize and move the Address Book dialog box. 
• You can resize the columns inside the Address Book dialog box. 
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Searching for Phone Book Listings 

Using Phone Data 

 

This Help topic describes functionality that is available only in Street Atlas USA 
Plus. 

  
You can install the phone data to your hard drive or use it from the DVD. 

To Install Phone Data to your Hard Drive 

If you install the phone data to your hard drive, it is always accessible when you use the 
Phone tab. 
To install the data: 

1. Insert the Phone Data DVD into your computer's DVD drive. 
The Installation Wizard opens. 

2. Follow the on-screen steps to install the phone data to your hard drive. 

To Use Phone Data from the DVD 

You can use the phone data from the DVD without installing it to your hard drive. 
1. Insert the Phone Data DVD into your computer's DVD drive. 

The Installation Wizard opens. 
2. Click Cancel, click Yes when prompted, and then click Finish to exit the wizard. 
3. Click the Phone tab. 
4. Click Data. 

The Browse for Folder dialog box opens. 
5. Browse to your computer's DVD drive and click the Phone folder. 
6. Click OK. 

The states/provinces on the DVD are available in the State/Prov drop-down list in the 
Phone tab. 

  

Searching for a Phone Book Listing 

 

This Help topic describes functionality that is available only in Street Atlas USA 
Plus. 

  
With the Phone tab, you can search for a name and address based on a given phone 
number or search for a phone number based upon a specified name and/or address. You 
can pick and choose your selections to add to map, make a dataset, and so on. 

Notes 
• A hyphen (-) before the name in a search result indicates a business listing. 
• An asterisk (*) before the name in a search result indicates a Do Not Call 

preferenceThe person or business listed has registered a preference to not be 
solicited by telephone (as provided by law). DeLorme products cannot be relied 
upon as a method for legal compliance with state and federal regulations. A 
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number is flagged as Do Not Call if at least one of the following is true: 
The phone number is unlisted. Unlisted phone numbers allow customers to have 
their phone number be available from directory assistance but not published in 
any phone directories.  
Note  Customers paying for non-published service desire complete privacy of 
their phone number, which means it is not published in the phone book and is 
unavailable from directory assistance. Non-published numbers are not available in 
Phone Data. 
The phone number is on the Federal Trade Commission's National Do Not Call 
Registry. 
You can register your home or mobile phone number or verify your registration at 
https://www.donotcall.gov. 
The address is on a mail preference list that limits mail solicitations. 
You can register your preference for mail and e-mail solicitations with the Direct 
Marketing Association at http://www.the-dma.org/. 

• Click Clear at any time to remove all of your search criteria from the Phone text 
boxes. 

• Select the Any State option to include all states in your search or if you do not 
know the state for your query. 

To Search for a Phone Book Listing 

Use the following steps to search for a phone book listing. 
1. If you have not installed the phone data to your hard disk drive, you can access it 

from the DVD. 
2. Click the Phone tab to display the Phone dialog area. 
3. Select the Residential check box to view residential phone book listings. 

AND/OR 
Select the Business check box to view business phone book listings. 
AND/OR 
Select the Hide Multiple YP Headings check box to display only one Yellow Pages 
heading for each business phone number. 

4. Select the country you want to search within from the Country drop-down list. 
The States/Provinces drop-down list updates according to the selected country. 

5. Type/select the name, street address, city, state, and/or ZIP/Postal Code to search 
for the phone number(s) associated with that information. 
OR 
Type the phone number to search for the name, address, city, state/province, and 
ZIP/Postal Code associated with that phone number. 
OR 
Type yellow page keywords in the Yellow Pg text box to find all of the phone book 
listings available based on your search criteria. 
Notes 

• Type a city in the City text box to narrow your yellow page search. Do not 
enter more than five digits for a ZIP Code search or three digits for a Postal 
Code search. 

• Yellow page keywords must be at least three characters in length. 

Text Box Tip 

Name Name searches do not require punctuation. 

https://donotcall.gov/
http://www.the-dma.org/
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Type the last name first. 
The Phone tab recognizes partial last names. You may get better 
results (for longer names or if you are unsure of the spelling) if 
you only type a portion of the name. 
Many business names are abbreviated in phone book listings. For 
best results, try additional searches using alternate spellings or 
abbreviations. 

Street Address Street name descriptors (e.g., street, road, drive) should not be 
used for address searches. However, you can use street name 
abbreviations (e.g., st, rd, dr). 
You can use street address ranges (such as 100-200 Main St) for 
address searches. 

City Long city names may be abbreviated in the Phone data. Try 
shortening the city name until the search finds the city name you 
recognize, then use that abbreviation. You must also select a 
State, or type a full or partial ZIP/Postal Code or phone number. 
City listings may have variances in spelling, such as "Saint Louis" 
rather than St Louis". 

ZIP/Postal 
Code 

ZIP Code searches must contain at least three digits. Postal Code 
searches must contain at least three characters. 

Phone Phone number searches must contain at least six digits (the area 
code and exchange; no punctuation is necessary). 

Yellow Pg 
(Yellow Pages) 

Yellow page searches should be singular (for example, type 
restaurant instead of restaurants). 
If you use multiple words, all of the words are required to form a 
match. 
There are over 34,000 yellow page headings possible. Use 
keywords you would expect to find in the yellow pages. 
Yellow page searches must be at least three characters in length. 

6. Press the ENTER key on your keyboard or click Search. 
The search results display in the Search Results area on the lower-left corner of the 
dialog area. 
Notes 

• If you do not receive any results from your yellow page search, use an 
alternative keyword for your search attempt. For example, if you are looking 
for a clothing store, type “clothing” instead of “clothes.” Or, if the alternative 
keyword still does not work, search (by name) for a clothing store and see 
what category it is listed under (the category displays in parenthesis at the 
end of the result). 

• If more than 1000 search results match your search criteria, the More button 
becomes activated. Click More to browse to the next 1000 search results. 

7. Click one or more search results in the Search Results area and then click Add (or 
right-click the search results and click Add) to add your search result to the 
Selection area in the lower-right corner of the dialog area.  
Note  Press the CTRL key on your keyboard to select more than one search result at 
a time. You can also double-click a search result to add it to the Selections area 
OR click Add All (or right-click the search results and click Add All) to include all of 
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your search results to the Selection area. 
Note  The Selection area has a 1,000 listing limit, as described in the license 
agreement. 

8. Use one of the following options to modify the selections in the Selections area: 
• Click Map (or right-click your selections and click Map) to add your phone 

book listings to the map. To add all of the phone book listings in the 
Selections area to the map, right-click the selections, click Select All, and 
then click Map. Once a phone selection is on the map, you can view details 
about the listing by right-clicking its symbol and clicking Info. 
Note  Mapped businesses are indicated with a square symbol on the map and 
mapped residences are indicated with a small house symbol on the map. 
Phone selections (symbol and label) that are placed on the map appear in red 
if they have been located reliably to a street address. Otherwise, the 
approximate location appears light gray on the map. 

• Click a listing in the Selections area and click Remove (or right-click a listing 
and click Remove) to remove the phone book listing from your list of 
selections. 

• Click Remove All (or right-click on your selections and click Remove All) to 
remove all of the phone book listings from the Selection area. All mapped 
selections will be removed from the map. 

• Click To File to save all of the phone book listings in the Selections area in a 
.txt file. The default location is C:\DeLorme Docs\Datasets. 

• Click To XData to copy all of the phone book listings in the Selections area to 
the XData tab as a dataset (using the Import Wizard). 

• Click a previously mapped listing in the Selections area to highlight it on the 
map. 

• Double-click a listing in the Selections area to center the map on that listing. 
Note  You can also copy, search, and sort search results and selections using right-click 
mouse options. 
  

Finding Phone Book Listings for a Specific Road 

 

This Help topic describes functionality that is available only in Street Atlas USA 
Plus. 

  
You can right-click a road to view all of the residential and business phone book listings on 
that road. 

Notes 
• A hyphen (-) before the name in a search result indicates a business listing. 
• An asterisk (*) before the name in a search result indicates a Do Not Call 

preference.The person or business listed has registered a preference to not be 
solicited by telephone (as provided by law). DeLorme products cannot be relied 
upon as a method for legal compliance with state and federal regulations. A 
number is flagged as Do Not Call if at least one of the following is true: 
The phone number is unlisted. Unlisted phone numbers allow customers to have 
their phone number be available from directory assistance but not published in 
any phone directories.  
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Note  Customers paying for non-published service desire complete privacy of 
their phone number, which means it is not published in the phone book and is 
unavailable from directory assistance. Non-published numbers are not available in 
Phone Data. 
The phone number is on the Federal Trade Commission's National Do Not Call 
Registry. 
You can register your home or mobile phone number or verify your registration at 
https://www.donotcall.gov. 
The address is on a mail preference list that limits mail solicitations. 
You can register your preference for mail and e-mail solicitations with the Direct 
Marketing Association at http://www.the-dma.org/ 

• Click Clear at any time to remove all of your search criteria from the Phone text 
boxes. 

• Select the Any State option to include all states in your search or if you do not 
know the state for your query. 

To Find Phone Information for a Specific Road 

Use the following steps to find available phone information for a specific road. If you did not 
install the phone data to your hard drive, you can use the DVD. 

1. To find all of the phone listings for a particular address, search for a phone book 
listing, right-click a search result, and then click Search This Address. 
All of the phone listings for that address display. 
OR 
To find phone information using the map, pan the map or click the Find tab and use 
the QuickSearch function to locate the road you want to use for your phone book 
listing search. Then, right-click the road and click Phone Listings. 
All the phone book listings for that road (in that city) display in the Search Results 
area on the lower-right corner of the dialog area. 
Notes  If more than 1,000 search results match your search criteria, the More 
button becomes activated. Click More to browse to the next 1,000 search results. 

2. Click one or more search results in the Search Results area and then click Add (or 
right-click the search results and click Add) to add your search result to the 
Selection area on the lower-right corner of the dialog area.  
Note  Press the CTRL key on your keyboard to select more than one search result at 
a time. You can also double-click a search result to add it to the Selections area. 
OR 
Click Add All (or right-click the search results and click Add All) to include all of 
your search results to the Selection area. 
Note  The Selection area has a 1,000 listing limit, as described in the license 
agreement. 
OR 
Click Clear All (or right-click on the search results and click Clear All) to remove all 
of the search results from the Selection area. 

3. Use one of the following options to modify the selections in the Selections area: 
• Click Map (or right-click on your selections and click Map) to add your phone 

book listings to the map. If only one item is selected, the map centers on the 
object. To add all of the phone book listings in the Selections area to the map, 
by right-click the selections, point to Select All in the menu, and then click 
Map. To view details about a phone selection once it's on the map, right-click 
its symbol and click Info. 

https://donotcall.gov/
http://www.the-dma.org/
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Note  Mapped businesses are indicated with a square symbol on the map and 
mapped residences are indicated with a small house symbol on the map. 
Phone selections (symbol and label) that are placed on the map appear in red 
if they have been located reliably to a street address. Otherwise, the 
approximate location appears light gray on the map. 

• Click a listing in the Selections area and click Remove (or right-click a listing 
and click Remove) to remove the phone book listing from your list of 
selections. 

• Click Remove All (or right-click your selections and click Remove All) to 
remove all of the phone book listings from the Selection area. All mapped 
selections are removed from the map. 

• Click To File to save all of the phone book listings in the Selections area in a 
.txt file. 
The default location for the file is C:\DeLorme Docs\Datasets. 

• Click To XData to copy all of the phone book listings in the Selections area to 
the XData tab as a dataset (using the XData Import Wizard). 
Note  This option is unavailable when the XData tab is hidden with Tab 
Manager. 

• Click a previously mapped listing in the Selections area to highlight it on the 
map. 

• Double-click a listing in the Selections area to center the map on that listing. 
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Using XData 

XData Overview 

• XData is available only in Street Atlas USA Plus. 
• Supported file formats include: 

• Microsoft® Access (.mdb, .mdw, and .mda) 
• Microsoft Excel (.xls) 
• Microsoft Visual FoxPro (.dbf) 
• dBase (.dbf) 
• Text files (.txt, .csv, .tab, and .asc) 

• XData labels, names, and URLs cannot be more than 255 characters. 

  
You can use the XData tab to import your data so you can view the location of each record 
on detailed maps. To geoplace (locate) your records on the map, the data file must contain 
either a coordinate (in decimal degrees), a city and state, a ZIP/Postal Code, or a complete 
physical address (street address, city, state) for each record. 
Whatever your business needs, you have powerful database management tools to help you 
plan accordingly. 

You can: 
• Import most database, spreadsheet, and text file formats for use within the 

program. 
• Select symbols (or design your own) to represent the locations of your records. 
• Display or hide databases so you can use them one at a time or together. You can 

also use your data with other program functions. 
• Customize an existing dataset and then save the new dataset by using the Export 

function. 
• Create a route using your XData records as a start, stop, and/or finish point. 

  

Importing Data 
You can import your own data and view the location of each record on detailed maps. To 
locate (or geoplace) your records on the map, the file must contain either a coordinate, a 
ZIP/Postal Code, or a complete physical address (street address, city, state) for each 
record.   

• XData is available only in Street Atlas USA Plus. 
• Supported file formats include: 

• Microsoft® Access (.mdb, .mdw, and .mda) 
• Microsoft Excel (.xls) 
• Microsoft Visual FoxPro (.dbf) 
• dBase (.dbf) 
• Text files (.txt, .csv, .tab, and .asc) 

• XData labels, names, and URLs cannot be more than 255 characters. 
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To Import a Database 

Use the following steps to import a database into the current map file. 
1. Click the XData tab. 

Each dataset included in the current map file is listed under Available Datasets. 
Note  If the check box is selected, it indicates that the dataset is displayed on the 
map. Clear the check box to hide the dataset's symbols on the map. 

2. Click Import to open the Import Wizard. 
3. On the Select Data Source screen, click Data Source to locate and select the file 

from the Open dialog box and then click Next. 
Note  If your file is not available in the directory as expected, you may need to 
change the file type in the Files of Type drop-down list. 

4. If your data source is a .csv or .txt file, complete this step. If not, go to step 5.  
The Select Schema screen displays. Verify how the data displays in the columns. If it 
is not displaying correctly, under Schema Type, select the option that separates 
your data into the appropriate columns. If your first row is not a header row, clear 
the First Row is Header check box. Click Next. The Assign Field Types screen 
displays. 

Notes 
• Select Other under Schema Type to use a non-standard file schema definition. 

You can then select any combination of Tab, Space, Comma, and Other. If you 
select Other under Delimiter, type the character(s) that separate your data in the 
text entry box. 

• The First Row is Header check box is selected by default. The program attempts 
to automatically assign field names based on the data in the first row. 

5. Select the column you want to display as a label on the map using the available radio 
buttons. 
Note  You can clear a selection to have no label displayed on the map. 

6. Click the Assignment header for each column and select the appropriate field option 
from the menu. 
The Status text box indicates how your data will be geoplaced on the map. 
7. Select how you want to locate your field information (street address or ZIP/Postal 
Code). 
Note  The available Locate By options are based on which fields have been assigned to the 
columns. 
8. Click Next. 
The Select Data Symbol screen displays. 
9. Under Match Status, click Exact, Street Name, Area, or ZIP Center and then 
select the unique symbol and text properties you want to display for each match status. 
Assigning different symbols/text to your records based on match status shows a visual 
representation on the map of which records in your dataset were geoplaced exactly, only by 
street name, only by area, or only by ZIP Center. 
OR 
Under Match Status, select the Use the same symbol/text for all categories check box 
to identify all of your records on the map using the same symbol without taking match 
status into consideration. 
Note  Click Edit to use XSym to create a new symbol or edit an existing symbol. For more 
information, see topics listed under Custom Symbols in the Draw section of the Help. 
10. Click Next. 
The Data Options screen displays. 



Using XData 

117 

11. Type the name for the dataset along with any additional identifying comments. 
The date and time of creation are automatically recorded. 
12. Click Finish. 
A progress bar displays with the status of matched records. When the import process is 
complete, the dialog box automatically closes, the dataset name displays in the Available 
Datasets list, and the symbol you chose displays on the map for every record which was 
geolocated. 
Note  Datasets have .dds extensions and are saved by default to C:\DeLorme 
Docs\Datasets. 
Note  If you decide to interrupt the import process, you can finish importing the dataset 
later by selecting the dataset from the Available Datasets list in the XData tab and then 
clicking Resume. 
  

Managing Datasets 
XData is available only in Street Atlas USA Plus. 
  
You can manage your dataset after you have imported/copied it as a dataset. 

To Manage Your Datasets 

Use the following steps to manage your datasets. 
1. Click the XData tab. 

A list of the datasets available in the current map file displays in the Available 
Datasets window. From this screen you can: 

• Update the symbols in the selected dataset by clicking Symbolize and 
updating the symbol properties. 

• Delete the selected dataset by clicking Delete. The dataset is deleted from 
the map, the current map file, and from your computer. 

• View the records within the selected dataset by clicking Query. For more 
information, see Viewing Dataset Records. 

Note  A selected check box indicates that the dataset is displayed on the map. Clear 
the check box to hide the dataset's symbols on the map. 

2. Click a dataset to select it and then click the Query subtab. You can then: 
• Edit a record in the dataset by double-clicking inside the cell you want to edit or by 

right-clicking the record (in the Query subtab) and clicking Edit. 
• Press the TAB key on your keyboard to advance through the cells in the record. 

When you are finished editing the record, press the ENTER key on your keyboard. 
• Create a route using a record in the dataset by right-clicking the record you want to 

use as your start, stop, or finish route point, clicking Route, and then clicking the 
route option. 

• Add a blank record to the end of the records list by clicking Add. 
• Duplicate a record in the dataset by right-clicking the record and clicking Duplicate 

Record(s). Duplicates of the records will be available at the bottom of the record 
list. 

• Delete a record in the dataset by selecting the record and clicking Delete or by 
right-clicking the record and clicking Delete Record(s). 
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• Center the map on the selected dataset by double-clicking it or clicking Go To. The 
map view changes to encompass all of the geoplaced records within that dataset. 
Note  To geoplace those records again, click GeoCode or right-click the records and 
select GeoCode Record(s). 

• Center the map on a particular record by double-clicking the first column of the 
record or by selecting the record and clicking Go To. 

  

Viewing Dataset Records 
XData is available only in Street Atlas USA Plus. 
  
After you have imported your data as a dataset, you can view information about the 
dataset, view the data records within a dataset, and select a specific record and view its 
symbol on the map. 

To View Records 

Follow the steps below to view records within a particular dataset. 
1. Click the XData tab. 

A list of the datasets available in the current map file is displayed in the Available 
Datasets window.  
Note  A selected check box indicates that the dataset is being displayed on the map. 
Clear the check box to hide the dataset's symbols on the map. 

2. Click a dataset to select it. 
The name, date, and time that the dataset was created display in the Dataset 
Statistics window. Any additional comments that you added during the import 
process also display here. 

3. Click Query. 
The records for the selected dataset display in the records window. You can then: 

• View a dataset other than the one currently selected by selecting the dataset 
from the Use Dataset drop-down list. The records contained within the 
dataset display in the table below. The Located To column indicates how each 
record was geoplaced on the map (by Address, ZIP/Postal Code, Street, 
Coordinate). 
Note  You can adjust the size of the tab area to expand the table. 

• Limit which records of the dataset display in the table by selecting one of the 
options from the Table Display drop-down list. Some of the Table Display 
options provide additional drop-down lists to choose a more limited query. For 
example, selecting the Records by Placement option provides an additional 
drop-down list of options so you can choose to display only those records 
placed to specific addresses, only those records placed manually, and so on. 

Additional Viewing Tips 

The following list provides information on how to view records or obtain information about 
the dataset symbols on the map while in the Query dialog area. 

• To select records and view the corresponding symbol on the map: 
 To select one record, click the record. 
 To select multiple records individually, press the CTRL key on your keyboard 

while clicking each of the individual records. 
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 To select a block of records, press the SHIFT key while clicking the record at 
the beginning of the block, and then click the record at the end of the block. 
All of the records are selected. 

• To center the map on the selected record(s), click Go To. 
Note  To geoplace records again, click GeoCode. 

• To delete one or more records within the dataset, while in the Query dialog area, 
select each record using one of the methods described above and then click Delete. 
Click Yes to confirm the deletion. Deleted records are unrecoverable. 

• To view the record of a particular dataset symbol on the map, click Select and then 
click the symbol on the map. Only the corresponding records display in the record 
window. 

• To resize columns, place the pointer near the column border in the header of the 
desired column. When the pointer changes to a double arrow, drag the column in the 
direction you want to increase or decrease its size. 

• To arrange the records in ascending order according to a particular column, click the 
header of that column. Click the column header again to arrange the records in 
descending order. 

Creating a Route with XData Records 
XData is available only in Street Atlas USA Plus. 
  
Once you import an XData dataset, you can use the individual records within the dataset to 
create a route. 

To Create a Route with XData Records 

Use the following steps to create a route with XData records. 
1. Import a database into the XData tab. 
2. Click the Query subtab. 
3. Right-click the record you want to use as a start for your route, click Route, and 

then click Set as Start. 
4. Optional. Right-click the record you want to use as a stop in your route, click Route, 

and then click Insert as Stop to add the stop geographically in the route or click 
Add as Stop to add the stop in the order it was added to the route. 

5. Right-click the record you want to use as a finish in your route, click Route, and 
then click Set as Finish. 

  

Geocoding or Moving a Record's Location 
XData is available only in Street Atlas USA Plus. 
  
During the import process, the program attempts to geocode all records. This means it 
places the symbol for the record on specific map coordinates (based on address or 
coordinate information). Once you have imported your data, you may want to make 
changes to the data and manually geocode each record to a new location. How an item has 
been located displays in the Located To column of the dataset's records. 

To Move a Record's Location 
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Use the following steps to move a record's location. 
1. Click the XData tab. 
2. Click Query. 
3. Select the dataset you want to view from the Use Dataset drop-down list. 
4. Select Records by Placement from the Table Display drop-down list. 
5. Select All Placed Records from the Record Placement drop-down list. 
6. Scroll right to the Located To column and view how each record in the dataset was 

placed. 
You can manually geocode any item listed as Not Placed or ZIP Code. 

7. Select the record you want to move. 
8. To manually place a record that has not been placed on the map, drag the record 

from the table to the location on the map. The Located To field for that record now 
reads as Manual Placement. 
OR 
Click GeoCode to geocode a record again. 
OR 
Right-click the record(s) and then click GeoCode Record(s). 

  

Exporting Data 
XData is available only in Street Atlas USA Plus. 
  
You can export datasets to another dataset or a text file. It is important to export datasets 
because: 

• If you have modified a dataset after you have imported it, you may want to save the 
new dataset for use in as a dataset in your application or as a text file. 

• If you have exported a copied dataset (resulting from conducting a phone book 
listing search) and then used the To XData function within the Phone tab, you can 
modify and export it to a new dataset or export it as a text file. 

To Export Data 

Use the following steps to export data. 
1. Click the XData tab. 
2. Click Query. 
3. Select a dataset from the Use Dataset drop-down list. 

The records contained within the dataset display in the records window. 
4. To limit which records of the dataset are available for export, you can: 

Select one of the options from the Table Display drop-down list. 
OR 
Select records manually from the existing dataset. To select multiple records 
individually, press the CTRL key on your keyboard while clicking each of the desired 
records. To select a block of records, press the SHIFT key while clicking the record at 
the beginning of the block, and then click the record at the end of the block; all of 
the records between the two you clicked are now selected. 

5. Click Export. 
6. Under Export Options, select one of the following options: 
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 Export to New Dataset–Exports the file as a .dds file for use within the 
program as another dataset. 

 Export to Text File–Exports the file as a .txt file for use in other programs. 
7. Under Records to Export, select one of the following options. 

 Entire Dataset–Exports all records in the selected dataset, including records 
that have not been placed. 

 Records in List (#)–Exports the records currently displaying in the Query 
table. The number of records is in parentheses. This may be a subset of the 
dataset, if you selected one of the Table Display options from the drop-down 
list in the Query dialog area. 

 Only Selected (#)–Exports only those records currently selected in the 
Query table. The number of records is in parentheses. These are the records 
you selected manually. 

8. To export your dataset as another dataset, click Create Dataset and follow the 
instructions provided to select a data symbol for each match status, type a dataset 
name, and select the map display option(s). Click Finish when prompted. Exported 
files are available immediately in the Available Datasets list in the Datasets dialog 
area of the XData tab. These files have .dds extensions and are saved by default in 
C:\DeLorme Docs\Datasets. 
OR 
To export your dataset as a text file, make sure the Export to Text File option is 
selected. Type the file name in the File text box and click Save. Exported files have 
a .txt extension and are saved by default in the C:\DeLorme Docs\Datasets. 

  

Printing XData Dataset Records 
XData is available only in Street Atlas USA Plus. 
  
You can print records from datasets imported with the XData tab. For information on 
viewing records from imported datasets, see Viewing Dataset Records. 

To Print XData Dataset Records 

Use the following steps to print dataset records. 
1. Click the XData tab and then click Query. 
2. Select a dataset from the Use Dataset drop-down list. Set Table Display or Record 

Placement options if they are available for your dataset. 
3. Click the Print tab and then click XData to display the Print/XData dialog area. 

The title of the currently selected dataset displays in a text box in the Dataset Print 
Title area. 

4. Optional. Click Setup to open the Print Setup dialog box; select a printer, change 
printer properties, select paper size, and select paper orientation. Click OK when 
finished. 

5. Click Columns to view the Columns display area if the Print dialog area is minimized. 
6. Under Dataset Print Title, select the Print Title check box to display a title on 

each printed page. Select the First Page Only check box to only display the title on 
the first printed page. 
Note  Click Font to change the font, style, size, and/or script. 
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7. Under Records, select an option. 
Note  Various options are available under the Records drop-down box depending on 
options you chose under the Table Display drop-down box in the XData dialog area. 
You can choose specific options available or to print All Records in the dataset. 

Option Action 

Print Column 
Names 

Displays column names on each printed page. Clear 
the check box to have no column names display. 

First Page Only Displays column names on the first page only. This 
option is unavailable if the Print Column Names 
check box is cleared. 

Print Column 
Borders 

Displays borders around table columns. 

Shade Alternate 
Records 

Displays shading in alternate rows in the table. 

8. Under Columns, select an option. 
Note  Selected check boxes indicate the columns that will print. Clear a column 
check box if you do not want the column to print or click: 

• Select All to select and print all columns. 
• Select None to clear all columns (no columns will print). 
• Reverse Selection to alternate selections. For example if you have selected 

columns 1, 3, and 5 to print and decide you want to print columns 2, 4, and 6 
instead. The Reverse Selection option selects those columns that were 
cleared. 

9. When all options are selected, click Print. 
Note  For specific recommendations on best printing results, see your printer manual. 
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Using the Draw Tools 

Draw Overview 
You can add draw objects, such as routable roads, waypoints, tracks, text, symbols, 
MapNotes, images, lines, arcs, splines, circles, polygons, and rectangles to your map with 
the tools provided in the Draw tab. 
To work with existing draw objects, you must first open the existing map file that contains 
the object or draw file. 
  
For more information, click the link for the version of the product you are using. 

• Street Atlas USA Plus OR regular Street Atlas USA with Advanced File Management 
What is a Draw File? 
Imagine a draw file as a sheet of glass laying on top of your map. You can add 
various objects to the draw file to help enhance or pinpoint specific areas on the 
map, but these objects do not become part of the map. They exist in a draw file that 
overlays the map. 

• There are four different types of draw files: draw, road, waypoint, and track. 
You can create more than one draw file and overlay one on top of the other 
while still viewing the map beneath. See Editing/Locking Draw Files. 

• A draw file is automatically generated the first time you add a draw object to 
the map. 

• You can save draw objects in a single draw file or in multiple draw files. 
• Draw files are saved by default in C:\DeLorme Docs\Draw with the default 

name; for example, DrawLayer#.an1, with # indicating the number order in 
which the file was created. You can rename draw files to better identify your 
specific information. See Creating a New Draw File. 

• You can view draw files individually or with other draw files. 
• As you create draw files, they are added to the current map files. 
• You can add draw files you create to multiple map files. 
• When you clear or delete a draw file, the objects in the draw file do not 

display and are deleted along with the draw file. 
• You can control the creation of new draw files in the draw file editing area. 

See Creating a New Draw File. 
• You can display multiple draw files while working on your map. You can work 

on one draw file at a time while viewing other files beneath it. You can select 
different draw files to be the active, editable file from within the Draw tab. 
See Editing/Locking Draw Files. 

• Draw files created in a particular map file are displayed only if that map file is 
currently displaying. For example, if DrawLayer27 is created in a map file 
named Yarmouth Zoom 14 only, DrawLayer27 does not display if a map file 
named Old Port is currently displaying. 

• Routable roads are not tied to a map file; they do not change even when a 
map file is changed. 

What is a Draw Object? 
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Draw objects are those objects you add to a draw file with the tools provided in the 
Draw tab. Draw objects consist of line, area, or point objects. You can copy, move, 
delete, and add draw objects to other draw files and add them to another map file. 

• Line objects are those objects consisting of line segments and points, such 
as: 

• Routable Roads 
• Tracks 
• Lines 
• Arcs 
• Splines 

• Area objects are those objects consisting of one or more closed line objects, 
such as: 

• Polygons 
• Rectangles 
• Circles 

• Point objects consist of one anchor point attached to either a waypoint, 
symbol, MapNote, image, or text label. The anchor point is the pixel position 
on the symbol that corresponds to the geographic coordinate of the point 
selected on the map when the symbol is placed. 

• Draw objects added to a draw file contain points that give the object its shape 
or allow you to snap one object to another object. Points display and act in 
different ways within the various draw objects. Click a link below to view 
additional information. 

Points in Routable Roads, Tracks, Lines, Splines, and Polygons 
Draw objects such as routable roads, tracks, lines, splines, and polygons consist of 
shape points and end points. 
Shape points are the points you place on the map when creating the object. They 
give the object its shape. When you select a draw object on the map, shape points 
display along the active object as small magenta squares. 
The line object below was drawn with the spline tool. 

 
End points are the first and last points of individual line segments on a draw object. 
When you select a shape point of a line segment within an active line, spline, or 
polygon: 
A small green circle indicates the start end point of the selected line segment. 
A small red circle indicates the last end point of the selected line segment. 
The same spline with end points indicating a selected spline segment. 

 
Notes 
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• When you click the start or last end point of the line segment within a line 
draw object and the Show Measurement check box is available (when using 
the Polygon or Line tool) and selected, it displays the bearing or angle of that 
point of the line, the length of the line segment (leg), and the total length of 
the entire line object on the map. 

• When you click the start or end point of the line segment within a polygon 
draw object, a text box displays the bearing or angle of that point of the line, 
the length of the line segment (leg), and the total area of the polygon on the 
map. 

Points in Rectangles, Circles, and Arcs 
Draw objects such as rectangles, circles, and arcs also contain points, but they are 
treated differently. 
Rectangles—;Contain shape points at the four corners, but the lines between the 
shape points contain no editable end points. When you click one of these shape 
points, a text box displays the width, height, and area of the rectangle on the map. 
Circles—;Contain no shape points, but have a central point that does not display 
until you snap it (see Note below) to another object. Clicking the circle displays a 
central crosshair within the circle and a text box containing information on the area 
and radius of the circle on the map. 
Arcs—;Contain three shape points. When you click any of the points, a text box 
displays the angle or bearing of the selected point, the radius of the arc, and the 
total length of the arc line on the map. 
Only the first and second points you placed on the map when creating the arc are 
treated as start and end points (i.e., show red or green when clicked). The central 
magenta shape point, or third point you placed, determines the shape of the arc. 
Note  For information on snapping a draw object to another draw object, see 
Snapping Draw Objects. 
  
Points in Draw Objects 
Point Objects, such as waypoints, symbols, and text, do not have shape or end 
points. Text label objects contain a point at the bottom center of the text label box 
and are only visible during a snap. 
Points in MapNotes 
MapNotes do not have shape or end points. They contain an anchor point at the end 
of the text box. Click the MapNote to display a central crosshair at the anchor point. 
  

• Regular Street Atlas USA with Simplified File Management 
If you are using Street Atlas USA with simplified file management, draw objects are 
saved in the map file rather than in a draw layer. 

  

 

Note for regular Street Atlas USA users 
Some of the information in this Help topic describes functionality provided in 
advanced file management. 
Advanced file management allows you to save multiple routes and draw layers in a 
single map file. With simplified file management, you can save only one route 
and/or draw layer in a single map file. If you did not select to enable advanced file 
management during the product installation, you can still change the settings 
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using the Change File Management option in the Options menu. For more 
information, see Activating Advanced/Simplified File Management. 
This note does not apply to Street Atlas USA Plus users. 

  

Viewing Hidden Draw Tools 
The Draw tab tools allow you to add routable roads, waypoints, tracks, lines (straight lines, 
arcs, and splines), shapes (polygons, rectangles, and circles), MapNotes, text labels, 
images, and symbols to a draw file. Some of these tools are hidden tools available in pull-
out menus. 

To View the Hidden Draw Tools 

Five draw tool options have pull-out menus with hidden tools. These draw tools each have a 
small arrow at the bottom-right of the draw tool button as shown in this sample . 
Use the following steps to view the hidden draw tools. 

1. Click the Draw tab. 
2. Click and hold one of the visible tools shown below to display and select one of the 

options. Selecting a hidden tool changes the default option. 

 

Waypoints/Tracks Tool 

 

Line/Arc/Spline Tool 

 

Polygon/Rectangle/Circle Tool 

 

MapNote/Text Label/Symbol/Image Tool 

Draw File Management 

Creating a New Draw File 
There are four different types of draw files: 

• DrawLayer—Created when you add a line, arc, spline, circle, rectangle, polygon, 
symbol, MapNote, or text label to the map. 

• RoadLayer—Created when you add a routable road. 
• WaypointLayer—Created when you add a waypoint to the map. 
• TrackLayer—Created when you add a track to the map. 

A draw file is automatically created when you add a draw object to the map and there are 
no draw files of that type included in or contained in the current map file. 
You can control the creation of new draw files in the draw file editing area. 

To Create a New Draw File 

Use the following steps to create a new draw file. 
1. Click the Draw tab. 
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2. Click File to open the draw file editing area. 
A selected check box next to the draw file's name in the file list indicates the file is 
displaying on the map. 
Note  The draw file editing area is categorized by draw file type. For example, all 
roadlayer files are grouped together in the list, all drawlayer files are grouped 
together, and so on. 

3. Click New and then click Draw, Road, Waypoint, or Track. 
The new file is now the active draw file. Each draw file type has an active file. 

4. Optional. If you want to rename the draw file: 
Right-click the draw file in the draw file editing area and click Rename. Type the 
new name in the Name box and press the ENTER key on your keyboard. 
OR 
Click the draw file in the draw file editing area and then click it again (do not double-
click). Type the new name in the Name box and press the ENTER key on your 
keyboard. 

5. Optional. If you want to ensure no changes are made to a particular draw file, select 
the Lock check box for that draw file in the draw file editing area. 

6. Click Save. 
7. Click Done to return to the main Draw tab area. 

Note  You can save new draw files any time. For more information, see Saving a Draw File. 
  

 

Note for regular Street Atlas USA users 
This Help topic describes functionality provided in advanced file management. 
Advanced file management allows you to save multiple routes and draw layers in a 
single map file. With simplified file management, you can save only one route 
and/or draw layer in a single map file. If you did not select to enable advanced file 
management during the product installation, you can still change the settings 
using the Change File Management option in the Options menu. For more 
information, see Activating Advanced/Simplified File Management. 
This note does not apply to Street Atlas USA Plus users. 

  

Saving a Draw File 
After you finish adding draw objects to a draw file, you can save them in a draw file that 
you can view or edit later. Any time you edit a draw file, click Save to save your changes. 

To Save a New Draw File 

Use the following steps to save a draw file. 
1. Click the Draw tab. 
2. Click File. 
3. Click Save. 

Draw files are saved by default in C:\DeLorme Docs\Draw with .an1 extensions. 
4. Click Done to return to the main Draw tab area. 

  

 

Note for regular Street Atlas USA users 
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This Help topic describes functionality provided in advanced file management. 
Advanced file management allows you to save multiple routes and draw layers in a 
single map file. With simplified file management, you can save only one route 
and/or draw layer in a single map file. If you did not select to enable advanced file 
management during the product installation, you can still change the settings 
using the Change File Management option in the Options menu. For more 
information, see Activating Advanced/Simplified File Management. 
This note does not apply to Street Atlas USA Plus users. 

  

Deleting a Draw File 
You can delete a draw file you just created or one you previously saved. 

To Delete a Draw File 

Use the following steps to delete a draw file. 
1. Open the map file that contains the draw file you want to delete. 
2. Click the Draw tab. 
3. Click File to open the draw file editing area. 

A draw file with a selected check box displays on the map. 
Note  The draw file editing area is categorized by draw file type (for example, all 
road layers are grouped together in the list, all draw layers are grouped together, 
and so on). 

4. Select a draw file from the file list and then click Delete. 
Click Yes in the confirmation message box to delete the object or click No to cancel. 
OR 
Right-click the draw file in the list and click Delete. 
Click Yes in the confirmation message box to delete the object or click No to cancel. 

5. Click Done to return to the main Draw tab area. 
  

 

Note for regular Street Atlas USA users 
This Help topic describes functionality provided in advanced file management. 
Advanced file management allows you to save multiple routes and draw layers in a 
single map file. With simplified file management, you can save only one route 
and/or draw layer in a single map file. If you did not select to enable advanced file 
management during the product installation, you can still change the settings 
using the Change File Management option in the Options menu. For more 
information, see Activating Advanced/Simplified File Management. 
This note does not apply to Street Atlas USA Plus users. 

  

Hiding Draw Files 
You can hide draw files you created. This removes from view all the draw objects in that file 
without permanently deleting them. 

To Hide a Draw File 

Use the following steps to hide a draw file. 
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1. Click the Draw tab. 
2. Click File to open the draw file editing area. 

Note  The draw file editing area is categorized by draw file type. For example, all 
road layers are grouped together in the list, all draw layers are grouped together, 
and so on. 

3. Hide any files in the file list by clearing the check box next to the file name. 
• A draw file with a selected check box displays on the map. 
• A draw file with a cleared check box does not display on the map. 

4. Click Done to return to the main Draw tab area. 
  

 

Note for regular Street Atlas USA users 
This Help topic describes functionality provided in advanced file management. 
Advanced file management allows you to save multiple routes and draw layers in a 
single map file. With simplified file management, you can save only one route 
and/or draw layer in a single map file. If you did not select to enable advanced file 
management during the product installation, you can still change the settings 
using the Change File Management option in the Options menu. For more 
information, see Activating Advanced/Simplified File Management. 
This note does not apply to Street Atlas USA Plus users. 

  

Editing/Locking Draw Files 
You can edit the current active (editable) draw file. You can also lock a draw file, making it 
uneditable. 

To Edit a Draw File 

Use the following steps to edit a draw file. 

1. Click the Draw tab. 

2. Click File to open the draw file editing area. 

3. Verify the draw file you want to edit is displaying on the map. A draw file with a 
selected check box displays on the map. 

4. Verify that the file is selected in the Active column in the file editing area. 

5. Click Done to return to the main Draw tab area. 

6. Click the Select tool  and then click the draw file object on the map that you 
want to edit. 

7. Click File and then click Save to save the changes you made to the draw file. 

8. Click Done to return to the main Draw tab area. 

To Lock a Draw File 

Use the following steps to lock a draw file. 

1. Click the Draw tab. 

2. Click File to open the draw file editing area.   
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3. Select the Lock check box for each draw file you want to lock. 
Note  Clear the Lock check box to make changes to a draw file. 

4. Click Done to return to the main Draw tab area. 

  

 

Note for regular Street Atlas USA users 
This Help topic describes functionality provided in advanced file management. 
Advanced file management allows you to save multiple routes and draw layers in a 
single map file. With simplified file management, you can save only one route 
and/or draw layer in a single map file. If you did not select to enable advanced file 
management during the product installation, you can still change the settings 
using the Change File Management option in the Options menu. For more 
information, see Activating Advanced/Simplified File Management. 
This note does not apply to Street Atlas USA Plus users. 

  

Exporting Draw Files to Text Files 
You can export draw files as text files. Draw objects exported to text files contain coordinate 
information for each line, area, or point object. You can open these text files in other 
DeLorme products. 

To Export Draw Files to Text Files 

Use the following steps to export an existing draw file to a text file. 
1. Click the Draw tab. 
2. Click File to open the draw file editing area. 

A draw file with a selected check box displays on the map. The Active column shows 
the active layers. 

3. From the file list, click the draw file to export. 
4. Click Export. 

The Export Draw File dialog box opens. 
5. Browse to a directory in which to save the file or use the default destination of 

C:\DeLorme Docs\Export. 
6. Select Text File from the Save as Type drop-down list. 
7. Type a name for the file in the File name text box. The default name is root name of 

the layer. 
8. Click Save. 
9. Click Done to return to the main Draw tab area. 

  

 

Note for regular Street Atlas USA users 
This Help topic describes functionality provided in advanced file management. 
Advanced file management allows you to save multiple routes and draw layers in a 
single map file. With simplified file management, you can save only one route 
and/or draw layer in a single map file. If you did not select to enable advanced file 
management during the product installation, you can still change the settings 
using the Change File Management option in the Options menu. For more 
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information, see Activating Advanced/Simplified File Management. 
This note does not apply to Street Atlas USA Plus users. 

  

Exporting Track or Waypoint Files to GPX Files 
You can export track or waypoint files as GPX files. GPX files derived from tracks contain the 
elevation, time, and GPS status for each point in the track. GPX files derived from a 
waypoint file include the waypoint name, comment, URL, lat/lon, elevation, time, GPS 
status and the symbol name. You cannot export more than one waypoint/track layer into a 
single GPX file. 

To Export Track or Waypoint Files to GPX Files 

Use the following steps to export an existing track or waypoint file to a GPX file. 
1. Open the map file containing the track or waypoint file you want to export. 

OR 
Create a new track or waypoint file for exporting. 

2. Click the Draw tab. 
3. Click File to open the draw file editing area. 

A draw file with a selected check box displays on the map. The Active column shows 
the active layers. 

4. Select the track or waypoint file to export from the file list. 
5. Click Export. 

The Export Draw File dialog box opens. 
6. Browse to a directory in which to save the file or use the default destination of 

C:\DeLorme Docs\Export. 
7. Select GPX File from the Save as Type drop-down list. 
8. Type a name for the file in the File name text box. The default name is DrawExport. 
9. Click Save. 
10. Click Done to return to the main Draw tab area. 

  

 

Note for regular Street Atlas USA users 
This Help topic describes functionality provided in advanced file management. 
Advanced file management allows you to save multiple routes and draw layers in a 
single map file. With simplified file management, you can save only one route 
and/or draw layer in a single map file. If you did not select to enable advanced file 
management during the product installation, you can still change the settings 
using the Change File Management option in the Options menu. For more 
information, see Activating Advanced/Simplified File Management. 
This note does not apply to Street Atlas USA Plus users. 

  

Importing Files to Draw Files 
You can import many types of files as draw files. The file items display as draw objects 
within the draw file. 
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You can also use the Exchange dialog to download waypoint and tracks to the Draw tab. See 
the Help topics under Exchanging Information with a Third-party GPS Device for more 
information. 
See the chart at the end of this topic to learn what is imported for each type of file. 
Important  To add a track Draw file (*.an1), to a map file, click the Add button on the Map 
Files tab. For more information, see Editing a Map File. 

To Import Files 

Use the following steps to import a file. 
1. Click the Draw tab. 
2. Click File to open the draw file editing area. 
3. Click Import. 

The Import Draw File dialog box opens. 
4. Browse to the source folder of the file. The default location is C:\DeLorme 

Docs\Export. 
5. From the Files of type drop-down list, select the type of file you want to import. 
6. If you selected GPS Log File format, select how you want the file to display on the 

map from the Import As drop-down list. 
7. Select the file and then click Open. The draw objects in the imported file display. A 

new draw file is automatically created for the imported file. 
8. Click Done to return to the Draw dialog area. 

  
Notes 
You can import a file containing survey information as long as the survey information is 
formatted correctly. 

• The file must start with Begin Survey and end with End. 
• The second line must be a coordinate. 
• The remainder of the file can be made up of lines or arcs. A line is defined by 

direction and length. 
• A curve is defined by the word curve, followed by a letter representing the side of 

the arc to put the radius. This is followed by the length of the radius and the length 
of the arc. The arc is completed with a bearing from the start to finish point. 

• For more information, see Sample Survey File. 

 

Street Atlas USA only 
This Help topic describes functionality that's provided in advanced file 
management. 
Advanced file management allows you to save multiple routes and draw layers in a 
single Map File. Simplified file management lets you save only one route and/or 
draw layer in a single Map File. If you did not select to enable advanced file 
management during the product installation, you can still change the settings 
using the Change File Management option in the Options menu. For more 
information, see Activating Advanced/Simplified File Management. 

  

If you import this 
type of file... 

That results from this 
source... 

The following is imported... 
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Address Book (.txt, 
.csv) 

Address Book File Draw objects display with the 
current symbol and style 
selections. 
Notes 
Files must be tab or comma-
delimited. 
Format: name, address, city, 
state, ZIP Code, phone. 
Files must be less than 250 
records long. 

Text File (.txt) Lat/Lon Text File Draw objects display with the 
current symbol and line style 
selections. 

GPS Log File (.gpl) Any DeLorme product that 
supports GPS tracking 

Line or waypoint object displays 
with the current line preferences. 

GPX File (.gpx) DeLorme product or third-
party application 

May contain one or more routes, 
tracks, or waypoints, as well as 
comments. 
Note   
When you import a GPX file, all 
the waypoints, tracks, 
comments, and routes found in 
the file are imported at the same 
time. 

Location File (.loc) Waypoint file from 
www.geocaching.com   

Coordinate information, name, 
and URL link. 

Magellan Track File 
(.log) 

Magellan Track Log Latitude, longitude, elevation, 
name and date/time (if 
specified). 

Magellan Waypoint 
File (.upt) 

Magellan Waypoint File Latitude, longitude, elevation, 
name, comment, and symbol are 
imported. 

Draw Layer Files Topo USA 2.0 (.ano) Draw objects display with the 
current symbol and line style 
selections. 

MapDocs (.sa7, .sa8, 
.sa9, .mn5, .mn6, 
.mn7) 

 Street Atlas USA 8.0, 
8.0, and 9.0. 

 AAA Map'n'Go 5.0, 6, 
and 8.0 

Draw objects display with the 
current symbol and line style 
selections. 

  

Formatting a Text File to Import as a Draw File 
These are the formatting conventions, with examples, for creating a text file to import as a 
draw file. 

http://www.geocaching.com/
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Draw Object Format Example 

Line BEGIN LINE 
LAT, LON 
LAT, LON 
LAT, LON 
END 

BEGIN LINE 
43.807801,-70.164440 
43.807629,-70.163801 
43.807211,-70.162746 
43.806707,-70.163400 
43.806696,-70.163905 
43.807125,-70.164768 
43.807801,-70.164440 
END 

Spline BEGIN SPLINE 
LAT, LON 
LAT, LON 
LAT, LON 
LAT, LON 
END 

BEGIN SPLINE 
43.807801,-70.164440 
43.807629,-70.163801 
43.807211,-70.162746 
43.806707,-70.163400 
43.806696,-70.163905 
43.807125,-70.164768 
43.807801,-70.164440 
END 

Arc BEGIN ARC 
LAT, LON 
LAT, LON 
LAT, LON 
LAT, LON 
END 

BEGIN ARC 
43.807801,-70.164440 
43.807704,-70.162775 
43.807211,-70.162746 
43.807430,-70.163644 
END 

Polygon 
Rectangle 

BEGIN POLY 
LAT, LON 
LAT, LON 
LAT, LON 
LAT, LON 
END 

BEGIN POLY 
43.808692,-70.165392 
43.808692,-70.162493 
43.806621,-70.162493 
43.806621,-70.165392 
43.808692,-70.165392 
END 

Circle BEGIN CIRCLE 
LAT, LON, Radius 
END 

BEGIN CIRCLE 
43.807662,-
70.163935,0.114611 
END 

Symbol BEGIN SYMBOL 
LAT, LON, Name, Symbol 
Name 
END 

BEGIN SYMBOL 
43.807662,-
70.163935,DeLorme, Blue 
Pin 
END 



Using the Draw Tools 

135 

MapNote BEGIN NOTE 
LAT, LON, Text 
END 

BEGIN NOTE 
43.807662,-
70.163935,DeLorme 
END 

Text Label BEGIN TEXT 
LAT, LON, Text 
END 

BEGIN TEXT 
43.807662,-
70.163935,DeLorme 
END 

 

Note for regular Street Atlas USA users 
This Help topic describes functionality provided in advanced file management. 
Advanced file management allows you to save multiple routes and draw layers in a 
single map file. With simplified file management, you can save only one route 
and/or draw layer in a single map file. If you did not select to enable advanced file 
management during the product installation, you can still change the settings 
using the Change File Management option in the Options menu. For more 
information, see Activating Advanced/Simplified File Management. 
This note does not apply to Street Atlas USA Plus users. 

  

Copying a Map Line to a Draw File 
Map lines that you can copy to draw objects include segments of all types of roads and 
highways, railroads, power lines, pipelines, rivers or streams, Zip Code boundaries, and grid 
lines. 

To Copy a Map Line 

Use the following steps to copy a map line to a draw file. 
1. Pan the map and zoom to the data zoom level. 

OR  
Open the map file with the map view you want. 

2. Right-click the object on the map you want to bring into the draw file, point to 
Manage Draw, point to Copy to Draw Object, and then click the object in the list. 
The object is copied into the draw file using the current line style selections. 

  

 

Note for regular Street Atlas USA users 
This Help topic describes functionality provided in advanced file management. 
Advanced file management allows you to save multiple routes and draw layers in a 
single map file. With simplified file management, you can save only one route 
and/or draw layer in a single map file. If you did not select to enable advanced file 
management during the product installation, you can still change the settings 
using the Change File Management option in the Options menu. For more 
information, see Activating Advanced/Simplified File Management. 
This note does not apply to Street Atlas USA Plus users. 

  

Saving a Track as a GPS Log 
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You can save any track as a GPS log with the right-click feature. 

To Save a Track as a GPS Log 

Use the following steps to save a track as a GPS log. 
1. Place a track on the map. 
2. Right-click the track, point to Manage Draw, and then click Save as GPS Log File. 
3. Browse to the location where you want to save the .gpl file. The default location is 

C:\DeLorme Docs\GPSLogs. 
4. Type the file name in the File Name text box. 
5. Click Save. 

The original track is retained in its draw file and a new GPS log is created. 
  

 

Note for regular Street Atlas USA users 
This Help topic describes functionality provided in advanced file management. 
Advanced file management allows you to save multiple routes and draw layers in a 
single map file. With simplified file management, you can save only one route 
and/or draw layer in a single map file. If you did not select to enable advanced file 
management during the product installation, you can still change the settings 
using the Change File Management option in the Options menu. For more 
information, see Activating Advanced/Simplified File Management. 
This note does not apply to Street Atlas USA Plus users. 

  

Viewing the Contents of a Draw File 
Once you create a draw file (draw, road, waypoint, or track layer), you can view the 
contents of that file using the More button in the File view of the Draw tab. 

To View the Contents of a Draw File 

Use the following steps to view the contents of a draw, road, waypoint, or track file. 
1. Click the Draw tab. 
2. Click File to open the draw file editing area. 

All the files you have created display in a table. A draw file with a selected check box 
displays on the map. 

3. Click to select the file that includes the contents you want to view. 
4. Click More. 

The tab area increases in height and the file contents table displays. The information 
that displays in the table is dependent on the file type that is selected. 

• Draw layer contents include the draw object label (name), comments about 
the draw object, the URL assigned when the draw object was added to the 
map, the date and time the object was last modified, and the draw object 
type (symbol, line, polygon, circle, etc.). 

• Road layer contents include the routable road name, comments about the 
routable road, the URL assigned when the routable road was added to the 
map, the date and time the routable road was last modified, and the length of 
the road (in the measurement chosen in the Display settings). 
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• Waypoint layer contents include comments about the waypoint, the URL 
assigned when the waypoint was added to the map, the date and time the 
waypoint was last modified, the coordinates of the waypoint, and the symbol 
name. 

• Track layer contents include comments about the track, the URL assigned 
when the track was added to the map, the date and time the track was last 
modified, the start and finish time of the track, the total time of the track, the 
distance of the track (in the measurement chosen in the Display settings), 
and the number of readings that the track includes. 

5. Optional. Double-click a draw object in the table to center the map on its location. 
OR 
Right-click the draw object in the table and click Go To. 

6. Optional. To sort the columns of data in the table in ascending order, click the 
column header. Click the column header again to sort in descending order. 

7. Optional. To modify a draw object's name, comment, or URL, in the table, click the 
draw file in the draw file editing area and then click it again (do not double-click). 
Type the new name in the Name box and press the ENTER key on your keyboard. 
OR 
Right-click the draw file in the draw file editing area and click Rename. Type the 
new name in the Name box and press the ENTER key on your keyboard. 
Note  To add a line break to text in the Comment field, press CTRL+ENTER on your 
keyboard. 

8. Optional. To view the contents of a track file in a dialog box, right click the file in the 
draw file editing area and click Details. 

9. Optional. To launch a Web browser for a draw object that includes a URL, right-click 
the file in the draw file editing area and click Launch Browser. 

10. Optional. To delete a draw object, click the draw object in the table and click the 
Delete button. 
Click Yes in the confirmation message box to delete the object or click No to cancel. 
OR 
Right-click the draw object in the table and click Delete. 
Click Yes in the confirmation message box to delete the object or click No to cancel. 

11. Optional. Click Less to return the tab height to its default height. 
Note  To edit the Comments field, click once in the cell, type your text in the box, and then 
press ENTER on your keyboard. When you hover your cursor over a comment, the entire 
comment displays as a ToolTip. 
  

 

Note for regular Street Atlas USA users 
This Help topic describes functionality provided in advanced file management. 
Advanced file management allows you to save multiple routes and draw layers in a 
single map file. With simplified file management, you can save only one route 
and/or draw layer in a single map file. If you did not select to enable advanced file 
management during the product installation, you can still change the settings 
using the Change File Management option in the Options menu. For more 
information, see Activating Advanced/Simplified File Management. 
This note does not apply to Street Atlas USA Plus users. 
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Copying a Draw File 
You can copy the contents of an existing file and save it as a different file type (for example, 
convert a road layer to a draw layer). 

To Copy a Draw File 

Use the following steps to copy a draw file. 
1. Click the Draw tab. 
2. Click File to open the draw file editing area. 
3. Click to select the file that you want to copy. 
4. Click Copy To. 

A menu displays the available layer types; Road, Waypoint, or Track. 
Note  If a layer type is not available in the menu, it is because the original draw file 
that you are copying does not contain data that is pertinent to that file type. For 
example, you cannot copy a draw layer that contains area objects (such as circles) to 
a road layer that requires line objects. 
A new file is created and inserted into the table. 

Tip  You can also change a draw object type using the right-click feature. For more 
information, see Changing Draw Object Types. 
  

 

Note for regular Street Atlas USA users 
This Help topic describes functionality provided in advanced file management. 
Advanced file management allows you to save multiple routes and draw layers in a 
single map file. With simplified file management, you can save only one route 
and/or draw layer in a single map file. If you did not select to enable advanced file 
management during the product installation, you can still change the settings 
using the Change File Management option in the Options menu. For more 
information, see Activating Advanced/Simplified File Management. 
This note does not apply to Street Atlas USA Plus users. 

  

Changing Draw Object Types 
When you add a draw object to the map, a draw file is automatically created that includes 
that object. The draw file type varies depending on the draw object that was created. 

Draw Object Type Draw File Type 

Routable Road Road Layer 

Waypoint Waypoint Layer 

Track Track Layer 

Area Object (Polygon, Circle, Rectangle) Draw Layer 

Point Object (MapNote, Text Label, Symbol, 
Image) 

Line Object (Line, Arc, Spline) 
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You can right-click a draw object on the map and change it to a road, track, waypoint, or 
draw layer, depending on the type of draw object you selected. When the draw file type is 
changed, the original draw file is maintained and a copy is made and switched to the new 
draw file type, leaving you with two files: the original draw file and the copied draw file, 
which has a new draw file type. 

To Change a Draw Object 

Use the following steps to change a draw object type. 
1. Use the Draw tab to place a draw object on the map. 
2. To change a track or line to a road layer, right-click the object on the map, point to 

Manage Draw, and then click Copy to Active Road Layer. 
OR 
To change a routable road to a track layer, right-click the object on the map, point to 
Manage Draw, and then click Copy to Active Track Layer. 
OR 
To change a routable road, waypoint, or track to a draw layer, right-click the object 
on the map, point to Manage Draw, point to Copy to Draw Object, and then click 
the object to copy to. 
OR 
To create a copy of an existing area object, point object, or line object, right-click the 
object on the map, point to Manage Draw, point to Copy to Draw Object, and 
then click the object to copy to. 
OR 
To change a track to a GPS log, right-click the track on the map, point to Manage 
Draw, and click Copy Track to GPS Log. 
OR 
To change a symbol to a waypoint, right-click the symbol on the map, point to 
Manage Draw, and click Copy Symbol to Waypoint. 

Tip  You can also change a draw file type using the File section of the Draw tab. For more 
information, see Copying a Draw File. 
  

 

Note for regular Street Atlas USA users 
This Help topic describes functionality provided in advanced file management. 
Advanced file management allows you to save multiple routes and draw layers in a 
single map file. With simplified file management, you can save only one route 
and/or draw layer in a single map file. If you did not select to enable advanced file 
management during the product installation, you can still change the settings 
using the Change File Management option in the Options menu. For more 
information, see Activating Advanced/Simplified File Management. 
This note does not apply to Street Atlas USA Plus users. 

  

Renaming a Draw File 
Once you create a draw file, you can rename it in the draw file list or on the map. 

To Rename a Draw File 

Use the following steps to rename a draw file. 
1. Click the Draw tab. 
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2. Click File to open the draw file editing area. 
All the files you have created display in a table. A draw file with a selected check box 
displays on the map. 

3. Right-click the draw file and click Rename. 
The file name area activates. 
OR 
Click within the file name cell once. Then, click it again (do not double click). 
The file name area activates. 

4. Type the new file name in the cell and press the ENTER key on your keyboard. 
  

 

Note for regular Street Atlas USA users 
This Help topic describes functionality provided in advanced file management. 
Advanced file management allows you to save multiple routes and draw layers in a 
single map file. With simplified file management, you can save only one route 
and/or draw layer in a single map file. If you did not select to enable advanced file 
management during the product installation, you can still change the settings 
using the Change File Management option in the Options menu. For more 
information, see Activating Advanced/Simplified File Management. 
This note does not apply to Street Atlas USA Plus users. 

  

Copying a Draw Object From One Draw File to Another 
You can copy draw objects from one draw file to another using the right-click feature in the 
draw file list. Copying retains the draw object in the original draw file while placing a copy of 
it in a selected draw file. If you want to move a draw object to another draw file, see Moving 
a Draw Object to a Different Draw File. 

To Copy a Draw Object to a Different Draw File 

Use the following steps to copy a draw object. 
1. Click the Draw tab. 
2. Click File to open the draw file editing area. 

All the files you created display in a table. A draw file with a selected check box 
displays on the map. 

3. Click to select the file that includes the contents you want to copy. 
4. Click More. 

The tab area increases in height and the file details table displays. The information 
that displays in the table is dependent on the file type that is selected. 

5. Right-click the draw object that you want to copy to another draw file, point to Copy 
To, and then click the draw file you want to copy the object to. 
The draw object remains in the original draw file and is copied to the selected draw 
file. 
Note  To select multiple draw objects in the file list, press and hold the CTRL key 
and click each file OR to select multiple sequential files, press and hold the SHIFT 
key and click the first and last file. 

  

 

Note for regular Street Atlas USA users 
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This Help topic describes functionality provided in advanced file management. 
Advanced file management allows you to save multiple routes and draw layers in a 
single map file. With simplified file management, you can save only one route 
and/or draw layer in a single map file. If you did not select to enable advanced file 
management during the product installation, you can still change the settings 
using the Change File Management option in the Options menu. For more 
information, see Activating Advanced/Simplified File Management. 
This note does not apply to Street Atlas USA Plus users. 

  

Moving a Draw Object to a Different Draw File 
You can move a draw object to a different draw file using the right-click feature in the draw 
file list. In order to move a draw object to another draw file, a secondary, compatible draw 
file must exist. 
Moving a draw object removes it from the current draw file. If you do not want to remove it, 
but copy it to another draw file, see Copying a Draw Object from One Draw File to Another. 

To Move a Draw Object to a Different Draw File 

Use the following steps to move a draw object. 
1. Click the Draw tab. 
2. Click File to open the draw file editing area. 

All the files you have created display in a table. A draw file with a selected check box 
displays on the map. 

3. Click to select the file that includes the contents you want to copy. 
4. Click More. The tab area increases in height and the file details table displays. The 

information that displays in the table is dependent on the file type that is selected. 
5. Right-click the draw object you want to move, point to Move To, and then click the 

draw file you want to copy the object to—all compatible draw files display in the 
Move To list. 
The draw object is moved to the new destination. 

  

 

Note for regular Street Atlas USA users 
This Help topic describes functionality provided in advanced file management. 
Advanced file management allows you to save multiple routes and draw layers in a 
single map file. With simplified file management, you can save only one route 
and/or draw layer in a single map file. If you did not select to enable advanced file 
management during the product installation, you can still change the settings 
using the Change File Management option in the Options menu. For more 
information, see Activating Advanced/Simplified File Management. 
This note does not apply to Street Atlas USA Plus users. 

  

Using Draw Objects 

Copying and Placing Draw Objects 
You can copy any draw object you place on the map. 
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To Copy Draw Objects 

Use the following steps to copy draw objects. 
1. Open the map file that contains the draw object you want to copy. 
2. Click the Draw tab. 

3. To copy a single draw object, click the Select tool  and then click the draw object 
on the map. A box displays around the active object. 
OR 
To copy multiple draw objects, click the Select tool  and then drag a box over 
the draw objects you want to copy. 

4. To copy, press the CTRL+C keys on your keyboard. 
5. To paste, press CTRL+V on your keyboard. The newly copied object is placed directly 

on top of the original (copied) object. 
6. To move the copied object, use the table below. 

If the draw object is a... Then... 

Routable Road, Track, 
Line, Arc, Spline, Polygon, 
Rectangle, Circle, or 
MapNote 

Press and hold the SHIFT 
key on your keyboard and 
drag the object to the new 
location. 

Symbol or Text Drag the object to the new 
location. 

Tips 
• To undo the move of the pasted draw object, click the Undo button  to undo the 

last action. If you decide not to undo the last action, click the Redo button . 
• If you undo the first move of the pasted object, the object is placed back on top of 

the original (copied) object. 
• To copy and move a single object, select the draw object you want to copy, press the 

CTRL key on your keyboard, and drag the draw object to the new location. 
• If the item you copied does not successfully paste, it may be because you clicked out 

of the map display. To focus the cursor back on the map, click inside the map 
display. Then, try pasting again. 

Moving Draw Objects 
You can move any draw object you place on the map using the Draw tab from one location 
to another. 

To Move Draw Objects 

Use the following steps to move draw objects. 
1. Open the map file that contains the object you want to move. 
2. Click the Draw tab. 

3. Click the Select tool  and click the draw object you want to move. A box displays 
around the active object. 
 
You can move draw objects in different ways: 
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If the object is a(n)... Then... 

Routable Road, Track, Line, 
Arc, Spline, Polygon, Rectangle, 
or Circle 

Press and hold the SHIFT key on your 
keyboard and drag the object to the new 
location. 
OR 
Press the arrow keys on your keyboard to 
move the object up, down, right, or left. 

Symbol or Text Press the arrow keys on your keyboard to 
move the object up, down, right, or left. 
OR 
Drag it to the new location. 

MapNote To move the entire MapNote, press and 
hold the SHIFT key on your keyboard and 
drag the object to the new location, or 
position your cursor between the MapNote 
text and the anchor and drag the entire 
MapNote to the desired location. 
OR 
To move the MapNote's anchor, drag the 
MapNote's anchor to the new location. 
OR 
To move the MapNote's text, drag the 
MapNote's text to the desired location.  

Tip  To undo a draw object move, click the Undo button  to undo the last action. If 
you decide not to undo the last action, click the Redo button . 

Notes  You can also move draw objects or their points by typing a new coordinate or 
distance and bearing/angle number within the corresponding text boxes. 

 Type new coordinates and click Apply to move circles, symbols, text, and 
MapNotes. The whole object moves to the entered location. If you change the 
distance and bearing numbers, the object moves in relationship to the object's 
last location. 

 Type new coordinates and click Apply to move individual end points (small red 
circles) in line segments in routable roads, lines, splines, polygons, rectangles, 
and arcs. If you change the distance and bearing numbers of the individual 
points (not recommended for rectangles), the end point's distance and 
bearing/angle change in relationship to the start point of the segment. 

Renaming a Draw Object 
Once you create a draw object, you can rename it in the draw file list or on the map. 

To Rename a Draw Object in the File List 

Note  This option is available only with regular Street Atlas USA using Advanced File 
Management or Street Atlas USA Plus. 
Use the following steps to rename a draw object in the file list. 

1. Click the Draw tab. 
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2. Click File to open the draw file editing area. 
All the files you have created display in a table. Any draw file with a selected check 
box displays on the map. 

3. Click to select the file that includes the draw object you want to rename. 
4. Click More. 

The tab area increases in height and the file details table displays. The information 
that displays in the table is dependent on the file type that is selected. 

5. Right-click the draw object and select Rename. 
OR 
Click within the file name cell once. Then, click it again (do not double click). 

6. The file name area activates. Type the file name and press the ENTER key on your 
keyboard. 

  

To Rename a Draw Object on the Map 

Use the following steps to rename a draw object on the map. 
1. Open the map file that contains the draw object you want to rename. 
2. Right-click the waypoint, point to Manage Draw and click Edit Draw Object Text. 

The waypoint text box opens. 
Note If you have more than one waypoint close together, you may have to select 
from a list. 
OR 
Click the Select tool , click the waypoint, and click the waypoint again (do not 
double-click). The waypoint text box opens. 

3. Type the new name in the box and press ENTER on your keyboard OR click away 
from the box. 

Deleting Draw Objects 
Once you place a draw object on a draw file, you can delete the object. You can also delete 
multiple or all draw objects in the active draw file. 

To Delete One Draw Object 

Use the following steps to delete a draw object. 
1. Open the existing map file that contains the draw object you want to delete. 
2. Click the Draw tab. 

3. Click the Select tool  and then click the draw object on the map to select it. A 
box displays around the selected object. 

4. Click Delete in the Draw dialog area. 
OR 
Press the DELETE key on your keyboard. 
OR 
Right-click the object and then select Manage Draw/Delete Draw Object. 

Tip  To bring back the last draw object you deleted, click the Undo button  to undo the 
last action. You can undo approximately 200 events in a single map file. 
Note  You can also delete a draw object using the right-click feature in the draw file list. 
Click the File button in the Draw tab, click to select the Draw File that contains the object 
you want to delete, click More, right-click the object, and then click Delete. 



Using the Draw Tools 

145 

To Delete Multiple Draw Objects 

Use the following steps to delete several draw objects. 
1. Click the Draw tab. 

2. To select multiple draw objects, click the Select tool , click the first draw object 
on the map to select it, and then press and hold the SHIFT key on your keyboard 
while clicking each additional draw object you want to delete. A box displays around 
each selected object. 
OR 
To select multiple draw objects, click the Select tool , drag a box over the draw 
objects you want to delete. 

3. Click the Delete button in the Draw dialog area. 
OR 
Press the DELETE key on your keyboard. 
OR 
Right-click the object and then click Manage Draw/Delete Draw Object. 
 
A message box displays asking if you want to delete the draw objects from the 
current file. 

• If you click Yes, all selected draw objects in the file are deleted. You cannot 
undo this action. 

• If you click No, no objects are cleared from the file. 

To Delete All Draw Objects 

To delete all draw objects from an unsaved draw file, click the Draw tab and, click a draw 
object button that represents the draw file you want to clear (for example, if you want to 
clear a RoadLayer, click the Routable Roads tool ) and then click Clear All. A message 
box displays asking if you want to clear all draw objects from the current file. 

• If you click Yes, all draw objects in the file are cleared. You cannot undo this 
action. 

• If you click No, no objects are cleared from the file. 

Snapping Draw Objects 
You can snap any draw object to the exact coordinates of a point in another draw object. 
You can also snap the central shape point of an arc to another object. 

To Snap a Draw Object to the Coordinates of Another Object 

Use the following steps to snap a draw object to the coordinates of another draw object. 
1. Click the Draw tab. 

2. Click the Select tool  and then click the draw object on the map. 
A box displays around the active object. Shape points display as small, magenta 
squares. 

3. Select an end point from any of the line segments within the draw object. 
It displays as a red or green circle. 

4. Drag the point to: 
• Any other shape point within a line, spline, polygon, arc, or rectangle. 
• The center point of a circle. 
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• The anchor of a symbol. 
• The base point of a text label. 
• The text box anchor point of a MapNote. 

When you drag your shape point over a point on the draw object, a yellow diamond 

defines the snap point . Release the point you dragged when the snap point 
displays. The active draw object is then snapped to the other object's point 
coordinate. 

Tip  To undo a draw object snap, click Undo to undo the last action. If you decide not to 
undo the last action, click Redo. 
  
Notes   

• Do not snap one end point of an arc to the other end point in the same arc. 
• To turn the snapping feature off, press the ALT key on the keyboard while dragging 

the draw object. 

To Snap the Central Shape Point of an Arc to Another Object 

Use the following steps to snap the central shape point of the arc to another object. 
1. Click the Draw tab. 

2. Click the Select tool  and then click the arc on the map. 
A box displays around the active object. Shape points display as small, magenta 
squares. 

3. While pressing the SHIFT key on the keyboard, drag the center point of the arc line 
over a point on the draw object until the snap point (the yellow diamond) displays. 

4. Release the arc. It is snapped to the other object's point coordinate. 

Adding Points to Draw Objects 
You can add points to routable road, line, spline, and polygon draw objects to change the 
shape of the object. 

To Add Points to Draw Objects 

Use the following steps to add points to routable roads, lines, splines, and polygons. 

1. In the Draw tab, click the Select tool , and then click the draw object you want 
to edit. 
A box displays around the line indicating it is active. The shape points of the draw 
objects display as small, magenta squares. 

2. Click the line between two shape points in the object and drag. 
A new point is created, as well as a new line segment within the object. The new 
segment displays with its first and last end points, as well as a text box indicating 
the new point's bearing or angle, length of the new segment (leg), and total object's 
length on the map. 

Tip  To undo the addition of the point to the draw object, click the Undo button  to undo 
the last action. If you decide not to undo the last action, click the Redo button . 

Deleting Points and Line Segments from Draw Objects 
You can delete points from routable road, track, line, spline, and polygon draw objects to 
change the shape of the object. 
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To Delete Points and Line Segments from Draw Objects 

Use the following steps to delete points and line segments from draw objects. 
1. Click the Draw tab. 

2. Click the Select tool  and click the draw object you want to edit. 
A box displays around the line indicating it is active. The shape points of the linear 
objects display as small, magenta squares. 

3. Select the shape point. 
The point displays as either a green or red end point depending upon the line 
segment it is associated with. 

4. Click Delete in the Draw display area. 
OR 
Press the DELETE key on your keyboard. 
The point is deleted, as well as the line segment within the draw object that was 
associated with that point. 

Tip  To undo the addition of the point to the draw object, click the Undo button  to undo 
the last action. If you decide not to undo the last action, click the Redo button . 

Labeling a Draw Object 
You can label any draw object. Once you label a draw object, you can search for it using the 
QuickSearch function in the Find tab or by typing the draw object label in any of the routing 
fields in the Route tab. 

To Label a Draw Object 

See the labeling procedures below for each of the draw objects. 

For this Draw Object... Use this labeling procedure... 

Routable Roads Type the name of the street in the text box available in the 
Draw dialog area. 

Arcs 
Circles 
Lines 
Polygons 
Rectangles 
Splines 
Tracks 
Waypoints 

1. Place the object on the map. 

2. Using the Select tool , click the draw object once. 
A gray box displays around the draw object. 

3. Click the draw object again. A text box displays. 
4. Type the label name in the text box and then press the 

ENTER key on your keyboard. 

Images 
MapNotes 
Symbols 
Text Labels 
Waypoints 

1. Place the object on the map. 
The URL/Label (Street Atlas USA Plus) or Label 
(Regular Street Atlas) text box opens. 

2. Type the label for your draw object in the Label section 
of the text box. 

Note (Street Atlas USA Plus only)  When viewing a 
hyperlinked draw object on the map, the object displays as 
an active hyperlink. If you want to click the object without 
opening the hyperlink, press the CTRL key on your keyboard 
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while you click the draw object. 

  

Routable Roads, Tracks, Lines, Arcs, and Splines 

Drawing Routable Roads on the Map 
The Routable Road tool allows you to add a new road to a draw layer in the current map 
file. You can then incorporate any new roads you add to a route when you create a route. 
You must be at data zoom level 11-0 or greater when adding roads with the Routable Road 
tool. 

To Draw Routable Roads 

Use the following steps to add routable roads to a road layer. 
1. Click the Draw tab. 

2. Click the Routable Road tool . 
3. Type the name of the road you want to add in the Road Name text box. 

Name each routable road you add so you can locate it using the find feature. 
4. Hover the mouse pointer over existing roads to display the yellow diamond symbol 

. The yellow diamond symbol indicates where on an existing road the point for your 
new road will connect (connection point). 
Notes 

• The new road must connect to an existing non-limited access road for routing 
to occur on the new road. 

• Each time you intersect an existing road, hover the mouse over the road to 
display the yellow diamond symbol and click to create a connection point 
before continuing to draw. If you draw the line over the road without 
creating a connection point, routing cannot occur along the intersection. 

5. Once you locate the connection point for your new road, click the map to place the 
first point. Click point-to-point or drag to add the new road to the draw layer. 
The following information is available as you add each point in your road: 

• The coordinates of each point display in the corresponding text boxes. 
• The distance and bearing/angle of each new point from its previous point 

display in the corresponding text boxes. 
6. To finish the line draw for the new road, enter the last point on the map screen and 

click Done. 
The new road displays on the map with the name you typed in the Road Name text 
box. 
You can also finish the line draw by pressing the ENTER key on your keyboard or 
double-clicking while entering the last point of the line. 

Drawing a Line, Arc, or Spline on the Map 
You can add lines, arcs, and splines to a draw file and adjust their line style, color, width, 
and display them with map line features. 

• Use lines to mark boundaries or to add railroads or utility lines. You can draw lines 
with varied line styles, weights, and colors, including lines that reflect actual map 
line types. 
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• Use arcs to add curved line features to a draw file. You can draw arcs with varied 
line styles, weights, and colors, including lines that reflect actual map line types. 
Note  An arc is created by entering only three points on the map. The first and 
second points determine the distance of the first arc base from the last arc base. The 
third point, placed between the first two, determines the radius of the arc and fixes 
the arc in place. 

• Use splines to add map features that contain curves. You can draw splines with 
varied line colors, weights, and styles, including lines that reflect actual map line 
types. 
Note  As you draw a spline, points are entered in much the same way as those 
entered when creating a line. The difference between a line and a spline is that when 
you enter each point, the line segment between the points curves instead of staying 
straight. 

To Draw a Line, Arc, or Spline 

Use the following steps to draw a line/arc/spline. 
1. Click the Draw tab. 

2. Click and hold the Line/Arc/Spline tool  and select the tool you want. 
3. Select a line/arc/spline style from the Style drop-down list. 
4. Click the color button next to the Style drop-down list to select a line/arc/spline 

color. 
5. If available, select a line/arc/spline width from the Width drop-down list. 
6. If available, select the Highlight check box to make your line/arc/spline appear 

translucent on the map. 
7. Select the Show Measurement check box to display information about the points 

on the map as you draw the line/arc/spline. 
As you add each point, a text box displays next to your pointer indicating the bearing 
or angle, leg (line segment) length, and total length of the line/arc/spline on the 
map. Labels display when end points are clicked if the Show Measurement check box 
is selected. 

8. To draw a line or spline, click the map to designate the start and end points of each 
line segment. 
You can also drag your cursor on the map to draw a squiggly line. 
OR 
To draw an arc, click the map to designate the start and end points of the arc. 

• The coordinates of each point display in the corresponding text boxes to the 
right of the line options. 

• The distance and bearing/angle of each new point from its previous point 
display in the corresponding text boxes. 

9. To finish the line/arc/spline, click the last point on the map screen and then click 
Done. 
OR 
Click the last point on the map screen and press the ENTER key on your keyboard. 
OR 
Double-click the last point of the line/arc/spline. 

Drawing a Track on the Map 
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You can add tracks to the map and adjust their line style, color, width, and display them 
with map line features. 

To Draw a Track 

Use the following steps to draw a track. 
1. Click the Draw tab. 

2. Click and hold the Track/Waypoint tool  and select the Track tool . 
3. Select a track style from the Style drop-down list. 
4. Click the color button next to the Style drop-down list to select a track color. 
5. Select a track width from the Width drop-down list. 
6. Select the Highlight check box to make your track appear translucent on the map. 
7. Select the Show Measurement check box to display information about the points 

on the map as you draw the track. 
As you add each point, a text box displays next to your pointer indicating the bearing 
or angle, leg (line segment) length, and total length of the track on the map. Labels 
display when end points are clicked if the Show Measurement check box is selected. 

8. Click the map to designate the start and end points of each line segment. 
You can also drag your cursor on the map to draw a squiggly line. 

• The coordinates of each point display in the corresponding text boxes to the 
right of the line options. 

• The distance and bearing/angle of each new point from its previous point 
display in the corresponding text boxes. 

9. To finish the track, click the last point on the map screen and then click Done. 
OR 
Click the last point on the map screen and press the ENTER key on your keyboard. 
OR 
Double-click the last point of the track. 

Tip  To get information about a track, right-click it on the map and click Info. The Info tab 
opens with information about the track. 

Editing a Routable Road, Line, Arc, or Spline 
Once you create a line object (routable road, line, arc, or spline) you can edit (including 
reshaping or changing line color or width), copy, move, or delete it at any time.   

To Edit a Line Object 

Use the following steps to edit the shape of a routable road, line, arc, or spline. 
1. Open the map file containing the draw layer with the line object you want to edit. 
2. Click the Draw tab. 
3. If the line object you want to edit is not active, click File and activate the draw file in 

the file list. Then, click Done. 

4. Click the Select tool  and then click the line object you want to edit. 
• A box displays around the selected line. 
• The shape points used to create the line object display as small, magenta 

squares. 
5. Perform any of the following edits to the line object: 
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• To edit any label on the line object, select it twice, then type the label in the 
text box that displays next to the line object. 
OR 
Select the line object and edit its label. 

• Reshape the line object by dragging any of its points to a new location. 
When you select a shape point of a line segment within an active line object: 

• A small green circle indicates the start end point of the selected line 
segment. 

• A small red circle indicates the last end point of the selected line 
segment. 

• Select the Coordinate or the Distance and Bearing/Angle option and edit 
the numbers. Click Apply to initiate the changes. 
Note  You can display either bearing or distance by clicking the drop-down 
arrow next to the Bearing or Angle text located below the distance text in 
the Distance and Bearing/Angle option. 

6. Click Done to finish your edit. 
OR 
Press the ENTER key on your keyboard. 
OR 
Click outside the object's active box on the map. 

Editing a Track 
Once you download a track from a GPS receiver, you can edit (including reshaping or 
changing line color or width), copy, move, or delete it at any time.   

To Edit a Track 

Use the following steps to edit a track. 
1. Open the map file containing the draw file with the track you want to edit. 
2. Click the Draw tab. 
3. If the track you want to edit is not in the active draw file, click File and select the 

draw file from the draw file dialog area. Then, click Done. 

4. Click the Select tool  and click the track you want to edit. 
• A box displays around the selected track. 
• The shape points used to create the line display as small, magenta squares. 

5. Change any of the track style, color, or weight options of the existing track. 
• To edit any label on a track, click the Select tool, select the line twice, then 

type the label in the text box that displays next to the track. 
• Reshape the track by dragging any of the points in the line to a new location. 

When you select a shape point of a line segment within an active line: 
• A small green circle indicates the start end point of the selected track 

segment. 
• A small red circle indicates the last end point of the selected track 

segment. 
• Select the Coordinate or the Distance and Bearing/Angle option and edit 

their numbers. Click Apply to initiate the changes. 
6. Click Done to finish your edit. 

OR 
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Press the ENTER key on your keyboard. 
OR 
Click outside the object's active box on the map. 

Placing a Routable Road, Line, Arc, or Spline at a Specific 
Location 
You can place any line object (routable road, line, arc, or spline) at a specific coordinate 
location. 

To Place a Line Object at a Specific Location 

Use the following steps to place your line object at a specific coordinate location. 
1. Click the Draw tab. 

2. To place a routable road, click the Routable Road tool . 
OR 

To place a line/arc/spline, click and hold the Line/Arc/Spline tool  and 
select the tool you want. Then, select the line, style, width (if available), and color 
for your line/arc/spline. 

3. Select the Coordinate option, or use the Distance and Bearing/Angle option in 
conjunction with the Coordinate option, and enter the appropriate coordinates or 
numbers into the corresponding text boxes to the right of the text style options box. 
Note  If you are placing an arc, enter new numbers into the Distance and 
Bearing/Angle text boxes for the two base points of the arc only. When the central 
shape point of the arc is selected, the text options change from Distance and 
Bearing/Angle to Radius and Direction. Enter the appropriate radius number and 
direction to change the radius for this point. 

4. Click Apply and repeat the procedure for the second point. 
The line object displays on the map at those coordinates, distance, and bearing or 
angle. 
OR 
After placing the first point coordinate, move your pointer to the map screen and 
place the other points by hand by clicking on the screen. 

5. To place additional points, lines, or other draw objects on the map in reference to the 
first line, enter a specific distance and bearing into the corresponding text boxes and 
click Apply. 

Joining and Breaking Linear Objects 
You can join two or more routable roads, tracks, lines, arcs, or splines into a single entity. 
You can also break routable roads, tracks, lines, or splines. You cannot break arcs. 

To Join 

Use the following steps to join linear objects. 
1. Click the Draw tab. 

2. Click the Select tool , press and hold the SHIFT key on the keyboard, and select 
any lines, arcs, or splines you want to join. 
OR 
Click the Select tool  and drag a box around the linear objects you want to join. 
Note  When joining the preceding types of line objects, you can mix and match lines, 
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arcs, and splines. The result is always a line. However, when you join multiple 
splines, the resulting joined object is a spline. 

3. Right-click, point to Manage Draw, and then click Join Lines. 
OR 
Join the lines by pressing CTRL+J or the keyboard shortcut combination you assigned 
for the joining function. 
The selected lines are joined. 
Note  Any other objects selected during the multi-select process are ignored. 

To Break 

Use the following steps to break linear objects. 
1. Click the Draw tab. 

2. Click the Select tool  and select the line object you want to break. 
• A box displays around the active line. 
• The shape points used to create the line display as small, magenta squares. 

3. Click the shape point where you want to break the line, right-click, point to Manage 
Draw, and then click Break Line. 
OR 
Break the line by pressing CTRL+B or the keyboard shortcut combination you 
assigned for the breaking function. 
The line is broken into two segments at the designated point and you can edit each 
line separately. 
Note  It is important that you perform steps 2 and 3 consecutively. If you pan the 
map, use another tab, and so on between steps, you may need to repeat the steps 
again to break your linear object. 

Circles, Rectangles, and Polygons 

Drawing a Circle, Rectangle, or Polygon on the Map 
You can add area objects (circles, rectangles, and polygons) to a draw file in your current 
map file. Area objects are those objects consisting of one or more closed line objects. 

• Use circles to designate circular map features. 
• Use rectangles to designate land boundaries or any other rectangular map feature. 
• Use polygons to designate water bodies, land boundaries, or any other irregular 

map feature. 
Once you have created an area draw object, you can edit (including reshaping or changing 
line color or weight), copy, move, or delete it at any time. 
Note  The best way to measure a large area on the map is with the circle, rectangle, and 
polygon tools in the Draw tab. When you draw an area object on the map, the area displays 
next to the object on the map. If you click off of the object, you can view the area again by 
clicking the Select tool in the Draw tab and then clicking the area object on the map. 

To Draw a Circle, Rectangle, or Polygon 

Use the following steps to add circles, rectangles, or polygons to the map. 
1. Click the Draw tab. 
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2. Click and hold the Polygon/Rectangle/Circle tool  to view its hidden 
options. Select the tool you want. 
  

3. From the Fill drop-down list, select the fill style you want to apply to the area object. 
4. Click the Fill Color button to the right of the Fill drop-down list to select the color 

for your fill style. 
5. Select an outline style for your circle from the Outline drop-down list. 
6. Click the outline color button to select a color for the outline of your area object. 
7. Select the width for your area object outline from the Width drop-down list. 
8. Select the Show Measurement check box to display area (and radius information 

for circles) on the map as you draw the object. 
9. To draw a circle, click the location for the circle's center on the map and drag away 

from center to set the radius for the circle. Release as soon as you achieve the radius 
you want. The radius of the circle and the coordinates of the circle's center display in 
the corresponding text boxes to the right of the circle fill option area. 
OR 
To draw a rectangle, click the location for the rectangle's upper-left corner on the 
map and drag away from the corner to set the width, height, and area for the 
rectangle. Release as soon as you achieve the size you want. The coordinates of the 
upper-left corner point display in the corresponding text boxes to the right of the fill 
options. The distance and bearing/angle of the final corner point from the first corner 
point display in the corresponding text boxes to the right of the fill options. 
OR 
To draw a polygon, click the map to enter each point of the polygon. The 
coordinates of each point display in the corresponding text boxes to the right of the 
fill options. The distance and bearing/angle of each new point from its previous point 
display in the corresponding text boxes. Labels display when end points are clicked if 
the Show Measurement check box is selected. 

10. Click the Select tool  and then click the area object on the map. 
A box displays around the object indicating that it is active. 

11. Click the object again. A text box displays. Type the label in the text box and press 
the ENTER key on your keyboard. 

Editing a Circle, Rectangle, or Polygon 
Once you have created an area draw object, you can edit (including reshaping or changing 
line color or weight), copy, move, or delete at any time. 

To Edit a Circle, Rectangle, or Polygon 

Use the following steps to edit an area draw object. 
1. Open the map file containing the draw file with the area object you want to edit. 
2. Click the Draw tab. 
3. If the object you want to edit is not in the active draw file, click File and select the 

draw file from the draw file dialog area. Then, click Done. The Draw dialog area 
displays. 

4. Click the Select tool  and then click the object on the map. 
A box displays around the object indicating that it is active. 
OR 
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To edit multiple objects, click the Select tool  and then drag a box around the 
objects that you want to edit. 

5. Change the object's fill, outline, and/or width option. 
OR 
If you selected a single circle, drag one of the magenta squares around the circle to 
change the circle's size. The center of the circle remains in its original location. 
OR 
If you selected a single rectangle, click one of the corner points of the rectangle and 
drag to change its width, height, and area on the map. 
OR 
If you selected a single polygon, click one of the shape points of the polygon and 
drag to change its bearing or angle, the leg length, and polygon area on the map. 
Reshape the polygon by dragging any of the points in the polygon to a new location. 
When you select a shape point of a line segment within an active polygon, a small 
green circle indicates the start end point of the selected line segment and a small red 
circle indicates the last end point of the selected line segment. Select the 
Coordinate option or the Distance and Bearing/Angle option and edit their 
numbers. Click Apply to initiate the changes.  
Notes  You can display either bearing or distance by clicking the drop-down arrow 
next to the Bearing or Angle text located below the distance text in the Distance and 
Bearing/Angle option. You can also delete points and line segments from or add 
points to a polygon. 

6. Press the ENTER key on your keyboard to finish your edit. 
OR 
Click outside the object's active box on the map. 

Placing a Circle, Rectangle, or Polygon on the Map 
You can place any area object (circle, rectangle, or polygon) at a specific coordinate 
location. 

To Place an Area Object on the Map 

Use the following steps to place a circle, rectangle, or polygon on the map. 
1. Click the Draw tab. 

2. Click and hold the Polygon/Rectangle/Circle tool  and select the tool 
you want. 

3. Select the circle fill, outline, and/or width options. 
4. To place a circle on the map, enter the coordinates for the circle's center into the 

corresponding text boxes. Then, enter the radius for the circle into the radius text 
box. 
OR 
To place a rectangle on the map, select the Coordinate option or use the Distance 
and Bearing/Angle option in conjunction with the Coordinate option. Enter the 
appropriate coordinates or numbers for the rectangle's upper-left corner point into 
the corresponding text boxes to the right of the fill options box. 
OR 
To place a polygon on the map, select the Coordinate option or use the Distance 
and Bearing/Angle option in conjunction with the Coordinate option, and enter 
the appropriate coordinates or numbers for the first polygon point into the 
corresponding text boxes to the right of the fill options box. 
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5. Click Apply. 
Note  If you are placing a polygon on the map, repeat the procedure for the other 
points. 

Waypoints, Symbols, MapNotes, Text Labels, and Images 

Adding a Waypoint, Symbol, MapNote, Text Label, or 
Image to the Map 
You can add point draw objects to a draw file in your current map file. Point objects consist 
of one anchor point attached to a waypoint, symbol, MapNote, image, or text label. The 
anchor point is the pixel position on the symbol that corresponds to the geographic 
coordinate of the point selected on the map when the symbol is placed. 

• Use the Waypoint tool to label waypoints on a map. You can exchange waypoints 
with a GPS receiver. 

• Use the Symbol tool to identify certain areas on the map such as houses, 
monuments, or points of interest. 

• Use the MapNote tool to point to and label a specific area on the map. See Map 
Notes for more information. 

• Use text labels to name features or give details about features on the map. 
• Use the Image tool to add, edit, or place .bmp, .jpg, and .gif images on the map. 

To Add a Point Object to the Map 

Street Atlas USA Plus 
• Add a MapNote, text label, or symbol 

From the Draw tab: 
1. Click and hold the MapNote/Text/Label/Symbol/Image tool and select 

the tool you want. Then, select the  font, style, size, and color for your point 
object's label from the text style options. 

2. Click the location for the point object on the map. 
The URL/Label text box opens. 

3. Optional. Click the Hyperlink button  and browse to the document you 
want to link your point object to. Then, click the file name and click Open. 
The address appears in the URL field. 

4. Type the name or phrase into the Label field. The coordinates or distance and 
bearing/angle numbers of the location appear in the corresponding 
Coordinate or Distance and Bearing/Angle text boxes. 

5. Press the ENTER key on your keyboard or click the map outside of the 
object's active area when you are finished. 

Notes 
These steps describe how to add Draw MapNotes. To show/delete Route MapNotes, 
see Setting Your Routing Preferences. 
You can also add a MapNote by right-clicking the map on the point you want to label, 
pointing to Add MapNote, and then selecting a MapNote option. 

• Add a waypoint 
From the Draw tab: 
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1. Click and hold the Tracks/Waypoints tool and select Waypoint . Then, 
select the waypoint symbol from the Symbols options. You can also select a 
different font, style, size, and color for the waypoint name. 

2. Click the location for the point object on the map. 
The URL/Label text box opens. 

3. Optional. Click the Hyperlink button  and browse to the document you 
want to link your point object to. Then, click the file name and click Open. 
The address appears in the URL field. 

4. Type the name or phrase into the Label field. The coordinates or distance and 
bearing/angle numbers of the location appear in the corresponding 
Coordinate or Distance and Bearing/Angle text boxes. 

5. Press the ENTER key on your keyboard or click the map outside of the 
object's active area when you are finished. 

• Add an image 
From the Draw tab: 

1. Click and hold the MapNote/Text Label/Symbol/Image tool and select 

Image . Under Images, select an existing image, or click Add, browse to 
an image, and click Open to add a new image to your Images selection. 
Note  To delete an image from the Images selection, select the image and 
then click Delete. 

2. Click the location for the point object on the map. 
The URL/Label text box opens. 

3. Optional. Click the Hyperlink button  and browse to the document you 
want to hyperlink your point object to. The address appears in the URL field. 

4. Type the name or phrase into the Label field. The coordinates or distance and 
bearing/angle numbers of the location appear in the corresponding 
Coordinate or Distance and Bearing/Angle text boxes. 

5. Press the ENTER key on your keyboard or click the map outside of the 
object's active area when you are finished. 

Regular Street Atlas USA 
• Add a MapNote, text label, or symbol 

From the Draw tab: 
1. Click and hold the MapNote/Text/Label/Symbol/Image tool and select 

the tool you want. Then, select the  font, style, size, and color for your point 
object's label from the text style options. 

2. Click the location for the point object on the map. 
The Label text box opens. 

3. Type the name or phrase into the Label field. The coordinates or distance and 
bearing/angle numbers of the location appear in the corresponding 
Coordinate or Distance and Bearing/Angle text boxes. 

4. Press the ENTER key on your keyboard or click the map outside of the 
object's active area when you are finished. 

Notes 
These steps describe how to add Draw MapNotes. To show/delete Route MapNotes, 
see Setting Your Routing Preferences. 
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You can also add a MapNote by right-clicking the map on the point you want to label, 
pointing to Add MapNote, and then selecting a MapNote option. 

• Add a waypoint 
From the Draw tab: 

1. Click and hold the Tracks/Waypoints tool and select Waypoint . Then, 
select the waypoint symbol from the Symbols options. You can also select a 
different font, style, size, and color for the waypoint name. 

2. Click the location for the point object on the map. 
The Label text box opens. 

3. Type the name or phrase into the Label field. The coordinates or distance and 
bearing/angle numbers of the location appear in the corresponding 
Coordinate or Distance and Bearing/Angle text boxes. 

4. Press the ENTER key on your keyboard or click the map outside of the 
object's active area when you are finished. 

• Add an image 
From the Draw tab: 

1. Click and hold the MapNote/Text Label/Symbol/Image tool and select 

Image . Under Images, select an existing image, or click Add, browse to 
an image, and click Open to add a new image to your Images selection. 
Note  To delete an image from the Images selection, select the image and 
then click Delete. 

2. Click the location for the point object on the map. 
The Label text box opens. 

3. Type the name or phrase into the Label field. The coordinates or distance and 
bearing/angle numbers of the location appear in the corresponding 
Coordinate or Distance and Bearing/Angle text boxes. 

4. Press the ENTER key on your keyboard or click the map outside of the 
object's active area when you are finished. 

Tip Search for a point object by its label name using the QuickSearch function in the Find 
tab or by typing the label name in the Start, Finish, Stop, or Via text boxes when creating 
a route in the Route tab. 

Editing a Waypoint, Symbol, MapNote, Text Label, or 
Image 
Once you add a point object to a draw file, you can edit (name only), copy, move, or delete 
it at any time. You can edit multiple point objects at the same time by dragging a box 
around the objects you want to edit. Any changes are made to all of the point objects 
included in the box. 

To Edit a Point Object 

Use the following steps to edit a waypoint, symbol, MapNote, text label, or image. 
1. Click the Draw tab. 

2. Click the Select tool  and then click the point object on the map twice. 
3. Type a new name or phrase in the Label field, change the name's font, style, size, or 

color; select a new symbol; or click the Hyperlink button to change the URL 
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address. 
Note  The Hyperlink button is available only in Street Atlas USA Plus. 

4. Press the ENTER key on your keyboard or click the map outside of the point object's 
active area when you are finished. 

Placing a Waypoint, Symbol, Text Label, or Image at a 
Specific Location 
You can place any point object (waypoint, symbol, text label, or image) at a specific 
coordinate location. 

To Place a Point Object at a Specific Location 

Use the following steps to place a waypoint, symbol, text label, or image at a specific 
coordinate location. 

1. Click the Draw tab. 

2. To place a waypoint, click and hold the Track/Waypoint tool  and select the 
Waypoint tool . Select the waypoint symbol from the Symbols options. You can 
also select a different font, style, size and color for the waypoint name. 
OR 
To place a symbol, click and hold the MapNote/Text Label/Symbol/Image tool 

  and select the Symbol tool . Select the symbol from the 
Symbol Selection list. You can also select a different font, style, size and color for 
the symbol name. 
OR 
To place a text label, click and hold the MapNote/Text Label/Symbol/Image tool 
and select the Text Label tool . Select the font, style, size, and color from the 
text style options. A sample of how your text display appears to the left of the 
options. 
OR 
To place an image, click and hold the MapNote/Text Label/Symbol/Image tool 

to view its hidden options. Select the Image tool . Under Images, select an 
existing image or click Add, browse to an image, and click Open to add a new image 
to your Images selection. 

3. Select the Coordinate option, or use the Distance and Bearing/Angle option in 
conjunction with the Coordinate option, and type the appropriate coordinates or 
numbers into the corresponding text boxes to the right of the text style options box. 

4. Click Apply. The point object displays on the map at those coordinates, distance, 
and bearing or angle. 

5. If you are placing a text label, enter the text and press the ENTER key on your 
keyboard or click the map outside of the text label active area when you are finished. 

Moving and Deleting Draw MapNotes 
You can add your own MapNotes to a map. MapNotes have a white background that make 
them highly visible on the map. They can contain multiple lines of text and can be moved 
off of the labeled area without losing their visual links with the points. You can use 
MapNotes for directions or explanations. 
Notes 
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• This Help topic describes the steps necessary to move and delete Draw MapNotes. To 
show/delete Route MapNotes, see Setting Your Routing Preferences. 

• When you use right-click functionality to add a MapNote, it is light blue unless it is a 
blank MapNote. 

• You can search for a MapNote by its label name using the QuickSearch function in 
the Find tab or by typing the label name in the Start, Finish, Stop, or Via text 
boxes when creating a route in the Route tab. 

To Move a MapNote 

Use the following steps to move a MapNote. 
1. Click the Draw tab. 

2. Click the Select tool . 
3. Click the MapNote to select it. 

The MapNote is enclosed with a box. 
4. You can: 

• Drag the stem to a new location to move the MapNote. 
• Drag the text box to a new location, leaving the anchor point in the same 

location on the map. 
• Drag the anchor point to a new location, leaving the text box in the same 

location on the map. 

 

To Delete a MapNote 

Use the following steps to delete a MapNote. 
1. Click the Draw tab. 

2. Click the Select tool . 
3. Click the MapNote to select it. 
4. Press the DELETE key on your keyboard. 

Custom Symbols 

Custom Symbols Overview 
DeLorme XSym lets you create and edit your own symbols, which you can edit and add to 
maps within DeLorme mapping programs. The symbols created are 24 x 24 pixels. New and 
edited symbols are saved within a symbol set (.dim file) and can contain up to 250 symbols. 
Symbol set files are located at C:\DeLorme Docs\Symbols. 

The DeLorme XSym Dialog Box 
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The XSym dialog box provides all the tools you need to create and edit symbols for your 
DeLorme mapping program. Click an area on the diagram below to view information on the 
various parts of the dialog box. 
Tip  To close the pop-up information box that displays when you click the diagram, click 
outside the image or click another part of the image. 
  

 
  

Creating a New Symbol 
With DeLorme XSym you can add a new symbol to an existing or new symbol set (.dim) file. 
You can assign a new category name for the symbol to help locate it under the Find tab in 
the DeLorme mapping program. 

To Create a New Symbol 

Use the following steps to create a new symbol. 
1. Click the Draw tab. 

2. Click and hold the Symbol/MapNote/Text Label/Image tool  to 
view its hidden options. Select the Symbol tool . 

3. Under Symbols, select the symbol set you want to add your new symbol to from the 
drop-down list OR select New to create a new symbol set. 

4. Under Symbols, click Edit to display the DeLorme XSym dialog box. 
5. Under Symbols in Set, click New to clear the Symbol Editing Grid. 
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6. Use the tools in the Draw Tool Box and the tools under Transparency and Anchor to 
create the new symbol. 

• To undo the last action, click the Undo button  under Edit Symbol. 
• To repeat the last action, click the Redo button  under Edit Symbol. 

7. To assign a symbol name to the current symbol, type a name or phrase in the 
Symbol Name text box under Edit Symbol. 
Note  Once a name is assigned to a symbol in a symbol set, each occurrence of that 
symbol placed on the map retains the new symbol name in addition to the default 
symbol name of "symbol." 

8. Click OK when finished. 
Notes   

• As you create a symbol, an image preview displays to the upper-left of the Symbol 
Editing Grid. You can make edits to the symbol in either the Image Preview or the 
Symbol Editing Grid. Any edits done in one view are mirrored in the other view. 

• See also:  Importing a Bitmap, Copying and Pasting, Pasting a Bitmap into XSym, 
Dragging a Bitmap into XSym 

GPS Device Custom Symbols 
You can create a custom symbol set that includes all of the waypoint symbols on your third-
party GPS device. By creating this custom symbol set, the waypoints you create display the 
same in both the mapping application and on your third-party GPS device, no matter where 
they originated. 
Third-party GPS waypoint symbols are identified by their waypoint ID number, which is 
assigned by the device's manufacturer. To successfully view third-party GPS waypoint 
symbols in the mapping application, you must assign the proper waypoint identification 
number to each symbol you add to the custom symbol set. 
Important  To create a custom symbol set of your third-party GPS device's waypoint 
symbols, you must contact the device's manufacturer to obtain the graphic files and the 
waypoint ID number associated with each symbol. 

To Assign a Waypoint ID to a Custom Symbol 

Use the following steps to assign a waypoint ID to a custom symbol. 
1. Click the Draw tab. 

2. Click and hold the Waypoint/Track tool  to view its hidden options. Select 
the Waypoint tool . 

3. Create a new symbol set. 
4. Paste the third-party GPS device's waypoint symbol into XSym. 
5. Use the transparency option to make the area behind the symbol transparent. 
6. Type the waypoint identification number for the symbol in the Waypoint ID text 

box. 
7. For each additional symbol, click New and then repeat steps 4–7. 
8. Click OK when finished. 

Notes 
• Waypoint ID numbers vary by manufacturer and model.    
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• If you import multiple waypoints from a third-party GPS device without assigning a 
waypoint ID to each first, all of the waypoints display in the mapping application with a 
single default symbol. 

• If you do not know the identification number for a third-party GPS device's waypoint, 
import the waypoint file into the mapping application. Then, use one of the two 
methods below to learn the waypoint ID: 
o Open the symbol set that holds the waypoint and view the waypoint's ID number in 

XSym. 
o Click the Info tool on the toolbar and click the symbol on the map. 

The waypoint ID displays in the Info tab. 
  

Editing a Symbol 
With DeLorme XSym, you can edit an existing symbol in a symbol set (.dim) file and save 
the change or save it as a new symbol to be added to another symbol set. You can assign a 
new category name for the symbol to help locate it under the Find tab in the DeLorme 
mapping program. 

To Edit a Symbol 

Use the following steps to edit a symbol. 
1. Click the Draw tab. 

2. Click and hold the Symbol/MapNote/Text Label/Image tool to 
view its hidden options. Select the Symbol tool . 

3. Under Symbols, select the symbol set that contains the symbol you want to edit. 
4. Click Edit. The DeLorme XSym dialog box opens. 
5. Select the symbol you want to edit from the symbol selection of the default symbol 

set or from another symbol set you have created. The symbol displays in the Symbol 
Editing Grid. 

6. Use the tools in the Draw Tool Box and under Transparency and Anchor to edit the 
symbol. 

• To undo the last action, click the Undo button  under Edit Symbol. 
• To repeat the last action, click the Redo button  under Edit Symbol. 

7. To assign a symbol name to the current symbol, type a name or phrase in the 
Symbol Name text box under Edit Symbol. 
Note  Once you assign a name to a symbol in a symbol set, each occurrence of that 
symbol you place on the map retains the new symbol name in addition to the default 
symbol name of "symbol." 

8. Click OK when finished. 
Note   

• As you create a symbol, an image preview displays to the upper-left of the Symbol 
Editing Grid. You can make edits to the symbol in either the Image Preview or the 
Symbol Editing Grid. Any edits done in one view are mirrored in the other view. 

• See also:  Importing a Bitmap, Copying and Pasting, Pasting a Bitmap into XSym, 
Dragging a Bitmap into XSym 
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Finding a Custom Symbol 
The symbol name you assign to a symbol in XSym is different than the label you attach to 
the symbol on the map using the symbol draw tool. You can use the symbol name to help 
locate a custom symbol you have already placed on a map using the Advanced feature 
under the Find tab. 

To Find a Custom Symbol 

Use the following steps to find a symbol by its symbol name. 
1. Click the Find tab and then click Advanced. 
2. Select Category from the Find drop-down list 
3. Select the applicable option from the Within drop-down list. 
4. Type the symbol name in the Keywords text box. 
5. Click Search. 
6. Click OK. 

The closet matches display in the list view to the right of the Search For text box. 
The Symbol Name displays in the Map Feature Type column just before the symbol's 
feature type (draw object). 

7. Double-click the item or select the item and click Go To to locate your selection on 
the map. 
The map view centers on the item. If you assigned a name for the symbol under the 
Draw tab, a MapTag displays the name at the symbol location. 
If you did not assign a name for the symbol, a MapTag displays the Symbol Name at 
the symbol location. 

Notes 
• If you do not assign a symbol name to a symbol in XSym, you can locate it with the 

generic keyword of "symbol" or by the name or phrase given the symbol in the Draw 
tab. For more information, see Finding a Symbol by its Name. 

• If you assigned a Symbol Name to a custom symbol in XSym and placed the symbol 
on the map, the Symbol Name displays in the demographic information area when 
you right-click the symbol and select Info. 

  

Importing a Bitmap 
You can import a bitmap into DeLorme XSym to use as a symbol, but any bitmap you 
import must be 24 x 24 pixels or less. You can assign a new category name for the symbol 
to help locate it under the Find tab in the DeLorme mapping program. 

To Import a Bitmap 

Use the following steps to import a bitmap to use as a symbol. 
1. Click the Draw tab. 

2. Click and hold the Symbol/MapNote/Text Label/Image tool  to 
view its hidden options. Select the Symbol tool . 

3. Under Symbols, click Edit. 
The DeLorme XSym dialog box opens. 

4. Under Symbols in Set, click New to clear the Symbol Editing Grid. 
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5. Click Import to display the Open Bitmap File dialog box. Browse to the location of 
the bitmap and click Open. 
The imported bitmap displays in the Symbol Editing Grid. See important Notes 
below. 

6. Use the tools in the Draw Tool Box and under Transparency and Anchor to edit the 
symbol. 

• To undo the last action, click the Undo button  under Edit Symbol. 
• To repeat the last action, click the Redo button  under Edit Symbol. 

7. To assign a symbol name to the current symbol, type a name or phrase in the 
Symbol Name text box under Edit Symbol. 
Note  Once you assign a name to a symbol in a symbol set, each occurrence of that 
symbol you place on the map retains the new symbol name in addition to the default 
symbol name of "symbol." 

8. Click OK when finished. 
Notes 

• If you attempt to import a bitmap larger than 24 x 24 pixels into XSym, a message 
box warns you the selected bitmap is larger than 24 x 24 pixels and the image is 
reduced. 

• If the bitmap is less than 24 x 24 pixels, the remaining area is filled to the edge of 
the Symbol Editing Grid with one of the symbol pixel colors. 

• As you create a symbol, an image preview displays to the upper-left of the Symbol 
Editing Grid. You can make edits to the symbol in either the Image Preview or the 
Symbol Editing Grid. Any edits done in one view are mirrored in the other view. 

  

Copying and Pasting 
You can copy and paste portions of a symbol or whole symbols to create new symbols or 
edit existing ones. 

To Copy and Paste in XSym 

Use the following steps to copy a symbol or portions of a symbol to edit an existing symbol 
or to create a new symbol. 

1. Click the Draw tab. 

2. Click and hold the Symbol/MapNote/Text Label/Image tool  to 
view its hidden options. Select the Symbol tool . 

3. Under Symbols, select the symbol set that contains the symbol you want to edit. 
4. Click Edit. 

The DeLorme XSym dialog box opens. 
5. Under Symbols in Set, select a symbol from the symbol selection. 
6. In the Draw Tool Box, click the Select tool. 
7. Select the area of the symbol you want to copy or select the whole symbol, and then 

click the Copy button  under Edit Symbol. 

8. Click the Paste button  under Edit Symbol. The copied image is pasted into the 
current symbol in the Symbol Editing Grid. Drag the pasted piece into the place you 
want it within the current symbol. 



Street Atlas USA User Guide 

166 

OR 
To create a new symbol with the copied image, click New under Symbols in Set to 
clear the Symbol Editing Grid, and then click the Paste button to add the pasted 
image into the grid. 
Note  You can assign a new symbol name for the symbol to help locate it under the 
Find tab in the DeLorme mapping program. To assign a symbol name to the current 
symbol, type a name or phrase in the Symbol Name text box under Edit Symbol. 

9. Click OK when finished. 
Notes 

• To undo an action, click the Undo button  under Edit Symbol. 
• To repeat an action, click the Redo button  under Edit Symbol. 

  

Pasting a Bitmap into XSym 
You can copy a bitmap or part of a bitmap to the clipboard and paste the image into 
DeLorme XSym to use as a symbol. Ideally, the pasted bitmap should be 24 x 24 pixels in 
size. You can assign a new symbol name for the symbol to help locate it under the Find tab 
in the DeLorme mapping program. 

To Paste a Bitmap into XSym 

Use the following steps to paste a bitmap into XSym. 
1. Click the Draw tab. 

2. Click and hold the Symbol/MapNote/Text Label/Image tool  to 
view its hidden options. Select the Symbol tool . 

3. Under Symbols, select the symbol set that contains the symbol you want to edit. 
4. Click Edit. 

The DeLorme XSym dialog box opens. 
5. Under Symbols in Set, click New to clear the Symbol Editing Grid. 
6. Open a bitmap in another image editing program, and select the bitmap or a part of 

the bitmap you want to copy. Press CTRL+C on your keyboard to copy the selection 
to the clipboard. 

7. Click the Paste button  under Edit Symbol. 
The copied image is pasted into the current symbol in the Symbol Editing Grid. See 
important Notes below. 

8. Use the tools in the Draw Tool Box and under Transparency and Anchor to edit the 
symbol. 

• To undo the last action, click the Undo button  under Edit Symbol. 
• To repeat the last action, click the Redo button  under Edit Symbol. 

9. To assign a symbol name to the current symbol, type a name or phrase in the 
Symbol Name text box under Edit Symbol. 

10. Click OK when finished. 
Notes 

• If you attempt to import a bitmap larger than 24 x 24 pixels into XSym, a message 
box warns you the selected bitmap is larger than 24 x 24 pixels and the image is 
reduced. 
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• If the bitmap is less than 24 x 24 pixels, the remaining area is filled to the edge of 
the Symbol Editing Grid with one of the symbol pixel colors. 

• As you create a symbol, an image preview displays to the upper-left of the Symbol 
Editing Grid. You can make edits to the symbol in either the Image Preview or the 
Symbol Editing Grid. Any edits done in one view are mirrored in the other view. 

Dragging a Bitmap into XSym 
You can drag a bitmap into DeLorme XSym to use as a symbol. Using drag to bring in an 
image is much like importing a bitmap into XSym. Ideally, the new bitmap should be 24 x 
24 pixels in size. You can assign a new symbol name for the symbol to help locate it under 
the Find tab in the DeLorme mapping program. 

To Drag a Bitmap into XSym 

Use the following steps to drag a bitmap into XSym. 
1. Click the Draw tab. 

2. Click and hold the Symbol/MapNote/Text Label/Image tool  to 
view its hidden options. Select the Symbol tool . 

3. Under Symbols, select the symbol set that contains the symbol you want to edit. 
4. Click Edit. 

The DeLorme XSym dialog box opens. 
5. Under Symbols in Set, click New to clear the Symbol Editing Grid. 
6. Browse your computer to locate the bitmap (.bmp) file. 
7. Drag the file into XSym. 

The bitmap image displays in the Symbol Editing Grid. See important Notes below. 
8. Use the tools in the Draw Tool Box and under Transparency and Anchor to edit the 

symbol. 
• To undo the last action, click the Undo button  under Edit Symbol. 
• To repeat the last action, click the Redo button  under Edit Symbol. 

9. To assign a symbol name to the current symbol, type a name or phrase in the 
Symbol Name text box under Edit Symbol. 

10. Click OK when finished. 
Notes 

• If you attempt to import a bitmap larger than 24 x 24 pixels into XSym, a message 
box warns you the selected bitmap is larger than 24 x 24 pixels and the image is 
reduced. 

• If the bitmap is less than 24 x 24 pixels, the remaining area is filled to the edge of 
the Symbol Editing Grid with one of the symbol pixel colors. 

• As you create a symbol, an image preview displays to the upper-left of the Symbol 
Editing Grid. You can make edits to the symbol in either the Image Preview or the 
Symbol Editing Grid. Any edits done in one view are mirrored in the other view. 

Removing a Symbol 
You can remove a symbol from the default symbol set or from any other symbol set you 
have created. 

To Remove a Symbol 
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Use the following steps to remove a symbol from a symbol set. 
1. Click the Draw tab. 

2. Click and hold the Symbol/MapNote/Text Label/Image tool  to 
view its hidden options. Select the Symbol tool . 

3. Under Symbols, select the symbol set that contains the symbol you want to edit. 
4. Click Edit. 

The DeLorme XSym dialog box opens. 
5. Select the symbol to remove from the symbol selection. 

The symbol displays in the Symbol Editing Grid. 
6. Click Remove. 

The symbol disappears from the symbol selection under Symbols in Set and the 
next symbol within the selection displays in the Symbol Editing Grid. 

7. Click OK when finished. 
  

Symbol Editing Tools 

Draw Tool Box 
DeLorme XSym has a Draw Tool Box that lets you create and edit symbols within the 
Symbol Editing Grid independently of the DeLorme mapping program. The tools provided 
help you to create unique symbols to add to your map. 
  
The following are the tools available in the Draw Tool Box. 

 

Pencil—Draw freehand lines within the grid. 

 

Line—Draw lines by clicking and dragging to the end point you want within the 
grid. 

 

Ellipse—Create an ellipse by clicking and dragging until you achieve the size or 
shape of the ellipse you want. 

 

Filled Ellipse—Create a filled ellipse by clicking and dragging until you achieve 
the size or shape of the filled ellipse you want. 

 

Rectangle—Create a rectangle by clicking and dragging until you achieve the 
size of the rectangle you want. 

 

Filled Rectangle—Create a filled rectangle by clicking and dragging until you 
achieve the size of the filled rectangle you want. 

 

Fill—Use the fill tool to fill an area of the grid with a color chosen from the color 
palette. 

 

Select—Use select to choose an area of the symbol to copy from the Symbol 
Editing Grid and then paste into the same symbol or another symbol in the grid. 

Using the Transparency Option 
The transparency option in DeLorme XSym lets you display a selected color as transparent 
in the final symbol image you place on a map within a DeLorme mapping program. For 
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example, you may want to view the symbol object without the square of the surrounding 
background color. You would then select the background color to appear transparent. 

To Make Part of a Symbol Transparent 

Use the following steps to make part a symbol transparent. 
1. Click the Draw tab. 

2. Click and hold the Symbol/MapNote/Text Label/Image tool  to 
view its hidden options. Select the Symbol tool . 

3. Under Symbols, select the symbol set that contains the symbol you want to edit. 
4. Click Edit. 

The DeLorme XSym dialog box opens. 
5. Select the symbol you want to edit from the Symbol Selection. 

The symbol displays in the Symbol Editing Grid. 
6. Select the Transparent option under Transparency. 

7. Click the Select Color tool . 
The pointer changes to a dropper tool. 

8. Select the color on the symbol you want to appear transparent. 
The Transparent Color display box updates with the selected color, and the Image 
Preview displays the chosen color area as transparent. 

9. To display all colors, select the Opaque option under Transparency. 
The Image Preview reflects this change. 

10. Click OK when finished. 
Note  Be sure the color in the symbol you want to appear transparent is not repeated in 
another part of the symbol you want to display as opaque. Select a new color from the color 
palette and fill the area on the symbol you want to display as transparent with the new 
color. Use the Select Color tool to select the new color in the symbol grid. 

Anchor Position 
Being aware of Cursor Position is important for choosing the anchor position of a symbol. 
The anchor is the pixel position on the symbol that corresponds to the geographic 
coordinate of the point selected on the map when the symbol is placed. Any newly created 
symbol, whether imported, pasted or dragged into the XSym Symbol Editing Grid, has a 
default position of center anchor. 
XSym lets you change the anchor position of your symbol. 

To Select the Anchor Position 

Use the following steps to select the anchor position of a symbol. 
  

1. Once your symbol is created, click the Anchor Position  button. 
When you pass your pointer over the Symbol Editing Grid, it changes to a small cross 
hair (plus sign). 

2. Click the pixel grid within the symbol to position your anchor. 
The anchor location pixel coordinate numbers display after the position text to the 
right of the Anchor Position button. The large cross hair in the Symbol Editing Grid 
moves from its default anchor position to the new anchor position. 
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To Center the Anchor Position 

Click Center Anchor to place the anchor point in the exact center of the Symbol Editing 
Grid. 

Cursor Position 
Any symbol created in XSym is 24 x 24 pixels square. Each of these pixels is represented in 
the Symbol Editing Grid. When you move your cursor over the Symbol Editing Grid, the 
cursor position by pixel number displays to the right of the Cursor Position text next to the 
Image Preview (as shown below). 
Image Preview and Cursor Position 

 
As you move the cursor over the grid, the numbers update according to where you are in 
the 24 x 24 grid. The first number in the above sample, 16, refers to the number of pixels 
across (the X coordinate) from the upper left corner of the grid, beginning with zero. The 
second number, 14, refers to the number of pixels down (the Y coordinate) from the upper-
left corner of the grid, beginning with zero. 

Symbol Sets 

Creating a New Symbol Set 
Symbols created in DeLorme XSym are saved within a symbol set (.dim file) which can 
contain up to 250 symbols. 

To Create a New Symbol Set 

Use the following steps to create a new symbol set. 
1. Click the Draw tab. 

2. Click and hold the Symbol/MapNote/Text Label/Image tool  to 
view its hidden options. Select the Symbol tool . 

3. Under Symbols, select [New...] from the drop-down list. 
The DeLorme XSym dialog box opens. 

4. Under Symbol Set Name, type the name for your new symbol set. The default 
name for the new symbol set is CustomSymbolSet. 

5. Import a bitmap into your new symbol set. 
OR 
Create a new symbol to add to your new symbol set. 

  

To Create a New Symbol Set from an Existing Symbol Set 

You can make a copy of an existing symbol set and save it as a custom symbol set. 
1. Click the Draw tab. 

2. Click and hold the Symbol/MapNote/Text Label/Image tool  to 
view its hidden options. Select the Symbol tool . 

3. Under Symbols, select the symbol set you want to copy from the drop-down list. 
The DeLorme XSym dialog box opens. 
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4. Under Symbol Set Name, type the name for your new symbol set. 
You can edit symbols, create symbols, or import bitmaps for your new symbol set. 

  

Opening a Symbol Set 
Open an existing symbol set (.dim) to add new symbols or edit existing ones. 

To Open a Symbol Set 

Use the following steps to open a symbol set. 
1. Click the Draw tab. 

2. Click and hold the Symbol/MapNote/Text Label/Image tool  to 
view its hidden options. Select the Symbol tool . 

3. Under Symbols, select the symbol set from the drop-down list. 
The DeLorme XSym dialog box opens. The symbol selection for the new symbol set 
displays under Symbols in Set and the Symbol Editing Grid displays the first symbol 
of the new symbol set. 
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Routing 

Creating a Route 
You can create a road route using the Route tab, right-click feature, or the toolbar. Once 
you create a route, you can use the Route tab to view route directions, edit a route, and 
display routes on a map. 
Routes are calculated using the default routing preferences. To show/remove routing 
MapNotes, waypoint labels, state borders, and route vias, enable/disable GPS voice 
navigation, or to change the default speed, road type, or routing preference, see Setting 
Your Routing Preferences. 

Tip  If you are using a GPS with NavMode, use the E-Z Nav route wizard to quickly 
calculate a route to a single destination. 

To Create a Route Using the Route Tab 

Use the following steps to create a route. 
1. Click the Route tab and then click New/Edit (if it is not already selected). 
2. Click File, click New, and then type the name for your route in the Name text box. 

3. Click the Start tool  and then click the point on the map where you want to begin 
your route. 
OR 
To use an address book entry as your start location, select Start From Address 
Book from the Start drop-down list, click to select an Address Book entry, and then 
click OK. 
OR 
To use your current GPS position as your start location, select Start From GPS 
Location from the Start drop-down list. 
OR 
Type your start location in the Start drop-down text box. You can type the name of 
an address book contact, user-added waypoint, or address.  
Notes 
An address must be in one of the following formats: street address, city, state OR 
street address, ZIP/Postal Code. 
The Book check box (underneath the Address Book buttons in the Find tab) must be 
selected to search for address book contact names. 

4. Optional. Add or insert stops or vias. 

5. Click the Finish tool  and then click the spot on the map where you want to end 
your route. 
OR 
To use an address book entry as your finish location, select Finish From Address 
Book from the Finish drop-down list, click to select an Address Book entry, and 
then click OK. 
OR 
Type your finish location in the Finish drop-down text box. You can type in the name 
of an address book contact, user-added waypoint, or address.   
Notes 
An address must be in one of the following formats: street address, city, state OR 
street address, ZIP/Postal Code. 
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The Book check box (underneath the Address Book buttons in the Find tab) must be 
selected to search for address book contact names. 

6. Select a calculation method — the program adjusts the default calculation values 
based on your selection: 

Driving–Use this method to calculate the route when you are driving a vehicle. 
Cycling–Use this method to calculate a bicycle route. 
Walking/running–Use this method to calculate routes when you are on foot. 

7. Select a route type (Road-Shortest or Road-Quickest) from the drop-down list. 
8. If the Auto check box is not selected, click Calculate. 

If the program is unable to find an exact match for the item that you typed, a dialog 
box opens with a list of the closest matches. Scroll through the list of search results 
until you find the one you want to locate, click the item to select it, and then click 
OK.   

9. Click Directions to view the route directions. 
AND/OR 
Click Advanced to display the advanced routing options. 
AND/OR 
Click Back on Track to add your current GPS position as a stop to the current route. 

To Create a Route Using the Right-click Function 

Use the following steps to create a route. 
1. Right-click the map location where you want to begin your route, point to Create 

Route, and click Set as Start. 
2. Optional. Add or insert stops or vias. 
3. Right-click the map location where you want to end your route, point to Create 

Route, and click Set as Finish. 
4. If the route doesn't automatically calculate, right-click the route, point to Manage 

Route, and click Calculate Road Quickest or Calculate Road Shortest. 
Note  If the program is unable to find an exact match for the item that you typed, a 
dialog box opens with a list of the closest matches. Scroll through the list of search 
results until you find the one you want to locate, click the item to select it, and then 
click OK. 

5. Optional. Click the Route tab. Then click the Directions subtab to view the route 
directions, the Advanced subtab to display advanced routing options, Plan Trip to 
assign end of day or fuel breaks to your route, or Back on Track to add your 
current GPS position as a stop to the current route. 

To Create a Route Using the Toolbar 

Click here to view the steps for creating a route using the toolbar. 

Adding and Inserting Stops and Vias 
Use stops and vias to route you through a particular place or along a particular road. You 
can add or insert stops or vias in any route you create using the Route tab, the route 
options on the toolbar, or by right-clicking the map (2-D only). 

• A stop is a location along a route where you want to stop and then proceed from. 
• A via is a point on the map that you want your route to go through. 
• Add stops or vias to follow a route in a particular order. 
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• Insert stops or vias to arrange them geographically in the route. 
Tips 

• Turn off Auto Calculate when you are adding many stops and vias. 
• Use Add instead of Insert when your start and finish are at the same place. 
• Don't place the finish point until you add all your stops and vias. 
• Place vias near the beginning of the road you want to use. 
• When you calculate the route, if it goes to a via and then returns to the original path, 

insert another via toward the end of that road (where you want to turn onto the next 
road) to force it to use that road. 

• When using a road as a stop or via, zoom in to ensure you select the correct road. 
The selected road segment is highlighted when you click it. 

To Add a Stop or Via To Your Route 

The Add Stop/Via function adds stops and vias in the order you add them to the route. Use 
the following steps to add a stop or via to your route. 

1. Create a route. 
2. In the New/Edit dialog area in the Route tab, make sure the button next to the 

Stop tool  (if you are adding a stop) or the Via tool  (if you are adding a via) is 
labeled Add. If it is not, click the arrow next to the button and select Add. 

3. To add a stop or via to the route, click the Stop or Via tool and then click the 
location on the map. 
OR 

• To use an address book entry as your stop or via location 
1. Select Stop From Address Book from the Stop drop-down list. 

OR 
Select Via From Address Book from the Via drop-down list. 

2. Select an Address Book entry, and then click OK. 
• To use your current GPS position as your stop or via location 

Select Stop at GPS Location from the Stop drop-down list. 
OR 
Select Via at GPS Location from the Via drop-down list. 

• Type the stop or via location in the Stop or Via text box 
Type the name of an address book contact, user-added waypoint, or address. 
If you type an address, it must be in one of the following formats: street 
address, city, state OR street address, ZIP/Postal Code. 
The Book check box (underneath the Address Book buttons in the Find tab) 
must be selected to search for address book contact names. 

• Right-click the map to add a last stop or via 
1. Right-click the map where you want to add the last stop or via. 
2. Point to Create Route, and then click Add as Last Stop or Add as 

Last Via. 
• Use the toolbar to add a stop or via. 

2. If the Auto check box is not selected, click Calculate to recalculate your route to 
include the stop or via. 
OR 

Click the Calculate button  on the toolbar. 
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OR 
If the Auto check box is not selected, right-click the route, point to Manage Route, 
and click Calculate Road Quickest, or Calculate Road Shortest. 
Note  If the program is unable to find an exact match for the item that you typed, a 
dialog box opens with a list of the closest matches. Scroll through the list of search 
results until you find the one you want to locate, click the item to select it, and then 
click OK. 

3. Click Directions to view the route directions. 
OR 
Click Advanced to display the advanced routing options. 
OR 
Click Plan Trip to assign end of day or fuel breaks to your route. 
OR 
Click Back on Track to add your current GPS position as a stop to the current route. 

To Insert a Stop or Via Into Your Route 

The Insert Stop/Via function arranges stops/vias geographically in the route. Use the 
following steps to insert a stop or via to your route. 

1. Create a route. 
2. In the New/Edit dialog area in the Route tab, make sure the button next to the 

Stop tool  (if you are adding a stop) or the Via tool  (if you are adding a via) is 
labeled Insert. If it is not, click the arrow next to the button and select Insert. 

3. To insert a stop or via to the route, click the Stop or Via tool and then click the 
location on the map. 
OR 

• To use an address book entry as your stop or via location 
1. Select Stop From Address Book from the Stop drop-down list. 

OR 
Select Via From Address Book from the Via drop-down list. 

2. Select an Address Book entry, and then click OK. 
• To use your current GPS position as your stop or via location 

Select Stop at GPS Location from the Stop drop-down list. 
OR 
Select Via at GPS Location from the Via drop-down list. 

• Type the stop or via location in the Stop or Via text box 
Type the name of an address book contact, user-added waypoint, or address. 
If you type an address, it must be in one of the following formats: street 
address, city, state OR street address, ZIP/Postal Code. 
The Book check box (underneath the Address Book buttons in the Find tab) 
must be selected to search for address book contact names. 

• Right-click the map where you want to insert the stop or via 
1. Right-click the map where you want to insert the stop or via. 
2. Point to Create Route, and then click Insert Stop or Insert Via. 

• Use the toolbar to insert a stop or via. 
3. If the Auto check box is not selected, click Calculate to recalculate your route to 

include the stop or via. 
OR 

Click the Calculate button  on the toolbar. 
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OR 
If the Auto check box is not selected, right-click the route, point to Manage Route, 
and click Calculate Road Quickest, or Calculate Road Shortest. 
Note  If the program is unable to find an exact match for the item that you typed, a 
dialog box opens with a list of the closest matches. Scroll through the list of search 
results until you find the one you want to locate, click the item to select it, and then 
click OK. 

4. Click Directions to view the route directions. 
OR 
Click Advanced to display the advanced routing options. 
OR 
Click Plan Trip to assign end of day or fuel breaks to your route. 
OR 
Click Back on Track to add your current GPS position as a via to the current route. 

Changing the Routing Method 
You can change your routing calculation method at any time. You may need to do this to 
update your routing preferences. 

To Change the Route Calculation Method 

1. From the Route tab, click the New/Edit subtab. 
2. Select a calculation method: 

 Driving–Use this method to calculate the route when you are driving a vehicle. 
 Cycling–Use this method to calculate a bicycle route. 
 Walking/running–Use this method to calculate routes when you are on foot. 

3. Select a route type (Road-Shortest or Road-Quickest) from the drop-down list. 

Changing the Properties of a Stop Along Your Route 
You can change the properties of a stop along your route by using the Stop Prefs function in 
the Advanced sub-tab under Route. 

To Change the Properties of a Stop 

Use the following steps to change the properties of a stop. 
1. Click the Route tab and then click Advanced. 
2. Click a stop from the waypoint list and then click Stop Prefs. 

The Stop Time Preferences dialog box opens. 
3. To designate the stop as an end of day stop, select the End of Day check box, click 

Apply, and then click Done. 
OR 
To designate the stop as a fuel break, select the Fuel check box, click Apply, select 
the Duration check box, select the duration of the fuel break using the Hrs and Mins 
drop-down lists, and then click Done. 
Note  It is not necessary to allocate a fuel stop duration. 

Viewing Route Directions 
After you create a route, you can view the accompanying route directions. 

To View the Route Directions 
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Use the following steps to view the route directions. 
1. Click the Route tab and then click Directions to open the Route Directions dialog 

area. 
The list of routes you have created display in the route list on the left. A selected 
check box indicates the route is displaying on the map. 

2. Click a route to select and highlight it. 
OR 
Double-click a route to center it on the map. 

3. The route directions for the selected route display in the right window. Adjust the 
size of the tab area to expand the view. 
Tip  Click the header of a column to open a menu from which you can select the type 
of information you want to display in each column. 

4. Click a leg to select it and then click Go To to center the map on the leg. 
OR 
Double-click a leg to center the map on the leg. 

Tip  When tracking with a GPS receiver, select the GPS Track check box to follow along 
with the route directions in real time as you travel. Click Show Turns to display the current 
distance and time to your finish. 

Avoiding a Specified Area When Routing 
If you know you will be travelling in an area that is under construction or is a highly-
populated area with a lot of traffic congestion, you can draw a circle/rectangle/polygon over 
that area to avoid it when you calculate your route. You can create multiple regions to 
avoid. 

To Avoid a Specified Area When Routing 

Use the following steps to designate an area to avoid when calculating your route. 
1. Create a route. 
2. Click the Draw tab to open the Draw dialog area. 

3. Click and hold the Polygon/Rectangle/Circle tool  to view its hidden 
options. Select the tool you want to use. 

4. Optional. Select one or more of the following: 
• From the Fill drop-down list, select the fill style you want to apply to the draw 

object. 
• Click the fill color button to the right of the Fill drop-down list to select the 

color for your fill style. 
• Select an outline style for your draw object from the Outline drop-down list. 
• Click the outline color button to select a color for the outline of your draw 

object. 
• Select the width for your draw object outline from the Width drop-down list. 
• Select the Show Measurement check box to display measurement 

information for your draw object as your draw it on the map. 
5. If you selected the Circle tool, click the location for the circle's center on the map 

and drag away from center to set the radius for the circle. Release as soon as you 
achieve the radius you want.   
The radius of the circle and the coordinates of the circle's center display in the 
corresponding text boxes to the right of the circle fill option area. 
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OR 
If you selected the Polygon tool, click the map to enter each point of the polygon. 
OR 
If you selected the Rectangle tool, click the location for the rectangle's upper-left 
corner on the map and drag away from the corner to set the width, height, and area 
for the rectangle. Release as soon as you achieve the size you want. 

6. Right-click the draw object, point to Manage Draw, and click Route Avoid. If the 
object has no name, it the name "Route Avoid" is visible on the map. 

7. If you do not have the Auto Calculate option selected in the Route tab, click the 
Route tab and then click Calculate to recalculate your route. 

Note  To undo your route avoid, right-click it on the map, point to Manage Draw, and click 
Route Avoid to clear the check box. To delete the route avoid from the map, click the 
Select tool in the Draw tab and click the draw object on the map. Then, press the DELETE 
key on your keyboard. 

Saving Route Directions as Text 
You can save your directions and along the way results as a text file. 

To Save Your Route Directions 

Use the following steps to save your directions. 
1. Click the Print tab and then click the Route subtab. 

If you do not have a route in this map file, the Route Options are unavailable. 
2. Select the route you want to save from the Name drop-down list. 

If the route you want to save is not available in the Name drop-down list, you may 
not have the correct map file open. 

3. Under Options, select Directions or Along the Way. 

4. Click the Save button  on the Route tab. 
5. To rename the .txt file, type the new name in the File Name text box and click 

Save. 

Setting Your Routing Preferences 
Once you master basic routing, you can customize your routing preferences and create 
more advanced routes. 

• The routing preferences allow you to favor or avoid various road types when 
calculating your route. You can also set your speed preferences. 

• The default settings are based on the calculation method you chose when creating 
the route. 

• To change your route calculation method, see Changing the Routing Methods. 

To Set Your Routing Preferences 

Use the following steps to set your routing preferences. 
1. Click the Route tab and then click the Advanced subtab. 
2. Click Route Prefs to display the Route Preferences dialog area. 
3. From the Road Type drop-down list, select the road type for which to set 

preferences. 
4. Select Preferred, Standard, or Avoid from the Routing Preference drop-down 

list. 
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Preferred favors this type of road whenever possible, Standard is the default level, 
and Avoid avoids this type of road whenever possible. An avoided road may be used 
when no other road is available. 

5. In the Speed text box, type your average driving speed for this road type. 
These speeds are used to compute the travel time for a route. 

6. In the Urban Speed text box, type your average driving speed within an urban 
area. 
These speeds are used to compute the travel time for a route. 

7. Repeat these steps for each road type. 
8. When you are finished setting your road preferences, click Review to display your 

settings. 
9. In the Route Features list, select the check box for each feature you want to 

display: 
• Show Location MapNotes–Displays Location MapNotes with their coordinate 

information for each point in your route. 
• Show Comments MapNotes–Displays comments about your route. 
• Show Summary MapNotes–Displays time and distance information for each 

waypoint and the finish point of your route. 
• Display Waypoint Labels–Displays start/stop/via/finish labels on the map 

when the route is created. 
• Include State Borders–Shows or hides state borders in your route 

directions (only available when Road is the selected route type). 
• GPS Voice Navigation–Provides spoken route directions when you are 

tracking with a GPS receiver. After initializing, the computer speaks the 
directions for the next turn in your route. It repeats the instructions 
approximately 90 seconds prior to arriving at the turn. 

• Display Route Vias—Shows or hides your route vias on the map. 
10. Click Done. 

Note  Click Use Defaults to restore all route preferences to the default settings. 

Editing a Route 
You can modify existing routes by: 

• Adding, removing, and rearranging stops and vias. 
• Adjusting your route preferences based on road type. 
• Customizing your route based on your driving style and speed. 
• Reversing a route. 

Tips   
• Zoom in to set accurate points for your route. 
• Use the right-click option for routing. Just right-click the route, stop, or via, point to 

Manage Route, and click the applicable option. 

To Edit a Route 

To edit a route, click the Route tab and then click the Advanced subtab. Select the route 
from the Name drop-down list box. The route becomes active. The following list describes 
the edit functions. 
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• Street Atlas USA Plus and regular Street Atlas USA with advanced file 
management only: To change the route name, select the name in the Name text 
box, type the new route name, and then press the ENTER key on your keyboard. 

• To change a route point, click the corresponding tool and then click the new spot on 
the map. 
OR 
Select a route point on the map and drag it to the new location on the map. 
Note  If you try to add a start or finish point to an existing route, the "Would you 
like to move your Start location or create a New route?" message opens. Click New 
to begin creating a new route. Click Move to move the Start or Finish point to the 
last location clicked. 

• To add or insert a stop or via to your route, click the corresponding tool and then 
click the spot on the map where you want to add or insert your stop or via. For more 
information, see Adding and Inserting Stops and Vias. 

• To rearrange stops and vias, click the point to select it and then click the Move Up 
or Move Down tools to relocate it in the route. 

• To delete a stop or via, select the stop or via in the route list and then click the 
Delete button. 

• To change a stop to a via, select the stop and click Make Via. To change a via to a 
stop, select the via and  click Make Stop. 

• Click Reverse Rte to reverse the order of all of the points in the route. 
• Click Calculate if the Auto check box is not selected in the New/Edit subtab. 

  

 

Note for regular Street Atlas USA users 
This Help topic describes functionality provided in advanced file management. 
Advanced file management allows you to save multiple routes and draw layers in a 
single map file. With simplified file management, you can save only one route 
and/or draw layer in a single map file. If you did not select to enable advanced file 
management during the product installation, you can still change the settings 
using the Change File Management option in the Options menu. For more 
information, see Activating Advanced/Simplified File Management. 
This note does not apply to Street Atlas USA Plus users. 

  

Editing Roads 
You can change the characteristics of any road on a map to: 

• Two Way 
• One Way N or E 
• No Left Turn N or E 
• No Right Turn N or E 
• No Way 
• One Way S or W 
• No Left Turn S or W 
• No Right Turn S or W 

To Edit a Road 
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Use the following steps to edit a road. 
1. Click the Route tab and then click the Advanced subtab. 
2. Click Edit Roads. 
3. Select the Display Road Edits check box to show existing road edits on the map. 

4. Click the Select tool  and select the road on the map you want to edit. 
5. Select a direction. 

• If you select Two Way, you can also select No Left Turn No Right Turn. 
• If you select One Way, you can also select No Left Turn or No Right Turn. 
• If you select No Way, you cannot select any other options. 
Note  Click Default to change the road properties to the default settings. Click 
Clear All Edits to remove all road options and return all road properties to their 
default settings. 

6. Click Done. 

Labeling a Route Point with a MapNote 
The easiest way to label your route points (start, stop, via, and finish) with a MapNote is to 
use the Route Preferences section of the Route tab. 
If you select more than one option, each category of information (location, comments, 
and/or summary) displays in the same MapNote. 

To Label a Route Point with a MapNote 

Use the following steps to label a route point with a MapNote. 
1. Click the Route tab and then click the Advanced subtab. 
2. Click Route Prefs to display the Route Preferences dialog area. 
3. Under Route Features, select the check box next to each MapNote you want to 

display at your route points: 
• Show Location MapNotes–Displays the coordinate information for each point in 

your route. 
• Show Comments MapNotes–Displays comments about each point of the route 

as specified in the Route Advanced subtab. 
To modify route comments, click the Route tab, click the Advanced subtab, 
select the route, and then click in the Comments column twice (do not double 
click) next to the route point you want to create a comment for. The information 
you type in the Comments field for that point is placed in a Comments MapNote 
when you selected to show it on the map.   

• Show Summary MapNotes–Displays time and distance information for each 
point in your route. 

4. Click Done. 

Moving Route MapNotes 
You can move route MapNotes. The text box moves, but the point stays on the map 
location. 
To show/delete route MapNotes, see Setting Your Routing Preferences. 
To move and delete draw Map Notes, see Moving and Deleting Draw MapNotes. 

To Move a Route MapNote 
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Use the following steps to move a MapNote. 
1. Click the Route tab and then click the Advanced subtab. 

2. Click the Move Route MapNotes button . 
3. Click the MapNote to select it. 
4. Drag the text box to the new location. 

Displaying and Centering Routes on the Map 
All the routes you create are automatically displayed. The active route displays as a gold 
line outlined in red. Each inactive route displays as a dashed, orange line outlined in green. 
You can choose to display only certain routes without deleting them from the map. 

To Display a Route on the Map 

Use the following steps to display a hidden route on the map. 
1. Click the Route tab and then click the Directions subtab. 
2. In the route list on the left, select the check box next to the route you want to 

display. 
OR 
To center the map on the route, double-click the route name. 

To Hide a Route on the Map 

Use the following steps to hide a route from view on the map. 
1. Click the Route tab and then click the Directions subtab. 
2. In the route list on the left, clear the check box next to each route you want to hide 

from view on the map. 
OR 
Right-click the route you want to clear from the map view, point to Manage Route, 
and then click Hide Route. 

To Center the Map on a Route 

Use the following steps to center a route on the map. 
1. Click the Route tab and then click the Directions subtab. 
2. Double-click the route in the route list on the left. 

Tip  To center a route that is not in the current map view, click the Route tab, click the 
New/Edit subtab, and select the route from the Name drop-down list. 

 

Note for regular Street Atlas USA users 
This Help topic describes functionality provided in advanced file management. 
Advanced file management allows you to save multiple routes and draw layers in a 
single map file. With simplified file management, you can save only one route 
and/or draw layer in a single map file. If you did not select to enable advanced file 
management during the product installation, you can still change the settings 
using the Change File Management option in the Options menu. For more 
information, see Activating Advanced/Simplified File Management. 
This note does not apply to Street Atlas USA Plus users. 

  

Saving a Route 
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The route in memory is retained as you create it. You are prompted to save your route 
when you create a new map file or exit the program. 

• Creating a new map file–When you click File/New in the Files dialog area on the Map 
Files tab, you are asked if you want to save changes to the most recently used map 
file. A separate dialog box asks if you want to save changes to an unsaved route. 

• Exiting the application–The Save Changes dialog box asks if you want to save your 
changes. 

You can also save the route using the Route tab. 
Routes have .anr extensions and are saved by default in C:\DeLorme Docs\Navigation. 

To Save a Route Using the Route Tab 

Use the following steps to save a route using the Route tab. 
1. Create a route. 
2. Click the Route tab and then click the New/Edit subtab. 
3. Click File and then click Save. 

 

Note for regular Street Atlas USA users 
This Help topic describes functionality provided in advanced file management. 
Advanced file management allows you to save multiple routes and draw layers in a 
single map file. With simplified file management, you can save only one route 
and/or draw layer in a single map file. If you did not select to enable advanced file 
management during the product installation, you can still change the settings 
using the Change File Management option in the Options menu. For more 
information, see Activating Advanced/Simplified File Management. 
This note does not apply to Street Atlas USA Plus users. 

  

Deleting a Route 
You can permanently delete routes. 

To Delete a Route 

Use the following steps to delete a route. 
1. Click the Route tab and then click the New/Edit subtab. 
2. Select the route from the Name drop-down list. 
3. Click File and then click Delete. 

OR 
Right-click the route, point to Manage Route, and then click Delete Route. 

 

Note for regular Street Atlas USA users 
This Help topic describes functionality provided in advanced file management. 
Advanced file management allows you to save multiple routes and draw layers in a 
single map file. With simplified file management, you can save only one route 
and/or draw layer in a single map file. If you did not select to enable advanced file 
management during the product installation, you can still change the settings 
using the Change File Management option in the Options menu. For more 
information, see Activating Advanced/Simplified File Management. 
This note does not apply to Street Atlas USA Plus users. 
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Importing Routes 
Routes can be imported from many other DeLorme mapping programs using the Route tab. 

To Import an Existing Route Using the Route Tab 

Use the following steps to import an existing route using the Route tab. 
1. Click the Route tab and then click the New/Edit subtab. 
2. Click File and then click Import. 

The Import dialog box opens. 
3. Browse to select the route file and then click Open. 

The map centers on the imported route and is available in the Name drop-down list. 

 

Note for regular Street Atlas USA users 
This Help topic describes functionality provided in advanced file management. 
Advanced file management allows you to save multiple routes and draw layers in a 
single map file. With simplified file management, you can save only one route 
and/or draw layer in a single map file. If you did not select to enable advanced file 
management during the product installation, you can still change the settings 
using the Change File Management option in the Options menu. For more 
information, see Activating Advanced/Simplified File Management. 
This note does not apply to Street Atlas USA Plus users. 

  

Setting Your End of Day and Fuel Break Preferences 
You can schedule end of day and fuel breaks along a route by using the Plan Trip option in 
the Route tab. You can schedule end of day breaks according to the miles (or other distance 
unit selected in Map Display) or hours driven and you can schedule fuel breaks according to 
your current fuel level, your vehicle's fuel consumption rate, and so on. 
This feature works with the route preferences you have designated with the Route 
Preferences option under Route. For more information, see Setting Your Routing 
Preferences. 
You can also estimate the fuel cost for your route. 

To Set Your End of Day and Fuel Stop Preferences 

Use the following steps to set your time preferences. 
1. Create a route. 
2. Click the Route tab and then click Plan Trip. 

• Select the Estimate End of Day Breaks check box to schedule end of day 
breaks for your trip. 

• Select Hours per day to schedule your end of day breaks after a 
designated number of hours traveled per day. Then, type the number 
of hours you want to travel per day in the Hours Per Day text box. 
Use the Flexibility drop-down list to determine the amount of time 
you want to be flexible between breaks and defined stops. For 
example, if you selected 1.5 Hrs from the Flexibility drop-down list and 
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have an end of day break within 1.5 hours of a planned stop, the end 
of day break is moved to the planned stop. 

OR 
• Select mi per day to schedule your end of day breaks after a 

designated number of miles traveled per day. Then, type the number of 
miles you want to travel per day in the Mi Per Day text box. Use the 
Flexibility drop-down list to determine the number of miles you want 
to be flexible between breaks and defined stops. For example, if you 
selected 50 mi from the Flexibility drop-down list and have an end of 
day break within 50 miles of a planned stop, the end of day break is 
moved to the planned stop. 
Note the unit of measurement used is based on your units of 
measurement setting. 

• Select the Estimate Fuel Breaks check box to schedule fuel breaks for your 
trip. 

• Type the fuel tank capacity (in gallons) in the Tank Cap text box. 
• Type the fuel consumption rate (in miles per gallon or the distance unit 

you have selected in the Display tab of the Options dialog) for your 
vehicle in the Fuel Rate text box. 

• Select the amount closest to your current fuel tank level from the 
Starting level drop-down list. 

• Select the amount of fuel you would like to have in your tank when 
warned to stop for fuel from the Warning Level drop-down list. 

3. Click Apply. 

Estimating the Fuel Cost of Your Route 
The Plan Trip subtab of the Route tab lets you estimate the fuel cost for your route using 
the fuel rate (how many gallons of fuel your vehicle uses per mile/kilometer traveled) and 
fuel price per gallon. 

To Estimate the Fuel Cost of Your Route 

Use the following steps to estimate the fuel cost of your route. 
1. Create a route. 
2. Click the Plan Trip subtab on the Route tab. 
3. Click Fuel Cost. 
4. Type the fuel rate for your vehicle in the Fuel Rate text box. The fuel rate can often 

be found in the vehicle's owners manual. 
5. Type the price of your fuel in the Fuel Price text box. 

The estimated fuel cost (in U.S. dollars) for your route automatically calculates when 
you enter information in the Fuel Rate and Fuel Price text boxes. The estimated fuel 
cost for your route displays in the Total Fuel Cost field. 

6. Click Close to close the dialog box and return to the Plan Trip subtab. 

Converting a Route to a GPS Log 
You can convert any route to a GPS log file (.gpl). 

To Convert a Route to a GPS Log File 

Use the following steps to convert a route to a GPS log file. 
1. Create a route. 
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2. Right-click the route, point to Manage Route, and then click Save as GPS Log 
File. The Save Route as GPS Log File dialog box opens. 

3. Browse to the location where you want to save the .gpl file. The default location is 
C:\DeLorme Docs\GPSLogs. 

4. Type the file name in the File Name text box. 
5. Click Save. 
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Using GPS 

GPS Overview 
Using your DeLorme application, a portable computer, and your GPS receiver, you can 
display a "bread crumb trail" to track your progress as you travel. 
  
You have two ways to use GPS in your mapping application: 

• NavMode–This is the default GPS view—a hands free full-screen view that you can 
display in 2-D or 3-D. NavMode also allows you to use the E-Z Nav route wizard, the 
easiest way to plan quick trips. 

• GPS tab view–This option allows you to use the GPS tab to control navigating and 
tracking. By default, the tabs and Control Panel are visible, but you can opt to hide 
them. It is available only in 2-D mode. 

For more information, see Using NavMode or GPS Tab View. 
  

 
Safety 

Warnings 

• Bring a passenger along to serve as GPS operator while you are driving 
a vehicle. 

• Do not use this application with automatic navigation, guidance 
systems or for any purpose requiring precise measurement of distance 
or direction. 

  

GPS Options/Initializing GPS 
Before beginning your GPS setup, read the user manual for your GPS receiver. Also, ensure 
you have the appropriate cable and any necessary adapters to connect your GPS receiver to 
the communications port of your portable computer. 
If you have an Earthmate GPS device, it is automatically enabled when it is connected. Just 
click Start GPS to begin tracking. 
  

To Set GPS Options 

• Manually change the location coordinates 
Each time you track with GPS, the initialization process uses the coordinates from 
the last initialized location. 
Use the following steps to change these coordinates to those of your choice. 

1. Connect your GPS receiver to your computer, set the receiver to the mode 
specified in your owner manual, and then turn the receiver on. 

2. Click the Options button  and then click the GPS Settings tab. 
3. Under GPS Options, verify that the Automatically detect GPS check box is 

cleared. 
4. Type the coordinates in the text boxes. 

Note  Coordinates display in the format specified in the Display tab of the 
Options dialog box. 
OR 
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Click Use Map Center to set the coordinates to the latitude and longitude of 
the current map center. 

• Update the date/time options 
You can use the date and time on your computer or you can change the date and 
time settings used by the GPS device to those of your choice. 
Use the following steps to change the date and/or time settings. 

1. Connect your GPS receiver to your computer, set the receiver to the mode 
specified in your user manual, and then turn the receiver on. 

2. Click the Options button  and then click the GPS Settings tab. 
3. To use the date and time on your computer, select the Use Current System 

Date/Time check box. 
OR 
To use the time and date of your choice, clear the Use Current System 
Date/Time check box, and then: 

• To manually set the time, select the time zone from the Zone drop-
down box, and if Daylight Saving Time is currently in effect where you 
are, select the DST check box. Then, use the scroll box to select the 
desired time. 
Note  Time is displayed in 24-hour format, with Midnight as 00:00:00. 

• To manually set the date, click the down arrow next to the Date field 
and select the date from the calendar. 

• Set your preferences 
You can set various options for how GPS works. 
Use the following steps to change the When tracking... and GPS Options. 

1. Click the Options button  on the toolbar and then click the GPS 
Settings tab. 

2. Set the preferences you want to use. 
When tracking... 

•  
 Use NavMode–Enables a hands free full-screen view that you can view in 2-

D or 3-D. 
 Use E-Z Nav route wizard–Opens the E-Z Nav route wizard when you start 

GPS and you are using NavMode. 
 Snap to route–Automatically locates the place on the route that is closest to 

your vehicle's current location. 
 Start GPS log–Automatically generates a GPS log. 
 Use High-Contrast colors–Automatically enables high-contrast map colors. 
 Magnify map–Automatically magnifies the map view to the specified 

magnification (125%, 150%, 175%, or 200%). 
 Recenter map on GPS–Automatically centers the map on the GPS. 
 Rotate map in GPS direction–Automatically rotates the 2-D/3-D map in the 

direction of travel. Direction of travel always displays as the top of the screen, 
regardless of compass direction. 

 Auto zoom to turn (2-D only)–Automatically pans and zooms the map to 
display both the current GPS position and the position of the next turn. Select 
data zoom levels from the Minimum zoom and Maximum zoom drop-down 
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lists to stop the map from zooming out/in further than you want it to when 
approaching the next turn. 

 Show GPS bread-crumb trail–Automatically displays your GPS progress on 
the map as a "bread-crumb" trail up to the maximum specified number of 
points. 5,000 points is approximately one hour and 20 minutes worth of 
points. This setting does not affect the number of points captured in the GPS 
log file. To change the point number, type the new number in the Trail 
length box. 

 Enable GPS voice navigation–Provides spoken directions when tracking a 
route with a GPS receiver. 

 Recalculate when off route–Automatically recalculates the route by the 
designated threshold distance (100 ft, 200 ft, 300 ft, 400 ft, or 500 ft) when 
the GPS is off of the route. 

 Display GPS overview (2-D only)–When selected, opens the GPS overview 
window after the GPS is connected. You can adjust the size of the map and 
overview areas. The overview map does not display when you use NavMode 
in 3-D. 

 Disable screen saver–Overrides the system screen saver so that the display 
stays activated during GPS tracking. 

GPS Options 
 Start GPS with the program–Automatically starts GPS tracking each time 

you open the program. 
 Automatically detect GPS–Automatically sets up your GPS connection. 

Suggestion: If your GPS receiver has a USB cable, select Automatically Detect 
GPS to ensure the correct COM port is detected for your device and that a 
connection can be made. 

 Enable WAAS use (USB Earthmate)–Enables WAAS use. This option is 
selected by default. 

 Enable LED on GPS device (USB Earthmate)—Turns on the LED on the 
Earthmate. When the check box is cleared, the LED does not display. 

  

To Initialize Your GPS Receiver 

If you are using a non-DeLorme Earthmate GPS receiver, you must initialize it before you 
use it. The initializing process can take several minutes before the program detects the 
correct communications (COM) port and updates the current settings. Use the following 
procedure to initialize your GPS receiver for use with your application. 

1. Connect your GPS receiver to your computer, set the receiver to the mode specified 
in your user manual, and then turn the on receiver, if necessary. 

2. Click the GPS tab and then click Clear Trail to delete any GPS points from the 
current map display. 

3. Click the Options button  on the toolbar (or click the menu arrow and click 
Options) and then click the GPS tab in the Options dialog box. 
OR 
Click the GPS tab and click the Options button . 

4. From the Device drop-down list, select the type of GPS receiver you are using. If 
your device is not listed, select Generic NMEA.  
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Note  The Settings text box automatically displays the default settings for the 
selected device. 

5. From the Port drop-down list, select the communications port you are using to 
attach the GPS receiver to your computer. See your computer manual for further 
information. 

6. You can also change the location coordinates, update the date/time options, set 
tracking options, and select GPS options. See To Set GPS Options above. 

5. Click OK to exit the Options dialog and return to the main GPS tab. 
6. Click Start GPS on the GPS tab 

OR 

Click the Start GPS button  on the toolbar. 
Notes 

• The status of your GPS connection displays on the screen. Once your GPS receiver 
acquires a fix on your location, your position on the map displays as a yellow or 
green dot that changes to an arrow as you travel. For more information, see 
Monitoring Your GPS Status. 

• While your receiver is acquiring data, many red dots display on your map (except 
with Magellan receivers). You may have to zoom in to see them clearly. These red 
dots are positioned at the readings taken by the GPS receiver as it is acquiring data. 

• Magellan receivers do not display any data until you are moving. 
• If you have the HotSync manager loaded in the startup (the default configuration), it 

reserves the COM port. If that is the one where the GPS receiver is attached, you 
must exit HotSync manager for the GPS receiver to initialize. To do this, right-click 
the HotSync icon on the taskbar and click Exit. If you have two COM ports, verify the 
correct COM port is selected for use with your application. This pertains to older 
devices. 

• Any questions or problems regarding the operation of your GPS receiver should be 
directed to its manufacturer. 

  

Using NavMode or GPS Tab View 
The default GPS view is NavMode—a hands free full-screen view that you can display in 2-D 
or 3-D. By default, the Control Panel is hidden and the tabs are minimized; however, you 
can change your display options. When using NavMode, the E-Z Nav route wizard is enabled 
by default. 
The GPS tab view option allows you to use the GPS tab to control navigating and tracking. 
By default, the tabs and Control Panel are visible, but you can opt to hide them. It is 
available only in 2-D mode. 

To turn NavMode on or off, click the NavMode  button on the toolbar. When the button 

appears indented , NavMode is on.  
Note  The button is grayed out  unless you have a GPS device plugged in or are playing 
back a GPS log file. 
  
You can also change your GPS view in the Options dialog box: 
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1. Click the Options button  on the toolbar and click the GPS tab. You can 
also click the Options button  on the GPS tab. 

2. Clear the Use NavMode check box to turn it off or select the check box to turn it on. 
3. Click OK. 

  
NavMode Display 

• Next Turn—The distance to the next turn, based on the units selected on the 
Display tab in the Options dialog box.   

• Dist to Finish—The distance to the finish point on your route, based on the units 
selected on the Display tab in the Options dialog box. 

• ETA—The estimated time of arrival at the finish of your route. This is based on the 
time and time zone set on your computer. If your trip goes beyond the current day, 
the day of arrival also displays. The ETA does not include any layover time at a stop. 

• GPS Fix—Indicates if your GPS fix is 2-D or 3-D. If you do not have a fix or if the 
GPS is acquiring a fix, "No Fix" displays. 

• Speed—Displays the speed you are traveling, based on the units selected on the 
Display tab in the Options dialog box. 

• Radar Results—If you are using GPS Radar, an orange bar displays the closest 
search result. Click Stop Here to insert a stop into your route. Click More Info to 
open the GPS Radar subtab on the Find tab and get more information about the 
result. Click Stop Radar to stop searching. 

• Progress Bar—The progress bar displays below the orange bar. It shows how far 
along you are in your route by distance. 

• Turns—The blue area at the bottom of the screen shows the next turn in large text 
and the following turn in smaller text. An arrow showing the direction of each turn 
displays next to the text.   

• Zoom In/Out—Click the plus sign in the Turns area to zoom the map in. Click the 
minus sign to zoom the map out. 

• Left 2-D or 3-D/Right 2-D–You can choose to view the left map in 2-D or 3-D or 
the right map in 2-D. Click the button for the view you want. To view both the right 
and left map, use the resize tool to change the map area. 

  

Tracking a Route with GPS 
When tracking, you can follow along a road route you created using any of the routing 
methods in your mapping program. As you travel, the current leg (segment) of your route is 
highlighted on the map. 
Notes 
• To automatically recalculate your route when off track, on the Route tab, select the 

Auto check box next to the Back on Track button on the New/Edit subtab. If you do 
not want the program to automatically recalculate your route when off track, clear the 
Back on Track check box and click Back on Track whenever you want to recalculate 
the route based on the current GPS position. 

• If you want to create a log of your travels, select the Start GPS Log check box in the 
GPS tab of the Options dialog to log automatically. Or, click the Record button in the 
GPS Log subtab to log manually start recording. 
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• The Turns option is available in routes only when GPS tracking. 

• To Start GPS Tracking 

Use the following steps to track your movement as you travel. 
1. Create a route.  

Important   If the current map file includes hidden routes, they may recalculate if 
you selected the Auto Back on Track check box or if you selected the Recalculate 
When Off Route check box in the GPS Settings. To ensure this does not occur, clear 
these check boxes or delete the routes you do not want to recalculate. 

2. Connect your GPS device to your computer. 
3. Initialize the device. This step is not necessary if you are using an Earthmate GPS 

device. 

4. In NavMode, click the GPS button  on the toolbar.  
Click here for a description of the screen display. 
OR 
In GPS tab view, click the GPS tab and then click the Status subtab. For more 
information, see Monitoring Your GPS Status. Then, click Start GPS or click the GPS 

button  on the toolbar. 
Click here for a description of the Show Turns area on the Route tab. 

• Next Turn–Displays the next turn and a turn graphic indicating the direction; 
the distance to the next turn, based on the units selected on the Display tab 
in the Options dialog box; and the time to the next turn. 

• Next Stop–The distance and estimated time to the next stop. 
• Finish–The distance and estimated time to the finish. 

Click the Show More Turns button  to view information for the turn after the 
following turn. 
click Show List to return to the Directions dialog area. 

• Next Turn–The distance to the next turn, based on the units selected on the 
Display tab in the Options dialog box. 

• Dist to Finish–The distance to the finish point on your route, based on the 
units selected on the Display tab in the Options dialog box. 

• ETA–The estimated time of arrival at the finish of your route. This is based on 
the time and time zone set on your computer. If your trip goes beyond the 
current day, the day of arrival also displays. The ETA does not include any 
layover time at a stop. 

• Speed–Displays the speed you are traveling, based on the units selected on 
the Display tab in the Options dialog box. 

• Radar Results–If you are using GPS Radar, an orange bar displays the 
closest search result. Click Stop Here to insert a stop into your route. Click 
More Info to open the GPS Radar subtab on the Find tab and get more 
information about the result. Click Stop Radar to stop searching. 

• Progress Bar–The progress bar displays below the orange bar. It shows how 
far along you are in your route by distance. 

• Turns–The blue area at the bottom of the screen shows the next turn in large 
text and the following turn in smaller text. An arrow showing the direction of 
each turn displays next to the text.   
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• Zoom In/Out–Click the plus sign in the Turns area to zoom the map in. Click 
the minus sign to zoom the map out. 

• 2-D or 3-D–You can view the map in 2-D or 3-D. The option you are NOT 
using shows—click the button to use that view. 

To Stop GPS Tracking 

In NavMode, click the GPS button  on the toolbar. 

In GPS tab view, click the GPS button  on the toolbar or click the GPS tab and then click 
Stop GPS. 
  

Getting Back on Track When Off Course 
To automatically recalculate your route when off course, select the Auto check box next to 
the Back on Track button in the Route tab. If you do not want the program to automatically 
recalculate your route when off track, clear the Auto check box and click the Back on 
Track button to manually recalculate the route. 
  

Using the E-Z Nav Route Wizard 
Use the E-Z Nav route wizard with NavMode when tracking with your GPS device. Planning a 
trip to a single destination is simple and quick. 
By default, the E-Z Nav route wizard is enabled to open when you start your GPS. You can 
change this setting on the GPS tab in the Options dialog box. To use the E-Z Nav route 

wizard at any time while using Nav Mode, click the E-Z Nav button  in the top right 
corner of the map. 
For more information, see the Use the E-Z Nav Route Wizard tutorial. 

Tips 
• To use GPS Radar with an E-Z Nav route, create your route, and then use the Find 

tab to set up your GPS Radar search. 
• If you do not find the search result you are looking for within a sub-category, try 

using the "All..." sub-category to expand your search. 

To Navigate the Pages in the Wizard 

• Click  to go back to the previous screen. 
• Click  to see another page of results. 
• Click  to see the previous page of results. 

To Use the E-Z Nav Route Wizard 

Before you start, set your GPS preferences on the GPS tab in the Options dialog box. If you 
have a GPS device from a manufacturer other than DeLorme, you must initialize it before 
you travel. 

1. Connect your GPS device to your computer and click the GPS button  in the 
toolbar. 
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Tip  If you want GPS to start when you open the program, select the Start GPS 
with the program check box on the GPS tab in the Options dialog box. 

2. To search near your current GPS location, ensure the Near Current Location option 
is highlighted. 
OR 
To search near another location, click Near Other Location. On the next screen, 
type the new location in the box. The more information you provide, the narrower 
the search results will be. Click the search location you want to use. 

3. Click the search category. Results are listed in order of distance from the location 
you are searching and an arrow shows the direction from your location. 

• Address or Location 
Type an address or location in the box. The more information you provide, the 
narrower the search results will be. 

• My Locations 
Select one of the following: 

• Recent Locations–Recent E-Z Nav routes. Click a route to open its 
detail page. 

• Address Book–The entries from the address book on the Find tab. 
• Waypoints–Waypoints in the current map file. Create waypoints on 

the Draw tab. 
• Food & Restaurants 

This category includes points of interest (POIs). Select All... or select a sub-
category. 

• Auto & Travel 
This category includes points of interest (POIs). Select All... or select a sub-
category. 

• Shopping & Recreation 
This category includes points of interest (POIs). Select All... or select a sub-
category. 

• Emergency & Community 
This category includes points of interest (POIs). Select All... or select a sub-
category. 

4. When you see the result you want, click it to open its details page. You can view the 
map before you create a route or you can just route to it. Click the option you want 
to use. 

• View Map–The map displays the search result for 15 seconds and then 
reverts to the details page. To close the map view at any time, click the E-Z 

Nav button  in the top right corner of the map.  
Note  The map displays in 2-D even if you are in 3-D mode. 

• Create Route–The route is created and you can start navigating. 
Note  When you close the program, you will be asked if you want to save the "E-Z Nav 
Route." Only the most recent E-Z Nav route is saved under that name. If you want to save a 
route for future reference, BEFORE you close the program, open the Route tab and change 
the route name. 
  

Panning the Map Automatically While GPS Tracking 
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When using the application with a GPS receiver to track a route, your map automatically 
pans and redraws as you travel, always indicating your position on the map when Center on 
GPS is activated. 

To Automatically Pan the Map 

The following procedure demonstrates how the check box and button work together 
to automatically pan the map. 

1. Click the Options button  on the toolbar (or click the menu arrow and click 
Options) and then click the GPS Settings tab. 
OR 
Click the GPS tab to open it and click the Options button . 

2. Under When Tracking, clear the Recenter Map on GPS check box. If you pan the 
map manually during GPS tracking, Center on GPS displays in the Control Panel. 
OR 
Select the Recenter Map on GPS check box. If you pan the map manually during 
GPS tracking, the map automatically re-centers itself on your location after 5 
seconds. 

3. Click OK. 
4. Click the GPS tab and click Start GPS. 

OR 

Click the GPS button  on the toolbar. 
Notes 
• The Center on GPS button displays and is activated by default on the Control Panel 

when the Recenter Map on GPS option is selected. 
• If you deactivate the Center on GPS button, you can continue to manually pan the map 

or use the search function in the Find tab. 
• When you are done with other tasks, click Center on GPS in the Control Panel to 

resume tracking. 
  

Playing Back a Log File 
After you log a route with your GPS receiver, you can play it back in the mapping 
application and review your entire journey on-screen. 
Your log will play back in NavMode unless you have it turned off. For more information, see 
Using NavMode or GPS Tab View. 
Notes 

• You cannot play back a log file if you are currently tracking with a GPS receiver. 
• Zooming in on the map allows you to see the log file in greater detail. 
• When you play back a log file in NavMode, the tab area is not minimized; this allows 

you to control the playback. 

To Play Back a Log File 

Use the following steps to play back and review a log file. 
1. Click the GPS tab and then click the GPS Log subtab. 
2. Click Clear Trail to clear any existing GPS points from the map display. 
3. Click File and then click Open. 
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4. Single click the file you want to view. 
The bottom of the Open a GPL File dialog box opens the start location, start time, 
start coordinate, total distance, duration, finish location, finish time, finish 
coordinate, and the number of readings for the selected log. Log files have .gpl 
extensions and are saved by default in C:\DeLorme Docs\GPSLogs. 

5. Click Open. 

6. Click the Play button  to begin playing back your log. 
OR 
Drag the slider in the Progress Bar (see graphic at the end of this topic) to the 
point in the log you want to play.  
Note  Playing back a log file defaults to 1x, which occurs in real time and takes the 
same amount of time as the original trip did; for example, if your trip took six hours, 
the on-screen tracking process also takes six hours. 

You can also: 
• From the Playback Speed drop-down list, select an option (2x, 5x, 10x, 25x, 

or 50x) to increase the tracking speed accordingly. 

• Click the Pause button  to pause the tracking of the log file. The Pause 
button turns blue to indicate the file is paused. Click the Play button to continue 
playing back the file. 

• Click the Stop button  to stop the play back. To start the file over, click 
the Play button again. 

• Click and hold the Rewind button  to rewind the log file to a particular 
point. 

• Click and hold the Forward button  to fast forward the log file to a 
particular point. 

• Drag the slider in the Progress Bar to view a particular point in the log. You can 
drag the slider forward or backward. 

 
  

Previewing a GPS Log File 
There are two ways to view an existing GPS log. You can play it back and watch it in real 
time (point-by-point), or you can preview it and view the entire log area without waiting for 
the playback to finish. 

To Preview a Log File 

Use the following steps to preview a log file. 
1. Click the GPS tab and then click the GPS Log subtab. 
2. Click Clear Trail to clear any existing GPS points from the map display. 
3. Click File and then click Open. 
4. Single click the file you want to view. 

The bottom of the Open a GPL File dialog box opens the start location, start time, 
start coordinate, total distance, duration, finish location, finish time, finish 
coordinate, and the number of readings for the selected log. 
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5. Click Open. 
6. Click File and then click File Preview. 

The map centers on your log location. 
  

Viewing File Details for a GPS Log 
If you want more information about your GPS log than just seeing where you've been on the 
map, the File Details option in the GPS Log subtab can give you a variety of information 
about your journey. 
For even more specific information about your log, simply play back or preview your log and 
then right-click a specific GPS point on the map to learn the date and time the point was 
obtained as well as the speed, bearing, elevation, and GPS status for that particular point. 

To View File Details for a GPS Log 

Use the following steps to view log file details. 
1. Click the GPS tab and then click the GPS Log subtab. 
2. Click Clear Trail to clear any existing GPS points from the map display. 
3. Click File and then click Open. 
4. Select the file you want to view details for and then click Open. 
5. Click File and then click File Details. 

A dialog box shows information about your log. 
6. Click OK to exit the dialog box. 

  

Monitoring Your GPS Status 
Once you initialize your GPS and begun tracking, you can continue to monitor the status of 
your GPS connection and other information. Status information accuracy is affected by 
speed (3 mph or more) and your GPS status. 3-D status provides the most accurate 
information. 

To Monitor Your GPS Status in GPS Tab View 

Speed and Heading 

 

Speed–Displays the speed you are traveling 
based on the units you selected on the Display 
tab in the Options dialog box. 
Heading–Displays the direction you are traveling 
as degrees T (True North) or M (Magnetic North) 
based on the bearing selected on the Units area 
on the Display tab in the Options dialog box. 
Heading is provided as a numerical value as well 
as a compass direction. 

  

Coordinates/Elevation 
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Coordinates–The coordinate fields display based on the units you selected 
on the Display tab in the Options dialog box. 
Elevation–Displays the current elevation if the GPS status is 3-D and is 
based on the selected Units preference. Elevation can be displayed with a 
2-D status; your position is indicated accurately on your screen as you 
travel unless you are in an area where your elevation varies greatly. 

  

GPS Status 

 

No GPS–A red circle with a slash indicates the GPS receiver is not yet 
detected by your computer. This status usually displays when initialization first 
begins. 
Acquiring–A red blinking circle indicates the GPS receiver is not yet receiving 
sufficient satellite data to determine your position. This status displays while 
the GPS receiver is acquiring satellite data and can take several minutes. 
2-D–A yellow circle indicates the GPS connection is successful but there is 
insufficient satellite data to determine your GPS position. This usually 
indicates insufficient data for an accurate location due to: 

• Only three satellites being used 
• Poor signals from the satellites. 

Move your receiver to another location until you get better reception. 
3-D–A green circle indicates the GPS receiver is receiving sufficient satellite 
data to determine your location. When the status reads 3-D, your current 
coordinates, elevation, and heading are displayed, along with the speed you 
are currently traveling. 
Note  If you are tracking with a WAAS-enabled device, a 3-D fix displays as 
"3-D DGPS." 

To Monitor Your GPS Status in NavMode 

In NavMode, you can view your speed, ETA, next turn, and distance to finish. To view other 
GPS status information, use the tab view. 
  

Monitoring GPS Satellite Information 
Click Sat. Info in the GPS tab to view the current satellite status. Sat. Info is a toggle 
button that switches to Status. Click Status to return to the original Status dialog area. 

  

Dilution of Precision 

 

The Dilution of Precision area lists your Position Dilution of Precision, 
your Horizontal Dilution of Precision, and your Vertical Dilution of 
Precision. For definitions of these terms, see Glossary Terms. 

  
Satellite Listing 
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The Satellite Listing window displays the satellites that are currently 
visible in the sky. The columns list the satellite number, elevation, 
azimuth, and signal-to-noise ratio. 
Satellite Listing information is only available for DeLorme receivers and 
NMEA-compatible receivers. 

  
Almanac 
 

When using a DeLorme GPS receiver, the Almanac window displays the 
satellite number and its current status. 
N–Indicates the satellite is being used for navigation. 
E–Indicates ephemeris data is available for the satellite. 
T–Indicates the satellite is currently being tracked by your GPS 
receiver. 
D–Indicates differential data is available for that satellite.  
Notes 

• Differential data is available on WAAS-enabled devices. 
• Almanac information is available only for DeLorme receivers. 

  
Skyview 
 

The Skyview diagram indicates visible satellites, their number (assigned by 
the Department of Defense), and their position in the sky relative to your 
current position. Each satellite is color coded, based on the quality of data 
it is transmitting. 
Gray–Indicates the satellite's position in the sky. 
Red–Indicates your GPS receiver is tracking the satellite but it is not 
receiving data from it. 
Yellow–(DeLorme GPS receivers only) Indicates your receiver is tracking 
the satellite, ephemeris data is available, but the satellite is not being used 
for navigation. 
Green–Indicates your GPS receiver is tracking the satellite, ephemeris data 
is available, and the satellite is being used for navigation. 
Dark Green–WAAS-enabled receivers only. Indicates your receiver is 
tracking the satellite, ephemeris data is available, the satellite is being used 
for navigation, and the satellite has DGPS and WAAS corrections available. 
Blue–WAAS-enabled receivers only. Indicates a WAAS satellite used for 
corrections. 

Viewing Sun and Moon Information 
You can use the Sun/Moon subtab in the GPS tab to view information about the rising and 
setting of the Sun and Moon relative to a specified date, time, and location. 

To View Sun and Moon Information 

Use the following steps to view Sun and Moon information in the GPS tab. 
1. Click the GPS tab. 
2. Click the Sun/Moon subtab. 
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3. Click the down arrow next to the date to change the date. 
4. Use the scroll arrows to change the time. 
5. After you update the date and time, you can view: 

• The Sun and Moon traveling across the compass as time passes with the 
Sun/Moon compass. In the center of the compass, a shadow grows and 
shrinks and changes direction as the Sun moves across the compass (similar 
to a sun dial). 

• Sun rise/set and Moon rise/set information. 
• Moon cycle information (such as the day of the moon cycle and the phase). 

  

GPS Devices 
DeLorme software interfaces with different GPS devices as outlined below. 

• DeLorme GPS Devices–DeLorme GPS devices work with DeLorme software 
programs. 

• USB GPS Support–DeLorme software can use the data output from a USB GPS if 
the device meets one of the following criteria: 

• When the GPS is attached to the computer, it is recognized and displayed 
under Ports in the Windows Device Manager. 

• The unit is a GARMIN USB device and the GARMIN drivers are installed. 
Note  Magellan USB devices are not currently supported. 

• Serial GPS Support–DeLorme software can use the data output from a serial GPS 
device. The device must be connected to a free COM port and output a generic NMEA 
(National Marine Electronics Association) stream. 

• Bluetooth GPS Support–DeLorme software can use the data output from a 
Bluetooth GPS device. You must configure your Bluetooth software to create a virtual 
serial port. 

  

 
Safety 

Warnings 

• Bring a passenger along to serve as GPS operator while you are driving 
a vehicle. 

• Do not use this application with automatic navigation, guidance 
systems or for any purpose requiring precise measurement of distance 
or direction. 

  

About GPS 
What is GPS? 

The Global Positioning System (GPS) applies modern technology to the ancient basics of 
navigation. The U.S. Department of Defense has developed and launched a series of 
positioning satellites in an orbiting constellation. These satellites are used as reference 
points much the same way stars have been used in conventional navigation. 
Using these satellites, a GPS receiver can determine your position anywhere on the globe. 
GPS provides accurate information about coordinate position, elevation, speed, and 
direction of travel. Many people have discovered the benefits of GPS for tracking vehicles, 
recording routes, and much more. 
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How Does GPS Work? 

The GPS constellation consists of 24 satellites, each carrying several atomic clocks to ensure 
the most accurate time possible. The satellites broadcast low-power radio waves containing 
the satellite's identity code and the exact time (to the nanosecond) that the message was 
sent. 
When a GPS receiver picks up a satellite signal, it identifies the satellite and compares the 
signal time with its own clock. The time difference represents the time it has taken for that 
radio wave to travel from the satellite to the receiver. Since radio waves travel at the speed 
of light, the time difference can be used to calculate the distance from the satellite to the 
GPS receiver. 
The satellite's identity code provides the location of the satellite, and the distance to the 
receiver creates a sphere of possible locations for the GPS receiver. Without more 
information, the receiver only knows that it is located somewhere on that sphere. 
Two additional satellites are necessary to narrow down the receiver's possible position. Each 
of these satellites sends a similar radio message containing time and identity information. 
The GPS receiver checks the orbital location of each satellite and uses the elapsed time to 
create two additional spheres of possible locations. These three spheres intersect at two 
points; however, one of these points is eliminated because it is far away from the earth's 
surface. Therefore, the second point is assumed to be correct. The data from these three 
satellites provides the receiver with a two-dimensional location. 
Data acquired from a fourth satellite pinpoints the receiver's exact location. This additional 
positioning information allows the GPS receiver to calculate its elevation, which is 
particularly important for GPS users in mountainous locations. 

GPS Position Accuracy 

The accuracy of the data your GPS receiver provides is dependent upon many factors, 
including the quality of your equipment. A low-quality clock within the receiver decreases 
the accuracy of your location. The atmosphere, the ionosphere, and the number of channels 
your receiver can handle all affect the accuracy of your system. Consult your GPS hardware 
manuals for information on how your receiver adjusts for errors. 
Any buildings, natural structures, or heavy foliage that obstruct the GPS antenna's view of 
the sky prevent satellite signals from reaching the receiver and decreases the accuracy of 
your position. 
Your accuracy will also depend on your level of clearance with the U.S. Department of 
Defense. There are two available radio signals that receivers can use: the Standard 
Positioning Service (SPS) for civilians and the Precise Positioning Service (PPS) for military 
and authorized personnel. 
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Using Small-screen Devices 

Using Small-screen Devices 
You can use your mapping application with small-screen devices, such as netbooks and 
UMPCs (Ultra Mobile PCs). If you are installing Street Atlas USA on a netbook or small-
screen device, select Netbook Mode as the default mode when you install Street Atlas USA. 
If you do not select Netbook Mode when you install, you can enable it at any time: Click the 

Options menu arrow  and click Netbook Mode to select the check box. To turn 
off Netbook Mode, clear the check box. 
The default interface minimizes the tab area, hides the Control Panel, and shows only the 
toolbar buttons you need for navigating and tracking on a small screen; however, you can 
add or remove tabs, show or hide toolbar buttons, and customize the interface to meet your 
needs. 
  
This screen is optimized for a netbook and is displaying GPS with NavMode in 3-D. 

 
  
Your Street Atlas license allows you to install a copy of the software on a portable device in 
addition to your computer. Please see the license agreement for your software for further 
information: 
Street Atlas USA Plus Single-User License Agreement 
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Using Voice Navigation and Speech Recognition 

Voice Overview 

 

To use voice navigation, you must have a 2-D or 3-D GPS fix and a route 
calculated. 

  
Using the speech recognition and text-to-speech technology included in your application, 
you can issue a series of voice commands to a laptop computer. The voice commands 
activate basic navigation, map control, and GPS features, providing you with hands-free 
program navigation so you can concentrate on your driving. When tracking with a GPS 
receiver, you can receive spoken updates about your route directions, next turn, next stop, 
current location, etc. 
  

Notes 
• The Voice label on the Voice tab displays red when the microphone is activated. 
• Your application comes equipped with Microsoft® English Recognizer Version 5.1. 

You can also use other speech recognition engines that you may have purchased 
separately from other software companies. Such speech recognition engines must 
support SAPI 5.1 to be available to you in your application. See the Speech 
settings in the Windows Control Panel for more information about your engine. 

• If you have purchased other voices (text-to-speech engines) that are SAPI 5.1-
compatible, they are available in your application. 

• You must have a microphone attached to your computer to use speech 
recognition (for input). 

• For tips on using the speech recognition feature and setting up your microphone, 
see Speech Recognition Tips. 

• If you are having difficulty hearing the voice output, adjust the volume on your 
external speakers or adjust your computer's volume using the settings in the 
Windows® Control Panel. 

• If you chose the custom installation option when you installed your application, 
you were asked whether or not to install a speech recognition engine for voice 
input. If you want to use voice input and selected not to install a speech 
recognition engine when you installed the program, you must uninstall and then 
reinstall the application, making sure to select to install the speech recognition 
engine. 

• The speech recognition engine is automatically installed on Windows Vista 
operating systems.   

• If you have another DeLorme product installed and already opted to install 
the speech recognition engine, you may not see the option to install it 
again. 

  

Voice Options 
Click a link to learn more about the Voice tab in the Options dialog box: 

• Training the Speech Recognition Engine 
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• Speech Recognition Tips 
• Changing Voice Output 
• Voice Preferences 

Activating and Monitoring Speech Recognition 

 

To use voice navigation, you must have a 2-D or 3-D GPS fix and a route 
calculated. 

  
Use the Voice tab to view status information about your microphone and the list of available 
voice commands. 

• The Microphone bar (VU meter) indicates the level of sound received from the 
microphone. 

• The Command Status area displays either the last recognized voice command or one 
of the following error messages: 

•  
• Too noisy 
• No signal 
• Input too loud 
• Input too quiet 

• The Commands box lists the voice commands for accessing the Voice tab, 
navigating, using the map, and using GPS. It shows the availability of the commands 
and their shortcut keys. You can double-click a command to issue it. 

To Activate and Monitor the Speech Recognition Feature 

Use the following steps to activate and monitor the speech recognition feature. 
1. Click the Voice tab. 
2. Select the Microphone check box to activate your microphone and to turn on the 

speech recognition feature. 
The tab name turns red if the microphone is listening to your commands. 
Note  If your microphone is active when you exit the program, it will still be active 
when you re-enter the application. 

3. To trigger an audible signal when a voice command is recognized, select the Beep 
When Heard check box. 

4. To display all of the possible voice commands, including variations of the commands, 
select the Show All Commands check box. 
Both enabled  and disabled  commands are displayed. 
Note  Some commands are disabled if a route is not calculated or if the GPS is not 
initialized. 

Training the Speech Recognition Engine 

 

To use voice navigation, you must have a 2-D or 3-D GPS fix and a route 
calculated. 
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You should train the speech recognition engine to provide good speech recognition results. 
Before training, ensure your microphone is active and the speech recognition feature is on. 
For more information, see Activating and Monitoring Speech Recognition. 

To Train the Engine to Recognize Your Speech Patterns 

You should train the speech recognition engine to recognize your specific speech patterns. 
This is often done by reading a predetermined piece of text supplied by the creator of the 
speech recognition engine. If the engine supports multiple user models, you can train the 
engine to recognize more than one speech pattern. 
Use the following steps to train the speech recognition engine to recognize your speech 
patterns. 

1. Click the Options button  on the toolbar. 
OR 
Click the arrow next to the Options toolbar button to open the menu. Then, click 
Options to open the dialog box. 

2. Click the Voice Settings tab. 
3. Select the microphone you intend to use from the Microphone drop-down list. 
4. Select your preferred user voice model from the User Profile drop-down list. 

Note  To create a new speech recognition profile for each of your working 
environments (noisy, quiet) and users (your spouse, your child), click Speech in the 
Windows Control Panel. 

5. Select your preferred speech recognition engine from the Recognizer drop-down 
list. 
Note  Select the most recent version available in the drop-down list. 

6. Click Speech Profile Training to display the speech training wizard specific to your 
speech recognition engine. 
Note  This feature is available only if it is supported by your speech recognition 
engine. 

7. Follow the on-screen instructions. 
Tips 
For best results: 

• Use a close-talk microphone that rests near the side of your mouth instead of a 
desktop or built-in microphone. 

• Train the speech recognition engine in the same environment in which you will use it. 
For example, if you use the engine mostly in the car, perform training in the car. 
Perform three training sessions to get the best results. 

• When training, speak the same voice as you will when giving voice commands to the 
computer. Speak distinctly and at an average speed, as if giving a command. 

• Use the Microphone Wizard to ensure your microphone is working correctly and to 
view tips on microphone selection and placement. To use the wizard, click 
Microphone Setup on the Voice tab of the Options dialog. Or, from the Start menu 
on your computer, browse to the Control Panel and double-click the Speech icon to 
open the Speech Properties dialog box. 

• To increase the likelihood of correct speech recognition, on the Voice Settings tab in 
the Options dialog box, select the Commands start with check box and then type 
the appropriate word/phrase in the text box (if using a single word, use a word with 
more than one syllable). For example, if you type computer, you would then say 
"Computer, zoom in." 
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Voice Commands 

 

To use voice navigation, you must have a 2-D or 3-D GPS fix and a route 
calculated. 

  
Your application includes Route, Map, GPS, and Voice tab control commands. Select the 
Show All Commands check box to view all options, including those which are variations or 
unavailable. 

Route Tab Commands 
The following table shows navigation voice commands for the Route tab. If there is a 
keyboard shortcut available, it is listed after the command. 

Spoken Command Response 

What is the next turn? 
(F5) 

Speaks the next turn name, time to turn, distance to turn, 
bearing to turn, and turn direction. Displays the Directions 
subtab in the Route tab. 

What's the next turn? 
(F5) 

Next turn. (F5) 

Show next turn. (F6) Displays current location and next turn. Displays the 
Directions subtab in the Route tab. 

Center on next turn. Centers map on the next turn. Displays the Directions subtab 
in the Route tab. 

What is the next stop? Speaks the next stop name, distance to stop, bearing to stop, 
and time to stop. Displays the Directions subtab in the Route 
tab. What's the next stop? 

Next stop 

Show next stop. (F7) Displays current location and next stop. Displays the 
Directions subtab in the Route tab. 

Center on next stop. Centers map on the next stop. Displays the Directions subtab 
in the Route tab. 

After that. Speaks the next stop or turn information, depending on the 
previous spoken direction. 

Are we there yet? Speaks the finish name, time to finish, and distance to finish. 

Show finish. (F8) Displays current location and finish on the map. 

Center on finish. Centers map on the finish. Displays the Directions subtab in 
the Route tab. 

Directions. Speaks the next turn, next stop, finish, name, time, and 
distance. Displays the Directions subtab in the Route tab. 

Where am I? Speaks current route segment, heading, speed, town, county, 
and state. 

Coordinates. Speaks the coordinate of your current location. 
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Shush. Silences GPS voice navigation, but does not turn it off. 

Be quiet. Silences GPS voice navigation, but does not turn it off. 

Voice nav on. (F2) Turns voice navigation (spoken turn directions) on. 

Voice nav off. (F2) Turns voice navigation (spoken turn directions) off. 

Show route. Displays your route on the map. 

Back on track. Adds current GPS location as a stop and recalculates the 
route. 

Continue route from here. 
(F9) 

Adds current location as a stop and recalculates the route. 

Show turns. Activates the Show Turns dialog area in the Route tab. 

Show directions. Activates the Directions subtab in the Route tab. 

Show list. 

Map Commands 
The following table shows main map voice commands. If there is a keyboard shortcut 
available, it is listed after the command. 

Spoken Command Response 

Pan left. (ALT+Left) Pans (or scrolls) the map left. 

Scroll left. (ALT+Left) 

Pan right. (ALT+Right) Pans (or scrolls) the map right. 

Scroll right. (ALT+Right) 

Pan up. (ALT+UP) Pans (or scrolls) the map up. 

Scroll up. (ALT+UP) 

Pan down. (ALT+DOWN) Pans (or scrolls) the map down. 

Scroll down. (ALT+DOWN) 

Zoom in. (ALT+PAGE 
DOWN) 

Zooms in one level. 

Zoom out. (ALT+PAGE 
UP) 

Zooms out one level. 

Zoom in <#> times. Zooms in the specified number of levels. 

Zoom out <#> times. Zooms out the specified number of levels. 

Zoom level <#>. Zooms to specified level. 

Previous map. Displays the previous map. 

Go back. 

GPS Tab Commands 
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The following table shows GPS voice commands. If there is a keyboard shortcut available, it 
is listed after the command. 

Spoken Command Response 

Start GPS. (CTRL+G) Starts GPS tracking. 

Stop GPS. (CTRL+G) Stops GPS tracking. 

GPS status. Displays the GPS Status subtab. 

Monitor GPS. Displays the GPS Monitor subtab. 

GPS Monitor. 

Center on GPS. (ALT+P) Recenters the map on the current GPS location. 

Stop centering on GPS. 
(ALT+P) 

Stops the map from recentering on your current GPS 
location. 

Stop center on GPS. 
(ALT+P) 

Clear GPS. Clears the GPS "bread crumb trail" from the map. 

Autorotate map on. 
(ALT+R) 

Turns automatic map rotation on. 

Autorotate map off. 
(ALT+R) 

Turns automatic map rotation off. 

Autozoom map on. 
(ALT+Z) 

When GPS tracking, turns automatic zoom on. 

Autozoom map off. 
(ALT+Z) 

When GPS tracking, turns automatic zoom off. 

Voice Tab Commands 
The following table shows Voice tab voice commands and the response. If there is a 
keyboard shortcut available, it is listed after the command. 

Spoken Command Response 

What can I say? Displays the Monitor dialog box. 

More commands. Displays next page of voice commands. 

Repeat last command. Repeats your last spoken command. 

  

Speech Recognition Tips 

 

To use voice navigation, you must have a 2-D or 3-D GPS fix and a route 
calculated. 

  
The following tips provide information on using the speech recognition feature and setting 
up your microphone. 

• Speech recognition is only active when your application is the active window. 
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• Commands become enabled based on your current GPS status, your data zoom level, 
and other factors. Enabled commands do not have a red "x" on the icon. 

• Disabled commands have a red "x" on the icon. 
Note  Some commands are disabled if a route is not calculated or if the GPS has not 
been initialized. 

• Avoid noisy environments when using voice command navigation. 
• Use a close-talk microphone for best speech recognition results. 
• Properly position your microphone to achieve the best speech recognition results. For 

a close-talk microphone, the recommended position is a thumb-width from the 
corner of your mouth and slightly to the side. For more information, see the note at 
the end of this topic. 

• When issuing commands to the computer, use the same tone that was used when 
during the speech recognition engine training. 

• Keep the microphone as far as possible from the car radio or console, computer 
speakers, or other speakers. 

• If your microphone is near your speakers, and you are using the microphone 
together with voice reminders (GPS VoiceNav), the program may recognize some of 
the words that it is speaking and react to them. Here are ways to eliminate this 
problem: 

• Make sure that you have chosen the Voice Output device (speakers, headset) 
and the Input device (on-board microphone, headset microphone) that you 
intend to use with DeLorme GPS voice navigation. Use the selections that are 
available in the Voice settings tab in the Options dialog box. 

• If more than one speech recognizer is available in the drop-down list, choose 
the most recent (highest version number). 

• Your best speech recognition responses will always be to use a close-talk 
microphone with voice output using the laptop speakers rather than a 
headphone speaker so that the computer will not "hear itself." 

• If you are speaking with someone else in the room, have a radio or television 
on, and so on, the computer may think those sounds are commands to follow. 
Select the Microphone check box on the Voice tab only when you intend to 
use it. If you exit the program with the Microphone check box selected, the 
program will start speech recognition again when you restart the program. 
Voice recognition requires a lot of disk space and slows down the system if 
you are not using it. Remember: the Voice tab displays with red font 
whenever the microphone is listening. 

• Use the Commands Start With feature in the Voice tab in the Options dialog 
to clearly distinguish commands from other noise and speech. Set the 
Commands Start With phrase to something like “computer” or “Simon Says” 
to reduce the chances of an unexpected command recognition. When 
choosing a phrase, make sure that it is more than one syllable. The phrases 
"computer" or "Simon Says" work well. But the simple word "map" probably 
will not. 

• Train the speech recognition system in the environment in which you will use 
it (for example, in a noisy car). 

Note  To find out the proper position for your microphone model, or to find tips on how to 

purchase a microphone, click the Options button  on the toolbar (or click the 
arrow next to the Options toolbar button to open the menu; then, click Options to open 
the dialog box), click the Voice Settings tab, and then click Microphone Setup. Or, from 
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the Start menu on your computer, browse to the Control Panel and double-click the Speech 
icon to open the Speech Properties dialog box. 

Changing Voice Output 

 

To use voice navigation, you must have a 2-D or 3-D GPS fix and a route 
calculated. 

  
Your application offers text-to-speech technology so you can receive spoken updates about 
your route directions, next turn, next stop, current location, time to finish, or current 
coordinates when navigating with a GPS receiver. Text-to-speech allows hands-free 
navigation of the program on your computer. 
Use your text-to-speech engine to change and preview the tone and quality of the 
computer's voice. 

To Change the Voice Output 

Use the following steps to change your computer's voice. 

1. Click the Options button  on the toolbar. 
OR 
Click the arrow next to the Options toolbar button to open the menu. Then, click 
Options to open the dialog box. 

2. Click the Voice Settings tab. 
3. From the Voice drop-down list box, select a voice from the list of options. 

A description of the selected voice displays to the right of the drop-down list box. 
Note  If you have purchased SAPI 5.1-compatible voices from another software 
vendor, they are included in this list. 

4. From the Device drop-down list box, select the output device from which you want 
to hear the computer's voice (for example, your speakers or a headset). 

5. To preview the voice, click Test Voice, type a sample sentence, and then click OK. 
The sample sentence is spoken in the selected voice. 

6. Use the Voice Volume spin box to adjust the output volume relative to the other 
programs you are running. By default, this is set to 100 (maximum). Note that you 
cannot set the volume higher than your speakers or Windows Control Panel settings 
capabilities.  
Note  Click Audio Controls to access additional volume settings. 

7. Use the Speaking Rate spin box to adjust the rate at which the computer's voice 
will speak. A value of 50 is normal. 

Voice Preferences 

 

To use voice navigation, you must have a 2-D or 3-D GPS fix and a route 
calculated. 

  
The Voice tab in the Options dialog displays a series of Engine Option buttons. These option 
buttons allow you to view information or change preference settings in your speech 
recognition or text-to-speech engines. Some speech recognition or text-to-speech engines 
do not support some of the preference options. 



Using Voice Navigation and Speech Recognition 

215 

To View and Update Speech Recognition Preferences 

To change speech input preferences, click the Options button  on the toolbar (or 
click the arrow next to the Options toolbar button to open the menu; then, click Options 
to open the dialog box), and then click the Voice Settings tab. The following options are 
available under the Speech Recognition area of the dialog box. 

• Microphone Setup–Opens the Microphone Wizard to adjust speech recognition 
whenever you change microphone or noise environments. 

• Speech Profile Training–Opens Voice Training Wizard to train the engine to 
recognize your speech patterns. This process may take 10–15 minutes to complete. 

• DeLorme Training–Opens an abbreviated version of the Voice Training Wizard. This 
dialog trains the system on DeLorme voice commands. 

• Add/Delete Words–Opens the Add/Delete Words Wizard with the pronunciation 
wizard specific to your speech recognition engine. You can enter, edit, or view the 
words in your pronunciation vocabulary. Use this wizard when the speech recognition 
has trouble understanding a specific word that you are saying. 

• Recognition Settings–Opens the Recognition Profile Settings dialog. Use this to 
change preferences for sensitivity and tolerance of errors in recognizing your voice. 
Note  Your application comes equipped with Microsoft English Recognizer Version 
5.1. You may have a premium version (for example, Microsoft Office 2003 installs 
Microsoft English U.S. Version 6.1 Recognizer). Select the most recent version. 

To View and Update Voice Output Preferences 

To change voice output preferences, click the Options button  on the toolbar (or 
click the arrow next to the Options toolbar button to open the menu; then, click Options 
to open the dialog box), and then click the Voice Settings tab. The following options are 
available under the Voice Output area of the dialog box. 

• Test Voice–Choose to display the preview voice dialog box for your text-to-speech 
engine. Type in a sentence and click OK to hear it spoken. 

• Audio Controls–Choose to adjust the speaker volume for all programs on your 
computer. This is equivalent to the same adjustment in the Windows Control Panel. 

Voice Prompts 
Directions (spoken first or alone) 

Proceed… 
Continue straight... 
Bear right… 
Bear left… 
Turn right… 
Turn left… 
Turn hard right… 
Turn hard left… 
Go east… 
Go west… 
Go north… 
Go northeast… 
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Go northwest… 
Go south… 
Go southeast… 
Go southwest… 

Direction distance modifiers (spoken second) 

…in [distance in tenths of a mile] 

Other (spoken alone) 

At finish. [was: “Destination reached.”] 
Last leg. 
Approaching finish. 
Off route. 
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Exchanging Information with A Third-party GPS Device 

Sending Route Information 
Third-party GPS 
If you have a compatible GPS device, you can use the Exchange Wizard to send route points 
or route directions to your device. 

To Send Route Points 

Use the following steps to send route points to your device. 
1. Connect your device to your computer. 
2. If you are using a third-party GPS receiver, you may have to use specific settings. 

For example, if you are using a GARMIN GPS receiver, set your GARMIN receiver 
interface to GRMN/GRMN. For more information, see your owner manual. 

3. Click the Exchange button  on the toolbar. 
4. Under Select Device, select GPS. 
5. Select Send to Device. 
6. Select Route Points from the Object drop-down list. 
7. Click Next. 
8. From the Route drop-down list, select the route file that contains the route points 

you want to send to your device. 
9. To avoid overwriting existing waypoints on your device, type a starting point for the 

new points and select the Prefix a Number to the Waypoint Name check box. Not 
all devices support starting points. For more information, see your device manual. 

10. Click Send to Device. 
11. Repeat the steps for every route file you want to send to your device. 
12. Click Finish. 

To Send Route Directions 

Use the following steps to send route directions to your GPS device. 
1. Connect your device to your computer. 
2. If you are using a third-party GPS receiver, you may have to use specific settings. 

For example, if you are using a GARMIN GPS receiver, set your GARMIN receiver 
interface to GRMN/GRMN. For more information, see your device manual. 

3. Click the Exchange button  on the toolbar. 
4. Under Select Device, select GPS. 
5. Select Send to Device. 
6. Select Route Directions from the Object drop-down list. 
7. Click Next. 
8. From the Route drop-down list, select the route file that contains the route 

directions you want to send to your device. 
9. Designate a route name and/or a route number for the file on the device (device 

dependent). 
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10. To avoid overwriting existing waypoints on your device, type a starting point for the 
new points and select the Prefix a Number to the Waypoint Name check box. Not 
all devices support starting points. For more information, see your device manual. 

11. Click Send to Device. 
12. Repeat the steps for each route file you wan to send to your device. 
13. Click Finish. 

Tip  You can also open the Exchange Wizard by clicking the Exchange button  on 
the GPS tab. 

Sending Tracks 
Third-party GPS 
If you have a compatible GPS device, you can use the Exchange Wizard to send tracks to 
your device. 

To Send Tracks 

Use the following steps to send tracks to your device. 
1. Connect your device to your computer. 
2. If you are using a third-party GPS receiver, you may have to use specific settings. 

For example, if you are using a GARMIN GPS receiver, set your GARMIN receiver 
interface to GRMN/GRMN. For more information, see your device manual. 

3. Click the Exchange button  on the toolbar. 
4. Under Select Device, select GPS. 
5. Select Send to Device. 
6. Select User Map Data - Track from the Object drop-down list. 
7. Click Next. 
8. Select the track file you want to send to your device from the Track File drop-down 

list. 
9. Optional. Designate a track name or a track number for the file on the device. 
10. Click Send to Device. 
11. Repeat the steps for every route file you want to send to your device. 
12. Click Finish. 

Tip  You can also open the Exchange Wizard by clicking the Exchange button  on 
the GPS tab. 

Sending Waypoints 
Third-party GPS 
If you have a compatible GPS device, you can use the Exchange Wizard to send waypoints 
to your device. 

To Send Waypoints 

Use the following steps to send waypoints to your device. 
1. Connect your device to your computer. 
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2. If you are using a third-party GPS receiver, you may have to use specific settings. 
For example, if you are using a GARMIN GPS receiver, set your GARMIN receiver 
interface to GRMN/GRMN. For more information, see your device manual.. 

3. Click the Exchange button  on the toolbar. 
4. Under Select Device, select GPS. 
5. Select Send to Device. 
6. Select User Map Data - Waypoints from the Object drop-down list. 
7. Click Next. 
8. Select the waypoint file you want to send to your device from the Waypoint File 

drop-down list. 
9. To avoid overwriting existing waypoints on your device, type a starting point for the 

new points and select the Prefix a Number to the Waypoint Name check box. Not 
all devices support starting points. For more information, see your device manual. 

10. Click Send to Device. 
11. Repeat the steps for every route file you want to send to your device. 
12. Click Finish. 

Tip  You can also open the Exchange Wizard by clicking the Exchange button  on 
the GPS tab. 

Receiving a Route 
Third-party GPS 
If you have a compatible GPS device, you can use the Exchange Wizard to receive routes 
created on your device. Once imported, you can use the file in your mapping program. 

To Receive a Route 

Use the following steps to receive a route from your device. 
1. Connect your device to your computer. 
2. If you are using a third-party GPS receiver, you may have to use specific settings. 

For example, if you are using a GARMIN GPS receiver, set your GARMIN receiver 
interface to GRMN/GRMN. For more information, see your device manual. 

3. Click the Exchange button  on the toolbar. 
4. Under Select Device, select GPS. 
5. Select Receive from Device. 
6. Select Route from the Object drop-down list. 
7. Select Route from the Save As drop-down list. 
8. Click Next. 
9. Select the route name or route number on the device that you want to receive. 
10. Select the route file you want to add the route information to. If you want to create a 

new route file, select New from the Route drop-down list and type the new route 
name in the available text box. 

11. Click Receive from Device. 
12. Repeat the steps for every route file you want to receive from your device. 
13. Click Finish. 
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Tip  You can also open the Exchange Wizard by clicking the Exchange button  on 
the GPS tab. 

Receiving a Track 
Third-party GPS 
If you have a compatible GPS device, you can use the Exchange Wizard to receive tracks 
created on your device. Once imported, you can use the file in your mapping program. 
Note  When you open a track you've imported from your GPS device, you may notice that 
the track does not join existing roads. Use the select tool in the Draw tab to snap the end 
node of the track to a road. For more information, see Snapping Draw Objects. 

To Receive a Track 

Use the following steps to receive a track from your device and save it as a track. 
1. Connect your device to your computer. 
2. If you are using a third-party GPS receiver, you may have to use specific settings. 

For example, if you are using a GARMIN GPS receiver, set your GARMIN receiver 
interface to GRMN/GRMN. For more information, see your device manual. 

3. Click the Exchange button  on the toolbar. 
4. Under Select Device, select GPS. 
5. Select Receive from Device. 
6. Select Track from the Object drop-down list. 
7. Select User Map Data - Track from the Save As drop-down list. 
8. Click Next. 
9. Select the track name or track number on the device that you want to receive. Not 

all devices support downloading individual track logs. See your device manual for 
more information. 

10. Select the track file you want to add the track information to. To create a new track 
file, select New from the Track File drop-down list and type the new track file name 
in the New Track File text box. 

11. Optional. Type a label for your track in the Track Label text box. 
12. Click Receive from Device. 
13. Repeat the steps for every track file you want to receive from your device. 
14. Click Finish. 

Tip  You can also open the Exchange Wizard by clicking the Exchange button  on 
the GPS tab. 

Receiving Waypoints 
Third-party GPS 
If you have a compatible GPS device, you can use the Exchange Wizard to receive 
waypoints created on your device and save them as a draw file or as a waypoint file. Once 
imported, you can use the file in your mapping program. 

To Receive Waypoints as a Waypoint File 

Use the following steps to receive waypoints from your device. 
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1. Connect your device to your computer. 
2. If you are using a third-party GPS receiver, you may have to use specific settings. 

For example, if you are using a GARMIN GPS receiver, set your GARMIN receiver 
interface to GRMN/GRMN. For more information, see your device manual. 

3. Click the Exchange button  on the toolbar. 
4. Under Select Device, select GPS. 
5. Select Receive from Device. 
6. Select Waypoints from the Object drop-down list. 
7. Select User Map Data - Waypoints from the Save As drop-down list. 
8. Click Next. 
9. Select the waypoint file you want to add the waypoint information to from the 

Waypoint File drop-down list. To create a new Waypoint file, select New from the 
Waypoint File drop-down list and type the new waypoint file name in the New 
Waypoint File text box. 

10. If you want all of the waypoints to display with the current symbol (such as the 
default red flag), select the Use Current Waypoint (active waypoint) option. If 
you want the waypoint symbols to match those on your third-party device, select the 
Use Custom Waypoint Symbol Set option and then select the appropriate set 
from the drop-down list. For more information on creating a custom symbol set, see 
Assigning a Waypoint ID to a Custom Symbol. 

11. Click Receive From Device. 
12. Repeats the steps for each waypoint file you want to receive. 
13. Click Finish. 

Tip  You can also open the Exchange Wizard by clicking the Exchange button  on 
the GPS tab. 
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Using NetLink 

NetLink 
NetLink is an online portal within Street Atlas USA®. You must have an Internet connection 
to use NetLink. To get help with NetLink, click the blue Help button  on the NetLink tab. 
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Using GeoTagger 

Getting Started with GeoTagger 
Use the GeoTagger Wizard to sync digital photos with GPS log files (.gpl) and track files 
(.an1) and tag them to the location you took them. You can place images as an actual 
image on the map, a MapNote with a hyperlink, or a symbol with a hyperlink. 

To open the GeoTagger Wizard, click the GeoTagger  button on the toolbar. The 
Geotagger button is hidden by default; to show it, right-click the toolbar to open the menu 
and click GeoTagger. 
  
Important!  Make sure the time and date on your camera and on your GPS device match 
before you begin. This ensures that your images are correctly matched to the GPS log file or 
track file. If you do not have the correct time on your camera, you can update the 
information with the Timestamp Offset option in the wizard. See Calculating the Timestamp 
Offset. 

Tagging an Image 
Once you successfully tag your digital images to a GPS log file or track file, you can view the 
points at which the photos were taken on the map in your DeLorme program. 
Before you begin, you must download the GPS log file or track file and digital photographs 
to your computer. See Receiving a Track From Your Third-party GPS Device for information 
on using the Exchange Wizard to transfer files.   

To Tag an Image 

1. Click the GeoTagger button  on the toolbar to open the GeoTagger Wizard. 
2. Select Images and click Next. 
3. In the Photo Directory box, type the path and file name for the folder (not specific 

images) on your computer where the images are stored. 
OR 
Click Browse to search for the folder on your computer. 

4. Under Time Zone, select the time zone where you were when you took the pictures. 
See GMT Time Zone Information for a table of time zones by state. 
If Daylight Saving Time was in effect (second Sunday in March through first Sunday 
in November), select the Adjust for Daylight Saving Time check box. 

5. Under GPS Data, select Track or GPL File. 
6. If you selected Track, the list of track layers in the Draw tab displays in a tree menu. 

Click the plus sign to expand the tree menu, and click the track. You can select only 
one track at a time. 
If you selected GPL File, in the GPS Data box, type the path and file name for the 
file or click Browse to search for the file on your computer. 

7. Click Next. 
The Image list displays the images that will be tagged. Click an image to preview it 
in Image Preview window. 

8. Under Time Offset, if the time on your camera differed from actual time when you 
recorded the data, calculate the offset, type the actual time in the Matching GPS 
Time text box. 
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9. Click Next. 
10. Select how you want to place the image on the map. 

• Hyperlink–A MapNote with a hyperlink to the image displays on the map. 
• Embedded–A MapNote with a thumbnail image hyperlinked to the image 

displays on the map. 
• Symbol–A camera symbol with a hyperlink to the image displays on the map. 

11. Click Next. 
A message displays telling you that you successfully tagged your images. Click 
Finish. When you view the GPS log file or track on the map, you can see where the 
images are tagged. 
OR 
An error message displays; usually this is because the timestamps for the camera 
and the file or track do not match. 

Calculate the Timestamp Offset 
The time on your camera must match the time in the track or GPS log so the images display 
in the correct place. If they do not, you must calculate a timestamp offset. If possible, do 
this before you use the GeoTagger Wizard. 

To Calculate the Timestamp Offset Before Using the Wizard 

Use these steps to calculate the timestamp offset before you use the GeoTagger Wizard. 
1. Click the Draw tab and view your track or GPS log. 
2. Find a point on the track or GPS log where you know you took a picture. 
3. Make a note of the time. 
4. Start the GeoTagger Wizard and follow the on-screen steps. 
5. When you get to the screen with the offset option, highlight the image in the file list. 

The image timestamp displays in the Data Timestamp box. 
6. Type the time you made a note of in the Matching GPS Time text box. 

To Calculate the Timestamp Offset When Using the Wizard 

Use the following steps to calculate the timestamp offset if you are already using the 
GeoTagger Wizard. 

1. Click Cancel to exit the GeoTagger Wizard. 
2. Click the Draw tab and view your track or GPS log. 
3. Find a point on the track or GPS log where you know you took a picture. 
4. Make a note of the time. 
5. Start the GeoTagger Wizard and follow the on-screen steps until you get to the 

screen with the offset option. 
6. Highlight the image in the file list. 

The image timestamp displays in the Data Timestamp box. 
7. Type the time you made a note of in the Matching GPS Time text box. 
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Legal Information 

Street Atlas USA® 2015 Plus Single-User License 
Agreement 
This is an Agreement between you, the end user, and DeLorme.  By using the Street Atlas 
USA 2015 Plus software, data and documentation (the “System”), you are agreeing to be 
bound by the terms of this Agreement. 
If you do not agree with the terms of this Agreement, you may not use the System. Return 
all materials within thirty (30) days of receipt to the dealer from which you obtained them 
or to DeLorme for a full refund. 
Any term or condition of an approved purchase order that differs from or adds to the terms 
or conditions of this License Agreement as well as any other modification or amendment to 
this Agreement will not be effective unless expressly agreed to in writing by both parties. 

LICENSE TERMS AND CONDITIONS 
THE LICENSED SYSTEM 

The System consists of DeLorme's patented (U.S. Pat. Nos. 4,972,319; 5,030,117; 
5,559,707; 5,802,492; and 6,321,158; other patents pending) processes for the formatting, 
storage, retrieval and presentation of geographic and geographically related data; 
DeLorme's copyrighted computer program for the use of those processes and related 
functions; and compilations of geographic and supplemental data that are proprietary to 
DeLorme or its licensors.  The entire System, including the software, documentation, data 
compilations, screen displays and map printouts are protected by U.S. and foreign 
copyright. You have no ownership rights in the System.  Rather, you have a license to use 
the System as long as this Agreement remains in full force and effect. 
  

YOUR USE OF THE SYSTEM 

Permitted Use. This Agreement permits a registered user to use the System on a non-
exclusive basis for personal, reference or business purposes on a single computer at one 
time.  You may install the System on an auxiliary computer in addition to your principal 
computer.  However, one of these two computers must be portable and the software may 
not be used simultaneously on both computers. Otherwise, once you have installed the 
System on one computer you may use the System on a second computer only if you delete 
the System from the first computer or purchase a separate license.  Installation of any part 
of the System on a network is prohibited unless you have a separate network license.  For 
information on network or multiple-user licensing, contact DeLorme at 
https://contact.delorme.com or 1-800-293-2389. You may use the System as instructed by 
the documentation to perform its designed functions only for the purposes authorized by 
this Agreement. 
Paper Map Printout Rights. You may reproduce paper copies or static digital images, 
such as PDF or TIFF files, of any Street Atlas USA map for personal or household use or, if 
you are a business or institution, for in-house purposes, provided that distribution and use 
of such printouts and copies of printouts is limited to the location where the System is 
installed or limited to use by employees based at that location. 
Paper Locator Map Distribution Rights. You may distribute to family and friends, 
including via fax, paper copies or static digital images, such as PDF or TIFF files, of Street 
Atlas USA map printouts depicting locations of personal interest. You may distribute to your 
colleagues, clients, customers or prospects, including via fax, paper copies or static digital 
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images, such as PDF or TIFF files, of Street Atlas USA map printouts depicting the location 
of your business or institution or the locations of your business or institution-related 
meetings or events and in flyers or brochures that contain no paid advertising. 
Paper Report Distribution Rights. You may reproduce for distribution to colleagues or 
clients up to one thousand (1,000) paper copies of any Street Atlas USA map printouts for 
use in paper reports such as appraisals or environmental studies, provided that no such 
report includes more than fifty (50) different Street Atlas USA maps and that the 
distribution does not constitute a general and unrestricted publication for sale or resale or 
contain paid advertising. 
Periodical Illustrations. You may reproduce paper copies of any Street Atlas USA map 
printouts as illustrations to articles in printed paper periodical works, such as magazines, 
newspapers and newsletters, provided that the publication is not primarily a collection of 
maps, and provided that proper legend, as described below, accompanies the output. Such 
articles may also be posted on your Web site. Graphic printers hired by licensee to print 
DeLorme map images are required to purchase a license. 
Special Presentation Rights. You may use paper copies of Street Atlas USA map displays 
and printouts in presentations to live audiences only with prior written permission from 
DeLorme. 
Web Site Map Display Rights. You may display on your personal, business or institutional 
static Web site map images derived from the System, provided that you include the Legend 
indicated below and that you provide a link to the DeLorme Web site at www.delorme.com 
from any page featuring a DeLorme map image. If you subcontract a web developer to 
display map images said web developer must purchase a license. 
Legend. Any System output that is provided to a third party must include the following 
credit and copyright notice: “© 2015 DeLorme (www.delorme.com) Street Atlas USA Plus”. 
You may not remove, alter, or conceal any copyright or trademark notices appearing on any 
System output, except that when creating a mural map, you need only retain a single 
legend with scale, for use in the field. 
Phone Data.  End User shall use Phone Data in compliance with any and all federal, state 
or local statutes, regulations, or ordinances, including without limitation, any applicable 
privacy, do-not-call, telemarketing, or related statutes regulations or ordinances.  End User 
shall defend and indemnify DeLorme, including attorney fees, against any claims arising out 
of the violation by End User of this License Agreement. Export of phone data is limited to 
one thousand (1,000) records at any one time.  Phone data may not be used in conjunction 
with any autodialer, or similar device, or for call center or telemarketing purposes. 
Copy Services. You may use a commercial copy service to reproduce paper copies that are 
authorized by this Agreement. 
NetLink Tab. All data downloaded or purchased through the NetLink Tab is subject to 
DeLorme’s specific data use license agreement associated with those products.  Commercial 
use of NetLink data is prohibited.   

  
You understand and agree that the trademarks, trade names, service marks, 
copyrights and other proprietary rights of DeLorme are and shall remain the 
sole and exclusive property of DeLorme, and that you will not hold yourself 
out as having any ownership rights thereto.  You further agree that you will 
make no use of such rights except as provided in this Agreement. 
  
PROHIBITIONS ON USE 
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No Resale or Distribution. Except as expressly permitted in this Agreement, you do not 
have the right to sell, or to reproduce or distribute for sale, any part of the System or 
output of the System alone or in combination with any other text, data, software, or graphic 
matter. 
No Interactive Use. You do not have the right to combine the System interactively with 
the operation of other software unless licensed to do so by DeLorme. 
No Modifications or Decompilation. Except through use of any software modification 
functions provided with the System you have no right to modify the System in any way, 
incorporate any part or product of it into a compilation or create any derivative work. You 
may not reverse engineer, decompile, disassemble or otherwise access source code or the 
logical structure and contents of the System database. 
No Third Party/Service Bureau Use.  Except as specifically provided in this Agreement, 
you may not (a) permit any third party to use the System or transfer, disclose or otherwise 
make available the System to any third party, (b) use the System in the operation of a 
service bureau or (c) allow access to the System through terminals located outside your 
premises.  You agree to secure and protect the System in a manner consistent with the 
maintenance of DeLorme’s rights therein and to take appropriate action by instruction or 
agreement with your employees who are permitted access to the System to satisfy your 
obligations hereunder. 
No Copies. The copying of the System, any portion of the System, or any of the printed 
materials accompanying the System is strictly prohibited. 
All rights not specifically granted by this Agreement are reserved by DeLorme. 
ADDITIONAL USE AND PUBLICATION RIGHTS MAY BE AVAILABLE UNDER A SEPARATE 
EXTENDED LICENSE AGREEMENT. CONTACT DELORME AT 
HTTPS://CONTACT.DELORME.COM FOR DETAILS AND PRICING. 
  

WARNING, WARRANTIES, AND DISCLAIMER 

Warning. THE SYSTEM IS SUITABLE AND INTENDED ONLY FOR GENERAL VISUAL 
REFERENCE USE. IT SHOULD NOT BE USED FOR ANY PURPOSE REQUIRING EXACT 
MEASUREMENT OF DISTANCE OR DIRECTION, OR FOR PRECISION IN ADDRESS LOCATION 
OR IN THE DEPICTION OF GEOGRAPHIC FEATURES. ROUTING DIRECTIONS SHOULD BE 
USED ONLY AS A TRAVEL AID AND MUST ALWAYS BE VISUALLY VERIFIED BY THE USER ON 
THE GROUND AND EXECUTED WITH DUE REGARD TO TRAFFIC AND ROAD CONDITIONS, 
ROAD SIGNS AND REGULATIONS. Please note that the Data is merely a graphical 
representation of geographic features appearing on the face of the earth. The Data may 
include features, such as roads and trails, etc., that are located on private property. Nothing 
in this License grants the use of, or is intended to imply the right to use, any such private 
property.  You should respect all landowner restrictions.  You are solely responsible for 
complying with all legal requirements relating to land use and for your own safety and for 
the consequences of your actions in your use of the Data. 
Limited Warranty on Media. DeLorme warrants that the media on which the System is 
furnished shall, for a period of sixty (60) days from date of receipt (the "Warranty Period"), 
be free from defects in material and workmanship under normal use. If a defect in the 
media appears during the Warranty Period, return all materials to DeLorme for replacement, 
or at DeLorme’s option, refund of the license fee. 
Disclaimer of Warranty. DeLorme does not warrant the completeness or accuracy of the 
System, or that its use will meet your needs or be uninterrupted or error-free. TO THE 
MAXIMUM EXTENT PERMITTED BY LAW, EXCEPT FOR THE WARRANTIES SET FORTH ABOVE, 
THE SYSTEM IS LICENSED “AS IS” AND DELORME DISCLAIMS ANY AND ALL OTHER 
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WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, IMPLIED 
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 
No Consequential Damages. IN NO EVENT SHALL DELORME BE LIABLE FOR ANY 
SPECIAL, INDIRECT, INCIDENTAL OR CONSEQUENTIAL DAMAGES, INCLUDING, BUT NOT 
LIMITED TO, LOSS OF REVENUES OR PROFITS, EVEN IF DELORME HAS BEEN ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGES. 
  

TERMINATION AND TRANSFER 

DeLorme may terminate this Agreement at any time for any reason, including, but not 
limited to, if DeLorme finds that you have violated any of the terms of this Agreement or 
that you have attempted to exceed the licensed uses in any way. Termination will be 
effective upon written notice to you. Upon termination of this Agreement you agree to 
promptly return all copies of the System, documentation and other materials furnished to 
you or made by you, including unauthorized copies. Termination is in addition to and not in 
lieu of any other remedies available to DeLorme.  All provisions relating to property rights 
shall survive termination.  You are not authorized to transfer your rights under this 
Agreement. 
  

OTHER 

This Agreement contains the complete understanding between the parties and supersedes 
and replaces any prior or contemporaneous agreement or understanding, whether oral or 
written, with respect to its subject matter.  This Agreement shall be governed by the laws of 
the State of Maine, applicable to agreements wholly executed and wholly performed in 
Maine.  Any action relating to this Agreement shall be brought in federal or state court in 
Maine and the parties consent to the personal jurisdiction of either such court. 
  

U.S. GOVERNMENT RIGHTS IN COMMERCIAL SOFTWARE 
Use, duplication, or disclosure by the Government of all parts of the Licensed Data except 
any USGS data is subject to restrictions set forth in the commercial computer software 
license agreement under which the software is delivered by DeLorme and as provided in 
DFARS 227.7202-1(a) and 227.7202-3(a) or DFARS 227.225-7013 (OCT 1988), as 
applicable, or FAR 12.212(a), FAR 52.227-14 or FAR 52.227-19, as applicable. 

  
CANADIAN GOVERNMENT DATA 
Certain of the Canadian data included in the System are Adapted from Statistics Canada, 
FSA Boundary File, 92F0170XCE, 2001 Census; or Statistics Canada, 2005 Road Network 
File, 92-500-XWE; or Melissa Data's Canadian Postal Data product, based on input from STC 
data files. 
Statistics Canada information is used with the permission of Statistics Canada. Users are 
forbidden to copy this material and/or re-disseminate the data, in an original or modified 
form, for commercial purposes, without the expressed permission of Statistics Canada. 
Information on the availability of the wide range of data from Statistics Canada can be 
obtained from Statistics Canada's Regional Offices, its World Wide Web site at 
http://www.statcan.ca, and its toll-free access number 1-800-263-1136. 
  
Copyright © 2015 DeLorme. All rights reserved. 
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Important Notices 
Patent and Copyright Notice 

Street Atlas USA/StreetAtlas USA Plus is a limited field of use license under United States 
Patent law including the following patents owned by DeLorme: U.S. Pat. Nos. 4,972,319; 
5,030,117; 5,559,707; 5,802,492; and 6,321,158. Other patents pending. All software, 
data compilations, screen displays and map printouts are all protected by U.S. and foreign 
copyright and owned by DeLorme or its licensors. Purchaser of license acquires no rights 
that are not specifically set forth in the License Agreement included in the documentation. 
  

U.S. Government Rights in Commercial Software 

Use, duplication or disclosure by the Government is subject to restrictions set forth in the 
commercial computer software license agreement under which the software is delivered by 
DeLorme and as provided in DFARS  227.7202-1(a) and 227.7203-3(a) or DFARS 227.225-
7013 (OCT 1988), as applicable, or FAR 12.212(a), FAR 52.227-14 or FAR 52.227-19, as 
applicable. 
Copyright © 2015 DeLorme. 
  

Curl License 

Copyright © 1996-2010, Daniel Stenberg, <daniel@haxx.se> 
All rights reserved. 
Permission to use, copy, modify, and distribute this software for any purpose with or 
without fee is hereby granted, provided that the above copyright 
notice and this permission notice appear in all copies. 
THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE AND NON INFRINGEMENT OF THIRD PARTY RIGHTS. 
IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, 
DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR 
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE 
USE OR OTHER DEALINGS IN THE SOFTWARE. 
Except as contained in this notice, the name of a copyright holder shall not be used in 
advertising or otherwise to promote the sale, use or other dealings 
in this Software without prior written authorization of the copyright holder. 
  

LibTiff License 

Copyright © 1988-1997 Sam Leffler Copyright © 1991-1997 Silicon Graphics, Inc. 
Permission to use, copy, modify, distribute, and sell this software and its documentation for 
any purpose is hereby granted without fee, provided that (i) the above copyright notices 
and this permission notice appear in all copies of the software and related documentation, 
and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising 
or publicity relating to the software without the specific, prior written permission of Sam 
Leffler and Silicon Graphics. 
THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, 
IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.   
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IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, 
INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND,OR ANY DAMAGES 
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,WHETHER OR NOT 
ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING 
OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE. 
  

CSMap License 

Copyright © 2008, Autodesk, Inc. 
All rights reserved. 
Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met:     
* Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer.     
* Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution.     
* Neither the name of the Autodesk, Inc. nor the names of its contributors may be used to 
endorse or promote products derived from this software without specific prior written 
permission. 
THIS SOFTWARE IS PROVIDED BY Autodesk, Inc. ``AS IS'' AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO 
EVENT SHALL Autodesk, Inc. OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, 
OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,OR TORT (INCLUDING NEGLIGENCE 
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 
  

Boost License 

Boost Software License - Version 1.0 - August 17th, 2003 
Permission is hereby granted, free of charge, to any person or organization obtaining a copy 
of the software and accompanying documentation covered by this license (the "Software") 
to use, reproduce, display, distribute,execute, and transmit the Software, and to prepare 
derivative works of the Software, and to permit third-parties to whom the Software is 
furnished to do so, all subject to the following: 
The copyright notices in the Software and this entire statement, including the above license 
grant, this restriction and the following disclaimer,must be included in all copies of the 
Software, in whole or in part, and all derivative works of the Software, unless such copies or 
derivative works are solely in the form of machine-executable object code generated by a 
source language processor. 
THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF 
MERCHANTABILITY,FITNESS FOR A PARTICULAR PURPOSE, TITLE AND NON-
INFRINGEMENT. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR ANYONE 
DISTRIBUTING THE SOFTWARE BE LIABLE FOR ANY DAMAGES OR OTHER LIABILITY, 



Legal Information 

233 

WHETHER IN CONTRACT, TORT OR OTHERWISE,ARISING FROM, OUT OF OR IN 
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE. 
  

JasPer License 

JasPer License Version 2.0 
Copyright © 1999-2000 Image Power, Inc. 
Copyright © 1999-2000 The University of British Columbia 
Copyright © 2001-2003 Michael David Adams 
All rights reserved. 
Permission is hereby granted, free of charge, to any person (the"User") obtaining a copy of 
this software and associated documentation files (the "Software"), to deal in the Software 
without restriction,including without limitation the rights to use, copy, modify, 
merge,publish, distribute, and/or sell copies of the Software, and to permit persons to 
whom the Software is furnished to do so, subject to the following conditions: 
1.  The above copyright notices and this permission notice (which includes the disclaimer 
below) shall be included in all copies or substantial portions of the Software. 
2.  The name of a copyright holder shall not be used to endorse or promote products 
derived from the Software without specific prior written permission. 
THIS DISCLAIMER OF WARRANTY CONSTITUTES AN ESSENTIAL PART OF THIS LICENSE. 
 NO USE OF THE SOFTWARE IS AUTHORIZED HEREUNDER EXCEPT UNDER THIS 
DISCLAIMER.  THE SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS"AS IS", 
WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED 
TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NON INFRINGEMENT OF THIRD PARTY RIGHTS.  IN NO EVENT SHALL THE COPYRIGHT 
HOLDERS BE LIABLE FOR ANY CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL 
DAMAGES, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR 
PROFITS, WHETHER IN AN ACTION OF CONTRACT,NEGLIGENCE OR OTHER TORTIOUS 
ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS 
SOFTWARE.  NO ASSURANCES ARE PROVIDED BY THE COPYRIGHT HOLDERS THAT THE 
SOFTWARE DOES NOT INFRINGE THE PATENT OR OTHER INTELLECTUAL PROPERTY RIGHTS 
OF ANY OTHER ENTITY. EACH COPYRIGHT HOLDER DISCLAIMS ANY LIABILITY TO THE 
USER FOR CLAIMS BROUGHT BY ANY OTHER ENTITY BASED ON INFRINGEMENT OF 
INTELLECTUAL PROPERTY RIGHTS OR OTHERWISE.  AS A CONDITION TO EXERCISING THE 
RIGHTS GRANTED HEREUNDER, EACH USER HEREBY ASSUMES SOLE RESPONSIBILITY TO 
SECURE ANY OTHER INTELLECTUAL PROPERTY RIGHTS NEEDED, IF ANY.  THE SOFTWARE 
IS NOT FAULT-TOLERANT AND IS NOT INTENDED FOR USE IN MISSION-CRITICAL 
SYSTEMS, SUCH AS THOSE USED IN THE OPERATION OF NUCLEAR FACILITIES,AIRCRAFT 
NAVIGATION OR COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL SYSTEMS, DIRECT 
LIFE SUPPORT MACHINES, OR WEAPONS SYSTEMS, IN WHICH THE FAILURE OF THE 
SOFTWARE OR SYSTEM COULD LEAD DIRECTLY TO DEATH,PERSONAL INJURY, OR SEVERE 
PHYSICAL OR ENVIRONMENTAL DAMAGE ("HIGH RISK ACTIVITIES").  THE COPYRIGHT 
HOLDERS SPECIFICALLY DISCLAIM ANY EXPRESS OR IMPLIED WARRANTY OF FITNESS FOR 
HIGH RISK ACTIVITIES. 
  

ShapeLib License 

Copyright © 1999, Frank Warmerdam 
Permission is hereby granted, free of charge, to any person obtaining a copy of this 
software and associated documentation files (the "Software"), to deal in the Software 
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without restriction, including without limitation the rights to use, copy, modify, merge, 
publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to 
whom the Software is furnished to do so, subject to the following conditions: 
The above copyright notice and this permission notice shall be included in all copies or 
substantial portions of the Software. 
THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE AND NON INFRINGEMENT. IN NO EVENT SHALL THE 
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER 
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, 
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN 
THE SOFTWARE. 
  

GDAL Proj4 License 

Copyright © 2000, Frank Warmerdam 
Permission is hereby granted, free of charge, to any person obtaining a copy of this 
software and associated documentation files (the "Software"), to deal in the Software 
without restriction, including without limitation the rights to use, copy, modify, merge, 
publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to 
whom the Software is furnished to do so, subject to the following conditions: 
The above copyright notice and this permission notice shall be included in all copies or 
substantial portions of the Software. 
THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE AND NON INFRINGEMENT. IN NO EVENT SHALL THE 
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER 
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, 
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN 
THE SOFTWARE. 
  

GDAL gtiff Format License 

Copyright © 2002, Industrial Light & Magic, a division of Lucas Digital Ltd. LLC 
All rights reserved. 
Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met: 
* Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer. 
* Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution. 
* Neither the name of Industrial Light & Magic nor the names of its contributors may be 
used to endorse or promote products derived from this software without specific prior 
written permission. 
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS"AS IS" 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FORA PARTICULAR PURPOSE 
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,SPECIAL, EXEMPLARY, OR 
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CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE. 
  

GDAL hdf4 Format License 

Copyright © 1996 Hughes and Applied Research Corporation 
Permission to use, modify, and distribute this software and its documentation  for any 
purpose without fee is hereby granted, provided that the above  copyright notice appear in 
all copies and that both that copyright notice and  this permission notice appear in 
supporting documentation. 
  

GDAL pcraster Format License 

Copyright © 1997-2003, Utrecht University 
All rights reserved. 
Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met: 
* Redistributions of source code must retain the above copyright  notice, this list of 
conditions and the following disclaimer. 
* Redistributions in binary form must reproduce the above  copyright notice, this list of 
conditions and the following  disclaimer in the documentation and/or other materials 
provided  with the distribution. 
* Neither the name of Utrecht University nor the names of its contributors  may be used to 
endorse or promote products derived from this software  without specific prior written 
permission. 
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS"AS IS" 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FORA PARTICULAR PURPOSE 
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE. 
  

GDAL grib Format License 

The degrib and g2clib source code are modified versions of code produced by NOAA NWS 
and are in the public domain subject to the following restrictions: 
http://www.weather.gov/im/softa.htm 
DISCLAIMER The United States Government makes no warranty, expressed or implied, as to 
the usefulness of the software and documentation for any purpose. The U.S. Government, 
its instrumentalities, officers, employees, and agents assumes no responsibility (1) for the 
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use of the software and documentation listed below, or (2) to provide technical support to 
users. 
http://www.weather.gov/disclaimer.php 
The information on government servers are in the public domain, unless specifically 
annotated otherwise, and may be used freely by the public so long as you do not 1) claim it 
is your own (e.g. by claiming copyright for NWS information -- see below), 2) use it in a 
manner that implies an endorsement or affiliation with NOAA/NWS, or 3) modify it in 
content and then present it as official government material. You also cannot present 
information of your own in a way that makes it appear to be official government 
information.. 
The user assumes the entire risk related to its use of this data. NWS is providing this data 
"as is," and NWS disclaims any and all warranties, whether express or implied, including 
(without limitation) any implied warranties of merchantability or fitness for a particular 
purpose. In no event will NWS be liable to you or to any third party for any direct, indirect, 
incidental, consequential, special or exemplary damages or lost profit resulting from any use 
or misuse of this data. 
As required by 17 U.S.C. 403, third parties producing copyrighted works consisting 
predominantly of the material appearing in NWS Web pages must provide notice with such 
work(s) identifying the NWS material incorporated and stating that such material is not 
subject to copyright protection. 

Acxiom License

The program includes information that is proprietary to Acxiom Corporation and is protected under 
U.S. copyright law and international treaty provisions. This information is licensed for your personal 
or professional use and may not be resold or provide to others. You may not distribute, sell, rent, 
sublicense, or lease such information in whole or in part to any third party; you will not make such 
Acxiom information available in whole or in part to any other user in any networked or time-sharing 
environment, or transfer the information in whole or in part to any computer other than the PC used 
to access this information.



 

237 

Index 
3 
3D Fix ............ 21, 27, 191, 201, 210, 215 
A 
About GPS ....................................... 204 
Activating Speech Recognition ........... 210 
Add/Delete Words ............................ 216 
Adding a Symbol .............................. 158 
Adding a Text Label .......................... 158 
Adding a Waypoint ........................... 158 
Adding Draw Objects .. 150, 151, 155, 158 
Adding Points to Draw Objects ........... 148 
Adding Stops and Vias ...................... 176 
Adding Text or Graphics ...................... 81 
Address Book..... 105, 106, 107, 108, 109, 

110 
Advanced Search ............................... 93 
Aligning Text and Graphic Items on Your 

Map ............................................... 83 
Almanac .......................................... 202 
Along the Way ............................ 80, 181 
Anchor Position ................................ 171 
Arc(s) ...............................150, 152, 154 
Assembling a Multi-page Map............... 86 
Assigning a Waypoint ID to a Custom 

Symbol ........................................ 164 
Assigning Keyboard Shortcuts .............. 61 
Audio Controls ................................. 216 
Auto Zoom To Turn .......................... 191 
Automatically Detect GPS .................. 191 
Avoiding a Specified Area When Routing

 ................................................... 180 
B 
Back on Track .................................. 197 
Basic Map Features............................. 49 
Basic Search ...................................... 92 
Beep When Heard ............................ 210 
Bitmap ........................ 14, 166, 168, 169 
Breaking Linear Objects .................... 154 
C 
Category ......................................... 166 
Category Searches ........................... 100 

Center on GPS ................................. 198 
Centering Routes on the Map ............. 185 
Centering the Map .............................. 13 
Centering the Map on an Address Book 

Contact ........................................ 106 
Changing Draw Object Types ............. 140 
Changing How POIs Display on the Map 53 
Changing the Background Color of a 

Printed Map .................................... 85 
Changing the Map Colors ..................... 52 
Changing the Map Magnification ........... 53 
Changing the Properties of a Stop ...... 179 
Changing Voice Output ..................... 215 
Chart of Supported Coordinate Formats 16 
Clear Trail ....................................... 199 
Compass Rose ................................... 18 
Connecting Data ................................ 67 
Control Panel ..................................... 18 
Converting a Route to a GPS Log........ 188 
Converting MapTags to MapNotes ....... 102 
Coordinate Formats ............................ 16 
Coordinates ................................ 54, 201 
Copy Symbol to Waypoint ................. 140 
Copy to Active Road Layer ................. 140 
Copy to Active Track Layer ................ 140 
Copy to Active Trail Layer .................. 140 
Copy to Draw Object ........................ 140 
Copy Track to GPS Log ..................... 140 
Copying a Draw File .......................... 139 
Copying a Draw Object From One Draw 

File to Another .............................. 142 
Copying a Map Line to a Draw File ...... 137 
Copying and Pasting ......................... 167 
Copying and Placing Draw Objects ...... 143 
Copying Your Map to the Clipboard ....... 13 
County Borders .................................. 49 
Create Dataset ................................. 122 
Create Route from Line ..................... 150 
Creating a New Custom Scheme .... 61, 63 
Creating a New Draw File .................. 128 
Creating a New Symbol ..................... 163 



Street Atlas USA User Guide 

238 
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Drag and Zoom .................................. 11 
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